Document Management

Release 4.6C
Copyright

© Copyright 2001 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are registered trademarks of Microsoft Corporation.

IBM®, DB2®, OS/2®, DB2/6000®, Parallel Sysplex®, MVS/ESA®, RS/6000®, AIX®, S/390®, AS/400®, OS/390®, and OS/400® are registered trademarks of IBM Corporation.

ORACLE® is a registered trademark of ORACLE Corporation.

INFORMIX®-OnLine for SAP and Informix® Dynamic Server™ are registered trademarks of Informix Software Incorporated.

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

JAVA® is a registered trademark of Sun Microsystems, Inc.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, SAP Logo, R/2, R/3, ABAP, SAP ArchiveLink, SAP Business Workflow, WebFlow, SAP EarlyWatch, BAPI, SAPHIRE, Management Cockpit, mySAP.com Logo and mySAP.com are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other products mentioned are trademarks or registered trademarks of their respective companies.
# Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Caution</td>
</tr>
<tr>
<td>📝</td>
<td>Example</td>
</tr>
<tr>
<td>📘</td>
<td>Note</td>
</tr>
<tr>
<td>📕</td>
<td>Recommendation</td>
</tr>
<tr>
<td>📜</td>
<td>Syntax</td>
</tr>
</tbody>
</table>
## Inhalt

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Management</td>
<td>11</td>
</tr>
<tr>
<td>Examples of the Uses of Document Management</td>
<td>14</td>
</tr>
<tr>
<td>Processing Options</td>
<td>17</td>
</tr>
<tr>
<td>Document Management Menu</td>
<td>19</td>
</tr>
<tr>
<td>Authorization Objects for Documents</td>
<td>20</td>
</tr>
<tr>
<td>Document Info Record</td>
<td>21</td>
</tr>
<tr>
<td>Document Number</td>
<td>24</td>
</tr>
<tr>
<td>- Internal Number Assignment</td>
<td>25</td>
</tr>
<tr>
<td>- Mixed Number Assignment</td>
<td>26</td>
</tr>
<tr>
<td>Document Type</td>
<td>29</td>
</tr>
<tr>
<td>Document Part</td>
<td>31</td>
</tr>
<tr>
<td>- List of Document Parts</td>
<td>32</td>
</tr>
<tr>
<td>Document version</td>
<td>33</td>
</tr>
<tr>
<td>- Version List</td>
<td>35</td>
</tr>
<tr>
<td>Default Settings</td>
<td>36</td>
</tr>
<tr>
<td>Document Description</td>
<td>38</td>
</tr>
<tr>
<td>- Creating Descriptions</td>
<td>39</td>
</tr>
<tr>
<td>- Copying Text</td>
<td>40</td>
</tr>
<tr>
<td>Definition of Responsibility</td>
<td>41</td>
</tr>
<tr>
<td>- Defining the Persons Responsible for a Document</td>
<td>42</td>
</tr>
<tr>
<td>Saving Documents</td>
<td>43</td>
</tr>
<tr>
<td>Status Management</td>
<td>44</td>
</tr>
<tr>
<td>- Defining Statuses</td>
<td>46</td>
</tr>
<tr>
<td>- Definition of a Status Network</td>
<td>47</td>
</tr>
<tr>
<td>- Displaying the Status Network</td>
<td>49</td>
</tr>
<tr>
<td>- Status History in the Status Log</td>
<td>51</td>
</tr>
<tr>
<td>- Release Status of Documents</td>
<td>53</td>
</tr>
<tr>
<td>- Complete for Engineering Change Management</td>
<td>55</td>
</tr>
<tr>
<td>- Content Versions for Original Application Files</td>
<td>56</td>
</tr>
<tr>
<td>- Storing Original Application Files</td>
<td>58</td>
</tr>
<tr>
<td>- Overview of Additional Functions after Status Changes</td>
<td>59</td>
</tr>
<tr>
<td>- Maintaining the Document Status</td>
<td>61</td>
</tr>
<tr>
<td>Linking objects to a document</td>
<td>62</td>
</tr>
<tr>
<td>- Linking Documents to R/3 Objects</td>
<td>64</td>
</tr>
<tr>
<td>- Displaying Object Links</td>
<td>65</td>
</tr>
<tr>
<td>- Adding Other Objects</td>
<td>66</td>
</tr>
<tr>
<td>- Additional Functions for Object Links</td>
<td>67</td>
</tr>
<tr>
<td>- Creating Long Texts for Object Links</td>
<td>68</td>
</tr>
<tr>
<td>- Valuation Objects for Object Links</td>
<td>69</td>
</tr>
<tr>
<td>- Classifying Object Links</td>
<td>71</td>
</tr>
<tr>
<td>Creation of a Simple Document Hierarchy</td>
<td>73</td>
</tr>
<tr>
<td>- Defining a Superior Document</td>
<td>75</td>
</tr>
<tr>
<td>- Displaying a Document Hierarchy</td>
<td>76</td>
</tr>
<tr>
<td>- Displaying a Document Hierarchy Graphic</td>
<td>77</td>
</tr>
</tbody>
</table>
Checking Authorization from the Document Management Systems ............................................................................................................. 343
Processing of Original Application Files .................................................................................................................................................. 344
General Document Processing .............................................................................................................................................................. 346
General Document Processing (II) ........................................................................................................................................................... 347
Status checks .......................................................................................................................................................................................... 348
Transport of Original Application Files .................................................................................................................................................. 349
Checking the Attributes of the Document Key ........................................................................................................................................ 350
Filter for DMS processes ......................................................................................................................................................................... 351
Enhancements for Internet Scenarios ...................................................................................................................................................... 352
Enhancements for Microsoft Office integration ......................................................................................................................................... 353
Enhancements using User Exits (Document) ............................................................................................................................................... 354
Enhancements Using Customer Exits (Material Master) ........................................................................................................................................... 356
Enhancements in the Area Engineering Change Management ............................................................................................................ 358
Enhancements in BOMs ...................................................................................................................................................................... 360
Enhancements Using Customer Exits (BOMs) ............................................................................................................................................... 361
Enhancements using Business Transaction Events (BOMs) ......................................................................................................................... 363
Update of a BOM (CS000010) .................................................................................................................................................................. 364
Enhancements in the Classification System ................................................................................................................................................ 365
Enhancements in Variant Configuration ......................................................................................................................................................... 367
Classification for Document Management .................................................................................................................................................. 370
Before you Classify a Document ............................................................................................................................................................... 372
Classifying a Document in the Document Info Record ........................................................................................................................................... 373
Classifying Documents in the Classification System ................................................................................................................................. 374
Changing the Classification Data of a Document .............................................................................................................................................. 376
Additional Data for a Document ............................................................................................................................................................... 377
Engineering Change Management in Document Management ........................................................................................................................................... 379
Creating a Change Master Record ............................................................................................................................................................. 381
Making Reservations in Engineering Change Management ........................................................................................................................................... 382
Reserving a Document for a Change Number .............................................................................................................................................. 383
Processing a Reserved Document ............................................................................................................................................................ 384
Revision Level Assignment ............................................................................................................................................................................. 385
Assigning a Revision Level to a Document .................................................................................................................................................... 387
Changing a Revision Level ........................................................................................................................................................................... 388
Displaying a Revision Level ............................................................................................................................................................................ 389
Engineering Change Requests (ECRs) ........................................................................................................................................................... 390
Changing a Document with an ECR .............................................................................................................................................................. 392
Checking a Document and Converting an ECR ............................................................................................................................................... 393
Changing a Document and Completing an ECO ............................................................................................................................................... 395
Document Distribution .................................................................................................................................................................................. 396
Recipient Management ............................................................................................................................................................................... 398
Recipients ........................................................................................................................................................................................................... 399
Creating a Recipient .................................................................................................................................................................................. 401
Recipient Lists ......................................................................................................................................................................................... 402
Create recipient list ..................................................................................................................................................................................... 404
Copying Documents from the Product Structure .............................................................................................................................................. 406
Selecting Original Application Files for Distribution .............................................................................................................................................. 407
Displaying the Recipient of a Document ...................................................................................................................................................... 408
Maintaining Objects in the Engineering Workbench .............................................................. 499
Maintaining Structures from Plant Maintenance .............................................................. 501
    Function Overview for Functional Locations ................................................................. 502
    Function Overview for Equipment ................................................................................. 504
Display Original Application File with the Viewer ............................................................ 506
Using the Product Structure for Object Folders ............................................................... 509
    Creating Object Folders ................................................................................................. 511
    Checking Objects from the Product Structure into a Folder ........................................... 512
    Object Transfer in Folder Processing ............................................................................ 514
Displaying the Product Structure with the Simple List Display ........................................... 516
    Processing Objects in List Display ............................................................................... 518
    Copying Documents from the List Display ...................................................................... 520
    Copying a Change Object from the List Display ............................................................. 522
Conversion ......................................................................................................................... 524
Installing the Converter ..................................................................................................... 528
    Hints on the Communication Programs ......................................................................... 531
    Connecting the Converter .............................................................................................. 534
Customizing for Conversions ............................................................................................ 542
    Maintaining Customizing for Conversions ..................................................................... 544
Converting Documents (Automatic Start) ........................................................................ 546
Converting Documents (Manual Start) ............................................................................. 547
Converting Assemblies ...................................................................................................... 548
Displaying Messages .......................................................................................................... 550
Administrative Utilities ....................................................................................................... 552
Setting up an RFC Destination for a RFC Server ............................................................ 553
    Setting up the Program Start Using SAP Gateway ......................................................... 554
    Setting up Registration on the SAP Gateway ................................................................. 556
Example Installation of a Conversion Server ..................................................................... 558
Digital Mock-Up Viewing .................................................................................................. 561
    Setting up Customizing for DMU Viewing ................................................................. 564
    Viewer for Displaying Original Application Files ......................................................... 566
    Displaying 3D Models of Assemblies ......................................................................... 570
Document Management

Purpose

In recent years, the increasing complexity of products has led to increasingly complex development tools, such as computer-aided design (CAD) systems, and more advanced production processes, such as computer-aided manufacturing (CAM) systems. CAD and CAM tools have been used to optimize production times and quality.

As this process becomes more complex, the systems for managing the technical documents involved need to be more sophisticated. The many different procedures for describing products (such as design drawings, photographs, and texts) mean that there is a huge increase in digitally stored data.

The quality and availability of documentation is becoming increasingly important. The Document Management System (DMS) in the SAP System offers the following advantages:

- If you link document management to computerized development and production systems, you avoid data redundancy, maintain consistency of data, and minimize the workload involved in entering and updating your data.

- In order to use large databases to the full, you need to be able to exchange data quickly and securely. You can access your data directly using electronic search tools, or find documents using known parameters. You can also search for and display documents (original application files) via the Internet/intranet.

  By reducing access time and the workload involved in routine tasks, you can lower your costs considerably.

- You can use document distribution to distribute documents that are managed in the document management system (DMS) either manually or automatically according to company-specific processes. This ensures that the employees responsible or external partners can view or process up-to-the-minute information.

- Stricter product liability laws mean that it is becoming increasingly important to archive documents during the life cycle of a product. The quality of a product includes the production process and the whole organizational environment, as well as the product itself. A company that wishes to be certified for quality management (ISO 9000 to 9006) can only meet strict quality requirements by using high-performance document management functions.

SAP Document Management meets all these complex requirements. In addition to managing documents, it also coordinates document processing. You can automate the entire life cycle of a document: from document creation to document storage, from access to update. Each document can be accessed immediately from any computer in the network.

Integration

The SAP Document Management comprises a range of functions for managing documents that may be stored both in your SAP System and external systems.

The following graphic shows objects that you can maintain documents for in the standard SAP System.
Features

SAP Document Management offers you a wide range of functions for managing product documentation and ensuring problem-free data exchange between different applications.

See: Example: Example: Processing Functions [Seite 19]

The integration of Document Management in many SAP System applications and its functions for interfaces to external systems, mean that you have many different ways of processing documents. Because of this deep integration, Document Management is one of the central functions within Logistics.

The following graphic shows the integration of Document Management in the SAP System.
Deep integration in the SAP System affords a wide range of functions and many options are open to you for configuring your system to meet your company's specific requirements. *Document Management* can be adapted to suit the needs of different user groups and industry sectors.

**See also:** [Enhancements in Document Management [Seite 323]]
Document Management

Purpose

In recent years, the increasing complexity of products has led to increasingly complex development tools, such as computer-aided design (CAD) systems, and more advanced production processes, such as computer-aided manufacturing (CAM) systems. CAD and CAM tools have been used to optimize production times and quality.

As this process becomes more complex, the systems for managing the technical documents involved need to be more sophisticated. The many different procedures for describing products (such as design drawings, photographs, and texts) mean that there is a huge increase in digitally stored data.

The quality and availability of documentation is becoming increasingly important. The Document Management System (DMS) in the SAP System offers the following advantages:

- If you link document management to computerized development and production systems, you avoid data redundancy, maintain consistency of data, and minimize the workload involved in entering and updating your data.

- In order to use large databases to the full, you need to be able to exchange data quickly and securely. You can access your data directly using electronic search tools, or find documents using known parameters. You can also search for and display documents (original application files) via the Internet/intranet. By reducing access time and the workload involved in routine tasks, you can lower your costs considerably.

- You can use document distribution to distribute documents that are managed in the document management system (DMS) either manually or automatically according to company-specific processes. This ensures that the employees responsible or external partners can view or process up-to-the-minute information.

- Stricter product liability laws mean that it is becoming increasingly important to archive documents during the life cycle of a product. The quality of a product includes the production process and the whole organizational environment, as well as the product itself. A company that wishes to be certified for quality management (ISO 9000 to 9006) can only meet strict quality requirements by using high-performance document management functions.

SAP Document Management meets all these complex requirements. In addition to managing documents, it also coordinates document processing. You can automate the entire life cycle of a document: from document creation to document storage, from access to update. Each document can be accessed immediately from any computer in the network.

Integration

The SAP Document Management comprises a range of functions for managing documents that may be stored both in your SAP System and external systems.

The following graphic shows objects that you can maintain documents for in the standard SAP System.
Features

SAP Document Management offers you a wide range of functions for managing product documentation and ensuring problem-free data exchange between different applications.

See: Example: Processing Functions [Seite 19]

The integration of Document Management in many SAP System applications and its functions for interfaces to external systems, mean that you have many different ways of processing documents. Because of this deep integration, Document Management is one of the central functions within Logistics.

The following graphic shows the integration of Document Management in the SAP System.
Document Management

Deep integration in the SAP System affords a wide range of functions and many options are open to you for configuring your system to meet your company's specific requirements. Document Management can be adapted to suit the needs of different user groups and industry sectors.

See also: Enhancements in Document Management [Seite 323]
Examples of the Uses of Document Management

The following examples show some of the uses of document management in different areas of a company.

- **Example 1**
  In the design office, document management can be used to manage drawings. All design drawings can be linked to material masters. Using classification functions, you can search for an assembly and copy the drawing of the assembly to a CAD system (via the CAD interface).

- **Example 2**
  Companies that process complex documents can use document structures to organize these documents. All documents and texts that are logically connected can be grouped together in one document structure.

- **Example 3**
  A routing contains the sequence of operations for manufacturing a product. Documents can be allocated to the operations in a routing as production resources/tools. These documents may be used, for example, to describe the specifications of a product, or to store inspection requirements.

  The following graphic shows the allocation of documents to operations.

- **Example 4**
  Documents can be linked to projects. You can use the document hierarchy to represent individual product folders that are given to the product administrators responsible. Using the status management functions, you can determine that a project folder is only
Examples of the Uses of Document Management

released when all the documents in the folder (for example, drawings, documentation) are released.
**Processing Options**

**Features**

The following overview shows some of the options available for processing a document.

**Processing Options for Documents**

<table>
<thead>
<tr>
<th>Functions for the document info record</th>
<th>Interfaces to internal systems</th>
<th>Interfaces to external systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number assignment</td>
<td>Link to other R/3 objects, such as:</td>
<td></td>
</tr>
<tr>
<td>Version management</td>
<td>- Materials</td>
<td></td>
</tr>
<tr>
<td>Classification</td>
<td>- Equipment</td>
<td></td>
</tr>
<tr>
<td>Document hierarchy</td>
<td>- Customer</td>
<td></td>
</tr>
<tr>
<td>Content versions for original application files</td>
<td>Engineering change management with integrated workflow</td>
<td></td>
</tr>
<tr>
<td>Find document (Also via Internet / Intranet)</td>
<td>SAP Business Workflow</td>
<td></td>
</tr>
<tr>
<td>Document distribution</td>
<td>Document Structures</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Internet application functions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distribution via ALE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Any workstation application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAD systems via SAP-CAD interface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Archiving using R/3 ArchiveLink or Knowledge Provider</td>
<td></td>
</tr>
</tbody>
</table>
Document Management Menu

Calling the Menu

You have the following options for calling the document management functions:

- **Call the Document Management menu directly**
  
  Choose Logistics → Central functions → Document management. You see the main Document Management screen.

- **Call from the Engineering menu**
  
  Choose Logistics → Central functions → Engineering. You can call the processing functions for documents under Document.

- **Call from an application component menu. For example:**
  
  Menu BOMs: Environment → Document management

- **Call from a customized user menu**

Structure

The Document Management main menu contains the following entries for processing documents:

**Documents**

You use the Document menu entry to create, change, or display a document. Find helps you to find documents. By entering different parameters, you can find existing documents and process them for new projects.

**Environment**

From this menu entry you can call the Bills of Material, Classification, or Engineering Change Management menu.

The Document distribution function allows you to define recipient lists for distributing documents and to start the actual distribution process. Documents that must be approved with a digital signature can be selected according to various signature data using the Find digital signatures function.
Authorization Objects for Documents

Definition

The document management authorization objects are elements of the standard R/3 System authorization concept.

They enable you to use complex authorizations for processing documents and their original application files.

Use

Document processing is organized in accordance with your company’s structure. Master data for all application areas is often created at one central location. Data that is specific to an application area is then added using the Change function.

The authorization system can be set up accordingly. Access authorizations are controlled via various authorization objects.

If you want to link the document to other SAP objects, the system also executes the authorization checks from the appropriate application areas while you are processing.

If you execute document management functions from within engineering change management your, the system checks the authorizations for engineering change management. The authorization objects are allocated to the Production Planning object class.

You need not know the individual authorization objects in detail if you generate the authorization profiles for the individual activity groups using the profile generator [Extern].

Structure

The authorization objects for documents are assigned to the Document Management object class. Four authorization objects are defined for the Document Management System in the standard system.

Authorization Object C_DRAW_TCD (Activities for Documents)

The following table shows authorization object C_DRAW_TCD. This object controls which users can process which document info records, based on a combination of activity and document type.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTVT (Activity)</td>
<td>01</td>
<td>Create</td>
</tr>
<tr>
<td></td>
<td>02</td>
<td>Change</td>
</tr>
<tr>
<td></td>
<td>03</td>
<td>Display</td>
</tr>
<tr>
<td></td>
<td>06</td>
<td>Delete</td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>Maintain number range object</td>
</tr>
</tbody>
</table>
Authorization Objects for Documents

**Authorization Object C_DRAW_TCS (Status Dependent Authorization)**

The following table shows authorization object C_DRAW_TCS. This object controls which users can process which document info records, based on a combination of activity, document type, and status.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTVT (Activity)</td>
<td>01, 02, 03, 06</td>
<td>Create, Change, Display, Delete</td>
</tr>
<tr>
<td>DOKAR (Document type)</td>
<td></td>
<td>The activities can be executed for the document type.</td>
</tr>
<tr>
<td>STATUS (Document status)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Authorization Object C_DRAW_STA (Document Status)**

The following table shows authorization object C_DRAW_STA. This object controls which status(es) can be set for which document type.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOKAR (Document type)</td>
<td>The statuses are allowed for this document type.</td>
</tr>
<tr>
<td>DOKST (Document status)</td>
<td></td>
</tr>
</tbody>
</table>

**Authorization Object C_DRAW_BGR (Authorization Group)**

The following table shows authorization object C_DRAW_BGR. This authorization object allows you to limit access to individual documents.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEGRU (Authorization group)</td>
<td>0000 - ZZZZ</td>
<td>Used to restrict the authorizations for document maintenance further.</td>
</tr>
</tbody>
</table>
Authorization Object C_DRAW_DOK (Document Access)

The following table shows authorization object C_DRAW_DOK. This authorization object controls which original data of a specific document type there are access authorizations for.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTVT</td>
<td>52</td>
<td>Change application start</td>
</tr>
<tr>
<td></td>
<td>53</td>
<td>Display application start</td>
</tr>
<tr>
<td></td>
<td>54</td>
<td>Display archive application</td>
</tr>
<tr>
<td></td>
<td>55</td>
<td>Change archive application</td>
</tr>
<tr>
<td></td>
<td>56</td>
<td>Display archive</td>
</tr>
<tr>
<td></td>
<td>57</td>
<td>Store archive</td>
</tr>
<tr>
<td>DOKAR</td>
<td></td>
<td>Here you enter the document type that access to original data is allowed for.</td>
</tr>
<tr>
<td>(Document type)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Authorization Object C_DRAD_OBJ (Object Link)

The following table shows authorization object C_DRAD_OBJ. This object controls which users can process which document info records, based on a combination of activity, object, and status.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTVT</td>
<td>01</td>
<td>Create</td>
</tr>
<tr>
<td></td>
<td>02</td>
<td>Change</td>
</tr>
<tr>
<td></td>
<td>03</td>
<td>Display</td>
</tr>
<tr>
<td></td>
<td>06</td>
<td>Delete</td>
</tr>
<tr>
<td>DOKOB</td>
<td></td>
<td>You must enter the data base table for the objects here (for example, MARA for material record).</td>
</tr>
<tr>
<td>(Object)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Document status)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

There are additional checks for document distribution.

See also: Authorization Objects for Document Distribution [Seite 466]
Document Info Record

Definition
A document is a carrier of information. This information is either for the user/person responsible or for exchanging between systems. A document contains information that can be stored and it can take many different forms (such as technical drawings, graphics, programs, or text). When complete, this information gives a full description of an object.

We use the term document info record to refer to the master record in the R/3 System that stores all the business information for a document. While the document info record contains the metadata for a document (such as the storage location), the original file (for example, the design drawing) contains the actual information in the document.

Structure
The document info record contains the following information:
- Data that is descriptive in character (for example, laboratory)
- Data with a control function (for example, document status)
- Original application file data (for example, processing application or storage location)
- Data that the system automatically copies (for example, CAD indicator)

Integration
Documents are identified in the R/3 System using the document key fields:
- Document number [Seite 25]
- Document type [Seite 29]
- Document part [Seite 31]
- Document version [Seite 33]
Document Number

Definition

The document number, or in short, document, identifies a document as the main part of a document key.

Structure

This is an alphanumeric field in which you can enter up to 25 characters.

The following overview shows some examples for documents.

<table>
<thead>
<tr>
<th>Document</th>
<th>Document type</th>
<th>Document part</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>02</td>
</tr>
<tr>
<td>DOC-02-AA</td>
<td>DRW</td>
<td>000</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>L01</td>
<td>000</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>L01</td>
<td>000</td>
<td>02</td>
</tr>
</tbody>
</table>

Integration

You can define number assignment in Customizing for Document Management under Define document types.

For example, you can make the following settings for number assignment:

- Type of number assignment (such as internal and external assignment)
  
  See Internal Number Assignment [Seite 26] and Mixed Number Assignment [Seite 27]

- Number ranges for internal and external number assignment

- Program for the number assignment
  
  In the standard system, number assignment is controlled by the MCDOKZNR program. The MCDOKZNR program contains the GET_NUMBER routine. In accordance with the document type, this routine allows you to define any part of the document number yourself.

Specifications for Number Assignment

There is a system check for special characters in the document number.

The following three special characters are not supported:

```
& *, and ".
```

The special character "*" at the beginning of the field has a specific meaning (internal number assignment).
Internal Number Assignment

Usage
Internal number assignment means that the system automatically assigns a document number to the document when you create it.

Prerequisites
You can define internal number assignment in Customizing for Document Management under Define document types.

You must make the following settings for internal number assignment:

- **Type of number assignment**
  Choose a type that supports internal number assignment, for example BLANK as value (internal or external number assignment)
- **Enter the internal number range**
- **Enter the program for the number assignment**
  In the standard system, number assignment is controlled by the MCDOKZNR program.

Activities
Internal number assignment takes place automatically if you make one of the following entries when you create a document:

- You do **not** enter a value for the document number
- You enter the special character "***"

When you save the document, the system assigns a consecutive number from the allocated number range.
Mixed Number Assignment

Usage

Mixed number assignment means that part of the document number can be assigned internally by the system, and the other part can be assigned by the user.

Mixed number assignment is supported for document type L01. The document number consists of the following two parts:

- First part of number:
  In a specific program for controlling number assignment, the character string `TRANS-01-ENG-` is defined as a fixed part of the document number. The system enters this string in the Document number field.

- Second part of number:
  The user assigns the second part from a defined external number range according to organizational criteria.

  TRANS-01-ENG-01
  TRANS-22-ENG-01
  TRANS-43-ENG-01

Prerequisites

You can define mixed number assignment in Customizing for Document Management under Define document types.

You must make the following settings for mixed number assignment:

- Type of number assignment
  Choose a type that supports mixed number assignment, for example the value 3 in the standard R/3 System (mixed number assignment with exit)

- Enter the internal and external number range

- Enter the program for the number assignment
  In the standard system, number assignment is controlled by the `MCDOKZNR` program. Copy this program. Remember that you must choose the program name from the reserved area for customer names.

  You must make the required adjustments in the following FORM routines:

  - GET_NUMBER
    The program controls number assignment according to the type of number assignment that has been defined.

  - CHECKNUMBER
    The program executes the number check.
Mixed Number Assignment

**Activities**

When you create a document, number assignment takes place according to the program exit for the document number. This program exit is defined for the chosen document type in Customizing.
Document Type

Definition
The document type is used to categorize documents according to their distinguishing features and the organizational procedures that result from them. The description of the document type is language-dependent.

Use
It has important control functions in document management and is used, for example, to control the processing flow via a status network.

Structure
The document type is an alphanumeric field in which you can enter up to three characters.

The following overview shows some examples for documents of the same and of different document types.

<table>
<thead>
<tr>
<th>Documents</th>
<th>Document Type</th>
<th>Document part</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>02</td>
</tr>
<tr>
<td>DOC-02</td>
<td>L11</td>
<td>000</td>
<td>00</td>
</tr>
<tr>
<td>DOC-03</td>
<td>L11</td>
<td>000</td>
<td>00</td>
</tr>
</tbody>
</table>

Integration

For example, the following control aspects are supported by the document types:
- Type of number assignment and number range
- Version increment
- Field selection
- Additional fields
- Status processing
- Storage in Knowledge Provider
- Transport of original application files using ALE

Internal Document Types
In the standard system, the following document types are defined and are used in various applications:
- Print list (D01)
- Batch record (EBR)
Document Type

- Quality agreement (Q01)
- Technical delivery conditions (Q02)

Since these document types are used internally, you cannot change or delete their settings in Customizing for the Document Management System.
**Document Part**

**Definition**

Document parts subdivide a document into several documents.

**Use**

Document parts can be used as follows:

- You can enter individual sheets of a complex design drawing as document parts for a document number.
- You can manage documents in different languages. You can enter a document in Spanish under a different document part than the same document in French.

**Structure**

The *Document part* is an alphanumeric field in which you can enter up to three characters.

The following overview shows some examples for document parts of a document.

<table>
<thead>
<tr>
<th>Document</th>
<th>Document Type</th>
<th>Document Part</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>001</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>002</td>
<td>01</td>
</tr>
</tbody>
</table>

**Integration**

The default value in the standard R/3 system is **000**.

There is a system check for special characters in the *Document part* field. The following three special characters are **not** supported: “&”, “*” and “,”.

The special character “*” has a specific meaning (list of document parts).

See [List of Document Parts [Seite 32]](#)
List of Document Parts

Use
This list gives you an overview of which document parts and versions exist for the document number of a specific document type. For example, all document parts and versions for the document DOC-01-AA, document type DRW are displayed.

Prerequisites
You can call the list of document part in different processing situations:

- *Initial screen* for the following functions:
  - Document → Create
  - Document → New version
  - Document → Change
  - Document → Display
- While processing a document for example on the tab page Document data

Features
The list displays the status and document description for all document parts and versions.

From this version list, you can execute the following functions:

- Edit the document
- Print the version list

Activities
Choose the functions Extras → Document part on one of the given screens.
Document version

Definition

Document versions are used to represent the different change or delivery statuses of a document.

This field is part of the document key and is often referred to simply as Version.

Use

Document versions document a processing status in a complex change process.

Structure

The Document version is an alphanumeric field in which you can enter up to two characters.

The following overview shows some examples for the versions of a document.

<table>
<thead>
<tr>
<th>Documents</th>
<th>Document Type</th>
<th>Document part</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>01</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>02</td>
</tr>
<tr>
<td>DOC-01-AA</td>
<td>DRW</td>
<td>000</td>
<td>03</td>
</tr>
</tbody>
</table>

Integration

You define how versions are assigned in Customizing for the Document Management System by choosing Define document types.

For example, you can make the following settings for version assignment:

- **Automatic**
  
  If automatic version number assignment is defined for the chosen document type, any entry you make is ignored. If the highest version number of a document is (n), the system assigns the version number (n+1) to the next version you create.

  You are processing a document for whose document type numeric and automatic version assignment has been defined.

  The highest existing version of this document is 08. When you change version 02 of the document, the system automatically creates version 09 as soon as you choose the New version function.

- **Manual**

- **Numeric or alphanumeric**

Specifications for Version Assignment

The default value in the standard R/3 system is 00.

There is a system check for special characters in the document version. The following three special characters are not supported: & *, ;
**Special character "*"**

The special character "*" has a specific meaning:

- Automatic version assignment means that when you create a document, a new version with the next consecutive number is created by the system. The version with the highest existing number serves as template for the next version.
- When you display a document, you see a list of versions.
- If you reserve [Seite 383] a document in the change master record and enter the special character "*" for the version, all versions of the document are taken into account.

### Document Version and Change Number

Engineering change management can be integrated into the document management functions to give the document version a reference to time, or assign it an effectivity period. The version can also be linked to a particular change that may also affect other R/3 objects (for example, bill of material or routing).

The following graphic shows the one-to-one relationship of a document version to a chosen change number.

<table>
<thead>
<tr>
<th>Document version</th>
<th>01</th>
<th>02</th>
<th>03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change number</td>
<td>CH001</td>
<td>CH002</td>
<td>CH003</td>
</tr>
<tr>
<td>Date</td>
<td>11.01.96</td>
<td>02.02.96</td>
<td>09.06.97</td>
</tr>
</tbody>
</table>
Version List

Use
This list gives you an overview of which versions exist for document part of a specific document type. For example, all document versions for the document DOC-01-AA, document type DRW, document part 000 are displayed.

Prerequisites
You can call the version lists in different processing situations:

- Initial screen for the following functions:
  - Document ### Create
  - Document ### New version
  - Document ### Change
  - Document ### Display
- While processing a document for example on the tab page Document data

Features
This list displays all versions of the chosen document part with the following data:

- Status
- Change numbers
- Description
- Validity

From this version list, you can execute the following functions:

- Edit the document
- Print the version list

Activities
Choose the functions Extras → Versions on one of the given screens.

💡 You can also display this list by choosing Document → Change or Document → Display from the initial screen and entering the special character “*” in the Version field.
Default Settings

Use

You can define user-specific default values for the key fields of the document info record. These default values can help you when you enter data. These values are defined as set/get parameters.

The following overview shows which values the system chooses in the different processing situations.

<table>
<thead>
<tr>
<th>Processing situation</th>
<th>Values that are determined</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start of document maintenance (after you start the system)</td>
<td>Default value from the presettings</td>
</tr>
<tr>
<td>Further maintenance</td>
<td>Value last entered</td>
</tr>
</tbody>
</table>

Integration

The following overview shows the set/get parameter identifiers that are defined for documents.

<table>
<thead>
<tr>
<th>Field</th>
<th>Set/get parameter ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document number</td>
<td>CV1</td>
</tr>
<tr>
<td>Document Type</td>
<td>CV2</td>
</tr>
<tr>
<td>Document version</td>
<td>CV3</td>
</tr>
<tr>
<td>Document part</td>
<td>CV4</td>
</tr>
<tr>
<td>Data carrier</td>
<td>CV5</td>
</tr>
<tr>
<td>Copy from document type</td>
<td>CV6</td>
</tr>
<tr>
<td>Copy from document version</td>
<td>CV7</td>
</tr>
<tr>
<td>Copy from document part</td>
<td>CV8</td>
</tr>
<tr>
<td>Copy from document version</td>
<td>CV9</td>
</tr>
<tr>
<td>Numbering of temporary original application files</td>
<td>CVA</td>
</tr>
</tbody>
</table>

Activities

1. From the initial R/3 System screen, choose Tools → Administration → Maintain users → Users.
   
   You see the Maintain Users: Initial Screen.

2. Enter the user name (for example, MILLER) and choose Change.

3. Select the Parameter tab page.

4. Enter the parameter IDs and the parameter values.
   
   Example:
   
   CV2  DRW

5. Confirm your entries. The system determines the descriptive short text for the field.
Example:

| CV2 | DRW | Document Type |

6. Save the parameter values.
Document Description

Use
You can enter all the important information about the document in the description. You can also enter notes for the next user.

💡
You can maintain short and long texts for each language.

Features
You can use the following to describe a document:

- Description in the logon language
  On the tab page Document data you can create a short text in the logon language and a long text using the long maintenance.

- Short and long texts for other languages
  On the tab page Texts you can create short and long texts in all supported language of the R/3 System.

- Importing long texts
  You can import text files from a local file to the long text you have entered in the document info record, or export your long text to a local file.
  This function is supported for the following text formats:
  - Rich Text Format (RTF): conversion to/from Word RTF format
  - American Standard Code for Information Interchange (ASCII): conversion to/from ASCII format
  - ITF: conversion to/from SAPscript format

Activities
See:
Describing Documents [Seite 39]
Transferring Long Text [Seite 40]
Creating Descriptions

Use

On the Document data tab page you can create a description that the system automatically allocates in the logon language.

You can also enter text in different languages on the tab page Texts. The system always reports text in the logon language while processing a document.

Creating Descriptions in the Logon Language

1. Select the Document data tab page.
2. Enter a short text in your log-on language in the Description field.
3. If you find that the 40 characters are insufficient, create a long text.
   Press (Create long text).
   The system goes to the long text editor. You can enter a text of any length. The first 40 characters are the same as the short text.
   Save your text.

Entering a Language-Dependent Description

1. Select the Texts tab page.
2. Enter the language
3. Maintain the short text for desired language.
4. If you want to maintain the long texts, select the lines with your chosen language. Select (Text).
   Save your text after entering the long text. Go back. You return to the Texts tab page.
   The indicator Long texts exist was set in the system.
5. You can continue with processing the document.
Copy Texting Text

Use
You can copy the following texts:

- **Import** text files in a long text of the document
- **Export** long texts of the document in a local file and save at operating system level.

Procedure
6. Select the **Texts** tab page.
7. Enter the language
8. Select *(Copy text).*
   You see the **Transfer** dialog box.
9. Select the type of text transfer you want to carry out.
   - If you want to import text from a local file to the long text you have entered, set the **From local file** indicator.
   - If you want to transfer your long text to a local file (at operating system level), set the **To local file** indicator.
     In this second case, the local file is overwritten with the long text from the document info record.
10. From the **Format** dataset, choose the format of the long text you want to transfer.
11. Choose **Continue**.
   You see the **Import file** or **Export file** dialog box.
12. Enter the required file data.
   
   If you want to use the file manager to find a file at the operating system level (for example, Windows NT), display the possible entries for the **File** field.
13. Choose **Transfer**.
   The system transfers the chosen text.
   - If you **import** text to an existing long text, the system inserts the text after the existing text. The system then goes to the long text editor, where you can edit the text as required.
     Save your long text.
   - If you **export** long text to a chosen file, you see a message in the OK line after the text has been exported.
     The local file now only contains the long text from your document info record.
Definition of Responsibility

Use
Defining who is responsible for a particular document usually requires the user to perform certain tasks or carry certain responsibilities. For example, engineering/design drawings are processed for different products in different offices that are also responsible for the appropriate document info records.

Integration
Entries you make regarding the person responsible are an important search criterion (main parameter) for searching for a document.

Prerequisites
In Customizing for the Document Management System, you can define design offices or laboratories by choosing General Data → Define laboratories/design offices.

Features
There are two fields for describing the employee subgroup for the document:

- User
  When you create a document, the system enters your user name in this field as a default. You can overwrite this with any user name defined in your R/3 System.
  
  The following data from the user address (System → User profile → User address) is displayed for the user:
  - Next to the User field, you see the Department
  - First name, last name, department, extension number
  
  If you copy from an existing document, the user in the source document is copied to the new document as a default value.

- Laboratory/office
  Next to the key, the system displays the text describing the office or laboratory.

Activities
See: Defining the Persons Responsible for a Document [Seite 42]
Defining the Persons Responsible for a Document

Procedure

1. Select the *Document data* tab page.

2. Enter the person responsible in the *User* field. You can choose between the following:
   - If required, change the default (your own user name) when you create the document. You can enter any user name defined in your R/3 System.
   - If you do not know the exact name of the user you require, you can enter search criteria to find it. Enter the characters that you know. For character strings you do not know, enter the special character "*". Display the input help. The system displays a list of all the users who meet the search criteria you entered.

   **Entry:** M*E*
   **Result:** MICHAELS
   MEYERS
   MALLEY

   Choose the user you require by double-clicking on the line concerned.

   ![User Search Example]

   If the department of the user in this field has been maintained in the user maintenance function (*User profile → User address*), the department appears next to the user name.

3. Enter the laboratory/office that is responsible for the document.
Saving Documents

Procedure

1. Check the tab pages whether the document data is correct.
   Depending on the document type, there may be several fields in which you have to make an entry.

2. Choose Document → Save.
   You return to the initial screen and see the following message:

   Document <Document number> <Document type> <Document part> <Version> has been created (changed)
**Status Management**

**Use**

You can control the processing statuses of documents using status management.

- You can define several **statuses** that represent important processing statuses a processing cycle of a document.
- The processing cycle of a document can be represented in a **status network**. You construct this network by creating a relationship between the statuses for a document type (predecessor/successor relationship).

In each processing situation, the system determines the possible subsequent statuses of the current status. You can display and select these statuses using the possible entries function.

**Integration**

Related application areas can read a status change, for example:

- SAP Business Workflow starts a workflow that distributes a task to selected employees when a certain processing status has been reached.
- The document is distributed to other systems via Application Link Enabling (ALE).
- When you release a document, you can define additional checks for certain R/3 objects, such as special checks for Engineering Change Management.

Authorization object C_DRAW_STA (document status) controls authorizations for status processing (See: Authorization Objects [Seite 21]).

💡

You decide while defining a document type in Customizing *Document management* whether a change of data, such as changing the person responsible, causes a status change at the same time.

**Features**

You can control the following functions according to the needs of your company:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Status [Seite 46]</td>
<td>You define a status for the important processing statuses of a document.</td>
</tr>
<tr>
<td>Definition of a Status Network [Seite 47]</td>
<td>Allows you to define and control the processing procedure of a document.</td>
</tr>
<tr>
<td>Status History in the Status Log [Seite 51]</td>
<td>Gives you a record of the statuses that a document has already had.</td>
</tr>
<tr>
<td>Document Release [Seite 53]</td>
<td>Indicates a document as released for related work areas in the company.</td>
</tr>
<tr>
<td>Complete for Engineering Change Management [Seite 55]</td>
<td>Indicates a document as released for engineering change management</td>
</tr>
<tr>
<td>Status Management</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Audit for Original Application Files [Seite 56]</strong></td>
<td>Saves the original application files automatically</td>
</tr>
<tr>
<td><strong>Approval Using Digital Signatures [Seite 78]</strong></td>
<td>Approval procedure for setting a status</td>
</tr>
<tr>
<td><strong>Additional Functions After a Status Change [Seite 59]</strong></td>
<td>Various additional functions</td>
</tr>
</tbody>
</table>
Defining Statuses

Use
The status indicates the processing status of a document. The characteristic statuses are defined for the document type and can be set in relationship to each other in a status network.

Prerequisites
You have carried out the following in Customizing Document management:
- Define document type
- Describe language-dependent document status

Procedure
1. In Customizing go to Document management → Define document type → Define document status.
   The Define Document Status: Overview screen appears.
2. You can display the online information for the work step by pressing (Online documentation).
   In this online documentation you will find information on how to control document processing with the use of status settings
   For example, you can set that a status can only be set when
   - A master record exists in the R/3 System for every linked object, such as material or customer.
   - Each original application file must be stored in a storage category of a storage system.
   Other indicators set that original application files are automatically stored in a storage category of a storage system and that you do not want distribution using ALE into other systems.
3. Save the status.
   The system lists the status under the entry options when you are processing a document. This option only occurs when the processing status supports this feature.

Result
You can set the defined status for the appropriate processing status of a document from the chosen document types.
If you want to set up the processing cycle of a document in a status network you can set the individual statuses in relation to each other.
See also: Definition of a Status Network [Seite 47]
Definition of a Status Network

Use
A status network represents the entire processing cycle of a document from the beginning to the end of a phase, for example from the creation of a document to its release. The processing steps can be defined and controlled exactly.

Prerequisites

Features
The statuses that you set in a relationship to one another as predecessor and successor form the status network.

You can allocate a status type to a status if you want to have greater control. The status type assigns specific features to a status, for example you may only be able to set a status when you create a document for the first time (primary status), or there may be important basic data that you are not allowed to change with a certain status (lock status).

In the following processing situations, the system sets a status automatically:

- Processing an original application file
- Checking an original application file into an archive

The following graphic shows a status network.

- Two possible primary statuses are defined as the initial status: A1 and A2. This means that two different processes are represented at the start of this status network.
- Complex predecessor and successor relationships are defined for the statuses in this network. These relationships are checked every time a new status is set.

In the following status network, status IR has statuses WR and WK as previous statuses. This means that status IR can only be set if the current document status is either WR or WK.
Defining Statuses

Define the important statuses for the document type that represent the processing statuses. See: Define Status [Seite 46].

Create one or more predecessors for each status. A maximum of six predecessors is checked. When you set a new status the system checks whether the current status belongs to the number of predecessors of the new status.
Displaying the Status Network

Use
You can display the status network graphically when you want to show large status relations. You see a quick overview of the processing process and the current status of the individual document.

Procedure
1. Choose Extras → Status network
   The Status network display options screen appears.

   Depending on the performance of your computer and on the current system workload, the system may require a few seconds to set up the graphic of your status network.

2. To print the status network, choose Status network → Print

Result
You receive the status network in the form of a graphic.

The screen layout depends on various settings made for graphics. For example, in the Settings menu you define the partitioning of the screen and the color assignment.

If you are using the global setting, the screen is sub-divided into the following areas:

- Graphic area
- Navigation area

Graphic area
In this area, the statuses with the different predecessors are displayed graphically in the form of a status network.

The language-dependent status abbreviation and the language-dependent description are displayed for each status. If a status type has been defined for the status, the abbreviation is displayed under the description.

The following table explains the meaning of shape and color in the status network graphic:

<table>
<thead>
<tr>
<th>Shape</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rounded</td>
<td>The document info record has already had this status, or this is its current status.</td>
</tr>
<tr>
<td>square</td>
<td>The document info record has not had this status yet.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>yellow</td>
<td>Yellow indicates the current status.</td>
</tr>
</tbody>
</table>
Displaying the Status Network

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>red</td>
<td>This status cannot be set from the current status.</td>
</tr>
<tr>
<td>green</td>
<td>Green indicates the statuses that can be set after the current status (provided the user has the appropriate authorization).</td>
</tr>
</tbody>
</table>

(1) This organization according to color takes the predecessor relationship into account (without authorization check).

You can change the display area by scrolling in the horizontal or vertical scroll bars.

**Navigation area**

The entire status network is displayed graphically in this area. The section of the network that is displayed in the graphic area is marked by the system at the same time. This form of display helps you orient yourself more easily when you are dealing with complex structures.
Status History in the Status Log

Use

Changes in status are logged by the system.

A document info record contains the following status information:

- **Current processing status.** This information appears on the Basic Data screen, in the Document status field.
- **Complete status history.** This information appears in the status log. The status log is a record that gives you an overview of which statuses a document has already had. A log field informs you about any changes to the status.

Prerequisites

You can only display the status history in the status log if the following conditions are met:

- A status network is defined for the document type of the document.
- You are in the change or display mode for the document.

Log field

In Customizing for the Document Management System, you can define for each document type which statuses require a log field entry, by choosing Control data → Define document types, then Define document status. In this case the status process is documented.

The log field can contain a short text up to 20 characters. The text is entered in a special dialog box. If the document status is defined to allow an entry to be made, the dialog box is displayed automatically after the status has been changed.

- In Customizing for the Document Management System, you can define for each document type which statuses require a log field entry by choosing Control Data → Define document types, then Define document status.
  - There are the following types of log field entries:
    - Entries that you may enter or must enter (depending on the document type)
    - Entries that are made by the system (independently of the document type)
  
  For example, when you archive a document, the system creates a log field entry, as well as setting the status concerned.

Features

In status log

- you have such information as
  - Who set a status
  - Which digital signature was necessary
  - From the log field.
- You can execute further additional function such as
Status History in the Status Log

- Display user data from user that set the status
- Display information from the set digital signature
- Print status log

The following graphic shows that the status log offers important information in a very large status network about the process run and the current processing status.

Activities

On any tab page choose Extras → Status log. The current status is in the first line.
Release Status of Documents

Use

When the processing stage for a document has been completed and checked, the document is generally released for all work areas in the company. Closely related work areas work with the released status. This application status protects the document against any further changes. You can define a special status for this special processing status.

Integration

There are additional checks for a released document in the following areas:

- Production resources/tools availability check
  You define the availability of a document as a production resource/tool with the release indicator.

- Quality Management
  Only documents that have been released are checked to determine the currently valid version for quality agreement purposes.

- Engineering change management:
  The document receives a revision level automatically when a change number is entered for it and it is given the status released for the first time.

Prerequisites

In Customizing for the Document Management System, you define the release status for document types by choosing Control data → Define document types → Define document statuses. The release status is set with the Release indicator. You can find further information in the online help about Release indicator.

Features

Release Indicator when Defining a Status

When you define a status in Customizing for the Document Management System, you can define whether this status is interpreted as Released by other application areas in the company. A document is released if it has a status that has the release indicator.

Release Indicator in the Document Info Record

You maintain the current status on the Basic Data screen of the document info record. The system checks whether the release indicator is set for the status in Customizing for the Document Management System.

The user sees the following release information in the document info record tab page Document data:

- Not released
  The Not released indicator is displayed next to the status.
  In the standard R/3 System, this indicator is shown in red.
### Release Status of Documents

- **Released**

  The *Released* indicator is displayed next to the status. In the standard R/3 System, this indicator is shown in green.

  You see the release date next to the status.

  - If no change number has been maintained, the date when the status is set counts as valid-from date.
  - If a change number has been maintained, the system takes the valid-from date of the change master as the release date.
Complete for Engineering Change Management

Use

Complex changes are controlled in Engineering Change Management, by using an engineering change request/engineering change order. You cannot release the change order until the processing of the change objects (for example, BOM, routing, document) has been completed and released. For most objects, the Complete system status is set in the object management record.

The processing status Complete is not set in the change master record for documents. You use the document status for each document type to determine the point at which a document is defined as Complete in the change master record.

Integration

If you want to set a status for a document and this status is to be defined as Complete in the change master record (change request/change order), the related change master record is also checked when you set the status in the document. You can only set the document status that is to be set as Released for engineering change management if the processing status of the change master record allows a release.

Prerequisites

In Customizing for the Document Management System, you define statuses for the document types by choosing Control data → Define document types → Define document statuses. Control is by use of the Complete for engineering change management indicator. You can find further information in the online help about Finished reports for ECH.

Features

The following dependencies exist in the release procedure of a document for engineering change management between document status and system status of the change master record:

- The processing cycle of a change master record is used to check the current status of all entered documents.

  In order to release you must choose a document info record that has been assigned the value of released for ECH (status with indicator Finished reports for ECH).

- If the document is entered as a change object in a change master record the system status of the change master record is checked at the same time when the document status is set.

  The document can only be given the status if the current status has the system status of the change master record Complete change as a subsequent system status.

The control record for the document in the change master record is automatically changed when the statuses allow release. The system status of the document is set to Finish change.
Content Versions for Original Application Files

Use

Certain processing statuses of an original application file (for example, file 1 and file 4) are of special importance to the person who created it or other employees and must be available at a later point.

You must be able to reproduce these special processing statuses - distinguished by the different statuses of the document info record - without constantly creating new versions.

For this reason, it is useful to save several, chosen processing statuses automatically for one version in a secure area. These automatically saved process statuses are called content versions. You can display them at any time.

Integration


Prerequisites

A content version is created using the following prerequisites:

- The original application file is stored in a secure area.
  
  Storage can have occurred in one of the following secure areas:
  
  - If storage using Knowledge Provider is set for the document type the original application file must be located in one of the defined storage categories (for example R/3 database, HTTP content server).
  
  - If storage using Knowledge Provider is NOT set for the document type the original application file must be located in one of the following data carriers: R/3 Database, vault or archive.

- The workstation application is defined in Customizing so the original model supports content versions. The settings are made under General data → Define workstation application.

Features

Important processing statuses of original application files are saved in a secure area. These processing statuses are often the basis for further processing. It could happen that later version contain incorrect information or are technically incorrect. In this case, the original application file that was saved in a secure area is still available.

Use the status to control that a copy is automatically created for further processing of original application files that are in secure areas and are to be processed later. This control is done using status indicator Content versions for originals that you can set in the definition of a status.

The new processing base or copy is a content version (also called “audit” in earlier Releases).

The following graphic shows a content version in a document info record.
Activities

The system creates content versions automatically.

You can display the content version in the document info record on the tab page *Originals* and select them for later processing.
Storing Original Application Files

Use

Original application files that have reached a processing status that requires them to be stored in a secure area can be stored manually using Store in secure area. Another advantage is that other users with the correct authorization can access the files.

You can simplify storing original application files when storage of original application files using the Knowledge Provider [Extern] is supported for a document type. You can transport all original application files of document info record into a secure area by setting a certain status.

Integration

In Customizing for the Document Management System, you define statuses for the document types by choosing Control data → Define document types → Define document statuses. This is controlled by the indicator Automatic storage of originals.

Prerequisites

The document type is defined that storage of the original application file is done using the Knowledge Provider. You make the required setting under Document Management System → Control data → Define document types. This is controlled by the indicator Document storage via Knowledge Provider.

Features

The automatic storage of the original application files is done in a storage category of your storage system.

The place for saving for each individual original application file is determined as follows:

- When the original application file:
  - has already been stored in a secure area, you see the previous storage data as default
  - as not yet been stored in a secure area a dialog box Storage data appears where you can enter the secure area
- You can enter a default value for storage in the user-specific settings.

See also: Default Values for Original Application Files [Seite 191]

Activities

1. Set the indicators for the status in Customizing Automatic storage of originals or For checking

2. Process the document info record and the allocated original application files. Once you have reached a processing status that you want to transport into a secure area set the supported status or the status For checking

As soon as the status is saved for the document the system transports all the original application file into the secure area.
Overview of Additional Functions after Status Changes

Use
You can link further activities to a status change to control and optimize the processing procedure in the related work areas of your company.

Integration
The following additional functions are supported:

- Functions that are available in the standard R/3 System
- Functions that you can develop and integrate for a chosen document type according to your company’s requirements

Prerequisites
You must fulfill different requirements for the different additional functions. Please see the following table for notes on this.

Features
This table lists activities that are performed automatically when you set a status.

<table>
<thead>
<tr>
<th>Function</th>
<th>When?</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send <strong>message</strong> via message control</td>
<td>Save document info record</td>
<td>Settings in Customizing Document Management → Messages</td>
</tr>
<tr>
<td>Perform <strong>workflow task</strong> from the Workflow Workbench</td>
<td>Save document info record</td>
<td>Settings in Customizing for the Document Management by choosing Control data → Define document types then Define document status</td>
</tr>
<tr>
<td>Create <strong>content version</strong></td>
<td>Set the status and later processing of the original application file</td>
<td>Settings in Customizing for the Document Management by choosing Control data → Define document types then Define document status</td>
</tr>
<tr>
<td><strong>See</strong>: Content Versions for Original Application Files [Seite 56]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assigning a <strong>revision level</strong></td>
<td>Save released document info record</td>
<td>Settings in Customizing for the Document Management System Control Data → Define document types</td>
</tr>
<tr>
<td><strong>See</strong>: Revision Level Assignment [Seite 385]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Execute <strong>FORM routine</strong> from a company-specific program</td>
<td>Set status or save document info record</td>
<td>Settings in Customizing for the Document Management by choosing Control data → Define document types then Define document status</td>
</tr>
<tr>
<td>Approval Using Digital Signatures [Seite 78]</td>
<td>When setting the status that requires a digital signature.</td>
<td>Settings in Customizing for the Document Management by choosing Control data → Define document types then Define document status</td>
</tr>
</tbody>
</table>
Overview of Additional Functions after Status Changes
Maintaining the Document Status

Prerequisites

In Customizing Document management at least one status is defined for the document type of the document. If you want to control the order the status is set in you must create a status network. Settings in Customizing for the Document Management System, by choosing Control data → Define document types → Define document status

Procedure

1. Process the document in change mode.
2. Place the cursor in the Document status field on the Basic Data screen.
3. Display the possible entries (F4).
   You see the screen Possible follow-up statuses for document type <Document type> with status <Status>.
   – You see all the possible follow-up statuses that can be set in the current processing status.
   – Place the cursor in the line of the status that you want to copy. The system copies the chosen status when you double-click.
   The Document data tab page appears.
4. Confirm the new document status.
   The system checks whether you are entitled to set this status for the chosen document type. If you are not entitled to do so, you see an error message.

   🧠

   The status you have just chosen may be defined as released. The Released indicator is displayed with the release date when you have saved.
5. You can also make a log entry. Whether a log entry is optional or required is dependent on the definition of the document status.

Result

The newly set status is displayed in the Status log [Seite 51]. The complete status history can be displayed while processing.

It is possible that other activities are triggered because of status changes.

See: Overview of Additional Functions After Status Changes [Seite 59]
Linking objects to a document

Use

You can link documents to a great number of SAP objects (for example, materials, customer) in order to document the objects in more detail for various business processes.

Integration

In the standard SAP System, document linking is supported for many SAP objects. The following graphic shows some of the SAP objects that you can link to a document info record in the standard system.

Prerequisites

In Customizing for the Document Management System, you can define which SAP objects can be linked to documents of each document type by choosing Control Data. The activity Define document type [Extern] is divided into several work steps where you enter the following data for the object link:

- Define Document Status [Extern]

Here you decide whether an object check is made when you set a certain status for your chosen document type. In this case, you can only set the status if there are master records for all the linked objects.
You can link a document with status A to a material for which there is no master record in the system. If you want to assign status B to the same document, an object check is made for this status. If there is no master record, the status cannot be set, or you must delete the object link.

- **Determine Object Link [Extern]**
  
  Here you define settings for object links.
  
  - **Choice of SAP objects to which documents can be linked**
    
    You see a list of all SAP objects that are supported for object links in the standard SAP System by choosing the input help. Additionally, you must enter the screen where the key fields for the object are maintained.
  
  - **Copying object links with new versions**
    
    You can decide whether the links for each SAP object are to be copied from the source version when making a new version.
  
  - **Activating additional functions for the object link**
    
    You can activate additional functions in order to link to a third object or to classify the link. Further information can be found using the online help (F1 help) for the indicator *Additional functions for object links active*.

**Features**

Linking a document to an SAP object allows you to do the following:

- You can maintain the object links from the object or from the document.

  **Additional Function for Material Master Record:**

  In Customizing for *Logistics Basic Data: Material Master*, you can define a standard document type by choosing *Make global settings*. Documents of this standard document type are displayed in the material master record, in the *Basic data 2* view (*Extras → Document data*).

- You can display the original application files of a document (for example, an engineering/design drawing) directly from the object (for example, material) using a display application (viewer).

- You can enter additional information for object links, such as:
  
  - **Creating Long Texts for Object Links [Seite 68]**
  
  - **Classifying Object Links [Seite 71]**
  
  - **Additional Objects for Object Links [Seite 69]**

- You can also link documents to SAP objects for which links are not supported in the standard SAP System. See: *Adding Other Objects [Seite 66]*.)
Linking Documents to R/3 Objects

Prerequisites

In Customizing for the Document Management System, at least one R/3 object (for example, material master record) is defined for links to the document type.

Procedure

1. On the Basic data screen, choose the tab page Object links.
   
   You now see a tab page with linked objects. The tab pages for the objects are dynamically determined based on the settings of the document type. For example, when object links are set for the document type DRW objects material, change number and customer a tab page appears for each of these objects.

   
   The short text for the object is displayed if no object allocation exists. As soon as one object link exists the short text is enhanced with the addition of the icon (Links exist).

2. You enter key data for the objects by selecting the appropriate tab page such as, Document info record.

3. Enter the identifying data for the SAP object.
   
   For a document info record, for example, you enter the document number, document type, document part, and document version. For a material, you enter the material number.

4. Confirm your entries.
   
   The system checks whether the object exists and displays the description from the object master.

5. If you want to make object links to other SAP objects choose the appropriate tab page such as customer.

Result

When you save the document info record, the object link is saved. When at least one object link exists is indicated with the icon (Links exist).
Displaying Object Links

Procedure

1. On the Basic data screen, choose Extras → Object link.
   
   You see the Object Selection dialog box. This dialog box contains all the types of SAP objects that can be linked to documents of the current document type. The objects for which links exist (for example, material) have an indicator against their description.

2. Choose the description of the SAP object (for example, material), for which you want to display the existing object links.

3. Press Choose.

   You see the Object Links dialog box, containing a list of all the objects linked to the document (for example, material master records MAT-01, MAT-02).

   - If you want to display a list of all the documents that are linked to the selected object (such as material master), choose Documents.
     
     The document you are currently processing is highlighted.
     
     From this list, you print all the document info records or the list.

   - You can display the master records of objects linked to your document by choosing Display.

4. Go back to the Basic data screen.
Adding Other Objects

Purpose
You can also link documents with SAP objects for which no linking is supported in the standard SAP System.

Prerequisites
In Customizing for the Document Management, you must maintain the key fields for the SAP objects that you want to link to document info records, by choosing Control Data → Maintain key fields.

Process
1. Program **two screens** for the following module pools for the SAP object that is to be linked additionally:
   - SAPLCV00
   - SAPLCVIN
   The process logic must be according to that of screen 0204 in program SAPLCV00 and must not be changed.
2. Create the **function module** OBJECT_CHECK_XXXX (XXXX = name of the SAP object).
   If this object can be classified, this function module already exists in the standard system. Otherwise, copy the existing function module OBJECT_CHECK_EQUI (linking of equipment) and change it to suit the new object.

Result
After you have completed the above, documents can be linked with the SAP object that you have added. You define the settings for this in Customizing for the Document Management System (see: Object Links [Seite 62]).
Additional Functions for Object Links

Use
We recommend in certain situations that you enter additional information for the links. You could, for example, also enter a customer for the link Document such as document type Design drawing) and material (Product: Pump) when this special contract.

Integration
These individual functions are active when the object link supports additional functions.

Prerequisites
The additional functions must active in Customizing Document management for the document type and the special object. To do this go to Define document type → Set object link.

Features
The following overview shows which additional functions for the object links are supported:

<table>
<thead>
<tr>
<th>You want to...</th>
<th>Additional function</th>
</tr>
</thead>
<tbody>
<tr>
<td>maintain an information text for every link between a document and a SAP object (for example, Customer US51).</td>
<td>Creating Long Texts for Object Links [Seite 68]</td>
</tr>
<tr>
<td>attach another SAP object, such as customer, to a link (for example: document material M-1)</td>
<td>Additional Objects for Object Links [Seite 69]</td>
</tr>
<tr>
<td>characterize the special link (for example, document customer US51) using selected characteristics</td>
<td>Classifying Object Links [Seite 71]</td>
</tr>
</tbody>
</table>
Creating Long Texts for Object Links

Use
Sometimes additional link information is useful when you link a document with an R/3 object. You can maintain an information text for every link between document and R/3 object (for example, Customer DEBI-US51).

Integration
You can maintain the link text in either the document info record or in the master record for the object (for example, customer DEBI-US51).

The long text is maintained with the PC editor and saved in the text database.

Prerequisites
You can only create a long text for an object when you have activated the additional function in Customizing Document management. You make the required settings under Define document types → Define object links.

You must have linked the document with at least one R/3 object (for example, Customer DEBI-US51).

Activities
1. In the Basic data screen choose the tab page for the R/3 object that has the additional functions activated, for example, customer
2. Select the object (for example, customer DEBI-US51) that you want to classify the link for.
3. Press (Long text to link).
   You see the Long text object links screen.
4. Enter your text and then save it.
5. Go back and save the document.
Valuation Objects for Object Links

Use
The link between a document and a SAP object is often only valid for a specific SAP object. For this reason, you can add another SAP object to every link. This object is called the valuation object. For example, you can enter a specific customer (for example DEBI-26) for the link between an engineering/design drawing and a material master record.

Integration
You can maintain the object link valuation in either the document info record or in the master record for the object (for example, material).
You can choose any R/3 object, provided that the key fields for this object have been maintained in Customizing for the Document Management System.

Prerequisites
You can valuate an object link with an SAP object if you have met the following requirements:

- Document info record
  You must have linked the document with an SAP object (for example, Customer DEBI-26).

- Customizing Document management → Control data → Define document type → Set object link
  The function Valuation is only active when you have done the following for the combination document type and linked SAP object
  - You have activated additional functions.
  - You have entered the additional object.

Features
The following functions are supported for link valuation:

- One SAP object is supported for the valuation of a document - object link.
  The valuation object KNA1 (customer) has been entered for the document - material (MARA) object link for document type DRW (engineering/design drawing).

- You can determine the direction in a document-document link.
  The direction indicates which document is active or passive in a document-document-link. The document - document link does not have a predefined direction in the standard R/3 System.

Activities
1. On the Basic data screen, choose Extras → Object link.
  You see the Object Selection dialog box.
Valuation Objects for Object Links

2. Select the object description (for example, material) that you want to valuate the link for.
3. Press Choose.
   
   You see the Object Links dialog box.
4. Select the link object (for example, material M-1) that you want to valuate the link for.
5. Select \(\text{(Valuation)}\).
   
   You see the Restrict value range dialog box.

   You cannot enter the valuation object (for example, customer) directly. You must use the hit list from selection.
6. Enter data that restricts the scope of the search.
   
   If required, limit the value range, and choose Continue.
   
   You see the Result list dialog box.
7. Select an object that you want to use as valuation object, and choose Continue.
   
   You see the Object Links dialog box. The system has copied the valuation object that you chose.
8. Return to the Basic data screen.
9. Save your entries on the Basic data screen.
Classifying Object Links

Use
Sometimes additional link information is useful when you link a document with an R/3 object. Classification makes it possible for you to characterize a document - R/3 object link (for example, Customer DEBI-US51) by using characteristics.

For example, you can add additional project information, such as persons responsible or organizational data, to a document - material link.

Integration
You can maintain classification in either the document info record or in the master record for the object (for example, customer DEBI-US51). You maintain the essential classification data in the classification system.

Prerequisites
You can only classify an object link when you have activated the additional functions in Customizing Document management. You make the required settings under Define document types → Define object links.

You must have linked the document with an R/3 object (for example, Customer DEBI-US51).

Classification System
The class type 048 (object links to documents) is supported in the standard R/3 System for classifying object links for document management.

In the classification system you must:
- Create the characteristics that are to be used to characterize the object link
- Create the class for class type 048 (object links to documents) and assign the characteristics

Features
You can enter one class for each document - R/3 object link (for example, customer DEBI-US51). Multiple classification is not supported.

Activities
6. In the Basic data screen choose the tab page for the R/3 object that has the additional functions activated, for example, customer
7. Select the object (for example, customer DEBI-US51) that you want to classify the link for.
8. Select (Classification).
You see the Classification screen.
9. Enter the required class data.
10. You display the characteristics of the class by double-clicking on the class in the lower area of the screen.
11. Enter values for the characteristics.

12. Go back.

13. Save your entries on the *Basic data* screen.
Creation of a Simple Document Hierarchy

Use

Documents can be set up in a hierarchical relationship to each other, for example, by creating an object link to the object type Document.

If there is a specific order for the documents in this link, you can represent the relationship between the documents by using a hierarchy.

Prerequisites

The superior document already exists.

Features

By entering a superior document, you set a direct predecessor for a simple document hierarchy. The hierarchy is not limited to this level; it can be expanded from the superior document.

The superior document can:

- be superior to other documents
- be inferior to another document

You can put documents of different document types into a document hierarchy. Recursiveness is not supported. This means that a document can only be entered once in the entire explosion path.

By entering superior documents, you can represent an entire document hierarchy in the system. This is illustrated in the following graphic.

![Document hierarchy diagram](attachment:image.png)
Creation of a Simple Document Hierarchy

For complex document structures, use Document Structure [Seite 306].
Defining a Superior Document

Procedure

1. Process the document in change mode.
2. Enter the following data on the Document data tab page in the Superior document data set:
   - Documents
     Enter the number of the document that is directly superior to the document currently being processed.
   - Document Type
   - Document part
   - Document version

To display the superior document info record for checking, choose any document key field.

💡

When you save the document, the system sets the Document included in hierarchy indicator in the data block.
_displaying a document hierarchy

**Displaying a Document Hierarchy**

**Prerequisites**

The document that you are currently processing is included in a hierarchy. If this is the case, the Document included in hierarchy indicator is set.

A hierarchy exists for the document that you are currently processing if:

- You have defined a superior document.
- The document has been defined as superior in another document.

**Procedure**

1. On the Basic Data screen, choose Extras → Hierarchy

   The Document Hierarchy screen appears, which shows a list of all the documents in the hierarchy. The documents are grouped by hierarchy level.
   - For each document, you see the following fields: Level (Document type), Document number, Document part, Version, Description.
   - The Status fields (abbreviation and description) may not be displayed on the screen. If you want to see status data, scroll to the right.
   - The document at the top of the hierarchy has level 0.
   - If a document has other documents below it, these appear immediately below it in the hierarchy, with the next level number.
   - The start document and all subordinate documents are highlighted.
   - If you cannot see all of the documents in the hierarchy on your screen, scroll down using the vertical scroll bar. The slider box on the scroll bar shows you roughly which section of the list you are currently displaying.

2. To display the document info record of a document in the hierarchy, select the line concerned. You see the Basic Data screen, where you can use all active functions.

   Although you are currently using display mode, you can change the document info records directly from the hierarchy.
   - The system indicates documents that you changed directly from a hierarchy list on the Document hierarchy screen in the column Level with a check mark.

   ![Light Bulb]

   You can also display the document hierarchy using the Product Structure Browser [Seite 468].
Displaying a Document Hierarchy Graphic

Prerequisites
The document that you are currently processing is included in a hierarchy. If this is the case, the Document included in hierarchy indicator is set.

A hierarchy exists for the document that you are currently processing if:

- You have defined a superior document.
- The document has been defined as superior in another document.

Procedure
1. On the Basic data tab page, choose Extras → Hierarchy graphic.
   
   The system goes into graphic display mode and shows the document hierarchy as a tree structure.

2. To modify the graphic according to your requirements, choose Settings. The Layout dialog box appears in which you can change the settings.
   
   If you change the settings for test purposes only, and you want the dialog box to remain open, choose Apply.
   
   You can, for example, change the tree branching, tree rotation, and tree fit.

3. To print the hierarchy graphic, choose Graphic → Print.
Approval Using Digital Signatures

Use
Processing steps that play a key role in how a document is processed further should only be executed by authorized persons. Digital signatures are part of an approval procedure that ensures that only authorized employees can influence how the process continues.

You can use the digital signature to fulfill the security requirements that are set for executing these processes in Good Manufacturing Practices (GMP).

Integration
The digital signature in the SAP System is supported by SSF (Secure Store and Forward).

Prerequisites

Customizing Settings
You need to define the following settings in Customizing for the Document Management System:

- Under Approval you can make all settings for the digital signature and the definition of the Signature Strategy [Extern].
  
  See also: Approval Using Digital Signatures [Extern]

- Assign a signature strategy to the document status. The signature check is done when a status is set. The required settings are made under Control data → Define document type → Define document status.

Processing a Document
1. You have the following authorizations:
   - Authorization to set the digital signature
     Authorization object C_SIGN_BGR (authorization group for digital signature) in the Production Planning object class.
   - Authorization to process the document (Authorization Objects for Documents [Seite 21])

2. The original application files for a document must be stored in one of the following secure storage areas:
   - In a Storage category [Seite 138] when storage is controlled by the Knowledge Provider
   - In a vault [Seite 147] or archive [Seite 145] when storage is not controlled by the Knowledge Provider

Features

Approval Procedure for Documents
You use the status of a document to determine in which processing situations the digital signature is required. The various approval procedures are defined as a signature strategy in
Customizing for Document Management and are then assigned to the document status that determines how the document is processed further.

When you set a status with a signature strategy, the approval process is started according to the defined approval procedure.

The following approval procedures are supported:

- **Double verification principle**
  
  One authorized person must sign the document digitally. The status is set to "active" once the signature has been provided.

- **Multiple verification principle**
  
  Several authorized persons must sign the document digitally.
  
  Once the first authorized person has signed the document digitally, the system automatically recognizes that the approval procedure is not yet complete. Each authorized person signs and saves the document. The status is set to "active" once all the signatures have been provided.

  Every person that is authorized to sign can cancel the process completely. In this case, the system returns the status of the document to the status that was valid before the signature process was started.

  ![Tip]

  The document is in an intermediate state during the approval process. You should, therefore, define a special document status (such as, *being signed*). The next status (for example, *released*) can only be set once all of the signatures have been provided.

**Original Application File in the Approval Procedure**

The status for which an electronic signature is required is defined in Customizing for Document Management as a status that automatically creates content versions. For this reason, the original application files must be stored in a secure storage area (Storage System of the Knowledge Provider [Seite 138], or vault [Seite 147] or archive [Seite 145]) during the approval procedure.

**Document after the Approval Procedure**

Once the signature strategy has been successfully completed, the document is locked with the result that most of the data cannot be changed. You can only carry out the following functions:

- **Change status**
- **Process object links**
- **Change deletion indicator**

Information on the signatures, for example the name of the signer, signed step, comment, date, and time, is documented and cannot be forged. It can be displayed from the document at any time.

A status, for which one or more digital signatures were entered, is indicated in the status log. You can also view information on the individual signatures and the processing status of the original application files in the log.
Activity

When a document is being processed, you can set the digital signature [Seite 81].
You can do the following with the signature data:

- You can verify and change the signatures available.
  
  See: Monitoring and Logging Signature Processes [Seite 85]

- You can search for documents that were approved with a digital signature according to the signature data [Seite 84].
Setting a Digital Signature for a Document

Prerequisites
Before you can set a digital signature, you must define the relevant settings in Customizing and store the original application files in the secure storage area.

See also:
Approval Using Digital Signatures [Seite 78]

Procedure
1. Choose Document → Change. Enter the necessary data, and confirm your entries.
   You see the Change document: Basic Data
2. On the Document data tab page set the status that requires a digital signature. When you confirm your entry, the system informs you that a digital signature is required.
3. Choose Digital signature.
   The Digital Signature dialog box appears.
   More information can be found under Carry out signature strategy [Seite 82]

Result
The digital signature is set once the approval procedure has been completed. Only certain changes, such as the deletion flag, can be made to the document.

The following information on the digital signature can be displayed while you are processing a document (Basic Data screen):
- Signature sequence or release statuses for the signature strategy (Environment → Digital signatures).
- Processing status of the original application files when the digital signature was entered (Extras → Status log).
Executing Signature Strategies

Use
You use this procedure for batch record approval if several individual signatures defined in a signature strategy [Extern] are required to approve the record.

If a signature process has already been started by someone else and you want to cancel it for some reason, you can withdraw the signatures executed so far (see Canceling Signature Processes [Extern]).

Prerequisites

- A signature strategy has been assigned to the material to which the batch record belongs in your plant (see Customizing for Batch Records).
- You have logged on to the system under your own user name. The system sets this name as the signatory name. You cannot overwrite it.
- You have called the function for approving batch records and are on the dialog box for executing a signature strategy (see Approving Batch Records [Extern]).
  
  The Signatures to be executed section contains an individual signature that may be executed by your authorization or user group (see authorization object C_SIGN_BGR Authorization Group for Digital Signatures in your authorization profile).
- You have not yet executed a signature for this batch record or its current version.
  
  If the same authorization or user group is used more than once in a signature strategy, the individual signatures must be executed by different members of the group.

Procedure

1. Enter your comment in the text field.
2. Select the individual signature that is assigned to your authorization group in the Signatures to be executed section.
2. If you use the user signature as your signature method [Extern], make sure that the system can access your Personal Security Environment (PSE) [Extern].
   How you do this, depends on your security product. If you use a smart card reader, for example, insert your smart card in the reader.
4. Enter your password and choose Continue.
   The system checks the following:
   - Whether you are authorized to execute the individual signature
   - Whether your entries match the data in your user master record
   - Whether your entries match the data in your PSE (if you use user signatures)
   Depending on the result of this check, processing is continued as follows:
If you do not have the required authorization or your entries are invalid, or if the system cannot access your PSE, the system takes you back to the dialog box where you can execute your signature again (steps 2 to 4).

The function is canceled after a certain number of unsuccessful attempts that can be defined specifically for each customer. Your user is locked and you cannot execute another digital signature. If a system signature is used, you are even locked against logging on to the system again.

If your entries are correct, the system takes you back to the batch record.

5. Save the batch record.

6. If the batch record has status *Partially archived* (and not *Archived*), further individual signatures must be executed according to the signature strategy. Notify the person who must execute the next individual signature. This person must now initiate the following steps:
   a. He or she must log on to the system under his or her user name.
   b. He or she must call the function for approving batch records (see Approving Batch Records [Extern]).
   c. He or she must carry out this procedure for the next individual signature.

**Result**

If a release status of the signature strategy was reached and no further signatures are required, the batch record is assigned status *Approved*.

For batches whose material master record specifies that an approved batch record is required (*Work scheduling view*), you can now do the following:

- Take the usage decision for the incoming inspection lot of the batch
- Change the batch status from *Restricted* to *Unrestricted*
Finding a Document with a Digital Signature

Use
If you are not sure of the key data of a certain document, you can search for the document using the signature data.

Prerequisites
The processing status of a document was approved with a digital signature.

Procedure
2. Enter the signature data, for example
   - signer, date
   - specify whether you want to include signatures with or without a comment
   - signature strategy data
   - status of the signature process
1. If necessary, enter key fields in the Find digital signature for data block (you can also specify a value range here).
2. Set the Include signatures for status change of document indicator.
3. Choose Execute.

Result
You see a list of all the documents that match your selection criteria. In this list, you can
- display the individual document info records (Display object)
- display information on the digital signature (Display signatures for selection).
Monitoring and Logging of Signature Processes

Use
Digital approval processes must be reliable and transparent in order to comply with security requirements. For this reason, the SAP System offers the following:

- You can lock users after a customer-specific number of unsuccessful attempts has been reached.
- You can monitor security-relevant activities that occurred during the signature process.
- You can analyze all activities performed in the context of the signature process.

Features

User Lock
When a signature is executed, unsuccessful attempts can take place for a number of different reasons (for example, the user has entered the wrong password, the user is not authorized to execute the signature, or the system could not verify the signature). After a certain number of unsuccessful attempts has been exceeded, the user is locked as follows:

- When a system signature is executed, the user is locked by the SAP System. The lock applies to the digital signature and a new system logon. You set up the number of unsuccessful attempts in the system profile (see Limiting Logon Attempts and Defining Clients [Extern]).
- When a user signature is executed, the user is locked by the external security product. The lock only applies to the digital signature. The number of allowed unsuccessful attempts is managed by the external security product.

Security Audit Log
Any failed signature attempt is logged in the Security Audit Log along with other security-relevant events of the SAP System. The system documents, for example, the reason for the error, date and time, and the signatory's user ID. The security administrator can use the CCMS alert monitor to evaluate the Security Audit Log.

Log for Digital Signature
The log for the digital signature documents all relevant steps in a signature process. This includes successful and canceled signatures as well as signatures that were deleted when the signature process was canceled. You can evaluate the signature log, for example, by signature object, signature time, and the signatory's user ID (see Analyzing Logs for Digital Signatures [Seite 86]). It contains the result of the signature steps along with all messages and the data that is transferred to the signed document if the signatures were successful.
Analyzing Logs for Digital Signatures

Use

You can use this procedure to get an overview of the course signature processes took and evaluate all activities performed in the course of the signature process.

If you only want to analyze the security-relevant events that occurred both in the context of digital signatures and during other activities in the SAP System, use the CCMS alert monitor to analyze the Security Audit Log instead (see The Alert Monitor [Extern]).

Procedure

1. Call up the log for the digital signature as follows:

<table>
<thead>
<tr>
<th>Area</th>
<th>Choose:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering Change Management (ECH)</td>
<td>Reporting → Log for Digital Signature</td>
</tr>
<tr>
<td>Process management (PP-PI)</td>
<td>Evaluations → Log for Digital Signature</td>
</tr>
<tr>
<td>Batch record (PP-PI)</td>
<td>Goto → Log for digital signature</td>
</tr>
</tbody>
</table>

2. Enter the criteria for log selection and choose 🎨.

   The overview of the logs that the system selected appears. The following data is displayed:

   - In the top screen area, the logs' header data, that is, the date and time, the signatory name, the number or log messages, and the reason for signature
     
     There is exactly one log for each signature attempt.

   - In the bottom screen area, the messages of the logs selected, that is, the result of the signature steps and all relevant signature data
     
     Messages are marked according to their type and logs are marked according to the most serious message type they contain:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Message Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>Information</td>
</tr>
<tr>
<td>🚨</td>
<td>Warning</td>
</tr>
<tr>
<td>🔴</td>
<td>Error</td>
</tr>
</tbody>
</table>
In addition, the following log classes are highlighted in different colors:

<table>
<thead>
<tr>
<th>Log or Error Class</th>
<th>Text Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature process canceled</td>
<td>Log red, message highlighted in yellow</td>
</tr>
<tr>
<td>Wrong password, name not maintained, missing SSF info</td>
<td>Log and message highlighted in yellow</td>
</tr>
</tbody>
</table>

3. Use the following functions to analyze the logs:

- If you only want to display messages of a particular type, choose the corresponding icon in the symbol bar at the bottom of the screen.
- If you only want to display messages of a particular log, double-click the log in the top screen area. By double-clicking the higher-level node, the system again displays all logs of the corresponding object type.
- To display the long text for a message, choose in the corresponding line in the bottom area of the screen.
Creating a Document

Use

You can create a document in different processing situations with different functions. Here, you create a document info record that stores all of the data required to process and manage a document (original file).

Prerequisites

You must carry out the necessary IMG activities under Control data in Customizing for Document Management.

⚠️

You cannot change the document type after you have saved the document.

Features

The following overview shows which functions you must call in the different processing situations.

<table>
<thead>
<tr>
<th>You want to...</th>
<th>Screen</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new document</td>
<td>Document Management menu</td>
<td>Document → Create [Seite 90]</td>
</tr>
<tr>
<td>Create document by copying template document (same document type)</td>
<td>Document Management menu</td>
<td>Document → Create using templates or by copying) [Seite 91]</td>
</tr>
<tr>
<td>Create new version by copying template (source) document (highest existing version)</td>
<td>Initial screen Document → Edit</td>
<td>Document → New Version (from Initial Screen) [Seite 95]</td>
</tr>
<tr>
<td>Create new version by copying template (source) document (version that is being processed in the current session)</td>
<td>Processing the document, for example on the tab page Document data</td>
<td>Document → New Version (from Basic Data Screen) [Seite 97]</td>
</tr>
</tbody>
</table>
Before Creating a Document Info Record

In order to create your document quickly and make sure that all the necessary data is entered and processed, you should make the following decisions before you start:

- Which document type do you want to assign to the document? The document type has important control functions and cannot be changed once you have saved your document.
- How do you want to assign document numbers, provided the document type allows both internal and external number assignment?
- Do you want to divide large documents into document parts? If so, which naming convention do you want to use for the document parts?
- If automatic version number assignment for the individual processing statuses is not supported for the chosen document type, you must decide whether to assign a version number manually or have the next version number assigned automatically.
- Is there a document whose basic data you can copy to your new document?
- Is the document part of a complex change which you want to link to other change objects using a particular change number?
- Do you want to maintain additional fields for the document?
Creating a Document

Procedure

1. From the main Document management screen, choose Document → Create.
   
   You see the Create document: Initial Screen.

2. In the Create document: Initial screen enter in the field Document document number.
   
   Note the settings for the document type. Internal or mixed number assignment may be supported for the document type.

   See Internal Number Assignment [Seite 26] Mixed Number Assignment [Seite 27]

3. Enter the document type in the Document type field.

4. If required, enter the following data:
   
   – Document Part [Seite 31]
   
   – Document Version [Seite 33]

5. Confirm your entries.

6. There are various system checks. For example, if the version number is assigned automatically, the system checks the object link of the previous version. You can either copy these links or cancel the link function.

   The Basic Data screen of the document appears.

7. Enter the necessary data in the Document data tab page.
   
   See also: Maintaining Data for the Original Application File [Seite 135]

8. Save your document.
Copying a Document

Prerequisites
The document that you want to use as a template for copying must already exist.
You can use the following documents to copy from:
- The document that you want to copy from must exist.
- The document that you copy from must have the same document type as the one you want to create.

Procedure
1. In the Create document: Initial screen enter the data for the document you want to create.  
   See Creating a Document [Seite 90]
2. In the Copy from box, you enter the data for the source document.
   If the source document has more than one version and you want to choose the version from a list, enter the special character * in the Document version field.
   - You see the Document Versions screen, showing a list of all the versions of the document.
   - Choose the version you want to copy from.
     The system checks the template, or source document. You will see one or several dialog boxes where you must decide which data you want to copy from the template, or source document.
     See also: Creating a New Version [Seite 93]
     You see the Basic Data screen of the document you are creating.
3. Process the document data such as:
   - Data that was copied from the template, or source documents such as person responsible and data from the original application file
   - Data that is not copied, for example document status
4. Save your document.
See also:
Displaying the Sequence of Source Documents or Templates [Seite 106]
Displaying the Sequence of Source Documents

Prerequisites

The document that you are currently processing was created with reference to a source document.

Procedure

1. On the Document data tab page, choose the function Extras → Sequence of sources

   The Sequence of Sources screen appears.
   - The document you are currently processing is in the lowest line of the list, with the highest sort number.
   - If this source document was also created by copying from another document, you see this source document, too. The source document is always in the lowest sort number in the superior line.

       The first document that was created without copying is shown in the first line, with sort number 001.

2. Go back.
Creating a New Version

Use
You create a new document version if the following conditions apply:

- Some of the data of the existing, original document version must be changed.
- The processing status of the existing, original document version has to be saved and processed further.

Integration
You can define version assignment in Customizing for the Document Management System by choosing Define document types.

See: Document Version [Seite 33]

Features
When you create a new version, the system checks the data from the source document: The following overview shows you the data can copy.

<table>
<thead>
<tr>
<th>Dialog box</th>
<th>The following exist for the source file...</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object selection</td>
<td>Object links</td>
<td>If you</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• want to copy objects (for example material) select them and choose Continue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Do not want to copy the objects choose Cancel.</td>
</tr>
<tr>
<td>Copying original application files that are not stored without</td>
<td>Original application files that are not stored in a secure area (storage category)</td>
<td>If you</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Want to copy original application files select the files and give them a new file name. Choose Continue.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Do not want to copy the original application files choose Cancel.</td>
</tr>
<tr>
<td>Making Reservations in Engineering Change Management</td>
<td>Making Reservations in Engineering Change Management</td>
<td>If you</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Want to copy a change number choose Copy.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Do not want to copy the change number choose Cancel.</td>
</tr>
</tbody>
</table>
Prerequisites
At least one document version exists.

Features
When you create a new version, the following data can be used to copy from:

- Data of an existing version with the highest version number
  
  See: Creating a New Version from the Initial Screen [Seite 95]

- Data of the version that is currently being processed
  
  See: Creating a New Version from the Basic Data Screen [Seite 97]
Creating a New Version from the Initial Screen

Prerequisites

You are on one of the following screens:

- Create Document: Initial Screen
- Change Document: Initial Screen
- Display Document: Initial Screen

Procedure

1. Choose Document → New version
2. Enter the following data:
   - Document number
   - Document Type
   - Document part
3. Enter the document version
   Depending on the setting for version assignment of the document type, you may have to make an entry. See: Document Version [Seite 33]

The following overview displays the possibilities for version assignment.

<table>
<thead>
<tr>
<th>Settings for Version Assignment of Document Type</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic</strong> assignment</td>
<td>The system ignores each entry in field Document version. The successor for the next highest version is automatically assigned (after the version number increments are set).</td>
</tr>
<tr>
<td><strong>No automatic</strong> assignment</td>
<td>You see the Create document: Initial Screen. Enter the data for the new version.</td>
</tr>
<tr>
<td>The next free Version should be assigned for the highest existing version.</td>
<td>Enter the special character &quot;*&quot; in the first part of the field Version. The system assigns the numbers according to the version number increments.</td>
</tr>
</tbody>
</table>

4. Confirm your entries.
   The system checks the data of the source document. You may need to edit the data in the dialog box.
   See: Creating a New Version [Seite 93]
5. Edit the basic data:
6. Save the new version.
New Version from Processing a Document

Prerequisites
You are processing a document, for example on the tab page Document data.

Procedure
1. Choose Document $\rightarrow$ New version
   Depending on the document type, you may have to make an entry in the Document version field.
   See: Document Version [Seite 33]
   The following overview displays the possibilities for version assignment.

<table>
<thead>
<tr>
<th>Settings for Version Assignment of Document Type</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic</strong> assignment</td>
<td>The system ignores each entry in field Document version. The successor for the next highest version is automatically assigned (after the set version number increments).</td>
</tr>
<tr>
<td><strong>No automatic</strong> assignment</td>
<td>You see the Create document: Initial Screen. Enter the data for the new version.</td>
</tr>
<tr>
<td>The next free Version should be assigned for the highest existing version.</td>
<td>Enter the special character &quot;*&quot; in the first part of the field Version. The system assigns the numbers according to the version number increments.</td>
</tr>
</tbody>
</table>

2. Confirm your entries.
   The system checks the data of the source document. You may need to edit the data in the dialog box.
   See: Creating a New Version [Seite 93]
4. Save the new version.
Changing a Document

Before you change a document, you need to consider the following:

- Changes to documents are not historical. This means that the status of the document before the change is lost. This is still the case if you enter a change number in the document. If you want to save the old status of the document, you must create a new version.

- In Customizing for the Document Management System, you can determine for each document type whether the system generates change documents. These show you who made a change to the document. You make the required settings under Document Management System → Control data → Define document types.

- If the document you want to change has a status of the status types Locked or Original processing, most fields cannot be changed. To change document data, the document must first be given a different status.

- Whenever you change a field in a document info record, a Workflow event is triggered when you save. In Workflow, you can define a receiver for this event. You can define and start enterprise-specific workflow tasks.

The following sections describe the various processing situations in which you can change a document. This is followed by information on how to change special data.

Notes on Changing a Document

<table>
<thead>
<tr>
<th>Processing situation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing a document directly</td>
<td>Changing a Document Using the Change Function [Seite 99]</td>
</tr>
<tr>
<td>Changing a document in display mode</td>
<td>Changing a Document from Display Mode [Seite 100]</td>
</tr>
<tr>
<td>Document hierarchy</td>
<td>Changing a Document from the Hierarchy [Seite 101]</td>
</tr>
</tbody>
</table>
Changing a Document Using the Change Function

Procedure

   
   You see the Change Document Initial Screen.
   
   If your user master contains default parameters for the fields in the document key, you see these default values. Once you overwrite the default values, you see the last field entry that was made in each case.

2. Enter the data on the initial screen:
   
   – In the Document field, enter the document number.
     
     You can also use the search help function to find the document.
     
     You can restrict the search areas using data for classification, object links, or short texts.
   
   – Enter the document type, the document part, and the document version.
     
     If you want to choose the document from a list of all the available document parts or versions, choose Environment → Document part or Version from the menu.
     
     When you double-click, the system goes to the Basic data screen of the document you chose.

3. Confirm your entries.
   
   If the system accepts the data you entered on the initial screen, you see the Basic data screen. On the screen there are several tab pages where you can add or change data.
   
   If the document has a Locked or Original processing status, you are unable to enter data in the majority of fields. If this is the case, you need to change the status.

4. Save your changes by choosing Document → Save.
Changing a Document from Display Mode

Procedure

1. Choose the display mode (Change <-> Display). The system changes to change mode. All the fields for maintaining basic data are now ready for you to change.

2. Save your changes by choosing Document → Save.
Changing Documents from the Hierarchy

Use
Even if you are in display mode, you can change document info records from the document hierarchy.

Procedure
1. On the Basic Data screen, choose (Extras → Hierarchy)
   The Document Hierarchy screen appears.
2. Select the document you want to change.
3. Choose Change.
   The Basic Data screen of the document appears. Here, you can change and add data as required.
4. Save your changes by choosing Document → Save.
   You see the document hierarchy again. The documents that you have changed are then marked with a tick in the list.
Changing the Deletion Indicator

Use
You can use the deletion indicator to control that documents are deleted after the next archiving run.
The same function enables you to set or remove the deletion indicator.

Prerequisites
You can set the deletion indicator in the following circumstances:

- There is an authorization check for setting the deletion indicator. When you set the deletion indicator, the system checks that you are authorized to maintain the deletion indicator for documents of this document type. See: Authorization Objects for Documents [Seite 21]
- A document of the document type Quality Agreement is not linked to other R/3 objects.
- The document is not a document in any bill of material.

Procedure
- From the Edit menu option, choose Change deletion ind.. The system immediately sets or deletes the deletion indicator as appropriate.
  - The system checks the link with other R/3 objects when you set the indicator with this function.
    - If the document is linked to other R/3 objects, you see a warning message.
    - If you confirm this message, the system sets the indicator.
    - As soon as the deletion indicator is set the fields can no longer be changed.

Result
You can edit documents that have the deletion indicator in the following way:

- To delete the documents physically from the database, you must run the MCDOKDEL program using the ABAP/4 editor. This program deletes all documents of a selected document type for which this indicator is set.
- In Archiving [Extern], you can select documents that have the deletion indicator to be archived. After the archiving run, you can delete all the documents that have the deletion indicator.
Display Document

Use

You can use this function to display a document and any original application files belonging to it by entering the document number and document type. You can choose the document part and document version from a list.

If you do not know the document number, you can use the Search Function [Seite 274].

Prerequisites

Before you can display a document info record and any original data belonging to it, the system carries out comprehensive checks.

- These include checks for the following authorizations:
  - Display document
  - Display application data
  - Display application from archive
  - Display archive

  See: Authorization Objects for Documents [Seite 21]

- Before you can display the original application data, certain technical requirements must be met. You must make certain system settings before you can start an application or display an original application file. You can make these settings in Customizing for Cross-Application Components under Document Management → General Data
Starting the Display Function

Procedure

   
   You see the Display Document: Initial Screen.
   
   If your user master contains default parameters for the fields in the document key, you see these default values. Once you overwrite the default values, you see the last field entry that was made in each case.

2. Enter the data on the initial screen:
   
   - In the Document field, enter the document number.
     
     You can also use the matchcode function to find the document number. You can search via classification, object links, or description.
   
   - Enter the document type, the document part, and the document version.
     
     If you want to choose the document from a list of all the available document parts or versions, choose Environment → Document part or Version from the menu. When you double-click, the system goes to the Basic data screen of the document you chose.

3. Confirm your entries.
   
   If the system accepts the data you entered on the initial screen, you see the Basic data screen.
   
   On this screen, you can call additional functions for displaying document data.
   
   This screen contains fields with the following features:
   
   - Fields with values that are displayed on the Basic Data screen (for example, classification data and user)
   
   - Fields in which the system sets an indicator (for example, hierarchy indicator, CAD indicator, long text indicator)
   
   - Fields in which you can overwrite the entries in display mode (you can overwrite the Language field to determine which language-dependent texts are displayed).
Displaying a Long Text

Prerequisites

When a long text exists the system sets the indicator *Long texts exist* on the tab page *Texts*.

Procedure

You can display long texts as follows:

- The long text in the **logon language** can be displayed on the tab page *Document data* with (Long text). The text editor appears and you can use all active functions.

- Long texts in **other** languages can be displayed on the tab page *Texts*. You can display long texts as follows:
  - Double-click on the short text to make the long text appear.
  - Choose the language and (Long text).
Displaying the Sequence of Source Documents

Prerequisites
The document that you are currently processing was created with reference to a source document.

Procedure
3. On the Document data tab page, choose the function Extras → Sequence of sources
   The Sequence of Sources screen appears.
   - The document you are currently processing is in the lowest line of the list, with the highest sort number.
   - If this source document was also created by copying from another document, you see this source document, too. The source document is always in the lowest sort number in the superior line.
     The first document that was created without copying is shown in the first line, with sort number 001.

4. Go back.
Displaying Document Parts and Versions

Procedure

The *Extras* menu contains functions for displaying all the document parts and versions of a document (with the document number and document type you entered).

You can display these lists on the screen *Display document: Initial* as well as the processing screen *Basic data*. The call using the menu is identical.

- If you want to display a list of all the **document parts** of a document (with the document number and document type you entered), choose *Extras → Document parts*.
  
  You see a list of all the document parts, including existing versions.

- If you want to display a list of all the versions of a document (with the document number, document type, and part document you entered), choose *Extras → Versions*.

Result

You see a list with existing document parts and versions. Next to the key fields of the documents are the status and short text. The version list contains additional entries for validity and shows which version the most up-to-date.

You can print these lists, or display individual documents in them by choosing the document. You can use all active functions on the *Display Document* screen.

To return to the *Display Document: Initial Screen*, choose *Back*.

If you want to display another document info record from the list of document parts or versions, the system leaves the document you chose to display on the *Display document* screen.
Displaying Output

Displaying Output

The output control function allows you to automatically create output concerning a user-defined event and to automatically send it to internal or external communication partners.

In Customizing for the Document Management System, you can define statuses for each document type that trigger a particular output to a partner (for example, an internal e-mail partner) by choosing Output.

Procedure

1. Choose Goto → Messages.
   You see the Output screen, containing the following information:
   - Output type
   - Output medium
   - Partner
   - Status
   - Language

2. Using the Communication and Further data functions, you can display more information:
   - Communication
     This function allows you to display information on mail messages that have been sent and information on message processing.
   - Further data
     This function allows you to display information on actual processing, requested processing, and archiving, as well as general data.

3. To return to the Basic Data screen, choose Back.
Displaying Change Documents

Prerequisites

You can use this function if the Create change documents indicator has been set in Customizing for the document type concerned. All changes to object links, short texts, and fields are logged.

The settings are made in Customizing Document management under Control data → Define document type → Detail screen.

Procedure

1. Process the document in change mode or display mode screen Basic data.
2. Choose Environment → Display changes. You see the Change document for document data screen.
   - The first line identifies the document.
   - Then the individual document records are listed. The changes are sorted in the following order:
     - Changes to object links
     - Changes to short texts
     - Changes to fields
3. For each change you receive information as to what kind of change was made, for example created, changed, deleted.
   - You see the following data:
     - User who made the change
     - Date/time of change
     - Function used to make the change
     - Old field value
     - New field value
Original Application File of a Document Info Record

Definition

Collection of related data that reports the real information about an object or product.

In the area of PDM [Extern], information that defines a product is maintained in digital files. These electronic documents make up a closed data amount that can be very different:

- File in graphic formats for 2D engineering and design drawings or assembly instructions
- Text files for load reports or specifications
- 3D models
- Pictures (scanned drawings, photos)
- Program files

You create two document info records and two original application files.

Document 1:
You enter a design drawing that was created with a CAD program for the document info record.
You compile extensive documentation in the form of a text file using a word-processing program.

Document 2:
You manage two different representative forms for one drawing. In the document info record you create the original application file in the original EDP format and a file in a pixel format based on the original application file.

Structure

The state of an original application file depends on its medium. For example, you can have the following original application files:

- Original application files that are stored on paper in a filing cabinet
  You can manage these original application files with the DMS [Extern] and organize how they are processed. Processing the document info record directly is not possible.

- Digital original application files
  These original application files can be managed by DMS and processing process can be organized. They can also be directly processed from the DMS.
  You start the chosen workstation application, such as Microsoft Word, directly from DMS in order to process it. You can also store special processing statuses in a secure area for later retrieval.
  You can set the scope of each original application file for each workstation application.
  You can maintain more than one Content version [Seite 113] for an original application file. Each content version can have one or more Additional files [Seite 117] assigned to it.
Integration

The document info record contains the metadata [Extern] for an original application file. They are necessary for managing and controlling processing flow of original application files.

To process digital original application files, such as text files, you must set the workstation application, for example, Microsoft Word and enter the storage data.

The following overview summarizes the data from the document info record that controls processing of original application files.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Type [Seite 29]</strong></td>
<td>Sets the storage <strong>possibilities</strong> in the secure area. The following possibilities exist:</td>
</tr>
<tr>
<td></td>
<td>- Storage via Knowledge Provider in defined storage systems (Content Repository) [Seite 138]</td>
</tr>
<tr>
<td></td>
<td>- Storage in Secure areas of DMS [Seite 141] that are defined in Customizing of document management (SAP Database, archive, vault)</td>
</tr>
<tr>
<td></td>
<td>Sets the <strong>number of original application files</strong> that can be entered in a document info record.</td>
</tr>
<tr>
<td></td>
<td>- Unlimited number when the document type supports storage using Knowledge Provider.</td>
</tr>
<tr>
<td></td>
<td>- Maximum two original application files (file 1 and file 2), when storage is controlled by DMS.</td>
</tr>
<tr>
<td><strong>Workstation application [Seite 119]</strong></td>
<td>Sets the program that is used to create and process the original application files.</td>
</tr>
<tr>
<td></td>
<td>Many settings are possible in Customizing. You can set the working directory for processing stored original application files.</td>
</tr>
<tr>
<td><strong>Document Status [Seite 44]</strong></td>
<td>The processing flow can be controlled using a Status network [Seite 44]. The status types Original in processing (C) and CheckIn Status (O) are supported for processing original application files.</td>
</tr>
<tr>
<td><strong>Authorizations [Seite 21]</strong></td>
<td>You can define authorizations for any processing functions for original application files.</td>
</tr>
</tbody>
</table>

Processing Functions

The selection function is dependent on the place where the original application file is saved. The following overview lists the most important functions for processing original application files.

<table>
<thead>
<tr>
<th>Where original application file is stored</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local or on a file server</td>
<td>Create [Seite 135] Edit [Seite 182]. Display [Seite 151]. Print CoKE Checking an Original Application File into a Secure Storage Area [Seite 141]</td>
</tr>
</tbody>
</table>
## Original Application File of a Document Info Record

<table>
<thead>
<tr>
<th>Secure storage area [Seite 141]</th>
<th>Create [Seite 135] Edit [Seite 185], Display [Seite 151], Print</th>
</tr>
</thead>
</table>

112 April 2001
Creating Content Versions

Use

Important processing situations of an original application file that may need to be stored for liability and proof purposes can be saved in secure areas as Content versions. You can create one or more content version in a document version for original application files.

This stored version of the original application file was called an audit in previous releases.

Integration

Maintenance of content versions depends on the workstation application. You set the scope of the original model during the definition of the workstation application (Setting in Customizing Document Management → General Data → Define workstation application). In order for you to maintain content versions you must set the indicator Content versions supported.

The following additional settings can differentiate the maintenance of content versions:

<table>
<thead>
<tr>
<th>Processing Content Versions</th>
<th>Activity in Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must define a status for the document type for automatically creating content versions.</td>
<td>Control data → Define document type → Define document status</td>
</tr>
<tr>
<td></td>
<td>Set the indicator Create content versions automatically</td>
</tr>
<tr>
<td>You must define storage of original application files using the Knowledge Provider (Content Repository) for manually creating content versions.</td>
<td>Control data → Define document types</td>
</tr>
<tr>
<td></td>
<td>Set the indicator Document storage via Knowledge Provider</td>
</tr>
<tr>
<td>The storage of content versions can be done in a predefined storage category.</td>
<td>General data → Define profile</td>
</tr>
<tr>
<td>The settings are put together in a profile and allocated to the user.</td>
<td>Enter the storage category</td>
</tr>
<tr>
<td></td>
<td>The setting is only read for document types that support storage using the Knowledge Provider.</td>
</tr>
</tbody>
</table>

Features

A content version is only created from an original application file that is not stored in a secure area in its current processing status. Each content version can have one or more Additional files [Seite 377] assigned to it.

You can create content version either manually or automatically in Customizing of Document Management.

The secure area where the content versions are to be transported is determined with the following checks:

1. If the original application file was already stored in a secure area, the system stores it in the same one again.
Creating Content Versions

2. The system checks if the user has a profile allocated when an original application file is stored in a secure area for the first time. In this case the storage occurs in the given storage category. The setting is only read for document types that support storage using the Knowledge Provider.

3. If the system could not find storage data a dialog box appears where you can choose from the possible secure areas.

The following graphic displays the original application files that are maintained for a document info record. One content version exists for each original application file. Three content versions were created for the 2D drawing.

Activities

Creating Content Versions Automatically [Seite 115]
Creating Content Versions Manually [Seite 116]
Creating Content Versions Automatically

Prerequisites

You can create a content version automatically for a processing status of an original application file if you have created the following two items in Customizing.

- The workstation application must support content versions (setting in Customizing of Document Management → General Data → Define workstation application).
- You must have at least one status defined for the document type (such as check request) that has the indicator Create content version automatically set (setting in Customizing of Document Management → Control Data → Define Document type → Define document status).

See: Creating Content Versions [Seite 113]

Procedure

1. Process the document on the tab page Document data
2. Set a status that automatically creates a content version, such as check request. A dialog box appears where you can enter a descriptive short text for the version.
3. Confirm your entry. You can continue with processing the document.
4. Save your document.

Result

The system creates a copy when start to process the original application file again. The previous processing status remains unchanged in the secure storage area and can be displayed from the tab page Originals. All changes are saved in the new content version that is also checked in and stored in a secure storage area.
Creating Content Versions Manually

Prerequisites
You can create a content version manually for a processing status of an original application file if you have created the following two items in Customizing.

- The workstation application must support content versions (setting in Customizing of Document Management → General Data → Define workstation application).
- The document type must support storage of original application files in the storage system (Content Repository) using the Knowledge Provider (setting in Customizing of Document Management → Control Data → Define document type).

See: Creating Content Versions [Seite 113]

Procedure
1. Process the document on the tab page Originals
2. Position the cursor in the line of the desired workstation application.
3. Choose Originals → Store as new version
   
   A dialog box appears where you can enter a descriptive short text for the version.
4. Confirm your entry. The Originals tab page reappears.

Result
The system creates a copy when start to process the original application file again. The previous processing status remains unchanged in the secure storage area and can be displayed from the tab page Originals.

All changes are saved in the new content version that is also checked in and stored in a secure storage area.
Creating Additional Files

Use

Original files sometimes contain reference links to other files. For example, a text file can have the following additional files: style sheets, graphics, or spreadsheet file. These files are maintained as additional files for an original application file.

Integration

Maintenance of additional files depends on the workstation application. You set the scope of the original model during the definition of the workstation application (Setting in Customizing Document management → General data → Define workstation application). Maintenance of additional files is only possible when the indicator Additional files supported is set.

Since the additional files are logically linked to the original application file, following functions you carry out for an original application file are automatically carried out for the additional files as well.

- Storing original application files in a Secure Area [Seite 141]
- Determining the prefix of the access path of an original application file (Setting in Customizing Document management → General data → Define data carrier → Set up mountpoints / logical drives)

Features

If you have set that the workstation application supports the maintenance of additional files the number of additional files for each original application file that you can maintain is dependent on the definition of the document type. The indicator Document storage using the Knowledge Provider influences the number of additional files in the following ways:

<table>
<thead>
<tr>
<th>Indicator Document storage using Knowledge Provider</th>
<th>Storing Original Application Files</th>
<th>Number of possible additional files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set</td>
<td>using Knowledge Provider in defined storage systems (Content Repository)</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Not set</td>
<td>in defined secure areas of DMS (archive, vault, SAP Database)</td>
<td>Max. 99</td>
</tr>
</tbody>
</table>

Activities

1. Process the document info record on the Basic data screen or on the tab page Originals.
2. In the screen area Originals position the cursor in the line of the desired workstation application.
3. Select (Detail).

   The Workstation application dialog box appears. Original application file where the workstation application and the storage data of original application file are maintained.

   You only see the maintenance area for the additional files when at least one additional file has been maintained.
4. Choose (Show additional files) for maintaining additional files.
Creating Additional Files

The dialog box is extended by the screen area Additional files.

5. Enter data for the additional data.
   - Workstation application
     - In the DataCar. field, enter the data carrier where the additional file is stored. You can choose the file from the file manager.
     - In the Original field, enter the path in the file system so that the application can access the additional file.

6. Confirm the entry and save the document.
Workstation Application for Processing Originals

Use
The original application files that you manage with DMS are usually produced digitally. You can create and edit these original application files directly from the document info record using workstation applications (such as Microsoft Word, or AutoCAD).

Integration
Any program that can read a file name as a parameter can be started as the workstation application for processing the original application file from the Document Management System.

This even works in heterogeneous networks. The application can be installed on any computer in the network. An original application file can therefore have any format and content. For example, it can take the form of a large text file, a photograph, a film, or a drawing.

The following data determines which workstation application is started for processing original application files:

- Make the settings for the workstation application in Customizing of Document Management.
- You enter the file that is to be processed by the workstation application in the document info record (storage location data).

Prerequisites
The settings for processing the original application files are defined in Customizing Document management → General data.

The following settings are necessary:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Activity in Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must define a data carrier for your frontend computer.</td>
<td>Define data carrier → Define data carrier type &quot;Server, frontend computer&quot;</td>
</tr>
<tr>
<td>Example: PC (PC with operating system Windows NT)</td>
<td></td>
</tr>
<tr>
<td>You must enter information about the transfer of data when the original application files are located on another computer.</td>
<td>Define data carrier → Define mount points and logical drives</td>
</tr>
<tr>
<td><strong>See:</strong> Data Carrier as Storage Location for an Original Application File [Seite 132]</td>
<td></td>
</tr>
<tr>
<td>You must define the workstation application that you use to process the original application file from a document info record and the path for the program call.</td>
<td>Define workstation application and → Define workstation application in a network</td>
</tr>
</tbody>
</table>

Enter a default value for the workstation application when defining the document type. The default value will be suggested when you create an original application file and additional files.
Workstation Application for Processing Originals

You can set default values for displaying and printing in a user-specific Profile [Seite 191].

Defining Workstation Applications

Each program you want to use to process original application files must be defined as a workstation application in this activity. Many processing steps for the original application files can be more effectively carried out by means of additional settings.

For example, the following settings can be used:

- You set that original application files are deleted locally after they have been stored in a secure storage area.
- You can visualize which workstation applications in the document info record by the assignment of program icons.
- You set the scope of the original model. You can save important processing statuses of original application files in content versions [Seite 113]. Each content version can have one or more additional files [Seite 117] assigned to it.

Defining Workstation Applications in Networks

You can assign each file format an application for displaying and changing the original application file in this activity. You enter the path for the program call. The program call depends on the data carrier type of the frontend computer (for example, a PC with Windows NT) and the workstation application (for example, Microsoft Word).

You can also make settings for the integrated SAP Integrated Viewer [Seite 506] that is used for displaying technical drawings and 3D models.

You can define the program call so that the system automatically determines the program to be started for frontend computers that have the Windows NT operating system. The application (for example, Microsoft Word) no longer has to be installed under the same path for all frontend computers.

For more information, see the Implementation Guide Define workstation applications in network.

Features

The workstation application allows you to view [Seite 151] and process [Seite 182] original application files directly from the document info record.

- When you define a secure area [Seite 141] in your company you have an area that requires special authorization for access.
- You can simplify processing original application files with Microsoft Office applications (such as Microsoft Word) by changing special settings in Customizing for Document Management.

See also: Desktop Office Integration [Seite 121]

The system checks that are carried out when displaying an original application file are shown in the graphic Displaying Original Application Files [Seite 154].
Desktop Office Integration

Use

The original application files of many business processes are managed using the Document Management System (DMS) and are stored in a secure area. Microsoft Office Integration offers an easy and comfortable way to process original application files with OLE2 capable desktop applications such as Microsoft Word or Microsoft Excel. You can start the application directly from a document info record and use a template to ease creating the document.

Integration

The settings for Office integration are in Customizing Document Management, under Define workstation application. Execute the following activities:

- **Activity: Define workstation applications in networks**
  
  Set in the path of the application-call whether the application is to be started inplace (within a screen section of the SAP System) or outplace (externally in its own window). You can also set that in display mode the application starts inplace, but in editing mode starts outplace.

  The syntax of the program call determines which method is used:

  - **inplace** (2 variants):
    
    %SAP-OFFICE-INTEGRATION.INPLACE%
    
    %SAP-OFFICE-INTEGRATION.INPLACE% %MAXSIZE%

  - **outplace**:

    %SAP-OFFICE-INTEGRATION.OUTPLACE%

  Use the F1 help in the field Application (Path with Program Name) for more information.

- **Activity Determine copy templates for original application files**

  You can create several and use copy templates (called source files in earlier Releases) dependent on document type and the application used. These copy templates are language-dependent.

  It is recommended that you save these templates in a storage system to allow them to be accessed by all users.

- **Activity Setup Office integration**

  You can set which data is supported for transport from the SAP System into the Office file.

  In this Release data transfer can only be handled by a linkserver, therefore no other method can be selected. The linkserver manages the fields of the SAP System that can be embedded into the Office application. The server is only started when you set the indicator Export in this activity.

Prerequisites

The frontend computer’s operating system must be either Windows 9X or Windows NT 4.0. You must process the links in the Office application by means of field functions. The field functions
Desktop Office Integration

must be displayed in the Office applications. See the note no. 0181044 for detailed information on how to do this.

You must convert old templates (source files) for use with the new Release by using the conversion report: DMS_TEMPLATES_CONVERT (Conversion of copy templates).

Features

You can create or process original application files directly from the document info record.

- You can use templates for creating original application files. You can create as many templates with Microsoft Office applications as you like for each document type. These templates can be language-dependent and chosen when creating new original application files.

- When you process an original application file with an Office application you can transfer data from the SAP System into the original application files.
  
  The transfer of data into original application files supports the fields from the following data groups:
  
  - General document data from the table DRAW
  - Short text from the table DRAT
  - Class data from the document info record

  See: List of SAP Fields [Seite 130]

  The field selection is dependent on the application.

  You can create a copy template that contains certain fields from drawing header data and automatically transfers matching field values automatically when the original application file is processed.

- You can set in Customizing whether an Office application (such as Microsoft Word) for creating or changing originals is to be started inplace or outplace.

  - inplace
    
    The Microsoft Office application starts within the window that is for processing the document info record.
    
    We recommend you only use this setting when making small changes because the data cannot be saved separately in the Office application rather only when saving the entire document info record.

  - outplace
    
    A new window is opened for the Microsoft Office application. You can use all the function of the application, such as saving the original only.
    
    You can process several original application files at the same time as you change a document info record.
    
    You can save each file individually in its own Office application or save all the changes at once by saving the document info record.

Activities

Process a document info record.
1. Select the function for processing the original application file. Call all active functions using the context menu. Position the cursor on the desired original application file. Click the right-hand mouse button to reveal a context menu with all active functions.
   - **Create**
     
     Select the section in the screen section for the original application files.
     
     You can select any of the templates for this document type that exist in your logon language from the dialog box.
     
     The system starts the application inplace or outplace based on the settings in Customizing.
   
   - **Change**
     
     The document must be checked out first if it is in a secure area.

   **See also:** Processing Original Application Files (Microsoft Office Integration) [Seite 124]

2. After you have finished editing the original application file, save it either in the Microsoft Office application or by saving the document info record.
Processing Originals (Microsoft Office Integration)

Use

Processing an original application file using a workstation application that is integrated directly into Document Management is discussed in this example.

In this example you process a document info record of the document type DRW (engineering/design drawing).

- In the first step you set up the outline for the documentation. You create an original application file with the workstation application Microsoft Word. While doing this the document info record is displayed in a separately in the current processing window and the Word file is open in a second window.
  
  You transfer the field Document status from the document info record in the SAP System.

- In the second step you display the document info record and the assigned original application file (Word file). In this case you want to start Microsoft Word inplace, that is directly in the processing window of the document info record.

Prerequisites

The settings for Office integration are in Customizing Document Management, under Define workstation application. General information for settings can be found in Desktop Office Integration [Seite 121].

In the activity Define workstation application you define the application Microsoft Word (WRD). For this example you will also make the following settings for Office Integration:

- Activity: Define workstation applications in networks
  - You enter two entries for the workstation application WRD with the required data carrier type (such as PC for frontend computers using Windows NT operating system).

<table>
<thead>
<tr>
<th>Field</th>
<th>First entry for change mode</th>
<th>Second entry for display mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application type</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Path with program name</td>
<td>%SAP-OFFICE-INTEGRATION.OUTPLACE%</td>
<td>%SAP-OFFICE-INTEGRATION.INPLACE%</td>
</tr>
</tbody>
</table>

- Activity Setup Office integration
  - Enter the document type (DRW) and the application type 2 for changing.
  - Select the technique Link Technique.
  - Select the data group whose fields you want to copy. The field Document status is assigned to the data group Document data.
  - Set the indicator: Export.

Creating Original Application Files

1. Process a document with the document type DRW.
2. In the lower screen section *Originals* select (Create).
   
The dialog box *Basic Data* screen appears.

3. Execute the following activities in the dialog box:
   
   - Enter the workstation application WRD.
   - Select .

   The system opens a new window with the Office application (Microsoft Word).

4. You can enter the documentation for the engineering/design drawing in the window of the Office application (Microsoft Word). All normal Microsoft Word functions are available such as format, insert, or save.

5. Enter the Link for SAP Field [Seite 126] Document status.

6. After you add the first link in the original application file must Update Fields [Seite 129].

7. Save the original application file in the Office application.

### Displaying Original Application Files

1. Display the document.

2. In the lower screen section *Originals* select (Create).
   
The dialog box *Basic Data* screen appears.

3. Execute the following activities in the dialog box:
   
   - Enter the workstation application WRD.
   - Select .

   The system splits the screen section for processing the document info record into two sections:

   - In the left screen section the data of the document info record is displayed.
   - In the right screen section the system starts the Office application in this case Microsoft Word.

4. You can enter the documentation for the engineering/design drawing in the screen section of the Office application (Microsoft Word). All normal Microsoft Word functions are available such as format and insert.

   ![Note]

   If you start the Office application *inplace* saving the original application file requires a special step. You cannot save the original application file directly in the Office application, you must use the *Save* function of the document info record.

   This saves the original application file and the document info record at the same time. Saving also ends processing of the document info record and you return to the initial screen for Create document or Change document.
Creating Links for SAP Fields

Use

Thanks to Office Integration [Seite 121] you can now enter field contents into the original application file from the SAP System.

See also: List of SAP Fields [Seite 130]

The number of links in a Word file can adversely affect performance for processing and display. Therefore create only links to the SAP fields that are need for information.

Creating Links in Microsoft Word

After you have created the first link you can create further links much more easily: Copy the complete character string for the link and replace the entry for the SAP field.

1. You are processing an original application file on Microsoft Word. You are using the Office Integration from Document Management.
   See: Processing Original Application Files (Microsoft Office Integration) [Seite 124]
   The system starts Microsoft Word.
2. Activate the function to display field codes. Depending on the language version of Microsoft Word have select the following function: Tools → Options → View. Set the indicator Field codes.
3. Select Insert → Field.
4. In the window section Category select the entry Links and References.
5. In the screen area Field name select Link.
   You will see in the lower section of the window a command line with the entry LINK.
6. Enter the character sequence for the link after this word (not language-dependent).
   SAP.OLELinkServer.ItemObject.1"SAPOLELinkServerDMS""Document.<field>"
   Replace the placeholder <field> with the character chain for the required field.
Example:
   SAP.OLELinkServer.ItemObject.1"SAPOLELinkServerDMS""Document.DRAW.DOKST"
7. Select Options.
8. Select the following options:
   • \a (Update fields automatically)
   • \t (Insert field as text)
   The complete string looks as the following (language-dependent):
Creating Links for SAP Fields

Creating Links in Microsoft Word

1. You are processing an original application file on Microsoft Word. You are using the Office Integration from Document Management.

   See: Processing Original Application Files (Microsoft Office Integration) [Seite 124]

   The system starts Microsoft Word.

2. Activate the function to display field contents. Depending on the language version of Microsoft Word have select the following function: Tools → Options → View. Set the indicator Field codes.

3. Select Insert → Field.

4. In the window section Categories select Link and References.

5. In the screen area Field name select Link.

   You will see in the lower section of the window a command line with the entry LINK.

6. Enter the character sequence for the link after this word.

   SAP.OLELinkServer.ItemObject.1"SAPOLELinkServerDMS""Document.<field>"

   Replace the placeholder <field> with the character chain for the required field.

   Example:
   SAP.OLELinkServer.ItemObject.1"SAPOLELinkServerDMS""Document.DRAW.DOKST"

7. Select Options.

8. Select the following options:
   • \a (Update fields automatically)
   • \t (Insert field as text)

   The complete string looks as the following:
   \{LINK SAP.OLELinkServer.ItemObject.1 "SAPOLELinkServerDMS" Document.DRAW.DOKNR" \a \t\}

9. Update [Seite 129] the field contents.

Creating Links in Microsoft Excel

1. Highlight the cell where you want to display the SAP field.

   The system sets the coordinates of the field in the name box.

2. Position the cursor in the formula bar.

   The operation character = is displayed.

3. Enter the following character sequence after the = :

   SAP.OLELinkServer.ItemObject.1|SAPOLELinkServerDMS!'!Document.<field>
Creating Links for SAP Fields

Replace the placeholder <field> with the SAP field.

Example:

=\$\text{A}\!\text{P}.\text{OLELinkServer}.\text{ItemObject}.1|\text{SAPOLELinkServerDMS}!'!\text{DOKAR}'

Consult the Excel help for more information.
Updating Field Contents

Use

After you add the first link in the original application file must update fields. Even when processing the original application file over a long period of time you should update the links. The update fields function ensures that the field values in the original application file are always the most current.

See also: Creating Links for SAP Fields [Seite 126]

Procedure

Highlight one or more links.

The following overview describes the procedure for your logon language and the English language version of Microsoft Word.

<table>
<thead>
<tr>
<th>Logon Language Version</th>
<th>English Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translate the English into your logon language for all entries</td>
<td>Edit → Links</td>
</tr>
<tr>
<td>The dialog box Links appears.</td>
<td>The dialog box Links appears.</td>
</tr>
<tr>
<td>Set the indicator Update:</td>
<td>Set the indicator Update:</td>
</tr>
<tr>
<td></td>
<td>Automatic or select Update now.</td>
</tr>
</tbody>
</table>

You can also highlight a link and press the function key F9 to update the links in any language version.

Result

The field contents from the SAP System were updated in the original application file (such Word file).
List of SAP Fields

The individual fields of the of three data groups that support transfer. You enter these fields using the placeholder <field> in the character sequence of a link.

See: Creating Links for SAP Fields [Seite 126]

Transfer of General Document Data

Table DRAW

<table>
<thead>
<tr>
<th>Field name</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document number</td>
<td>Document.DRAW.DOKNR</td>
</tr>
<tr>
<td>Document Type</td>
<td>Document.DRAW.DOKAR</td>
</tr>
<tr>
<td>Document version</td>
<td>Document.DRAW.DKVR</td>
</tr>
<tr>
<td>Document part</td>
<td>Document.DRAW.DOKTL</td>
</tr>
<tr>
<td>Person responsible</td>
<td>Document.DRAW.DWNAM</td>
</tr>
<tr>
<td>Document status</td>
<td>Document.DRAW.DOKST</td>
</tr>
<tr>
<td>Laboratory/office</td>
<td>Document.DRAW.LABOR</td>
</tr>
<tr>
<td>Change numbers</td>
<td>Document.DRAW.AENNR</td>
</tr>
<tr>
<td>Plant</td>
<td>Document.DRAW.WERKA</td>
</tr>
<tr>
<td>Deletion indicator</td>
<td>Document.DRAW.LOEDK</td>
</tr>
<tr>
<td>CAD indicator</td>
<td>Document.DRAW.CADKZ</td>
</tr>
<tr>
<td>Document number of the superior document</td>
<td>Document.DRAW.PRENR</td>
</tr>
<tr>
<td>Document version of the superior document</td>
<td>Document.DRAW.PREVR</td>
</tr>
<tr>
<td>Document part of the superior document</td>
<td>Document.DRAW.PRETL</td>
</tr>
<tr>
<td>Document type of the superior document</td>
<td>Document.DRAW.PREAR</td>
</tr>
<tr>
<td>Authorization group</td>
<td>Document.DRAW.BEGRU</td>
</tr>
<tr>
<td>Customer specific reserve field 1</td>
<td>Document.DRAW.RES1</td>
</tr>
<tr>
<td>Customer specific reserve field 2</td>
<td>Document.DRAW.RES2</td>
</tr>
<tr>
<td>Customer specific reserve field 3</td>
<td>Document.DRAW.RES3</td>
</tr>
<tr>
<td>Customer specific reserve field 4</td>
<td>Document.DRAW.RES4</td>
</tr>
<tr>
<td>Output date:</td>
<td>Document.DRAW.ADATUM</td>
</tr>
<tr>
<td>Document number of the templates</td>
<td>Document.DRAW.DOKNR_VL</td>
</tr>
<tr>
<td>Document part if the template</td>
<td>Document.DRAW.DOKTL_VL</td>
</tr>
</tbody>
</table>

Table TDWST

<table>
<thead>
<tr>
<th>Field name</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization group</td>
<td>Document.DRAW.BEGRU</td>
</tr>
<tr>
<td>Customer specific reserve field 1</td>
<td>Document.DRAW.RES1</td>
</tr>
<tr>
<td>Customer specific reserve field 2</td>
<td>Document.DRAW.RES2</td>
</tr>
<tr>
<td>Customer specific reserve field 3</td>
<td>Document.DRAW.RES3</td>
</tr>
<tr>
<td>Customer specific reserve field 4</td>
<td>Document.DRAW.RES4</td>
</tr>
<tr>
<td>Output date:</td>
<td>Document.DRAW.ADATUM</td>
</tr>
<tr>
<td>Document number of the templates</td>
<td>Document.DRAW.DOKNR_VL</td>
</tr>
<tr>
<td>Document part if the template</td>
<td>Document.DRAW.DOKTL_VL</td>
</tr>
</tbody>
</table>
### List of SAP Fields

<table>
<thead>
<tr>
<th>Field name</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language-dependent status</td>
<td>Document.TDWST.STABK</td>
</tr>
<tr>
<td>Description of the document status in the logon language</td>
<td>Document.TDWST.DOSTX</td>
</tr>
</tbody>
</table>

#### Table AENR

<table>
<thead>
<tr>
<th>Field name</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effectivity date for the change number:</td>
<td>Document.AENR.DATUV</td>
</tr>
</tbody>
</table>

#### Transfer of Short Texts from the Table DRAT

<table>
<thead>
<tr>
<th>Field name</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short text in the standard/logon language</td>
<td>Document.DRAT.DKTXT</td>
</tr>
</tbody>
</table>

#### Transfer of Class Data

<table>
<thead>
<tr>
<th>Field name</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language-dependent characteristic value</td>
<td>Char_Value.DRAW.&lt;classtype&gt;.&lt;characteristic&gt;.&lt;n&gt;</td>
</tr>
<tr>
<td><strong>Place holder meaning:</strong></td>
<td></td>
</tr>
<tr>
<td>• Ÿ &lt;classtype&gt;</td>
<td></td>
</tr>
<tr>
<td>Place holder for the class type</td>
<td></td>
</tr>
<tr>
<td>Example: 017 as a class type for documents</td>
<td></td>
</tr>
<tr>
<td>All characteristics of the classes entered are transferred.</td>
<td></td>
</tr>
<tr>
<td>• Ÿ &lt;characteristic&gt;</td>
<td></td>
</tr>
<tr>
<td>Place holder for the characteristic name</td>
<td></td>
</tr>
<tr>
<td>You can see the characteristic name by displaying the class (transaction code CL03) and selecting &quot;Characteristics&quot;. The characteristic names are in the column with the header &quot;Characteristic&quot;.</td>
<td></td>
</tr>
<tr>
<td>• Ÿ &lt;n&gt;</td>
<td></td>
</tr>
<tr>
<td>Place holder for a number that numbers the characteristic value (multi-value characteristics possible)</td>
<td></td>
</tr>
<tr>
<td>Example: Char_Value.DRAW.017.IB_TARGET.1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description of the characteristic value in the logon language</th>
<th>Descr_Cval.&lt;objecttype&gt;.&lt;classtype&gt;.&lt;characteristic&gt;.&lt;n&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Descr_Cval.DRAW.017.IB_TARGET.1</td>
<td></td>
</tr>
</tbody>
</table>
Preparing a Data Carrier

Use

Original application files are stored on different data carriers.

The following computers are define as Data carriers in the area of DMS:

- Computer that is used to process the original application files
  (Server and frontend computer)
  In most cases, you can access these computers (data carriers) over the network.
- Computer where the workstation applications is installed for processing original application files
  (Server and frontend computer)
  In most cases, you can access these computers (data carriers) over the network.
- Computer where the secure area is set up and storage is controlled by DMS:
  - SAP Database [Seite 143]
    These secure areas are already set up in the standard SAP System.
  - Archive [Seite 145]
    The data transfer is done using the SAP ArchiveLink interface.
  - Vault [Seite 147]
    Vaults are defined in Customizing Document Management.

In the following example, three data carriers are necessary for processing the original application files:

Microsoft Word is installed on the frontend computer as a workstation application. You are processing a text file that is saved on a server. After processing save the file in the secure area for later proof.

Additionally to these data carriers you can use storage systems that are controlled by the Knowledge Provider as secure storage systems. The storage systems are defined in Customizing of Document Management and not as data carrier types. The definition of storage systems is done in special activities.

See also: Storage Data in Storage Systems Using the Knowledge Provider [Seite 138]

Prerequisites

The settings for the data carrier are defined in Customizing Document management → General data.

The following settings are necessary:
Preparing a Data Carrier

<table>
<thead>
<tr>
<th>Data that is necessary</th>
<th>Activity in Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must define a <strong>data carrier</strong> for your frontend computer. Example: PC (PC with operating system Windows NT)</td>
<td>General data → Define data carrier type “Server, frontend computer”</td>
</tr>
<tr>
<td>You must define a <strong>data carrier</strong> for the archive and vault.</td>
<td>General data → Define data carrier → Define data carrier type archive and Define data carrier type vault</td>
</tr>
<tr>
<td>So you can transfer data among all the computers of your network you must control the processing access for the desired computer combination (frontend computer ↔ data carrier of original application file).</td>
<td>General data → Define data carrier → Set up mount points / logical drives</td>
</tr>
</tbody>
</table>

In *Document Management*, every data carrier is identified by a logical name. You define the data carrier for the individual frontend computers PC003634 and PC00345678 as well as the server DEMO1 and PPSERV.

**Features**

You can store original application files on the following data carriers:

- **Server that can be accessed using the file manager.**
  
  The storage location that you enter in the document info record consists of the data carrier and the path in the file system.

- **Secure storage area [Seite 141]**
  
  Once an original application file has reached the stage where it needs to be recorded, either for security or legal reasons, you can save it in a secure storage area. The path for these data carriers is not shown in the document info record.

The following graphic shows the transport paths for an original application file to the different storage locations. This example explains how the transport occurs in secure areas when it is controlled by DMS (archive, vault, SAP Database).
Preparing a Data Carrier

- SAP Database
- Archiv
- Vault
- Frontend computer
- Applikations Server
- Server in Database-system

Transport of Originals

Check in
Display
Process
Print

Check in
Display
Process
Print
Maintaining Data for the Original Application File

Prerequisites

You have entered the data for the workstation application and the data carrier in Customizing for the Document Management System. If file checking is active in Customizing of the workstation application the original application file must be accessible under the given path.

Procedure

1. Process the document either in the screen Basic data, screen area Originals or on the tab page Originals.

2. The rest of the procedure is dependent on the processing situation:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Activity</th>
</tr>
</thead>
</table>
| Copy the original application file and the workstation application directly from the file manager | Select 📷 (Open).  
  - You can navigate in the file manager. Copy the original application file with a double-click.  
  - The system copies the file path as well as the workstation application of the document. |
| Enter the workstation application and storage data manually | Set the  📲 (Create).  
  - You can enter the workstation application and the storage data in a dialog box. |

3. Confirm your entries.

Result

As soon as you have entered a workstation application or storage data for an original application file the workstation application with additional information is displayed (for example, storage in secure area) on the screen Basic data and on the tab page Originals.

Detailed information about storage data or other additional files can be found under 📦 (Detail).

So you can quickly see whether an original application file was transported into a secure area the original application files are marked with the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷</td>
<td>Original application file was transported into a secure area</td>
</tr>
</tbody>
</table>
Maintaining Data for the Original Application File

| ![icon] | Original application file is not in a secure area |
Storing Original Application Files

Use
Original application files that have reached a processing status that requires them to be stored in a secure area can be stored manually using Store in secure area. Another advantage is that other users with the correct authorization can access the files.

You can simplify storing original application files when storage of original application files using the Knowledge Provider [Extern] is supported for a document type. You can transport all original application files of document info record into a secure area by setting a certain status.

Integration
In Customizing for the Document Management System, you define statuses for the document types by choosing Control data → Define document types → Define document statuses. This is controlled by the indicator Automatic storage of originals.

Prerequisites
The document type is defined that storage of the original application file is done using the Knowledge Provider. You make the required setting under Document Management System → Control data → Define document types. This is controlled by the indicator Document storage via Knowledge Provider.

Features
The automatic storage of the original application files is done in a storage category of your storage system.

The place for saving for each individual original application file is determined as follows:

- When the original application file:
  - has already been stored in a secure are, you see the previous storage data as default
  - as not yet been stored in a secure a dialog box Storage data appears where you can enter the secure area

- You can enter a default value for storage in the user-specific settings.

See also: Default Values for Original Application Files [Seite 191]

Activities
3. Set the indicators for the status in Customizing Automatic storage of originals or For checking
4. Process the document info record and the allocated original application files. Once you have reached a processing status that you want to transport into a secure area set the supported status or the status For checking

   As soon as the status is saved for the document the system transports all the original application file into the secure area.
Storage Data in Storage Systems using the Knowledge Provider

Use

We use the term secure storage area to define a storage location that, for security reasons, cannot be accessed using the file manager of the frontend computer. The storage data is displayed in the document info record only in the storage category. The path in the file system and the file name are not displayed. Original files that are stored in a secure storage area can only be processed using the Document Management System.

You can use the storage system as a secure area. The secure area is where data is transported to using the Knowledge Provider. The data transfer is done using the SAP HTTP Content Server [Extern] interface. This interface ensures that communication with external storage systems only use industry standard such as HTTP and BAPIs. This can also ensure that your storage system operates correctly in Internet and Intranet environments.

Further information is available in the SAP Library under SAP Knowledge Provider [Extern].

You can also check in and store original application files that are managed by the Document Management System (DMS) [Seite 141].

The new functions, such as document search in the World Wide Web, only work when the original application files are checked in and stored in the Content Repository of the Knowledge Providers.

Prerequisites

Define a document type that uses the Knowledge Provider for check-in and storage of the original application files. In Customizing of Document Management set the indicator for Storage via Knowledge Provider.

The settings for storage of the original application files into storage systems are defined in Customizing Document management → General data → Settings for storage systems.

The following overview shows the settings in Customizing that are necessary.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Activity in Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>You define the storage systems such as HTTP content server or the SAP Database.</td>
<td>Maintain storage system</td>
</tr>
<tr>
<td>Separate the storage system into several storage categories. These create different views of the storage system and allow for structured storage.</td>
<td>Maintain storage category</td>
</tr>
<tr>
<td>Select the MIME types of original application files that support a full text search.</td>
<td>Enter the MIME types for full text search</td>
</tr>
</tbody>
</table>

Features

1. If the original application file was already stored in a storage category [Extern], the system stores it in the same one again.
2. If you are storing a file for the first time in a secure area the system checks if you have been assigned a user profile that has settings for processing the original application files. This profile is maintained in Customizing of Document management and contains the default values for the storage category.

3. If no storage category can be determined the system presents you with a dialog box of all the possible storage categories. You can select one storage category.

   Original application files using the Knowledge Provider are read during the Full Text Search [Seite 304].

Activities

1. Process the document either in the screen Basic data, screen area Originals or on the tab page Originals.

2. Highlight the original application file you want to check into the secure area for storage.

3. Choose Check in original.

4. Choose a storage category in the dialog box if necessary and ✓.

   Once the system has transported the original application file to the storage category the icon ✓ for the original application file will change automatically to ✓.

5. Save your document.
Storage in Secure Areas of Document Management System

Use

We use the term **secure storage area** to define a storage location that, for security reasons, cannot be accessed using the file manager of the frontend computer. The storage data is displayed in the document info record only in the **storage category** [Extern]. The path in the file system as well as the file name are no longer necessary. Original application files that are stored in a secure storage area can therefore only be processed using the Document Management System.

Integration

You can only access original application files that are stored in secure storage areas by processing the document info record. The secure storage areas are defined in Customizing **Document distribution** and are part of the authorization checks of DMS.

💡 You can also use secure storage areas that are managed by the [SAP HTTP Content Server 4.5 Interface][14).

See: Storage Data in Storage Systems (using the Knowledge Provider) [Seite 138]

Prerequisites

In Customizing for **Document Management**, under **General data → Define data carriers**, you must define the data carrier types for the data carriers that are to be used as secure storage areas.

Features

The following data carrier types are supported as **secure storage areas** for storing original application files:

- [SAP Database][143] (settings available in standard SAP System)
- [Archive][145] (selection in Customizing **Document Management** and data transport using the SAP ArchiveLink interface)
- [Vault][147] (definition in Customizing **Document Management**)

Checking an Original Application File into a Secure Storage Area

In its processing phase, an original application file is usually to be found on a file server (for example, server hs0011). This file server can be accessed by means of the file manager.

If you have to store certain processing statuses of an original application file (for example, ju52.tif) in a secure storage area, the system creates a copy of the original application file. The storage data of the file in its processing phase (for example, server hs0011) is ignored for further processing in the Document Management System. Once you have checked the original application file into the secure storage area, you can no longer change the workstation application in the **File12** field.
Storage in Secure Areas of Document Management System

The following graphic shows the check-in procedure from a file server to a secure storage area.

Processing in a Secure Storage Area

There are additional checks for Processing an Original Application File in a Secure Storage Area [Seite 185].

By using the Resetting the Storage Data of Original Application Files [Seite 187] function you can reset the processing status of the original application file in the secure storage area to the status it had before it was placed in secure storage.
Checking an Original Application File into the SAP Database

Use

The SAP Database is a Secure Storage Area [Seite 141] that is predefined internally in the standard SAP System. When you save an original application file to the database, the file is divided into a series of data blocks with a fixed length. You do not use this storage method for large files (for example, screen designs).

This storage method is suitable for small files (for example, text files) because all of the original application files are also stored to the database. If the original file is changed, however, the original version in the database is overwritten. In other words, only the last version is kept.

Integration

The SAP database is not a BLOB on database level, but 2K strings that are stored in a table. In Document Management, the SAP database is identified by the following language-independent key:

Data carrier: SAP SYSTEM
Description: SAP database

If there is no entry, then an entry is made automatically as soon as the original file is saved to the SAP database.

Prerequisites

You can only store an original in the SAP database if you have maintained a storage location (server or frontend computer) in the document info record.

The following settings are necessary in Customizing Document Management for the document type under Control Data → Define document type:

- The indicator Storage using the Knowledge Provider must not be set.
- Define the maximum File size (in bytes) for original application files in the SAP database. This value for the file size also controls whether the CheckIn SAP function is active. If the value for the file size is 0, the CheckIn SAP function is inactive for all documents of this document type.

Activities

1. Go to the Basic Data screen.
2. Check whether the original file is stored on a server or a frontend computer.
   You can only perform the Check-in SAP function for these files.
3. Choose Extras → Originals → File 1(2) → Check in SAP.
   The system determines the path for the SAP database. This path is defined internally.
The original file is in a secure storage area that is not accessible via the file manager.

The workstation application for *File 1 (2)* is protected against any changes. The path for the storage location is not displayed. You can only see the data carrier SAP SYSTEM.
Checking an Original Application File into an Archive

Use

The archive is a Secure Storage Area that the original files are transported to via the SAP ArchiveLink interface. The archiving process takes place on a special archive server.

If you control how a document is processed using an approval procedure (digital signature), you must store the original application files in either a vault or archive before the digital signature is set.

Integration

You use SAP ArchiveLink as a communication interface between the Document Management System and the archiving systems. You can display the archived data using the SAP ArchiveLink viewer.

Prerequisites

When checking in without using the Knowledge Provider you can only check original application files into an archive that is managed by DMS and the SAP ArchiveLink interface.

In Customizing of Document Management you must therefore in this case not set the indicator Storage using the Knowledge Provider. You have made the required setting under Control data → Define document types.

You can only archive an original file if you have maintained a storage location (server or frontend computer) in the document info record.

You need to define the following settings in Customizing for the Document Management System:

- Define the data carrier type Archive under General data → Define Data Carriers → Define data carrier type “archive”.
- For each workstation application (for example, Microsoft Word), define the archive where the original application files are to be stored, under General data → Define workstation applications.

Activities

1. Go to the Basic Data screen.
2. Check whether the original file is stored on a server or a frontend computer.
   
   You can only perform the CheckIn archive function for files that are stored on a server or a frontend computer.
3. Choose Extras → Originals → File 1(2) → Check in archive.
   
   If you have a choice of archive available for the workstation application, a dialog box appears. Choose an archive.
   
   The system determines the path for the archive. You see the message: Archiving completed successfully.
   
   The workstation application for File 1 (2) is protected against any changes. The path for the storage location is not displayed. You only see the archive.
Checking an Original Application File into an Archive
Checking an Original Application File into a Vault

Use

The vault is a server that can be accessed in the local network. When you save the original application file to a vault, the system assigns a new file name that is invisible. For this reason, you can only process original application files stored in a vault from the document info record.

If you control how a document info record is processed using an approval procedure (digital signature [Seite 78]), you must store the original application files in either a vault or archive before the digital signature is set.

Integration

You can integrate a vault in the SAP System in the following ways:

- You can set up a vault in the standard SAP System where the original application files are transferred to the frontend computers via an application server.

- You can also transfer the original files directly between the vault and the frontend computer using a special log. SAP recommends this method known as DVA (Direct Vault Access), because it is better for system performance reasons. DVA is not predefined in the standard system, as you need a password for the DVA user.

Prerequisites

If you are not using the Knowledge Provider for storing and checking in original application files you can only store original application files in a vault that is managed by DMS. In Customizing of Document Management you must therefore in this case not set the indicator Storage using the Knowledge Provider. You have made the required setting under Control data → Define document types.

Prerequisites for the Vault without DVA

The following table shows the settings you must make to set up a vault without DVA. In Customizing for the Document Management System, choose General Data → Define Data Carriers.

<table>
<thead>
<tr>
<th>Step</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define data carrier type vault</td>
<td>Define vault (without specifying the DVA computer)</td>
</tr>
<tr>
<td></td>
<td>Defines access path for vault</td>
</tr>
<tr>
<td>Define mount points / logical drive</td>
<td>Defines the prefix for the access path, for accessing the data carrier (logical drive)</td>
</tr>
</tbody>
</table>

Prerequisites for the Vault with DVA

The following table shows the settings you must define in Customizing for the Document Management System to set up a vault with DVA, by choosing General Data.
Checking an Original Application File into a Vault

Activities for the Vault with DVA

<table>
<thead>
<tr>
<th>Step</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain global settings</td>
<td>Determines whether you want to use Direct Vault Access (DVA) to transfer original application files from a vault to the frontend computer.</td>
</tr>
<tr>
<td>Define Data Carriers</td>
<td>1. Define data carrier type vault</td>
</tr>
<tr>
<td></td>
<td>2. Define vault (specifying the DVA computer)</td>
</tr>
<tr>
<td>Define Number Ranges for Vaults</td>
<td>Check the number ranges for the vault</td>
</tr>
</tbody>
</table>

If you activate DVA in the global settings, you cannot store original files in vaults that are accessed via an application server.

Features

When you save an original application file to a vault, the system generates a file name for it from an internal number range. This number range is predefined in the standard system.

The following graphic shows the data transfer procedure for an original application file. This graphic shows both the transfer of an original application file via an application server and direct transfer between frontend computer and vault.

Activities

1. Go to the Basic Data screen.
2. Check whether the original file is stored on a server or a frontend computer.
You can only perform the Check-in vault function for files that are stored on a server or frontend computer.

3. Choose Extras → Originals → File 1(2) → Check in vault.

A dialog box appears containing all the vaults defined in Customizing for the Document Management System under General Data → Define Data Carriers.

4. Choose a vault.

The system saves the original application file to the chosen vault using a number assigned from an internal number range.

You see the message: File checked in to vault <Vault name>.
Source Files (Templates) for Original Application Files

Use

The system starts the workstation application (for example, Microsoft Word) needed to create the original application file without any data in the new file.

In order to reduce having to enter data that is often repeated you can create a template, or source file to help when creating new original application files. The data from the templates is copied in the original application file you want to create.

You can create a letter that already contains certain data (for example, sender, address, and other text elements) as the template, and use this letter as a source for other documents. When you create an original application file with the same application (for example, Microsoft Word), the data from the letter is copied to your new file, where you can change it as required.

Prerequisites

You must define the following settings in Customizing for the Document Management:

- **Control data → Define Document Types**
  The name of the source file (for example, letter.doc) must be entered with the data carrier type (for example, PC with Windows NT operating system) and workstation application (for example, Microsoft Word) under Define templates for original application file.

- **General data → Define Workstation Applications**
  The path containing the source file for the combination of data carrier type (for example, PC with Windows NT operating system) and workstation application (Microsoft Word) must be entered under Define workstation applications in network.

Features

Whenever you create a new original application file with this workstation application from the document info record, the system opens a new file containing the data from the source file. You can revise the source data and enhance it.
## Displaying Original Application Files

### Use

You can display the original application files, irrespective of where they are stored, while you are processing a document. The procedures for displaying original application files stored on a server and in a secure storage area are identical. Additional settings, however, must be made in Customizing to display the files from a secure storage area.

### Prerequisites

#### Customizing Settings Document Management

Under General data you must make the following settings:

<table>
<thead>
<tr>
<th>Data that is necessary</th>
<th>Activity in Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>You set the <strong>Workstation application</strong> can be started from the document info record for display.</td>
<td>Set the start authorization for the workstation application under General data → Define workstation application.</td>
</tr>
<tr>
<td>You set which workstation application, dependent on the frontend computer is to be started for <strong>displaying</strong> and from which directory the program is called.</td>
<td>Set the path for the program call for the application type 1 (display) under General data → Define workstation application in network.</td>
</tr>
<tr>
<td>For displaying an original application file that are located in Secure Storage Areas [Seite 141] the system create a temporary copy.</td>
<td>In order to display these original application file, set the file format that you want the system to create; under General Data → Define workstation application.</td>
</tr>
<tr>
<td>You can also use the integrated viewer [Seite 566] to display the original application files.</td>
<td>You must first enter the required data under General Settings → Define workstation application in order to use the integrated viewer.</td>
</tr>
<tr>
<td></td>
<td>• Maintain all data on the detail screen that are supported for processing original application files with the workstation application such as for the application Direct Model for processing JT files.</td>
</tr>
<tr>
<td></td>
<td>• Set which viewer you want to use to display the original application files for the workstation application (for example, Direct Model). Work step: Maintain workstation application in network</td>
</tr>
</tbody>
</table>

**Digital Mock-Up Viewing [Seite 561]** allows for 3D models to be displayed in the development phase.

You must first maintain settings in Customizing of Document Management before you can display a 3D model of an assembly and its components in the Engineering Workbench.

**See also:** Setting up Customizing for DMU Viewing [Seite 564]
Displaying Original Application Files

**Processing a Document Info Record**

When you want to display original application files that are managed by DMS you must first process the document info record that belongs to the original application file.

You have the necessary authorizations [Seite 21].

**Procedure**

To display the original application files (irrespective of where they are stored):

1. Process the document info record in either display or change mode.
2. Select the *Originals* tab page.
3. You have two options for displaying original application files:
   - Double-click on the entry of the original application file. This starts the application for displaying the original application file.
   - Position the cursor on the entry and select ![icons](image).

**Result**

In a second window, the system starts the application with the specified original application file. You can use all active functions of the application you have started.

You can also still process the document info record or close it while processing the original application file in its application.
Displaying Original Application Files from the Document List

Prerequisites
Before you can display original application files, a number of settings and authorizations must be defined in the system. See: Displaying an Original Application File [Seite 151]

Procedure
1. To display an original file of an individual document info record, select the line containing the document and choose Display originals.
   - If only one application was entered with original data for this document info record, and no additional documents were archived, the system displays the original application data immediately.
   - If two applications were entered, or additional documents were archived, you see the Start Display Application dialog box.
     Choose the application with which you want to display original application data.
     The system starts the selected application with original application data.
     If documents were archived as well, the list contains the Archive entry.
     If only one document was archived, the system displays this document when you choose it.
     If more than one document was archived, you see a list from SAP ArchiveLink. Select the documents you want to display from this list.

2. If no application data was entered for the selected document info record and no documents were archived, you see the following system message:
   - No applications exist
Displaying Original Application Files from the Server

The following graphic shows how an original application file is displayed when it is saved on a server. The graphic also shows how the system determines the data so the user can display the original application file using a workstation application.

In this example the secure area is not a storage system that can be accessed using the Knowledge Provider. This secure area was defined in the settings in Customizing of DMS (vault, archive, R/3 Database).
Viewer for Displaying Original Application Files

Purpose

The standard SAP System’s SAP Graphical User Interface (SAP GUI) now has a viewer from Engineering Animation, Inc. (EAI) that allows you to view your products in the PLM area [Extern]. This viewer works with all Windows 32 bit operating systems and can display most original application files of a document info record.

- Thanks to the integration of this viewer solution in the Product Structure Browser you can view not only technical drawings but also 3D models. There are different functions for navigation such as rotate, zoom, center. You can then use the functions for redlining for processing the objects, saving them or printing them out.

- You can view products during the development phase using Digital Mock-Up Viewing [Seite 561].

Implementation Notes

You must make the following settings in Customizing of Document Management for the viewer of the SAP System.

- Control data → Define document types

  The document type of the document info record that manages the original application file must have the Knowledge Provider [Seite 138] defined for the storage systems. This setting is done on the detail screen of the document type, indicator Storage via Knowledge Provider.

  You can only use viewer and redlining functions when the document type is so defined that it allows storage of original application files using Knowledge Provider.

  The original application file does not have to be stored in a storage category of the Knowledge Provider in order to display it. The file can also be in a logical directory with the local network. This type of storage is not always accessible by all frontend computers, whereas with the Knowledge Providers all frontend computers can access the original application files. SAP recommends therefore that all original application files be stored using the Knowledge Providers.

- General data → Define Workstation Applications [Extern]

  The following partial steps are necessary:

  - Assign the correct application (for example Direct Model) for the file format you want to display (for example *.jt).
  
  - Maintain all data on the Detail screen that are supported for processing original application files with the workstation application such as for the application Direct Model for processing JT files.
  
  - Select the navigation step Maintain workstation application in network. Enter the call for the viewer.
Viewer for Displaying Original Application Files

You can use this call to determine for such things as whether you want display 2D or 3D formats.
The call for saying 3D formats (such as *.jt for Direct Model) with a workstation application could be done as follows:
EAIWeb.webviewer3D.1 %SAP-CONTROL%

Detailed information for the call of the application can be found in the IMG under Define workstation application.

Integration

You can view the product data in the following processing situations:

- Product Structure Browser
  You can expand the document data in a product structure and view the original application files of a document.

- Document Management
  You can display original application files from the tab page Document data or Originals.

- Engineering Workbench
  You can view original application files of material items from the Product Structure Browser.

- Process using the Project Builder (change and display) or use the Internet-Scenario Collaborative Engineering

Features

Supported Viewing Formats

The integrated viewer can display most 2D pixel, vector, and some text formats as well as 3D model formats. A complete overview is available in the List of Viewing Formats [Seite 254].

Calling the Menu

After the function Display original application file is started the original application file is displayed either inplace or outplace. The display variant is set for the individual processing situations (such as displaying from a document info record or the Product Structure Browser) and cannot be changed.

- inplace
  The original application file is displayed in the same window as the one used for processing.
  - Example: If you display the original application file while processing the document info record of the Product Structure Browser or Engineering Workbench, the system splits the screen and the current screen and displays the viewer in the new screen section.
  - In the screen section where the viewer is located the original application file is also displayed the viewer function bar becomes active.

- outplace
The original application file is displayed in a different window as the one used for processing.

If you display the original application file from the results screen of a document search, the system creates a new window automatically. In the new screen section the original application file is also displayed the viewer function bar becomes active.

See also: Displaying Original Application File with a Viewer [Seite 506]

Viewer Function Bar

When you display the original application file with the integrated viewer the system adds a function bar for the viewer. The viewer function bar contains all the functions you can use in the current processing situation, such as Redlining functions. The scope of function depends on whether the viewer is displaying 2D or 3D format files.

An overview of the processing functions can be found in the Function Overview of the Viewer [Seite 251].

Redlining Function Bar

The call of the Redlining functions is done from the viewer function bar. The system changes from viewer mode into Redlining mode and makes the Redlining function bar available.

For more information, see Redlining for Original application files [Seite 259].

Dimensioning 2D Files

Dimensioning functions allows you to measure such things as angles, line and radii.

An overview of dimensioning functions can be found under Dimensioning 2D files [Seite 270]

Example

The following example shows how an assembly is viewed in the Engineering Workbench. The assembly was transferred from a CAD system into the SAP-System (Digital Mock-Up Viewing).
Restrictions

The viewer can be used on machines with at least a Pentium® class processor at 133 MHz.

For 3D formats you will need the following:

- Pentium II
- 128 MB RAM
Function Overview of the Viewer

The systems automatically starts the integrated viewer when you display an original application file in the supported processing situations either inplace or outplace.

Scope of functions for both display forms is identical. You can call functions as follows:

- The viewer function bar contains all the functions you can use in the current processing situation.
- You can use the context menu for a selection of functions. Depress the right–hand mouse button to call up the context menu in the screen section of the viewer.

The scope of function depends on whether the viewer is displaying 2D or 3D format files.

Functions for 2D Files

The following overview shows all the tab pages that are active when displaying 2D files. In the column Usage some of the functions are described.

<table>
<thead>
<tr>
<th>Tab Page</th>
<th>Functions</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Full-view</td>
<td>When an object cannot be completely viewed in the screen section of the viewer, you can use this function Full-view to display it again. This is useful with 2D files after having changed them with the following: Shift, Center, and Zoom.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Navigation</td>
<td>Shift</td>
<td>Under Align you will find the functions Rotate clockwise or Mirror horizontally.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Align</td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td>Redlining [Seite 259]</td>
<td>You can display the original application file in different colors according to the needs of the current processing situation. The simplified display can also increase performance (example: Monochrome and Grey scale 8 bit). The changed display of the original application file can be saved in the following formats:</td>
</tr>
<tr>
<td></td>
<td>Dimensioning [Seite 270]</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>Color</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Save format</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Function Overview of the Viewer

<table>
<thead>
<tr>
<th>Layer</th>
<th>Original application file</th>
<th>Layer name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When the viewer is started on the original application file is displayed only – No layer is active. The tab page <em>Layer</em> is not active if no layers exist yet for the original application file. Only after you create a comment as a <a href="#">Markup</a> using Redlining functions and then saved them in one or more layers does the entry <em>Layer</em> appear and the layer names are listed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You load the saved information by clicking on the selected layer. The currently loaded layer is indicated by a check mark. You can process this layer and save the changes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clicking again deactivates the layer.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When more than one layer is loaded and further comments added the comments are added to the active layer. The system determines the active layer based in the sequence of the layer loaded. The layer is active that is furthest on the bottom.</td>
<td></td>
</tr>
</tbody>
</table>

### Functions for 3D Models

The following overview shows all the tab pages that are active when displaying 3D files. In the column *Usage* some of the functions are described.

<table>
<thead>
<tr>
<th>Tab Page</th>
<th>Functions</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Full-view, Print</td>
<td>When an object cannot be completely viewed in the screen section of the viewer, you can use this function <em>Full-view</em> to display it again. This is useful with 3D files after having changed them with the following: <em>Shift, Center, and Zoom</em>.</td>
</tr>
<tr>
<td>Navigation</td>
<td>Rotate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• x axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• y axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• z axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom area</td>
<td>You can rotate the 3D model about any axis freely in order to looks at the model from any angle. You can then create or anchor comments as <a href="#">Markups</a> using Redlining functions.</td>
</tr>
<tr>
<td>Tools</td>
<td>Redlining [#259]</td>
<td></td>
</tr>
</tbody>
</table>
Options | Performance Background Save format
---|---
You can improve performance dramatically by switching on Frame view, turning off Interior view or setting the Number of frames per second.
The changed display of the 3D model can be saved in the following formats:
- Bitmap (24 bit color, 8 bit gray scale)
- JPEG (Color 24 bit)
- TIF

Redlining files
When the viewer is started on the original application file is displayed.
If you create a comment as Markups [Seite 269] using Redlining functions and then saved them the Redlining files are listed.
When the viewer is started no Redlining file is active. You load the saved information by clicking on the selected Redlining file.
List of Viewing Formats

You can use the integrated viewer from Engineering Animation, Inc. (EAI) to display the following formats and process using Redlining functions:

2D Formats

<table>
<thead>
<tr>
<th>2D vector images files</th>
<th>AutoCAD DWG 2.5-14 (DWG)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AutoCAD DXF R11-14 (DXF)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD DWF (DWF)</td>
</tr>
<tr>
<td></td>
<td>CGM (CGM)</td>
</tr>
<tr>
<td></td>
<td>IGES (IGES, IGS)</td>
</tr>
<tr>
<td></td>
<td>HPGL/HPGL-2 (HPG, HPGL)</td>
</tr>
<tr>
<td></td>
<td>HP ME 10/30 MI (MI)</td>
</tr>
<tr>
<td></td>
<td>Calomp (906, 907)</td>
</tr>
<tr>
<td></td>
<td>CALS MIL-R Type I and Type II (MLR, MIL, MILR)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D pixel images files</th>
<th>Tagged Image File Format - Monochrome, color, &amp; grayscale (TIF)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows Bitmap (BMP)</td>
</tr>
<tr>
<td></td>
<td>JFIF Compliant (JPG, JPEG)</td>
</tr>
<tr>
<td></td>
<td>Portable Network Graphics (PNG)</td>
</tr>
<tr>
<td></td>
<td>EDMICS C4 (C4)</td>
</tr>
<tr>
<td></td>
<td>(TLC)</td>
</tr>
<tr>
<td></td>
<td>CompuServe (GIF)</td>
</tr>
<tr>
<td></td>
<td>MIL-RII - TRIFF (FSX)</td>
</tr>
<tr>
<td></td>
<td>SunRaster (RAS)</td>
</tr>
<tr>
<td></td>
<td>PICT-Macintosh Paint (PCT, PICT)</td>
</tr>
<tr>
<td></td>
<td>PC Paint (PCX)</td>
</tr>
<tr>
<td></td>
<td>Microstation (DGN)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D ASCII and Postscript files</th>
<th>ASCII Text (TXT)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PostScriptI, II (PS)</td>
</tr>
<tr>
<td></td>
<td>Encapsulated Postscript (EPS)</td>
</tr>
</tbody>
</table>

3D Formats

Direct Model (*.JT)

Virtual Reality Modeling Language (*.WRL)
Stereolithography (*.STL)
Display Original Application File with the Viewer

Use
You can display original application files with the integrated viewer in the supported processing situations (for example, from the product structure or form the document info record).

See: Viewer for Displaying Original Application Files [Seite 566]

Prerequisites
You have made the setting in Customizing of Document Management for the viewer of the SAP System.

You are in a processing situation that supports viewing the original application file in the integrated viewer.

See: Viewer for Displaying Original Application Files [Seite 566]

Procedure
The following examples show you how to display an original application file in the different processing situations.

In all situation you can display the original application file by clicking on the button (Display original) or using the context menu (entry Display original).

Displaying Original Application File from the Product Structure

1. Display the product structure in the Product Structure Browser.
   
   See: Display Product Structure [Seite 482]

2. Explode the structure for documents.
   
   You can see whether a document versions has one or more original application files assigned to it:
   
   – Identifier in the display column Original with icon (Display original application files)
   
   – In the context menu the entry Display original exists.

3. Click on the icon Display original application file.
   
   The number of maintained original application files determines later procedures:

<table>
<thead>
<tr>
<th>Number of Original Application Files</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>No further action required. The original application file is displayed.</td>
</tr>
<tr>
<td>Several</td>
<td>You see a dialog box with a list. The list contains the workstation application or display a short text for the original application file. Select an original application file then choose Continue.</td>
</tr>
</tbody>
</table>

April 2001
Displaying Original Application Files from the Document Info Record

1. Display the document info record.
   On the tab page Document data or Originals all existing original application files are listed.

2. Set your cursor on the line of the original application file you want to display. By double clicking on the original application file you start the viewer.

Result

The system checks the setting in Customizing of Document Management for the current frontend type (such as PC with operating system Microsoft Windows NT). Th system determines which viewer is appropriate for displaying the selected file format (for example *.ACD format for AutoCAD files calls a 2D viewer).

The viewer is started automatically and displays the data of the original application file in a new screen section.

The following example shows the redlining functions in addition to the viewer.
Display Original Application File with the Viewer

Display Document: Basic Data Engin/Des. Drawing (JB2)
Redlining for Original Application Files

Use
Especially in the development process of a product is it important to have an efficient exchange of information in order to save costs, time, and effort.

You can display your product with the integrated viewer of the standard system. All departments can visualize original application files in 2D and 3D formats.

Being able to see a product before it is produced allows you to expand on the scope of employees for product analysis. You can use Redlining functions to include original application files in other business processes. Users with authorization can add comments and suggestions to the document (for example, 3D model).

Integration
The standard SAP System’s SAP Graphical User Interface (SAP GUI) now has a viewer from Engineering Animation, Inc. (EAI). When you have made the setting in Customizing of Document Management for the viewer of the SAP System you can use Redlining functions without making any further settings.

See also: Viewer for Displaying Original Application Files [Seite 566]

Prerequisites
You can then use the functions for redlining when the following have been met:

- You have made the setting in Customizing of Document Management for the integrated viewer of the SAP System.

  See also: Viewer for Displaying Original Application Files [Seite 566]

- It is recommended to define the categories for markups, under General Data → Define category for markup.

  The remarks and comments (markups) that you create on an original application file are saved in a layer that you can also edit. You can edit a layer when the layer is assigned to individual categories (such as engineering/design, sales & distribution).

- The authorization assignment for editing layers is done with the authorization object for Document Management (C_DRAW_MUP – authorizations for markups).

  This authorization object controls which users can process which layers, based on a combination of activity and document type. You can restrict the check more by using document status and category.

Features

Calling the Menu
The Redlining functions are automatically available when you display an original application file with the integrated viewer in the supported processing situations.
Redlining for Original Application Files

**Formats**

You can create comments for original application files in all file formats that can be displayed by the viewer. The viewer can display the following formats:

<table>
<thead>
<tr>
<th>2D data</th>
<th>Vector data:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• With model character (such as DXF)</td>
</tr>
<tr>
<td></td>
<td>• With screen character (such as CGM)</td>
</tr>
<tr>
<td></td>
<td>• With plot character (such as HPGL)</td>
</tr>
<tr>
<td></td>
<td>Pixel data (such as TIFF, BMP, JPG)</td>
</tr>
<tr>
<td></td>
<td>Text data (such as ASCII, EPS, PDF)</td>
</tr>
</tbody>
</table>

| 3D model | Model data (JT, WRL, STL) |

The complete list is available in the List of Viewing Formats [Seite 254].

**Markups and Layers for Comments**

You can write your comments on the original application file like when using a red pen. This does not change the actual original application file. Your comments are saved as *Markups* in a *Layer*. A list of the supported text and graphic elements for markups can be found here: Redlining Function Bar [Seite 262]

Other users add their comments to further layers. The system saves a layer for an original application file as an additional file for the original application file in the same storage data as the original application file itself.

The processing functions for layers depend on whether the viewer is displaying 2D or 3D format files.

<table>
<thead>
<tr>
<th>Format</th>
<th>Saving Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D data</td>
<td>The layer is saved as a transparent vector format (CGM) for 2D files.</td>
</tr>
<tr>
<td></td>
<td>• There is no limit to the number of layers for each original application file. You can display as many original application files and as many layers as you want on top of each other in the viewer. The process is similar to when you lay transparencies on top of one another on an overhead projector.</td>
</tr>
<tr>
<td></td>
<td>• The authorization assignment ensures that on authorized persons can create, change or delete layers for documents of a particular document type.</td>
</tr>
<tr>
<td></td>
<td>• You can change or even delete the information that is stored in a layer.</td>
</tr>
<tr>
<td></td>
<td>• You can use the layer menu for easy processing of the individual layers.</td>
</tr>
<tr>
<td>3D model</td>
<td>The current development phase allows only storing redlining files in pixel format (TIF) for 3D models. Storage is the same as the layers. More layer functions are planned for future Releases.</td>
</tr>
<tr>
<td></td>
<td>• The system copies the 3D model into the Redlining file the way it currently appears on the monitor screen (for example rotated on the X axis and with frames) as well as with markups for your comments.</td>
</tr>
<tr>
<td></td>
<td>• Special Redlining functions for 3D Models are available such as anchoring markups in the 3D model.</td>
</tr>
</tbody>
</table>
Activities
When you are in one of the named processing situations with the original application file in the integrated viewer you automatically see the application function bar. You can execute the following functions:

- Maintaining Layers for 2D Files [Seite 265]
- Creating Redlining Files for 3D Models [Seite 268]
- Executing Redlining Functions [Seite 269]
- Dimensioning 2D files [Seite 270]

The selection of the active functions depends on the current processing situation. For example, it depends on whether the viewer is displaying 2D or 3D format files.
Redlining Function Bar

See also: [Executing Redlining Functions][1]

### General Redlining Functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
</table>
| ![Select Redlining object](image) | Select Redlining object  
Highlight the markup object before cutting it. |
| ![Cut](image) | Cut  
Highlight the markup object before cutting it. Select . Click on it to highlight it. |
| ![Undo](image) | Undo |
| ![Redo](image) | Redo |
| ![Create layer](image) | Create layer |
| ![Save layer](image) | Save layer |
| ![Delete current layer](image) | Delete current layer |
| ![Settings](image) | Settings  
Before you create markup objects, make these settings. You will on the tab page Extras special functions that are in an overview below called Special Redlining Functions for 2D Files. |
| ![Return](image) | Return  
You return to the screen with the Viewer function bar. The current 2D original application file with the current layer is loaded, or the current 3D model with the current Redlining file is loaded. |

### Markup Functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Draw free-hand" /></td>
<td>Draw free-hand</td>
</tr>
</tbody>
</table>
| ![Draw note arrow](image) | Draw note arrow  
A selection of arrow type is under Extras, tab page Extras. |
Redlining Function Bar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Draw line</td>
</tr>
<tr>
<td>✓</td>
<td>Draw poly line</td>
</tr>
<tr>
<td>✓</td>
<td>Draw ellipse</td>
</tr>
<tr>
<td>✓</td>
<td>Draw polygon</td>
</tr>
<tr>
<td>✓</td>
<td>Draw rectangle</td>
</tr>
<tr>
<td>✓</td>
<td>Create text</td>
</tr>
</tbody>
</table>

- Click on ✏️ and a dialog box appears for entering text. After creating the comment confirm your entry with 🖇. The system closes the dialog box.
- Put the cursor where you want to add the text.
- Click on the spot and the system positions the comment box according to the settings you made.

**Special Redlining Functions for 2D Files**

**Measuring functions**

If you want to use these measuring functions, you must activate them.

See also: [Dimensioning 2D files](Seite 270)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Measuring function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Angle measurement</td>
</tr>
<tr>
<td>✓</td>
<td>Line measurement</td>
</tr>
<tr>
<td>✓</td>
<td>Radius measurement</td>
</tr>
</tbody>
</table>

**Calibrate**

This function only works with files in pixel format (such as *.BMP, *.TIF) because files in the vector format (such as *.DWG for AutoCAD) are already calibrated.

See also:

- [Calibration](Seite 273)
- [List of Viewing Formats](Seite 254)
Special Redlining Functions for 3D Models

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Anchor" /></td>
<td>Anchor</td>
</tr>
</tbody>
</table>

Anchoring a markup object keeps the markup object in the position where it was created. For example, when highlighting the piston of a motor with an arrow and rotate the motor, the position for the arrow is always recalculated and rotates with the motor.

- Activate the anchor mode by clicking on ![Anchor](image) (Anchor).
  You can verify that the anchor mode is active. Place the cursor on the 3D model. The current cursor position is displayed using the little anchor symbol.
- Select the desired markup function. For example, if you want to draw a line click on ![Line](image).
- Click on the model a second time to position markup object.
Maintaining Layers for 2D Files

Use

You can create comments for an original application file without changing the original application file itself. You save the comments in a layer.

Prerequisites

You are displaying the original application file with the integrated viewer of the standard SAP system.

See also: Viewer for Displaying Original Application Files [Seite 566]

Creating Layers for 2D Files

You can create a layer from the viewer function bar as well as from the Redlining function bar.

💡

In the viewer function bar the entry Layer appears when at least one layer exists for an original application file.

When one or more layers are loaded and you want to use Redlining functions it recommended that you check which layers are loaded. Click on Layer. You see a list of all existing layers.

- The loaded layer is indicated by a check mark. Click on the layer to remove it from the screen section.
- Redlining functions are done using the active layer. The system determines the active layer based in the sequence of the layer loaded. The layer is active that is furthest on the bottom.

Creating Layers using the Viewer Function Bar

When you display the original application file with the integrated viewer of the standard SAP system and the viewer function bar is active.

See also: Viewer for Displaying Original Application Files [Extern]

A layer is automatically created when none exist and you switch to the Redlining processing mode.

1. In the viewer function bar select Tools → Redlining.

   When no layer is currently active, the Layer name dialog box appears.

2. Enter a layer name and confirm with .

   The remainder of the procedure depends on whether you have Redlining categories maintained for your enterprise in Customizing.

<table>
<thead>
<tr>
<th>Redlining Categories Maintained</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>no</td>
<td>The markup function bar appears that contains all the functions for creating markups.</td>
</tr>
</tbody>
</table>
Maintaining Layers for 2D Files

The dialog box Redlining category appears where the categories are listed that are maintained in your enterprise. Double-click on the desired category and the system assigns the new layer that is to be created to this category. The markup function bar appears that contains all the functions for creating markups.

3. Create comments using the markup functions.
   - You can add a text, for example:
     - In the first step set up the layout; such as lines, framing, and text formats. Click on and the dialog box Settings appears for these settings.
     - Click on and a dialog box appears for entering text. After creating the comment confirm your entry with . The system closes the dialog box.
     - Put the cursor where you want to add the text.
     - Click on the spot and the system positions the comment box according to the settings you made.
   
   See also: Executing Redlining Functions [Seite 269]

4. Save the layer using .
   
   You can return to the viewer function bar of the viewer by selecting .

Crating Layers Using the Redlining Function Bar

You display the original application file with the integrated viewer of the standard system. You selected the Redlining function in the viewer function bar (Tools → Redlining) and the Redlining function bar is active.

- Select .
  
  The dialog box Layer name appears.

- The rest of the procedure is the same as Crating Layers using the Viewer Function Bar.

Changing Layers for 2D Files

You are displaying the original application file with the integrated viewer of the standard SAP system and the viewer function bar is active.

1. Select Layer.
   
   You see a list of all existing layers. You can use the context menu to display the attributes of the active layer, such as Redlining- category.

2. Double-click on the desired layer to see the comments made in the text.

   
   The Redlining function bar contains all the functions you can use in the current processing situation, such as:
- Delete a previous markup object.
  Select the markup object you want to delete and cut it with.

- Enter a new text.
  Click on to make settings for lines, frames or text formats.
  Click on and a dialog box appears where you enter your comments. Confirm with .
  The system closes the dialog box.
  Put the cursor where you want to add the text.
  The system puts the comment where you click once.

4. Save the changes made to the layers.

You can return to the application function bar of the viewer by selecting (Back).
Creating Redlining Files for 3D Models

Use
You can create comments for a 3D model without changing the original application file. You save the comments in a Redlining file.

As opposed to the layers used for making comments on 2D files, you **cannot** make changes to a Redlining after you have saved.

Prerequisites
You are displaying the original application file with the integrated viewer of the standard SAP system.

See also: Viewer for Displaying Original Application Files [Seite 566]

Procedure
1. Display the 3D model in such a way so that you can make your comments as easily as possible. You can rotate the model about its X-axis for example.

2. Select **Tools → Redlining**.
   - In the first step set up the layout; such as lines, framing, and text formats. Click on ![settings](image) and the dialog box **Settings** appears for these settings.
   - The remainder of the procedure depends on whether you want to anchor the markup in the 3D-model.
     - When you want to anchor the markup object, activate the anchor mode by clicking on ![anchor](image) (Anchor).
       - You can verify that the anchor mode is active. Place the cursor on the 3D model. The current cursor position is displayed using the little anchor symbol.
     - Select the desired markup function. For example, if you want to draw a line click on ![line](image).
     - Click on the 3D model. Clicking on the 3D Model again allows you to create the markup object.
       See also: Executing Redlining Functions [Seite 269]

3. Save the layer using ![save](image).
   - The system copies the 3D model into the Redlining file the way it currently appears on the monitor screen as well as the markups.
   - You can return to the application function bar of the viewer by selecting ![back](image) **(Back)**.
Executing Redlining Functions

Use

You can use markups to add comments and remarks to the displayed original application file. For 2D original application files these comments are saved in a layer and for 3D models they are saved as Redlining files.

General Redlining functions are for processing both 2D files and 3D models. Certain functions work only for one format or the other.

Prerequisites

You display the original application file with the integrated viewer of the standard system. You selected the Redlining function in the viewer function bar (Tools → Redlining). The screen section of the viewer displays the Redlining function bar. This bar contains all functions you can use to create, change, and delete markup objects for the original application files.

See also:

Maintaining Layers for 2D Files [Seite 265]
Creating Redlining Files for 3D Models [Seite 268]

Procedure

1. Before you create the markup objects you must set up the layout; such as lines, framing, and text formats.

   Click on and the dialog box Settings appears.

2. Select the markup function by clicking on the desired function in the Redlining function bar.

   See: Redlining Function Bar [Seite 262]
Dimensioning 2D Files

Use

The integrated viewer contains dimensioning functions so you can measure angles, lines and radii and save them to a layer. There are two ways of adding measurements to an original application file:

- You only need the measurements for the time being and therefore they do not have to be saved in a layer.
- You want to save the measurements for later processing purposes. In this case you save the measurements in an existing layer or create a new layer for the measurements.

Measurement Functions and Measurement Procedures

The following dimensioning functions can be used for measurement:

<table>
<thead>
<tr>
<th>Measuring function</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Angle measurement  | - Position the cursor on the first side of the angle and click the left-hand mouse button.  
                  | - Position the cursor on the vertex of the angle and click the left-hand mouse button.  
                  | - Position the cursor on the second side of the angle and click the left-hand mouse button. |
| Line measurement   | - Position the cursor on the beginning point of the line and click the left-hand mouse button.  
                  | - Position the cursor on the end point of the line and click the left-hand mouse button. |
| Radius measurement | Position the cursor on three points one after the other for the circle to be measured. Click with the left-hand mouse button on each point. |

The following measurement procedures can be selected:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pixel</td>
<td>This measurement is best used with original application files in pixel format such as: *.TIF, *.BMP. The basis of this procedure is the pixels that are saved in the original application file. In order to preserve accuracy of the measurement results it is highly recommended that you Calibrate [Seite 273] before measuring lines and radii.</td>
</tr>
<tr>
<td>Vector</td>
<td>This measurement is best used with original application files in vector format such as: *.DWG, *.CGM. The basis for this procedure is the data for the vectors (contact point, direction, and relief) that is saved in the original application file.</td>
</tr>
</tbody>
</table>
Dimensioning without Saving

You are displaying the original application file with the integrated viewer of the standard SAP system and the viewer function bar is active.

See also: [Viewer for Displaying Original Application Files][566]

1. Select Tools → Dimensioning.
   
   The system adapts the function bar for the new functions. For example, measurement and dimensioning functions as well as calibration are available.

   A description of the meaning of the application functions can be found here: [Creating Markups as Comments][269].

2. Select the measurement procedure for the original application file (for example pixel for *.TIF).

3. Select the measurement function (such as length measurement).
   
   The remainder of the procedure depends on which measurement procedure you selected.

   - If you selected Pixel it is recommended that you [calibrate][273] first. Then execute the measurement function.

   - If you selected Vector you can start immediately with the measurement function.

   You can switch between any measurement functions.

4. You can return to the viewer function bar of the viewer by selecting `. The measurement data is not saved.

Dimensioning with Saving

You are displaying the original application file with the integrated viewer of the standard SAP System and selected Redlining functions. The Redlining function bar is active.

See also: [Maintaining Layers for 2D Files][265]

1. Select Settings → Extras.

2. Make changes to the following settings in the dialog box that appears:

   - Select Measurement functions on.
     
     You must set this indicator in order to use the measurement functions in the Redlining function bar.

   - Select Calibrate if the original application file is a pixel format.

   - Select the measurement procedure such as Pixel orientated.

   - Confirm with .
     
     The Redlining function bar is active again.

3. Select the measurement function (such as length measurement).

   - If you selected Pixel it is recommended that you [calibrate][273] first. Then execute the measurement function.

   - If you selected Vector you can start immediately with the measurement function.
Dimensioning 2D Files

You can switch between any measurement functions.

4. Save the layer using  

Calibrate

Use

You need to calibrate when measuring and dimensioning lines and radii. This function is only used with files in pixel format (such as *.BMP, *.TIF) because files in the vector format (such as *.DWG for AutoCAD) are already calibrated. You can, for example, make a measurement of length for 10 centimeters (3.9 inches). For all further measurements there is a conversion according to the scale.

The Calibrate operation is dependent on how you carry out measurements:

- Calibrate, when you do not save the measurement
- Calibrate, when you save the measurement

Calibrate, when you save the measurement

You display the original application file with the integrated viewer. In the viewer function bar you selected Tools → Dimensioning. The measurement procedure is set to Pixel.

See also: Dimensioning 2D files [Seite 270]

1. Select Calibrate.

2. Highlight the length that you want to use for all measurements as a point of reference:
   - Position the cursor on the beginning point of the line and click the left-hand mouse button.
   - Pull the cursor to the end point of the line. The line then appears. Click the left-hand mouse button.

   The Calibration dialog box appears automatically.

3. Enter the Distance and the Unit of measure (for example 10 centimeters).

   Confirm with ✓.

4. Select the measurement function (Line- or Radius measurement).

Calibrate, when you save the measurement

You are processing a layer. The screen section of the viewer displays the Redlining function bar.

See also: Dimensioning 2D files [Seite 270]

5. In the Redlining function bar select Settings → Extras.

6. In the data group Measurement functions select Calibrate.

   Confirm with ✓. The Redlining function bar is active again.

7. Highlight the length that you want to use for all measurements as a point of reference.

   The remainder of the operation is the same as in Calibrate, when you do not save the measurement.
Processing an Original Application File

Use
You sometimes have to process original application files during the processing cycle of a document info record. You process the files directly from the document info record.

Prerequisites

Customizing Settings Document Management
Under General data you must make the following settings:

<table>
<thead>
<tr>
<th>Data that is necessary</th>
<th>Activity in Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>You set the Workstation application can be started from the document info record for changing.</td>
<td>Set the start authorization for the workstation application under General data → Define workstation application.</td>
</tr>
<tr>
<td>You set which workstation application, dependent on the frontend computer is to be started for changing and from which directory the program is called.</td>
<td>Set the path for the program call for the application type 2 (change) under General data → Define workstation application → Define workstation application in network.</td>
</tr>
<tr>
<td>You must enter the path where the system can access files for processing when the original application file is already stored in a secure storage area.</td>
<td>In order to change original application files you must enter a path dependent on the secure storage area:</td>
</tr>
<tr>
<td></td>
<td>• When the secure storage area is managed by DMS you must set the path for the data carrier type (server, frontends) in the following activity: General data → Define data carrier type “Server, frontend computer”</td>
</tr>
<tr>
<td></td>
<td>• When the secure storage area is managed by the Knowledge Provider you set the working directory in the following activity: General Data → Define Profile → Determine settings for applications.</td>
</tr>
</tbody>
</table>

Processing a Document Info Record
When you want to process original application files that are managed by DMS you must first process the document info record that belongs to the original application file.

You have the necessary authorizations [Seite 21].

Features

Status Check
If you want to process an original file, the system first performs a status check. The system checks whether the status network for the document type supports a status of the Original in work (O) status type (settings in Customizing for the Document Management System, under Control data → Define Document Types → Define document statuses).
Status Network without Status of Type Original in Work

If a status of the Original in work (O) status type is not defined in the status network for the document type concerned, the original application file can be changed.

Status Network with Status of Type Original in Work

- If this status can be set immediately after the current status according to the status sequence in the status network, the system sets it. The system also copies the current name of the user as user responsible.

  If the document has this status, only the user responsible can edit it. Other users are only allowed to display the document and, possibly, set a different status (authorization check).

- If this status cannot be set immediately after the current status according to the status sequence in the status network, the original file cannot be changed.

  The document info record is closed. You cannot process the original file until the status of type Original in work can be set.

Checks for Original Application Files in Secure Storage

There are additional checks for Processing an Original Application File in a Secure Storage Area [Seite 185]

Activity

To change the original application files (irrespective of where they are stored):

1. Process the document info record change mode.
2. Highlight the original application file you want to change on the Basic Data or Originals tab page.
3. Select 📝.

   The system checks whether the status network allows the original application file to be changed.

   If the status check allows you to change the original file, the system performs the following activities:

   - Your user name is copied as user responsible.
   - If required, another status is set automatically.
   - The processing of the document info record is ended.

   If you have changed document data, these changes are saved.

   - A second processing window is started with the application and the chosen original file.

Result

In a second window, the system starts the application with the specified original application file. You can use all active functions of the application you have started.

Depending on the status network defined for the document type, you may have to change the status of the document info record afterwards.
Processing an Original Application File
Processing an Original Application File in a Secure Storage Area

Use

Original files that have already been saved in to a secure storage area must sometimes be reprocessed during the processing life cycle of the document info record. You can process the files directly from the document info record.

Features

If the original application file you want to change is stored in a secure storage area (SAP database, archive, or vault), you have two options for changing the file:

- Creating a New Version
- Changing an Existing Version

The status check is performed as for Processing an Original Application File (Page 182) (that has not been stored in a secure area).

Creating a New Version

This means that you retain the old version (for example, 00) that refers to the checked-in original application file and create a new version (for example, 01) directly from the processing function for the old one.

- Create a new version (Document → New Version). The data of the existing version (for example, 00) – and the stored original files – are copied to be used as a source document (template) for processing.
  
  In the new version (for example, 01), the original application file is still in the secure storage area, as in the source document (for example, 00).

- Edit the original application file in the new version (for example, 01). The system automatically creates a copy of the original in secure storage.
  
  A dialog box appears where you enter the destination for the copy (data carrier, path, and file name).

  The system copies the data carrier, path, and file you enter in the dialog box to the storage data fields in the document info record.

- The system starts the program that the original can be processed with for the data carrier type of the frontend computer and the application data in the document info record.

Creating New Content Version Processing Existing Versions

If you use this procedure, you keep only the one version. The system makes a copy of the original in secure storage and you can access it and process it in your local work area.

The procedure is as follows:

- Choose Extras → File 1 → Change to process the original file. The system automatically creates a copy of the original in secure storage.
A dialog box appears where you enter the destination for the copy (data carrier, path, and file name).

As a default value, you see the path in which the file was stored before being checked into the secure storage area.

<table>
<thead>
<tr>
<th>You want to...</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the default value</td>
<td>Choose <em>Continue</em>.</td>
</tr>
<tr>
<td>Enter a different storage location</td>
<td>Enter the new data (data carrier, path, and file name) in the dialog box. The system automatically takes this path as the storage location of the original application file for the version you are currently processing. The data on the secure storage area is overwritten. To check the new storage location, choose <em>Storage data</em>.</td>
</tr>
</tbody>
</table>

From the status log, you can display the old processing status that the original application file had when it was in the secure storage area (SAP database, archive, or vault). However, you can only use this function if you have set a status for which the *Indicator: audit* function is chosen when checking the original application file into the secure storage area. This indicator ensures that checked-in original application files are stored automatically when the status is set.

**See also:** *Status Management [Seite 44]*.

- The system starts the program that the original can be processed with for the data carrier type of the frontend computer and the application data in the document info record.
Resetting the Storage Data of Original Application Files

Usage
You can use this function to undo changes you have made to an original application file. You can undo all the changes that you made up to the last change status after the original was placed in secure storage. The original file is not retrieved from these storage locations.

An original application file has been checked into the SAP database. You have to make further changes, so you process this original application file (Original 1 → Edit [Seite 185]). The system creates a copy for you to process.

While you are changing the file, the file is destroyed or you discover that you have made numerous errors over a period of time. You can undo these erroneous changes and reset the status of the original application file to what it was when it was placed in secure storage.

Integration
This function is for original application files that you have stored in a Secure Storage Area [Seite 141] and then reprocessed.

Prerequisites
You can only use this function if an original application file has been checked into a secure storage area.

Scope of the Function
With this function you can undo all your changes and go back to the archived version of the file. The storage data entries for the original application file in the document info record are reverted to their pre-change state.

The Reset original function may also be active if neither a workstation application nor a storage location is entered for the current processing status of a file. This shows you that an original application file was saved to a secure storage area sometime in the past, but the storage data was deleted from the document info record at a later date. You can still reset the Original field.

The following graphic illustrates the Reset original function for a securely stored file.
Resetting the Storage Data of Original Application Files

**Activities**

1. Go to the **Basic Data** screen.

2. Choose **Extras** → **Originals** → **File 1(2)** → **Reset original**.

   The system determines the data carrier on which the original application file was last stored (SAP database, vault, or archive) and copies the description of this data carrier as the storage location.

   For example, if the original application file was last stored in an archive, the Data carrier field in the Storage data dialog box contains the description of the archive (for example, Archive 1). For security reasons, you do not see the complete path.

   This reset original application file is now available for processing again. If you choose **Extras** → **Originals** → **File 1(2)** → **Change** again, a dialog box appears in which you can enter a path for the copy.
Exchanging Document Data with an External System

Use

The *Insert* function allows you to transfer document data between the SAP Document Management System and an external system (for example, CAD system).

You are editing a technical drawing (for example, a design drawing for a driving gear) in a CAD system. You want to insert a gearwheel in this drawing. Your SAP Document Management System contains a document with an original application file that is a drawing of this gearwheel.

Prerequisites

This function is only active if you are working with the CAD dialog RFC interface.

See also:

Function Overview of the Dialog RFC Interface [Extern]
Technical Description of the Dialog RFC Interface [Extern]

Features

If you are working with the CAD dialog RFC interface, an RFC link is established between an external system and the SAP GUI (graphical user interface). This connection allows you to access SAP transactions and transfer data.

The *Insert* function allows you to transfer the following document data between the SAP Document Management System and an external system:

- Access path for original application file

Activities

1. In edit mode in the external system, choose the function for displaying a document.
   You see the *Display Document: Initial Screen*.

2. Enter your document data.
   You see the *Display Document: Basic Data*

3. Highlight the original application file that you want to insert.

4. Choose *Original* → *Insert*.
   The original application file for the gearwheel is inserted in the design drawing for the driving gear.
   In the status bar of the document you see the following information:
   *Document* <Document number> <Document type> <Document part> <Version> has been inserted.
Hints on Finding a Document Using Object Links:

In the external system, you are searching for a material (the gearwheel) via classes.

- You find the material master record. The material is linked to a document that has an original application file for the gearwheel.
- To display documents that are linked to a material, choose Extras → Document data. You see the Linked Documents dialog box with a list of all documents that are linked to the material.
- Select a field of the document whose original application file you want to copy to the CAD system.
- Choose Insert original. If more than one original application file is maintained for the document, you can choose one.
Default Values for Original Application Files

Use
The processing of original application files can be simplified by entering some data, default values, and settings.

Integration
Settings for some data are put together in a profile that is allocated to a user or an activity group.

Features
The profiles are defined in Customizing of Document management under General data → Define profile

• You allocate, or assign a profile to a user an activity group.

  You allocate, or assign only one profile to a user an activity group. When several allocations exist, the system uses the default values of the first reported profile.

• You can enter the following default values and settings in a profile:
  
  – The workstation application you want started when displaying or printing an original application file.
  
  – Working directory where the an original application file is to be copied under the following processing situations:
    
    • Automatic storage when a status is set with the indicator Store originals automatically.
    
    • Processing of an original application file that is already stored in a secure area.
  
  – Storage category for storing the original application file using the Knowledge Provider
Creation of an EPS Print File

Usage

You can include EPS print files as text element in a SAPscript text by using an INCLUDE. For example, you can copy a drawing to the job ticket of an equipment.

Prerequisites

Before you can create an EPS print file, the following requirements must be met:

- You must have created an EPS file from the original application file using an external program. As a result, the file has an Encapsulated PostScript (EPS) format. The EPS file is uploaded to the document info record as a standard text and can be copied to a SAPscript text by other applications.

- It must be possible for the frontend computer to access the EPS file in the network.

Scope of the Function

You can create an EPS print file either from original application file 1 or from original application file 2. Since texts in EPS print files are language-dependent, it is possible for a document to have an EPS print file in one language, but none in another language.

The system sets the EPS print file exists indicator on the Basic data screen when an EPS print file has been created for a document.

The following graphic shows how an EPS print file is created.
Standard Text Key

The system assigns a standard text key for the EPS print file. The standard text key is identical to the document key.

\[
\begin{array}{|c|c|}
\hline
\text{Document} & \text{ADTEST.................} \\
\hline
\text{Document type:} & \text{DRW} \\
\text{Document part:} & \text{000} \\
\text{Version} & \text{00} \\
\hline
\end{array}
\]

(The string “ADTEST.................” is the 25-character document number. The 19 dots in this example stand for the blanks contained in the document number.)

The system assigns the following text key for this document:

000DRWADTEST.................00000

In another application (for example, plant maintenance), this key is incorporated in a SAPscript text using the following INCLUDE:

\[
\text{INCLUDE '000DRWADTEST.................00000' OBJECT TEXT ID ST}
\]
Storing an EPS Print File

Prerequisites
You must have created an EPS file from the original application file using an external program.

Procedure
1. Go to the Basic Data screen.
2. Choose Extras → Originals → EPS print file → Store.
   You see a dialog box, in which you enter the following data:
   - **EPS file**
     You can choose the EPS file using the possible entries function and the file manager.
     Example: 01.EPS
   - **Height in cm**
     In this field, you define the height of the file when it is printed in a standard text. The system automatically adapts the width of the file to the height you enter.
     Example: 6
3. Confirm the entries and choose Continue.
   The Upload Files to Standard Text screen appears, where you find the standard text key for the uploaded EPS file. In addition, you see the file size as well as the coordinates for the EPS print file.
   The standard text key is identical to the document key.
4. Go back to the Basic Data screen.
   The system sets the EPS print file indicator.
Choosing a Different EPS Print File

Prerequisites

There must be an EPS print file for the document info record and the EPS print file indicator must be set. In this case, a standard text exists for the document key.

See: Example in Storing an EPS Print File [Seite 194]

Procedure

You can change the content of the standard text for the document key by storing a different EPS file. When you store a different EPS file, the content of the old EPS file is lost.

1. Go to the Basic Data screen.

2. Choose Extras → Originals → EPS print file → Store.

   You see a dialog box in which you enter the data for the EPS file. The data for the old EPS file is not displayed, even if an EPS file has already been uploaded for this document info record.

3. Enter the data for the new EPS file (EPS file, Height in cm).

4. Confirm the entries and choose Continue.

   Since a standard text exists already for the document key concerned, you see a dialog box in which the system asks you if you want to overwrite the existing standard text.

   When you confirm, the new EPS file is stored. The Upload Files to Standard Text screen appears, containing the data of the standard text. The standard text key remains the same.

5. Go back to the Basic Data screen.
Displaying Information on an EPS Print File

Procedure

1. Go to the Basic Data screen.
2. Choose Extras → Originals → EPS print file → Info.
   
A dialog box appears that tells you who created the EPS print file and the date on which it was created. In addition, you see the path where the EPS file is stored as well as the height of the file in the standard text.
Printing an EPS Print File

Prerequisites
To print an EPS print file, you need a PostScript printer.

Procedure
1. Go to the Basic Data screen.
2. Choose Extras → Originals → EPS print file → Print.
   You see a dialog box in which you can enter the print parameters, such as the output device, as well as spool control data and the spool request.
3. Choose Print.
   The EPS print file is printed.
Optical Archiving

In the R/3 Document Management System, you can use SAP ArchiveLink® to optically archive the following documents:

- **Inbound document**
  (NCI - Non-Coded Information)
  You process inbound documents in the Archive menu in the document info record.
  You can use the following functions:
  - Check in archive
  - Display from archive
  - Copy from archive

- **Digital original application file, managed in the document info record**
  (CI - Coded Information)
  You can process the digital original application files in the Extras menu in the document info record.
  You can use the following functions:
  - Originals ➔ File ➔ Check in archive
  - Display archived original application file

You can find more detailed information about SAP ArchiveLink® and scenarios in Document Management in the R/3 Library (Basis ➔ Basis Services ➔ SAPArchiveLink ➔ SAPArchiveLink - Application scenarios ➔ Archiving in Document Management (CA-DMS) [Extern])
Conversion

Purpose

Optimization of the product setup and development process can be obtained by means of methods from Digital Mock-up (DMU) or Virtual Product Development Management (VPDM). All members participating in the design process have common, regulated access to the product’s geometry and topology and can even display the product digitally in the development stages.

The standard SAP System’s SAP Graphical User Interface (SAPgui) now has a viewer from Engineering Animation, Inc. (EAI) that allows you to view your products in the Product Lifecycle Management [Extern] (PLM) area.

This integrated viewer as well as other visualization programs can only display product information of certain file formats. For this reason it is necessary that you be able to convert the source file into a file format that can be displayed by the available software.

You crate a drawing (file type *.model) in a CATIA system that you want to display in the product structure. The viewer cannot display the CATIA format directly. In this case it is necessary to convert the file to a format either 2D (for example *.jpg) or 3D (for example *.jt) that can be displayed by the viewer.

The following Release allows the use of conversion interface functions of Digital Mock-Up Viewing.

Integration

You need the conversion server where the actual conversion takes place. Install the converter and communication programs on this server.

The SAP System communicates using an RFC connection to the conversion server. RFC destinations must be maintained. Use Customizing for conversions to set which original application files are converted at which processing statuses.

The following graphic shows the integration.
The integration is done in the following steps:

- **Installing the Converter [Seite 528]**
  
  Therefore, one or more converters need to be installed for the conversion process. The selection of converters is based on which conversions are necessary and which type of files you want to display.

- **Definition of an RFC destination**
  
  RFC (Remote Function Call) is an SAP interface protocol sets up communication between the converter and the SAP System. Notes on the definition of RFC destinations can be found under Programs for Communication [Seite 531].

- **Customizing of Conversion [Seite 542]**
  
  The conversion interface controls conversions of original application files and document info records in the standard SAP System. You can set in the SAP System which processing status triggers an automatic conversion. The conversion specification contains all notes, indications, and details for the conversion. You create this in Customizing for Conversions. SAP help programs take care of the actual data transfer to the converter.

### Features

The current conversion interface allows original application files to be converted: Conversion of Original Application Files [Seite 547].

The following overview contains the phases of the conversion processes.

<table>
<thead>
<tr>
<th>Conversion phase</th>
<th>Process</th>
</tr>
</thead>
</table>
You can start the conversion in two ways:

**Document:**
- Converting Documents (Automatic Start) [Seite 546]
- Converting Documents (Manual Start) [Seite 547]

**Assembly:**
- Convert Assembly [Seite 548]

### Preparation for conversion

- **Beginning background preparations**
  The conversion process is started as a background job. This allows the user who started the conversion to continue working. The conversion does not have to be completed before resuming work. You can also set up the conversion to run only at night (See: Customizing for Conversions [Seite 542]).

- **Finding a free conversion server**
  The system checks which conversion server is available for the conversion (Maintaining the converter [Extern]) and reports the destinations where the SAP help programs communicate with the conversion program.

  The system creates a temporary directory on the conversion server where the original application files are stored:
  - Original application files that you want to convert
  - Converted original application files that you want to transfer to the SAP System

- **Messages in the application log**
  Since the conversion process is not a dialog process you see no dialog messages during the conversion. Logs messages in the application log tell you what happened during the conversion (Display Messages [Seite 550]).

  The scope of the output messages is determined in Customizing for Conversions [Seite 542], You decide in what time frame the logs are deleted.

### Conversion on the Conversion server

The conversion of original application file is done using a converter that you installed to fit your needs.

You can set up a time period for the converter in Customizing for conversions. The selection and syntax of these parameters are dependent on the converter.
### Conversion

| Import of converted original application files on the storage systems | After conversion the original application files are saved in the temporary working directory. The converted original application files are transported into the SAP System by means of SAP help programs. The transport is done into the storage category that was entered in the conversion specification. You define in the conversion specification in which processing situations the converted original application files are deleted from the temporary working directory. You can set, for example, that the files are deleted once they have been converted correctly but converted original application files with errors are left intact. |

### Result

A visual result appears where the system displays a list of the original application files for the document info record. The converted original application files are added to the originals in the source format automatically. You can display all file formats from the tab page *Original Application Files*.

The integrated viewer [Seite 566] of the SAP System will display many standard formats and is set up as the default viewer for these.
Installing the Converter

Purpose

Converting original application files is not done with tools of the SAP System but by means of one or more converters from different suppliers on the market.

A converter interface is part of the standard SAP System. This interface controls the conversion as well as the data exchange between the converter and the SAP System. Specify in Customizing of the SAP System how the conversion is run. You determine at what processing status the conversion is started automatically.

We strongly recommend that you read all instructions and notes from the converter’s manufacturer as well as from SAP before installing a converter to ensure that conversion fits optimally into your business processes.

Prerequisites

The converter that you chose for conversion can be coupled the SAP System. Important here is that the converter is running in batch mode, this means without user entries.

Installing the Converter and Communication Programs

1. Select the computer where you want to install the converter.
   
   This computer is the conversion server.

   Note the following:

   - Some converters require additional hardware and software that must also be installed on the conversion server.

   - It is recommended to always leave the conversion server running so that conversions can also be executed evenings and weekends. The conversion time of the converter are set in Customizing of Conversion under Determine conversion.

   - When other users also use the conversion server during the day you may want to have all conversions executed at night. This avoids the users being slowed down during the workday.

     This is also true when you use an SAP application server as the conversion server. Otherwise the SAP System performance may be greatly reduced.

     It is highly recommended the application server not be used as the conversion server to ensure reliable and efficient operation.

   - You can set up as many conversion servers as required. The definition is done in Customizing of Conversion; under Maintain converter.

2. Install the converter.

   Please read all of the manufacturer’s documentation.
Installing the Converter

The SAP GUI can display the 3D format *.jt. If you want to convert CAD original application files into the .jt format you can use the converter from Engineering Animation, Inc. (EAI). This converter already has an interface built into the standard SAP System.

3. Install the following programs for communication between the SAP System and the converter.

<table>
<thead>
<tr>
<th>Program</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapftp and saphttp</td>
<td>Transport files between the SAP System and the conversion server</td>
</tr>
<tr>
<td>(Available on the SAP R/3 Client Installation CD)</td>
<td></td>
</tr>
</tbody>
</table>
| ConvUtil | • Creates temporary directories  
• Deletes files from the conversion server |
| Program for communicating with the converter such as ConvServSamp, ConvRfc2Corba | Communication between the SAP System and the converter |

You can find more information under: Connecting the Converter [Seite 534]

You will find the programs ConvUtil, ConvServSamp and ConvRfc2Corba on a SAP server SapservX under the following path: ~ftp/general/misc/converter. It is highly recommended that you read Hints for the Communication Programs [Seite 531] as well as the readme.txt file that is on the server under the archive docu.SAR. This file contains the most up-to-date information.

4. Set up an RFC destination for the program RunConvUtil.bat (for Windows NT) or StartConvUtil (for UNIX).

See:

5. You can also create an RFC destination for the other three programs that you need.

The other three programs are started by the program ConvUtil with the name ConvServ or ConvServ.bat. Sapftp and saphttp start them if you do not set up RFC destinations for the three programs. The start is done with the parameters that are necessary for communication with the SAP System.

Notes

Converting CATIA Files to Direct Model Files (*.jt)

If you specify a conversion of CATIA files into Direct Model format note the following entries:

• Read the installation information from EAI. Choose the settings in the configuration file in such a way so that each CATIA is converted into exactly one Direct Model file.

• Enter the configuration file in Customizing of Conversion for the conversion specification. Enter the configuration file according to the following convention in the activity Enter parameters for conversion: -z <Filename>
• The temporary path where the files are checked out from can only be a maximum of 8 characters long.
Hints on the Communication Programs

The following overview contains special information regarding each of the four programs.

<table>
<thead>
<tr>
<th>Program</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapftp</td>
<td>Under WinNT, the program <em>librfc32.dll</em> must be accessible.</td>
</tr>
<tr>
<td>saphttp</td>
<td></td>
</tr>
<tr>
<td>ConvUtil</td>
<td>Before calling the program, set the path to that <em>sapftp</em>, <em>saphttp</em>,</td>
</tr>
<tr>
<td>ConvServSamp</td>
<td>and <em>ConvServ</em> can be accessed and be started by the program <em>ConvUtil</em>.</td>
</tr>
<tr>
<td>ConvRfc2Corba</td>
<td>When you select the option <em>Start</em> for when defining the RFC destination you will only have a very basic path set. In this case use <em>shell script</em> to set the path and then call the program <em>ConvUtil</em>.</td>
</tr>
</tbody>
</table>
When you start the program using ConvUtil you write a shell script with the name ConvServ (or ConvServ.bat when using the operating system Windows NT). You call the RFC server for communication with the converter in this shell script (Examples: ConvServSamp, ConvRfc2Corba).

If you use a CORBA server from Engineering Animation, Inc. (EAI) for conversion you will need the SAP program ConvRfc2Corba.

- In addition to the parameters stated here the program also needs the parameter for CORBA communication with the CORBA server. These parameters can be found in the installation guide from EAI.
- The program ConvRfc2Corba must be started with the parameters that are used to start the conversion server from EAI for example:
  
  ```
  CatiaTranslatorServer -hostName iw1027
  -TranslatorName CAT1 -namingContext DefaultNamingContext -portNumber 10000
  ```
- The following parameters are needed as well:
  
  ```
  -sessionFactory <sessionFactory> - listFactory <GeneralListFactory>
  ```
  The values of these parameters must be identical to the parameters used when calling the program VisDSSessionMgr.
  Here is an example of a complete call:
  
  ```
  ConvRfc2Corba <RFC Parameter> -hostName iw1027
  -TranslatorName CAT1 -namingContext -sessionFactory sessionFactory -listFactory GeneralListFactory -portNumber 10000
  ```

- Start the program ConvRfc2Corba after the other CORBA programs from EAI have been started.
  
  The program ConvRfc2Corba must be closed and restarted in the following situations:
  
  - Another CORBA program has been started.
  - The SAP System was restarted.
  
  The program runs better on a UNIX machine and when maintaining the RFC destination (transaction code SM59) select the option Start or start the program using ConvUtil.
  
  The program ConvRfc2Corba does not have to be run from the conversion server. The other three programs do.

- If you encounter communication problems between the CORBA programs you must add the -Oanumeric parameter.
  A communication problem can occur when the nameserver (ConvRfc2Corba, nameserv, VisDSSessionMgr and the translator server, such as CatiaTranslatorServer or ProETranslatorServer.exe) cannot be found in the CORBA programs.

- You can also start the CORBA programs from EAI from ConvRfc2Corba. In this case the parameters are automatically selected for consistency.
  To do this you must set the path for nameserv and VisDSSessionMgr so that the can be found before calling ConvRfc2Corba.

Set all environment variables for ConvRfc2Corba as required by the converter.
Also enter the parameters -corbaTranslatorServerName `<TranslatorServer>` when calling ConvRfc2Corba.
`<TranslatorServer>` is required for your conversion.
Connecting the Converter

Use

There are several ways to connect a converter to the SAP System. You must consider the conversion results when selecting one. For example, if you want to convert original application files from documents, you must set up the conversion server differently than when you want to convert assemblies.

There are three ways to connect a converter to the SAP System:

<table>
<thead>
<tr>
<th>Method</th>
<th>Objects you want to convert</th>
<th>Transfer of parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Individual original application files from documents</td>
<td>Parameters are transferred between the SAP System and the converter using files</td>
</tr>
<tr>
<td>2</td>
<td>Individual original application files from documents and assemblies</td>
<td>Parameters are transferred between the SAP System and the converter using an RFC interface</td>
</tr>
<tr>
<td>3</td>
<td>Individual original application files from documents and assemblies</td>
<td>Parameters are transferred between the SAP System and the converter using an RFC interface</td>
</tr>
</tbody>
</table>

1. Method

You can convert individual original application files of documents using the converter connected with this method. You can use the compiled example server ConvServSamp. No previous programming knowledge is required. It is however necessary to modify the shell-script and possibly a batch file.

You can find examples on the SAP server SapservX in the directory ~ftp/general/misc/.converter/.

The graphic display how the example convert All2txt is connected to the SAP System using the first method. All2txt converts files to text files. A shell-script file (such as ConvServ) starts ConvServSamp. This method uses the following conversion steps:

- Information for the conversion is transferred to the form the SAP System to the program ConvServSamp using the RFC destination.
- ConvServSamp stores the information as files on the conversion server and starts a shell-script file (in this case: StartConv) with its own parameters.
- The shell-script file (in this case: StartConv) calls the converter (here: All2txt) using the syntax for the converter.

When you install your own converter you must modify StartConv that it is called with its special syntax and not All2txt which was used only as an example.
Example for First Method

Conversion server

ConvServSamp ↔ StartConv

Konverter: All2txt

Information transfer using RFC connection

RFC destination (Transaction SM59)

SAP System

Below are tips and notes for the individual steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call ConvServSamp</td>
<td>You must enter the following parameters when calling ConvServSamp:</td>
</tr>
<tr>
<td></td>
<td>• RFC parameter</td>
</tr>
<tr>
<td></td>
<td>• Path name of the shell-script file that ConvServSamp starts</td>
</tr>
<tr>
<td></td>
<td>for conversion (using parameter -s&lt;shell-script filename&gt;)</td>
</tr>
<tr>
<td></td>
<td>More information about the document you are converting can be saved</td>
</tr>
<tr>
<td></td>
<td>as an extra file by using the parameter -ReadDocumentDetails.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>• ConvServSamp -s c:\bat\StartConv.bat    &lt;RFC Parameter&gt;</td>
</tr>
<tr>
<td></td>
<td>• ConvServSamp -s $HOME/bin/StartConv    &lt;RFC Parameter&gt;</td>
</tr>
</tbody>
</table>
ConvServSamp creates <WorkingDirectory>/Parameters.txt

The file `<WorkingDirectory>/Parameters.txt` is created before calling `StartConv` and contains the parameters that were maintained in Customizing of the conversion specification. In Customizing of Conversion you make the settings Logistics General -> Conversion -> Determine conversion.

### Additional Files

The following files are also created when ConvServSamp is called using the parameter `-ReadDocumentDetails`:

- `<WorkingDirectory>/Documentdata.txt`
- `<WorkingDirectory>/Ecmdata.txt`
- `<WorkingDirectory>/Documentdescriptions.txt`
- `<WorkingDirectory>/Longtexts.txt`
- `<WorkingDirectory>/ClassData.txt`
- `<WorkingDirectory>/Objectlinks.txt`
- `<WorkingDirectory>/Statuslog.txt`
- `<WorkingDirectory>/ExportData.txt`
- `<WorkingDirectory>/UserData.txt`

The files contain the data that the function module `CAD_GET_TITLE_BLOCK_DATA` determines. You can find information about the content of these files in the documentation for this function module (Export Parameter `DOCUMENTDATA` and `ECMDATA` and tables `DOCUMENTDESCRIPTIONS`, `LONGTEXTS`, `CLASS_DATA`, `OBJECTLINKS`, `STATUSLOG`, `EXPORT_DATA` and `USER_DATA`).

- The files `Documentdata.txt` and `Ecmdata.txt` contain `DOCUMENTDATA` or `ECMDATA` for every element of the structure. This data is in a line where the name and value of the element are entered: `<Name> = <Value>` (example: `DOCUMENTTYPE = DRW`)
- All other files contain a line for each line of the structure. Each line contains a value for each element of the structure from the table. The number of the columns is based on the width set in the SAP System. No limits are used.
ConvServSamp sets parameter values for StartConv

The example server ConvServSamp calls the file StartConv:

```plaintext
StartConv <Version> <WorkingDirectory> <FileToConvert> <language> <ConverterTimeOut> <conversionName> <DocumentKey> <current_user_name> <sy_language>
```

- ConvServSamp sets `<WorkingDirectory>`, `<FileToConvert>`, `<DocumentKey>`, `<current_user_name>` and `<sy_language>` for the parameter values at the beginning and end of each special character " This keeps the Shell from interpreting the special character.
- Each conversion has its own (`<WorkingDirectory>`) where the converted files are written.

Parameter meanings:

- `<Version>` (such as: 5): Which functions are supported by the current SAP System
- `<WorkingDirectory>`: Directory used for converted files
- `<FileToConvert>`: Files you want to convert
- `<language>`: Language for possible dialog boxes ('X' means no language selected)
- `<ConverterTimeOut>`: Cancel conversion after this many minutes.
- `<conversionName>`: Name for conversion
- `<DocumentKey>`: Key for the document in the following sequence:
  - 3 characters: documenttype
  - 25 characters: documentnumber
  - 3 characters: documentpart
  - 2 characters: documentversion
- `<current_user_name>`: Name of user who started the conversion implicit or explicit
- `<sy_language>`: Language used by `<current_user_name>`
Modifying StartConv

<table>
<thead>
<tr>
<th>Activity</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConvServSamp creates</td>
<td>Before calling StartConv the &lt;WorkingDirectory&gt;/ConvStructFilename.txt is created by ConvServSamp. Each line of this file contains the following parameters:</td>
</tr>
<tr>
<td>&lt;WorkingDirectory&gt;/ConvStructFilename.txt</td>
<td>parent_guid[38] ID of the father of this part</td>
</tr>
<tr>
<td></td>
<td>guid[38] ID of this part</td>
</tr>
<tr>
<td></td>
<td>file_changed[1] If the part was changed (currently not supported)</td>
</tr>
<tr>
<td></td>
<td>filename[255] Path name of the part</td>
</tr>
<tr>
<td></td>
<td>The format is fixed. There is no separator between the entries.</td>
</tr>
</tbody>
</table>

Change the example file StartConv so that
- This file starts your converter and
- One of the files <WorkingDirectory>/Error.txt or <WorkingDirectory>/ConvPath.txt is created

After StartConv is completed ConvServSamp runs through the following steps:
- The first line of the file <WorkingDirectory>/Error.txt is transferred to the SAP System as an error message when
  - The file <WorkingDirectory>/Error.txt exists and
  - The first line of this file is not empty
- If exit code of the shell-scripts (for example StartConv) does not equal 0 (zero) the value is returned the SAP System as an error.
- If none of the above is true, the path name of the converted file from the file <WorkingDirectory>/ConvPath.txt is read. This file is automatically transferred to the SAP System and stored as a new original application file.

2. Method

You can convert individual original application files of documents and assemblies using the converter connected with this method.

You can use the compiled example server ConvServSamp. No previous programming knowledge is required. It is however necessary to modify the shell-script and possibly a batch file.

The procedure is very much the same as the previous method.

The following overview shows information about files and parameters that are processed for converting assemblies only.
Connecting the Converter

Converter creates <WorkingDirectory>/ConvPathAndMatrix.txt instead of the file <WorkingDirectory>/ConvPath.txt. This file is not read when the file <WorkingDirectory>/ConvPath.txt exists.

Each line of this file contains the following parameters:

- parent_guid[38]
  ID of the father of this part (as entered)
- guid[38]
  ID of this part (as entered)
- filename[255]
  Path name of the part
  Path name: Must not contain any empty spaces, end with empty or end of line

The format for these three parameters. There is no separator between the entries.

In case the path name is not yet at its end, it must contain 12 real number between these there must be an empty space:

locox, locoy, locoz, axis1x, axis2x, axis3x, axis1y, axis2y, axis3y, axis1z, axis2z, axis3z, scale

The transformation matrix is used to describe the relative position of the part to the father.

When more than on instance exists then each instance must have its own line. These lines must be identical except for the transformation matrix.

3. Method

You can change the example server ConvServSamp when you do not wan to transfer your conversion parameters as files or when the first two methods do not meet your needs. You need to have programming knowledge of (C source code).

You will find the C source code for the RFC Server ConvServSamp on the SAP Server SapservX in the following directory: ~ftp/general/misc/converter/source.SAR

The converter is called from the SAP System as follows:

CALL FUNCTION 'ASSEMBLIE_CONVERTER'

    DESTINATION wa_converter_dests-conv_dest
    EXPORTING interface_version = interface_version
    output_directory = output_directory
    language = isola
    sy_language = sy_isola
    timeout_minutes = timeout_minutes
    conversion_name = wa_conv_requested-handle
    document_key = document_key
Information about the type and structure of the fields are in the file \textit{ConvServ.h}.

Below is information about the use of individual fields.

### Entries for the Converter

<table>
<thead>
<tr>
<th>Entry</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{interface_version} (int, for example 3)</td>
<td>Indicates which functions are supported by the current SAP version</td>
</tr>
<tr>
<td>\texttt{output_directory} (char *255)</td>
<td>Working directory where the converted files are sent</td>
</tr>
<tr>
<td>\texttt{language} (char *2, such DE or EN)</td>
<td>Language for the error messages in the SAP System</td>
</tr>
<tr>
<td>\texttt{sy_language} (char *2, such as DE or EN)</td>
<td>Language used by the user to logon to the SAP System before starting the conversion.</td>
</tr>
<tr>
<td>\texttt{timeout_minutes} (int, for example 30)</td>
<td>Time in minutes after which the conversion is cancelled as not successful</td>
</tr>
<tr>
<td>\texttt{conversion_name} (char *32)</td>
<td>Name for identifying the conversion</td>
</tr>
<tr>
<td>\texttt{document_key} (struct DOCUMENT_KEY)</td>
<td>Key of the document that you want to convert</td>
</tr>
<tr>
<td>\texttt{current_user_name} (char 12*)</td>
<td>User who started the conversion</td>
</tr>
</tbody>
</table>
| \texttt{ti\_conv\_struct\_filename} (table) | Structure and path names  
See: Section \textit{Converting Assemblies},  
<WorkingDirectory>/ConvStructFilename.txt |
| \texttt{ti\_parameters} (table) | See: Section \textit{Converting Original Application Files of a Document},  
<WorkingDirectory>/Parameters.txt |

### Output of the Converter

<table>
<thead>
<tr>
<th>Output</th>
<th>Use</th>
</tr>
</thead>
</table>
Here you can transfer the converted file and the transformation matrix and/or an error message (in 2 table lines) for the file you entered.

- **msg_type = ' '** (Blank)
  The table lines (struct CONV_PATH_AND_MATRIX) contain a converted file and possibly transformation matrix
  transformation_matrix_valid = 'X'
  See: Section *Converting Assemblies*, <WorkingDirectory>/ConvPath.txt)

- **msg_type <> ' '** (Blank)
  The table lines (struct CONV_PATH_AND_MATRIX_ERR) contain an error message.

### Error Messages:

- **msg_type = ' '** (Blank)
  No error

- **msg_type = 'W'** Warning: The file was converted, however there is still a problem that user should know about

- **msg_type = 'E'**
  Error: File or assembly could not be converted

- **msg_type = 'F'**
  There are error messages in te_conv_path_and_matrix; parts of the assembly or the entire assembly could not be converted.

- **msg_type = 'L'**
  Not all licenses are available for conversion. The converter will be available later, however with input from an administrator.

- **msg_type = 'C'**
  System error that requires input form the administrator (for example hard drive is full)

If all fields (except msg_type and msg_txt) are released, an long message can be entered in the msg_txt that has up to 200 characters.

The RFC server must also contain the function CONV_SERV_ABOUT that you can use without changing the example *ConvServSamp.c*. 
Customizing for Conversions

Use

Settings have to be made in the system for other applications as well as in Customizing for Conversions. Use the Implementation Guide (IMG) for instructions of the individual activities where you enter the required data.

Activities

1. Decide whether you want to check in files to a secure area that you want to convert into the SAP System. Secure storage areas are storage systems controlled by the Knowledge Provider [Seite 138] such as vault, archive, and the SAP database [Seite 141].

   By deciding to check in and store the files you make it possible for the files to be accessed from any workstation. A disadvantage of this is that the data must be transported often. Note the following:

<table>
<thead>
<tr>
<th>Checking an Original Application File into a Secure Storage Area</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>In Customizing for Conversions [Seite 542] you must not set the following indicators:</td>
</tr>
<tr>
<td></td>
<td>• General local files</td>
</tr>
<tr>
<td></td>
<td>• Local files</td>
</tr>
</tbody>
</table>

April 2001
No | Set up a file server so that all users and the conversion server can access the files under the same path name.

Under WinNT a file c:\users\test.doc is created and put in a document info record of the SAP Systems as an original application file.

Problem
The conversion server that is running on another computer cannot access this file.

Solution
Allow other computers to access c:\users.
Connect c:\users to the local computer as well as the conversion server with a logical drive, for example x:
Process the file locally under the name x:\test.doc.
Create an original application file in the document info record of the SAP System using this name.

Enter in Customizing of Conversion (conversion specification) the following data:
  - Indicator General local files
  - Storage category, where the converted original application files are checked in and stored

2. Maintain the conversion data.

See: Maintain Customizing for Conversions [Seite 544]

3. Assign SAP authorizations for users.

Each user that starts a conversion (implicitly) needs the following authorizations:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_DRAW_TCD</td>
<td>Check in and check out of original application files</td>
</tr>
<tr>
<td>C_STUE_BER</td>
<td>Process bills of material (only necessary when converting assemblies)</td>
</tr>
<tr>
<td>S_BTCH_ADM</td>
<td>Batch administrator</td>
</tr>
<tr>
<td>S_BTCH_JOB</td>
<td>Operations for jobs in background processing</td>
</tr>
<tr>
<td>Call RFC modules</td>
<td></td>
</tr>
</tbody>
</table>

4. Verify that a DEFAULT entry for the frontend computer is defined in Document Management.
   This setting is in Customizing of Document Management; under General Data → Define data carrier [Seite 132] → Data carrier type "Defined server, frontends" → Identify frontend computer.
Maintaining Customizing for Conversions

Use

You control the conversion process in Customizing for Conversions. In the SAP reference IMG you will find Customizing of Conversion under the path: Logistics General → Conversion.

The following activities are required for conversion:
1. **Maintaining Converters**
2. **Determine conversion**

Maintaining Converters

In this activity you maintain the general data for the converter.

1. You can name the converter as you like, such as CATtoJT for a converter that converts CATIA files to JT files.
2. Enter the RFC destinations [Extern] for the program ConvUtil.

Enter the RFC Destination as the Help program for conversions. This is the same destination you use for the program ConvUtil.

💡 You do not have to make any other entries for the rest of the RFC Destinations. The program ConvUtil starts the RFC server.

See also: Installing the Converter [Seite 528]

More Notes

<table>
<thead>
<tr>
<th>Area</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch process</td>
<td>All converters that you define in this activity can be used at the same time for conversions. Each conversion uses its own batch process. Set up the SAP System so that enough batch processes are available. We recommend you have an additional batch process for each converter in addition to the batch processes for the enterprise areas.</td>
</tr>
</tbody>
</table>
| Lock active converter| Normally, each of these programs [Seite 531] can only be accessed one at a time when converting. Running another program simultaneously will cause an error to appear. To avoid this, the converter being used for the conversion is locked while converting. This lock is only possible when the following conditions are met:  
  • Each RFC destination is only used once.  
  • Different converters are maintained in different activities for different SAP Systems and in different clients. |
Maintaining Customizing for Conversions

| Conversion test | When you test the settings in Customizing system and then transport the settings into the productive system both systems have the same entries. Do not start any more conversion in the Customizing system at this point. Otherwise errors will occur during conversion. |

More information can be found in the IMG of Conversion; Logistics General → Conversion → Maintain converter.

Determine conversion

Enter the conversion data in two partial-steps:

1. Enter data for the converter specification.
   - You decide for each document type which source format of original application files in which target format for the conversion.
   - Enter the status of the document info record that will automatically trigger a conversion of original application files.

2. Enter the parameters and parameter values for each specification. The entries are dependent on the converter you selected.

More information can be found in the IMG of Conversion; Logistics General → Conversion → Determine conversion.
Converting Documents (Automatic Start)

Use
This function converts original application files of a workstation application automatically when you save a document info record to a particular status you set in the conversion specification.

Prerequisites
You have maintained Customizing of Conversion [Seite 542] and entered detailed instructions for the conversion. You create the conversion specification for a document type in conjunction with a particular document status.
When you set a status in a document info record, the system checks whether this document type is set up so that this status triggers an automatic conversion.

Procedure
1. Process the document, such as by Logistics → Central Functions → Document Management → Document → Change).
2. In the Basic Data screen set the status that is used in the conversion specification.
3. Save your document.
   The system starts the conversion process. It checks which workstation application is set in the conversion specification.
   See also: Conversion [Seite 524]

Result
You can control the results of the conversion in the following ways:

- Display the messages from the application log.
  See also: Displaying messages [Seite 550]
- Display the document info record.
  A visual result appears where the system displays a list of the original application files from the document info record.
  The converted original application files are added to the originals in the source format automatically. You can display all file formats from the tab page Original Application Files.
Converting Documents (Manual Start)

Use

This function you carry out when you want to start the conversion for original application files of a particular document manually.

Prerequisites

You have maintained Customizing of Conversion [Seite 542] and entered detailed instructions for the conversion. You create the conversion specification for a document type in conjunction with a particular document status.

When you start a conversion manually the system only checks the settings in Customizing. The status history of the documents is not checked. The document does not have to have had this status nor does this status have to be set to the current processing time point.

Procedure

Ensure that the document you want to convert is not locked. A document can be locked when it is in change mode, for example.

   
   You see the Convert document screen.

2. Enter the data that identifies the document info record whose original application files you want to convert.

3. Enter the status of the document info record that a conversion specification in Customizing of Conversion.

4. Choose Execute.

When the document you entered does not exist or if no conversion specification exists for the document type and document status you entered the conversion is cancelled. Otherwise the conversion runs in the background.

Result

A visual result appears where the system displays a list of the original application files for the document info record. The converted original application files are added to the originals in the source format automatically. You can display all file formats from the tab page Original Application Files.

The integrated viewer of the SAP System will display many standard formats and is set up as the default viewer for these.

Messages that occur during the conversion can be displayed.

See: Displaying messages [Seite 550]
Converting Assemblies

Purpose

So that you can carry out Digital Mock-Up Viewing, transformation matrices have to be maintained for the SAP System. The transformation matrices can either be generated from the CAD coupling (such as from the CATIA-System) or by the conversion of assemblies.

Prerequisites

Customizing

You need to define the following settings in Customizing:

- In Customizing of Conversion you define the scope of the conversion scenario. In this case set that the entire BOM structure is to be converted.
  
  The setting is under Logistics General → Conversion → Determine conversion → Conversion specification (detail screen). Enter Complete structure as the Check out depth.

- In Customizing of Document Management you must set up support for document assignments for the BOM header as well as for the BOM items.

  See also: Setting up Customizing for DMU Viewing [Seite 564]

CAD Coupling

The following is required for CAD coupling:

- The CAD link for the material BOM must be set up and functional. Assemblies are stored in these material BOMs that you want to convert or display.

- The following documents must be stored in the BOM using the CAD coupling in the SAP System:
  - The document for the assembly must be stored in the BOM header (Assembly file).
  - The base object must be stored on the BOM items (Part files).

- The CAD coupling call the following function modules for converting assemblies:
  CONV_API_CONVERT_BOM_ASSEMBLY (development class CONV, function group CONV_API).

Process Flow

1. The engineer creates a CAD drawing for each assembly part in the CAD system.
2. Then the CAD coupling is used to create the assembly in the material BOM of the SAP System.

   The system creates a document info record for each CAD file and links the document info record to the BOM header or BOM item.

3. The conversion program is started.

   You have the following options:

   - Manual Start [Seite 547] (parallel to conversion of individual files)
Converting Assemblies

- Automatic Start (using CAD coupling)
  The system runs the following steps:

- Converts the CAD files in the format of the viewer (Direct Model).
- Assigns the files to the documents in the SAP System.
- Determines the transformation matrices based on the CAD files for the entire assembly.
  A transformation matrix defines geometrical position of a component within space.
- Assigns transformation matrices to the BOM items.

A wheel has 19 spokes.
In the BOM for the wheel the system assigns the item "Spoke" to the drawing and 19 transformation matrices. Each transformation matrix defines the geometric position of an individual spoke.

Result
You can now display the 3D model in the Engineering Workbench.
Displaying Messages

Use
The conversion process is a background job, therefore any information generated while running it can be read in the application log.

Prerequisites
At least one conversion process was started either manually or automatically with the automatic start being triggered by a particular status of the document status. Both cause messages to be written to the application log.

Procedure
1. Select Logistics → Central Functions → Engineering → Environment → Conversions → Display messages.
   You see the Display messages screen.
2. Enter the time period that you want the conversion to take place in.
3. Enter the name of the user who carried out the following activities:
   - User who started the conversion of the original application file manually
     (Converting documents (manual start) [Seite 547]
   - User who saved the document status that triggered the automatic conversion.
     If you want to see all messages without restrictions do not make any entries.
4. Choose Execute.
   - If no conversion were executed according to the selections you made the following message appears:
     No log found in the data base
   - When conversions were executed according to your selections then the Display log screen appears.

Reading the Log
The screen Display log contains all conversions that were executed with the selections you made.

The traffic light gives you a quick and easy way to see how the conversion were executed:
- Conversion was completed successfully (green light)
- Errors occurred during conversion (red light)
  You will find detailed information in the application log when errors or warnings occurred in the individual conversions. Use the following transactions to restart a conversion that was cancelled because of timeout errors:
  - conv02 (convert document)
  - conv03 (convert assembly)
Displaying Messages

- The user who started the conversion as well as the time of start are displayed.
- Double-click on a message to see more technical information or display the long text.

💡

You will receive notes about troubleshooting if errors occurred during conversion. These notes are in the output file on the conversion server of the converter.
## Administrative Utilities

Checking the status of a converter is an important administrative utility. This helps you avoid conversion errors.

Display the status in [Customizing for Conversions](#) in activity *Maintain converter*. Each converter can have one of the following statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready for conversions</td>
<td>No error has occurred yet.</td>
</tr>
<tr>
<td>Conversion in execution</td>
<td>This status can sometimes be incorrect. It may appear after a system crash, for example. Check whether a conversion is actually running. Set the status: <em>ready for conversions</em> when no conversion is actually taking place.</td>
</tr>
<tr>
<td>Connection error not ready</td>
<td>The system sets this status when an error occurs.</td>
</tr>
<tr>
<td></td>
<td>Check the RFC destinations and the installation.</td>
</tr>
<tr>
<td></td>
<td>You will find notes about troubleshooting the errors in the field <em>Error number</em>. Also read the output files from the communication programs (<a href="#">See: Installing the Converter</a>).</td>
</tr>
<tr>
<td></td>
<td>Set the status to <em>Ready for conversions</em> once everything runs properly.</td>
</tr>
<tr>
<td></td>
<td>Rerun a conversion with this converter to ensure that the error was corrected.</td>
</tr>
<tr>
<td>No license for the last conversion</td>
<td>No software license available that is required for the conversion.</td>
</tr>
<tr>
<td></td>
<td>The system automatically sets the status: <em>Ready for conversions</em> after a short pause. You can also set this status manually.</td>
</tr>
</tbody>
</table>

---

April 2001 227
Setting up an RFC Destination for a RFC Server

There are two methods for setting up RFC destinations:

- **Method A:** Set up for starting the program using the SAP Gateway
- **Method B:** Registration on the SAP Gateway

Below are the methods with a comparison of their advantages and disadvantages:

<table>
<thead>
<tr>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method A</td>
<td>Method B</td>
<td></td>
</tr>
<tr>
<td>• The program only runs when it</td>
<td>• Only works when the conversion server is running on</td>
<td>This method is highly recommended if you</td>
</tr>
<tr>
<td>is actually needed.</td>
<td>UNIX.</td>
<td>have a conversion server running UNIX.</td>
</tr>
<tr>
<td>• The system is more stable.</td>
<td>• Installation is very complex.</td>
<td></td>
</tr>
<tr>
<td>You can usually continue working</td>
<td>• Program always runs in the background.</td>
<td>This method is best for conversion</td>
</tr>
<tr>
<td>even if the conversion server is</td>
<td>If the program is halted, for example,</td>
<td>servers using Microsoft Windows NT.</td>
</tr>
<tr>
<td>restarted.</td>
<td>because the conversion server has been restarted, it</td>
<td></td>
</tr>
<tr>
<td></td>
<td>must be restarted.</td>
<td></td>
</tr>
</tbody>
</table>

**Information for Setting up an RFC Destination**

The following information is required for both methods:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GATEWAY_HOST</td>
<td>Name of the computer where the SAP Gateway is running (for example hs0009)</td>
</tr>
<tr>
<td>GATEWAY_SERVICE</td>
<td>Gateway Service you are using (such as sapgw01)</td>
</tr>
<tr>
<td>RFC_SERVER</td>
<td>Complete path name of the program on the conversion server where you want</td>
</tr>
<tr>
<td></td>
<td>to set up the RFC destination (for example /usr/converter/All2txt/StartConvUtil)</td>
</tr>
</tbody>
</table>
Setting up the Program Start Using SAP Gateway

Use

You are making the settings for using **Method A** that uses the SAP gateway to start a program for the opening the RFC connection.

See also: Setting up an RFC Destination for a RFC Server [Seite 553]

Prerequisites

The following information is required for **method A**:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GATEWAY_USER</td>
<td>Name of the user who started the SAP Gateway on GATEWAY_HOST</td>
</tr>
<tr>
<td>CONVERTER_HOST</td>
<td>Name of the conversion server (such as hs100)</td>
</tr>
</tbody>
</table>

Procedure

Replace the text between < and > with the values used in your enterprise.

1. Create a user with the name <GATEWAY_USER> on the conversion server.
2. Log on to the conversion server using <GATEWAY_USER>.
3. Create or modify the file `$HOME/.rhosts`.
4. Add the line `<GATEWAY_HOST>` to the file `$HOME/.rhosts`.
5. Set the access authorization for the file using the following values: `-rw-r--r--` (for example with `chmod 644 $HOME/.rhosts`).

   Read the **main page** for the command `remote login` if problems occur. The command could be `man remsh` or `man rsh` depending on the computer. Or contact a UNIX specialist.

   **IN some cases the Gateway computer must entered twice in two lines in the file $HOME/.rhosts once with and once without the domain name.**

   hs0009
   hs0009.sap-ag.de

6. Set the access authorization for `<RFC_SERVER>` so that `<GATEWAY_USER>` is authorized for at least `r-` and `x-`.

   `chmod 755 <RFC_SERVER>`
Setting up the Program Start Using SAP Gateway

7. Give authorization to write to the files and files that are written on the <RFC_SERVER> the user <GATEWAY_USER>.
   
   If you are using the SAP example programs you must give authorization to the <GATEWAY_USER> to write to the directories where <RFC_SERVER> is located.

8. Start the transaction SM59 (*Display and maintenance of RFC destinations*) on your SAP System
   
   - Select *Create* and enter any name in the *RFC destination* field, for example CONVERTER_ALL2TXT.
   - Enter T as the *Connection type* value.
   - Enter a description and confirm your entries.

9. Select the value *Start on explicit host* as *activation type*.
   
   Enter <RFC_SERVER> as the value for *Program* and <CONVERTER_HOST> as *Target machine*.

10. Select the entry *Gateway options* in the *Destination* menu.
    
   Enter <GATEWAY_HOST> as *Gateway host* and as <GATEWAY_SERVICE> *Gateway service*. Confirm the entry and save the document.

11. Select *Test connection*.
    
    - Everything is fine when you see the connection data with the transfer times.
    - A red colored error message indicates and error.
      
      Hints for troubleshooting can be found when files were created <RFC_SERVER>. No files exist when:
    
    - The user <GATEWAY_USER> does not have authorization to write to the files.
    - Start using `remsh` or `rsh` was unsuccessful.

    Verify your procedure. You can find information in the UNIX help (*man remsh* or *man rsh*). Conversion can only be executed when the connection test is successful.
Setting up Registration on the SAP Gateway

Use

You are making the settings for using Method B that registers the RFC connection on the SAP gateway.

See also: Setting up an RFC Destination for a RFC Server [Seite 553]

Prerequisites

The following information is required for method B:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProgramID</td>
<td>ID where the RFC server can be identified. Select and ID for each RFC server (such as converter.All2txt.1)</td>
</tr>
</tbody>
</table>

Procedure

Replace the text between < and > with the values used in your enterprise.

<GATEWAY_HOST> Replace using the name of the computer where your SAP gateway is running.

1. Edit <RFC_SERVER>.

   When using the example programs (RunConvUtil.bat or RunConvUtil) you must include the following information in the file:

   ```
   set ProgramID=<ProgramID>
   set GATEWAY_HOST=<GATEWAY_HOST>
   set GATEWAY_SERVICE=<GATEWAY_SERVICE>
   ```

   (RunConvUtil.bat) or

   ```
   ProgramID=<ProgramID>
   GATEWAY_HOST=<GATEWAY_HOST>
   GATEWAY_SERVICE=<GATEWAY_SERVICE>
   ```

   (RunConvUtil)

   Otherwise the RFC server must be called with the following parameters:

   ```
   -a <ProgramID> -g <GATEWAY_HOST> -x <GATEWAY_SERVICE>
   ```

2. Start <RFC_SERVER>.

3. Verify the messages on the screen (RunConvUtil.bat) and in the output files (RunConvUtil).

   After 30 seconds or more it is unlikely that an error occurs.

   Otherwise verify whether <GATEWAY_HOST> and <GATEWAY_SERVICE> are set correctly and whether the gateway server is operational.
Setting up Registration on the SAP Gateway

4. Start the transaction SM59 (*Display and maintenance of RFC destinations*) on your SAP System
   - Select Create and enter any name in the *RFC destination* field, for example CONVERTER_ALL2TXT.
   - Enter T as the *Connection type* value.
   - Enter a description and confirm your entries.
   - Select Registration as the *Activation type*.
     Enter <ProgramID> as the value for Program-ID.
   - Select the entry Gateway options in the Destination menu.
     Enter <GATEWAY_HOST> as Gateway host and as <GATEWAY_SERVICE> Gateway service. Confirm the entry and save the document.

5. Select Test connection.
   - Everything is fine when you see the connection data with the transfer times.
   - A red colored error message indicates an error.
     Verify whether <RFC_SERVER> is still running and if the data <ProgramID>, <GATEWAY_HOST> and <GATEWAY_SERVICE> are the same as the data you entered in the <RFC_SERVER>.
     Conversion can only be executed when the connection test is successful.
Example Installation of a Conversion Server

Procedure

The following example will show you how to install the conversion server All2txt.

1. Create a directory on the conversion server.
   
   (for example c:\converter (WinNT) or $USER/converter (UNIX).

2. Copy the archive (files *.SAR) into your directory from the directory
   ~ftp/general/misc/converter on the SAP FTP server sapservX.
   
   Read the file ~ftp/general/misc/converter/contents.txt to find out which archives you
   need.

3. Extract the archive with the program SAPCAR. The following files must then be in your
   directory:

<table>
<thead>
<tr>
<th>WinNT</th>
<th>UNIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConvUtil.exe</td>
<td>ConvUtil</td>
</tr>
<tr>
<td>ConvServSam</td>
<td>ConvServ</td>
</tr>
<tr>
<td>p.exe</td>
<td>Samp</td>
</tr>
<tr>
<td>sapftp.exe</td>
<td>sapftp</td>
</tr>
<tr>
<td>saphttp.exe</td>
<td>saphttp</td>
</tr>
<tr>
<td>sleep.exe</td>
<td>All2txt/Sta</td>
</tr>
<tr>
<td>librfc32.dll</td>
<td>rtConvUtil</td>
</tr>
<tr>
<td>All2txt\RunCo</td>
<td>All2txt/Co</td>
</tr>
<tr>
<td>nvUtil.bat</td>
<td>nvServ</td>
</tr>
<tr>
<td>All2txt\ConvSe</td>
<td>All2txt/Sta</td>
</tr>
<tr>
<td>rv.bat</td>
<td>rtConv</td>
</tr>
<tr>
<td>All2txt\StartCo</td>
<td>All2txt/All2</td>
</tr>
<tr>
<td>nv.bat</td>
<td>txt</td>
</tr>
<tr>
<td>All2txt\All2txt.bat</td>
<td></td>
</tr>
</tbody>
</table>

   The programs sapftp.exe and saphttp.exe (WinNT) or sapftp and saphttp (UNIX) are
   on the Client Installation CD.

4. Set up the RFC destination [Seite 553] to All2txt\RunConvUtil.bat or All2txt/StartConvUtil.
   Name the RFC destination ALL2TXT_RFC.

5. Make the settings Customizing for conversions [Seite 542].
   
   In the SAP reference IMG you will find Customizing of Conversion under the path:
   Logistics General → Conversion.

   - Select Maintain converter. Create a new entry with the following data:
**Example Installation of a Conversion Server**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the conversion server</td>
<td>All2txt</td>
</tr>
<tr>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>RFC destination for converter</td>
<td>ALL2TXT_RFC</td>
</tr>
<tr>
<td>Help programs (utilities) for conversion</td>
<td></td>
</tr>
<tr>
<td>FTP destination</td>
<td></td>
</tr>
<tr>
<td>HTTP destination</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Ready for conversions</td>
</tr>
<tr>
<td>Error number</td>
<td>000</td>
</tr>
</tbody>
</table>

- Select **Determine conversion**. Create a new entry with the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the conversion specification</td>
<td>DOC to TXT</td>
</tr>
<tr>
<td>Workstation application (source)</td>
<td>DOC</td>
</tr>
<tr>
<td>Workstation application (target)</td>
<td>TXT</td>
</tr>
<tr>
<td>Name of the conversion server</td>
<td>All2txt</td>
</tr>
<tr>
<td>Document Type</td>
<td>DRW</td>
</tr>
<tr>
<td>Automatically start according to status</td>
<td>RE (released)</td>
</tr>
<tr>
<td>Storage category for converted original application files</td>
<td>/tmp/all2txt</td>
</tr>
<tr>
<td>Language for error messages</td>
<td></td>
</tr>
<tr>
<td>Directory where files are checked out</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Earliest start time</td>
<td>00:02:00</td>
</tr>
<tr>
<td>Maximum time</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Start delay</td>
<td></td>
</tr>
<tr>
<td>Wait time, days</td>
<td></td>
</tr>
<tr>
<td>Time limit for converter (min)</td>
<td>When without errors, delete</td>
</tr>
<tr>
<td>Delete input files</td>
<td>When without errors, delete</td>
</tr>
<tr>
<td>Delete output files</td>
<td>Messages at the beginning and end of each conversion</td>
</tr>
<tr>
<td>Messages</td>
<td></td>
</tr>
<tr>
<td>Expiration date for application log</td>
<td></td>
</tr>
<tr>
<td>Check out depth</td>
<td></td>
</tr>
<tr>
<td>Structure of the files that were checked out</td>
<td></td>
</tr>
<tr>
<td>Epsilon for comparing lengths</td>
<td></td>
</tr>
<tr>
<td>Epsilon for angles</td>
<td></td>
</tr>
</tbody>
</table>

6. The installation is complete after you have saved your data.

Test the converter as follows:
- Create a document with the document type DRW.
- Create an original application file in the document using the workstation application DOC.
- Set the status of the documents to RE (released). Depending on the status network you may have to carry out more than one step.
- Save your document.

**Result**

Conversion starts. Note the [Messages in the application log][Seite 550].

After a several minutes open up the document again. You will see another original application file in the screen section *Original* if the conversion was successful, in this case the original application file is in *.txt* format.
Digital Mock-Up Viewing

Use

You can use this function to visualize new products as 3D models in the development phase throughout the whole enterprise. You can display a 3D model of an assembly and its components in the Engineering Workbench of the SAP System.

Other areas can now use product information that used to only be accessible on paper format to the engineering/design department as well. All departments involved in the development project can see the 3D model of an assembly on the screen even before a prototype is available.

Integration

CAD Interface

The SAP System obtains product information from a CAD system. You create a construction drawing the CAD system for the assembly and its components. While doing this you also set the spatial relations of the components to each other.

You use the CAD Interface [Extern] to transfer your BOMs and CAD documents from your CAD system to your SAP System.

Contact your CAD interface provider about whether SAP’s DMU Viewing is supported. If DMU viewing is supported the CAD coupling creates the required assignments and starts the converter that then creates the transformation matrices and original application files in Direct Model format.

See: Converting Assemblies [Seite 548]

Alternatively, the CAD coupling can write the transformation matrices. The converter creates the original application files in Direct Model format when a status is set.

See: Converting Documents (Automatic Start) [Seite 546]

A converter must be installed in both cases. Please note the Installation Notes [Seite 528].

Conversion Interface

The conversion interface SAP System along with the external converter control the conversion of the original application files as well as the creating of the transformation matrices that contain the information about the geometric positions of the components.

The system creates a visual 3D file (such as *.jt) out of the CAD document for each component. This file is then stored in the SAP System as an original application file of the Document Management System and managed by means of a document info record.

You can now use the viewer that is integrated into the SAP System from Engineering Animation, Inc. (EAI) to view your 3D models of assemblies. The viewer is part of the standard SAP System’s SAP Graphical User Interface (SAPgui) and is integrated into Engineering Workbench.

See: Viewer for Displaying Original Application Files [Seite 566]
**Prerequisites**

Original application files must be in a 3D format that supports *Digital Mock-Up*. Direct Model format (*.jt) is supported, for example.

The original application files in the SAP System are managed by means of *Document info records*. These document info records are assigned to items in your BOM.

*See: [Document Assignment](#) [Extern]*

**Transformation matrices** are also assigned to BOM items. A transformation matrix defines geometrical position of a component within space. When a component in an assembly is used more than once you need a transformation matrix for each part.

If you are working with multilevel BOMs, each level of the BOM must have a transformation matrix assigned to it.

💡

Set the parameter for *Digital Mock-Up* when you transfer data to the SAP System using the *CAD interface*. Once you have done this the system converts the original application files automatically and creates the document info records and document assignments. Further information can be found under [Conversion of CAD Files](#) [Seite 548].

In Customizing of Document Management you will find the setting for the viewer of the standard SAP System under General Settings → Define workstation application:

- You created the entry for the workstation application JT.
- Set which viewer you want to use to display the JT original application files for the workstation application. Work step: Maintain workstation application in network.

*See: [Displaying Original Application File with a Viewer](#) [Seite 506]*

**Features**

You can display a 3D model of an assembly and its components in the SAP System. You can display a 3D model on the screen without opening another window while processing or displaying a BOM in *Engineering Workbench*.

You can also display individual or several components. When you select several components the system calculates the geometric items of the component and sends them to the viewer for display. When the components are an assembly in and of themselves you can dismantle components and display or hide individual components.

💡

The BOM of an automobile contains the body and wheels, for example. You can just display the wheels or just the body.

When you display the body and the wheels or the whole automobile the system calculates the geometrical positions of the components and displays them.

When the body itself is an assembly you can also dismantle it into its components (fender, doors).

If the product has a multi-level BOM you can dismantle all assemblies for the 3D models of their components. This requires however that data from design drawings has been transferred to the
Digital Mock-Up Viewing

SAP System. You can do this for any number of levels. You can combine the components from any assemblies.

You can execute the following functions in 3D models:

- Display an individual component
- Display further components
- Hide individual components
- Display an entire assembly

You can also dismantle the components of assemblies to subordinate levels.

- You can highlight a component.
- Display a multi-level BOM

You can also use all the 3D functions of the viewer for displaying original application files such as:

- Rotating and tilting the 3D model
- Zoom
- Save the current screen contents of a file
Setting up Customizing for DMU Viewing

Use

Some data is already preset in the standard SAP System. Verify that this data is also correct and complete for your enterprise.

Special DMU Settings
Carry out the following steps under the structure node Control data:

- Define document types [Extern]
  Define a document type that you can use to manage the original application files that you create using the CAD interface. The interface is used when working with CAD drawings and the SAP System. For storing and checking in original application files we recommend you use the Knowledge Provider.

  Under the structure nodes Determine object links, you enter the document assignment for the following entries:
  - STKO_DOC for the assignment to a BOM header
  - STPO_DOC for the assignment to a BOM item

- Maintain screen for object link
  Screens [Extern] are already part of the standard SAP System that are required for links to BOM headers and BOM items.

  Verify the following entries or add others to them:

<table>
<thead>
<tr>
<th>Object</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>STKO_DOC (BOM header)</td>
<td>258</td>
</tr>
<tr>
<td>STPO_DOC (BOM item)</td>
<td>257</td>
</tr>
</tbody>
</table>

- Maintain key fields
  Key fields are already part of the standard SAP System that are required for links to BOM headers and BOM items.

  Verify the following entries or add others to them:

<table>
<thead>
<tr>
<th>Object</th>
<th>Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>STKO_DOC (BOM header)</td>
<td>GUIDX</td>
</tr>
<tr>
<td>STPO_DOC (BOM item)</td>
<td>GUIDX</td>
</tr>
</tbody>
</table>

Further entries (such as transaction codes) are not necessary for these link objects because the data is read internally.
Setting up Customizing for DMU Viewing

**Settings for Conversion**

When you use the CAD interface to transfer CAD data into the SAP System the CAD files are converted into visual 3D files (such as *.jt). You define the settings for the conversion process in Customizing for Conversion.

See [Customizing for Conversions](#) for more information about the required settings.

**Setting for the Integrated Viewer**

You can display your product with the integrated viewer of the standard SAP System. See [Viewer for Displaying Original Application Files](#) for more information about the required settings.
Viewer for Displaying Original Application Files

Purpose
The standard SAP System’s SAP Graphical User Interface (SAP GUI) now has a viewer from Engineering Animation, Inc. (EAI) that allows you to view your products in the PLM area [Extern]. This viewer works with all Windows 32 bit operating systems and can display most original application files of a document info record.

- Thanks to the integration of this viewer solution in the Product Structure Browser you can view not only technical drawings but also 3D models. There are different functions for navigation such as rotate, zoom, center. You can then use the functions for redlining for processing the objects, saving them or printing them out.

- You can view products during the development phase using Digital Mock-Up Viewing [Seite 561].

Implementation Notes
You must make the following settings in Customizing of Document Management for the viewer of the SAP System.

- Control data → Define document types
  The document type of the document info record that manages the original application file must have the Knowledge Provider [Seite 138] defined for the storage systems. This setting is done on the detail screen of the document type, indicator Storage via Knowledge Provider.

  You can only use viewer and redlining functions when the document type is so defined that it allows storage of original application files using Knowledge Provider.

  The original application file does not have to be stored in a storage category of the Knowledge Provider in order to display it. The file can also be in a logical directory with the local network.

  This type of storage is not always accessible by all frontend computers, whereas with the Knowledge Providers all frontend computers can access the original application files. SAP recommends therefore that all original application files be stored using the Knowledge Providers.

- General data → Define Workstation Applications [Extern]
  The following partial steps are necessary:
  - Assign the correct application (for example Direct Model) for the file format you want to display (for example *.jt).
  - Maintain all data on the Detail screen that are supported for processing original application files with the workstation application such as for the application Direct Model for processing JT files.
  - Select the navigation step Maintain workstation application in network. Enter the call for the viewer.
Viewer for Displaying Original Application Files

You can use this call to determine for such things as whether you want display 2D or 3D formats. The call for saying 3D formats (such as *.jt for Direct Model) with a workstation application could be done as follows:

EAIWeb.webviewer3D.1 %SAP-CONTROL%

Detailed information for the call of the application can be found in the IMG under Define workstation application.

Integration

You can view the product data in the following processing situations:

- **Product Structure Browser**
  
  You can expand the document data in a product structure and view the original application files of a document.

- **Document Management**
  
  You can display original application files from the tab page Document data or Originals.

- **Engineering Workbench**
  
  You can view original application files of material items from the Product Structure Browser.

- **Process using the Project Builder (change and display) or use the Internet-Scenario Collaborative Engineering**

Features

Supported Viewing Formats

The integrated viewer can display most 2D pixel, vector, and some text formats as well as 3D model formats. A complete overview is available in the List of Viewing Formats [Seite 254].

Calling the Menu

After the function Display original application file is started the original application file is displayed either inplace or outplace. The display variant is set for the individual processing situations (such as displaying from a document info record or the Product Structure Browser) and cannot be changed.

- **inplace**
  
  The original application file is displayed in the same window as the one used for processing.

  - Example: If you display the original application file while processing the document info record of the Product Structure Browser or Engineering Workbench, the system splits the screen and the current screen and displays the viewer in the new screen section.

  - In the screen section where the viewer is located the original application file is also displayed the viewer function bar becomes active.

- **outplace**
The original application file is displayed in a different window as the one used for processing.

If you display the original application file from the results screen of a document search, the system creates a new window automatically. In the new screen section the original application file is also displayed the viewer function bar becomes active.

See also: Displaying Original Application File with a Viewer [Side 506]

**Viewer Function Bar**

When you display the original application file with the integrated viewer the system adds a function bar for the viewer. The viewer function bar contains all the functions you can use in the current processing situation, such as Redlining functions. The scope of function depends on whether the viewer is displaying 2D or 3D format files.

An overview of the processing functions can be found in the Function Overview of the Viewer [Side 251].

**Redlining Function Bar**

The call of the Redlining functions is done from the viewer function bar. The system changes from viewer mode into Redlining mode and makes the Redlining function bar available.

For more information, see Redlining for Original application files [Side 259].

**Dimensioning 2D Files**

Dimensioning functions allows you to measure such things as angles, line and radii.

An overview of dimensioning functions can be found under Dimensioning 2D files [Side 270].

**Example**

The following example shows how an assembly is viewed in the Engineering Workbench. The assembly was transferred from a CAD system into the SAP-System (Digital Mock-Up Viewing).
Restrictions

The viewer can be used on machines with at least a Pentium® class processor at 133 MHz.

For 3D formats you will need the following:

- Pentium II
- 128 MB RAM
Displaying 3D Models of Assemblies

You are in the Engineering Workbench overview for items.

1. Click 
   The dialog box *EWB: Options* appears.

2. Select in the tab page *Browser* the option *Digital Mock-up*.
   In this way you ensure that the BOM in the object browser is displayed on a key date, this means that only change status is displayed for each BOM item.

3. Click 

4. Enter the change number or the key date in the dialog window that appears and select 
   The object browser is displayed in the left screen section. There you find the column with the heading *DMU* (Digital Mock-Up). In this column a check-box appears for each component.
   
   If you do not see the column *DMU* you must increase the size of the screen section of the object browser to the right.

You can use the check-boxes to hide or display individual components in the *DMU* column or use the context menu.

Displaying Components Using Check-Boxes

Click on the check-box to display or hide a component. The viewer is displayed as soon as the first check-box is activated.

You can see which assemblies and components are currently being displayed in the viewer by looking at the check-boxes.

When you activate the check-box for an item, the system automatically activates the check-boxes for the subordinate assembly. This displays that the data came from this assembly.

The advantage of this is that you can always recognize which assembly’s data is currently being displayed, even when you collapse the partial tree under the assembly.

Displaying Components Using the Context Menu

The context menu is displayed when you click with the right-hand mouse button on a BOM header or an item. The following commands are available in the context menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>System activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMU: Display item again</td>
<td>Delete the display in the viewer and display the individual components</td>
</tr>
</tbody>
</table>
## Displaying 3D Models of Assemblies

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMU: Add items</td>
<td>Display another component in the viewer while considering the components that are already displayed</td>
</tr>
<tr>
<td>DMU: Highlight items</td>
<td>Highlight components in the viewer</td>
</tr>
<tr>
<td>DMU: Hide item</td>
<td>Hide item in viewer</td>
</tr>
<tr>
<td>DMU: Display item</td>
<td>Show an item again that you had hidden with the command DMU: Hide item</td>
</tr>
</tbody>
</table>

**See also:**
- [Highlighting Components](http://extern)
Viewer for Displaying Original Application Files

Purpose

The standard SAP System’s SAP Graphical User Interface (SAP GUI) now has a viewer from Engineering Animation, Inc. (EAI) that allows you to view your products in the PLM area [Extern]. This viewer works with all Windows 32 bit operating systems and can display most original application files of a document info record.

- Thanks to the integration of this viewer solution in the Product Structure Browser you can view not only technical drawings but also 3D models. There are different functions for navigation such as rotate, zoom, center. You can then use the functions for redlining for processing the objects, saving them or printing them out.

- You can view products during the development phase using Digital Mock-Up Viewing [Seite 561].

Implementation Notes

You must make the following settings in Customizing of Document Management for the viewer of the SAP System.

- Control data → Define document types

  The document type of the document info record that manages the original application file must have the Knowledge Provider [Seite 138] defined for the storage systems. This setting is done on the detail screen of the document type, indicator Storage via Knowledge Provider.

  You can only use viewer and redlining functions when the document type is so defined that it allows storage of original application files using Knowledge Provider. The original application file does not have to be stored in a storage category of the Knowledge Provider in order to display it. The file can also be in a logical directory with the local network.

  This type of storage is not always accessible by all frontend computers, whereas with the Knowledge Providers all frontend computers can access the original application files. SAP recommends therefore that all original application files be stored using the Knowledge Providers.

- General data → Define Workstation Applications [Extern]

  The following partial steps are necessary:

  - Assign the correct application (for example Direct Model) for the file format you want to display (for example *.jt).
  - Maintain all data on the Detail screen that are supported for processing original application files with the workstation application such as for the application Direct Model for processing JT files.
  - Select the navigation step Maintain workstation application in network. Enter the call for the viewer.
Viewer for Displaying Original Application Files

You can use this call to determine for such things as whether you want display 2D or 3D formats. The call for saying 3D formats (such as *.jt for Direct Model) with a workstation application could be done as follows:

EAIWeb.webviewer3D.1 %SAP-CONTROL%

Detailed information for the call of the application can be found in the IMG under Define workstation application.

Integration

You can view the product data in the following processing situations:

- Product Structure Browser
  
  You can expand the document data in a product structure and view the original application files of a document.

- Document Management
  
  You can display original application files from the tab page Document data or Originals.

- Engineering Workbench
  
  You can view original application files of material items from the Product Structure Browser.

- Process using the Project Builder (change and display) or use the Internet-Scenario Collaborative Engineering

Features

Supported Viewing Formats

The integrated viewer can display most 2D pixel, vector, and some text formats as well as 3D model formats. A complete overview is available in the List of Viewing Formats [Seite 254].

Calling the Menu

After the function Display original application file is started the original application file is displayed either inplace or outplace. The display variant is set for the individual processing situations (such as displaying from a document info record or the Product Structure Browser) and cannot be changed.

- inplace
  
  The original application file is displayed in the same window as the one used for processing.

  - Example: If you display the original application file while processing the document info record of the Product Structure Browser or Engineering Workbench, the system splits the screen and the current screen and displays the viewer in the new screen section.

  - In the screen section where the viewer is located the original application file is also displayed the viewer function bar becomes active.

- outplace
The original application file is displayed in a different window as the one used for processing.

If you display the original application file from the results screen of a document search, the system creates a new window automatically. In the new screen section the original application file is also displayed the viewer function bar becomes active.

See also: Displaying Original Application File with a Viewer [Seite 506]

Viewer Function Bar

When you display the original application file with the integrated viewer the system adds a function bar for the viewer. The viewer function bar contains all the functions you can use in the current processing situation, such as Redlining functions. The scope of function depends on whether the viewer is displaying 2D or 3D format files.

An overview of the processing functions can be found in the Function Overview of the Viewer [Seite 251].

Redlining Function Bar

The call of the Redlining functions is done from the viewer function bar. The system changes from viewer mode into Redlining mode and makes the Redlining function bar available.

For more information, see Redlining for Original application files [Seite 259].

Dimensioning 2D Files

Dimensioning functions allows you to measure such things as angles, line and radii.

An overview of dimensioning functions can be found under Dimensioning 2D files [Seite 270]

Example

The following example shows how an assembly is viewed in the Engineering Workbench. The assembly was transferred from a CAD system into the SAP-System (Digital Mock-Up Viewing).
Restrictions

The viewer can be used on machines with at least a Pentium® class processor at 133 MHz.

For 3D formats you will need the following:

- Pentium II
- 128 MB RAM
Function Overview of the Viewer

The systems automatically starts the integrated viewer when you display an original application file in the supported processing situations either inplace or outplace.

Scope of functions for both display forms is identical. You can call functions as follows:

- The viewer function bar contains all the functions you can use in the current processing situation.
- You can use the context menu for a selection of functions. Depress the right–hand mouse button to call up the context menu in the screen section of the viewer.

The scope of function depends on whether the viewer is displaying 2D or 3D format files.

Functions for 2D Files

The following overview shows all the tab pages that are active when displaying 2D files. In the column Usage some of the functions are described.

<table>
<thead>
<tr>
<th>Tab Page</th>
<th>Functions</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Full-view</td>
<td>When an object cannot be completely viewed in the screen section of the viewer, you can use this function Full-view to display it again. This is useful with 2D files after having changed them with the following: Shift, Center, and Zoom.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Navigation</td>
<td>Shift</td>
<td>Under Align you will find the functions Rotate clockwise or Mirror horizontally.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Align</td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td>Redlining [Seite 259]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dimensioning [Seite 270]</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>Color</td>
<td>You can display the original application file in different colors according to the needs of the current processing situation. The simplified display can also increase performance (example: Monochrome and Grey scale 8 bit). The changed display of the original application file can be saved in the following formats:</td>
</tr>
<tr>
<td></td>
<td>Save format</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bitmap (24 bit color, 8 bit gray scale)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>JPEG (Color 24 bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TIF</td>
<td></td>
</tr>
</tbody>
</table>
Function Overview of the Viewer

<table>
<thead>
<tr>
<th>Layer</th>
<th>Original application file</th>
<th>When the viewer is started on the original application file is displayed only – No layer is active.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer name</td>
<td></td>
<td>The tab page Layer is not active if no layers exist yet for the original application file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only after you create a comment as a Markup [Seite 269] using Redlining functions and then saved them in one or more layers does the entry Layer appear and the layer names are listed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You load the saved information by clicking on the selected layer. The currently loaded layer is indicated by a check mark. You can process this layer and save the changes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clicking again deactivates the layer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When more than one layer is loaded and further comments added the comments are added to the active layer. The system determines the active layer based in the sequence of the layer loaded. The layer is active that is furthest on the bottom.</td>
</tr>
</tbody>
</table>

Functions for 3D Models

The following overview shows all the tab pages that are active when displaying 3D files. In the column Usage some of the functions are described.

<table>
<thead>
<tr>
<th>Tab Page</th>
<th>Functions</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Full-view</td>
<td>When an object cannot be completely viewed in the screen section of the viewer, you can use this function Full-view to display it again.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>This is useful with 3D files after having changed them with the following: Shift, Center, and Zoom.</td>
</tr>
<tr>
<td>Navigation</td>
<td>Rotate</td>
<td>You can rotate the 3D model about any axis freely in order to looks at the model from any angle. You can then create or anchor comments as Markups [Seite 269] using Redlining functions.</td>
</tr>
<tr>
<td></td>
<td>• x axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• y axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• z axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom area</td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td>Redlining</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Seite 259]</td>
<td></td>
</tr>
</tbody>
</table>
### Function Overview of the Viewer

| Options       | Performance Background Save format | You can improve performance dramatically by switching on *Frame view*, turning off *Interior view* or setting the *Number of frames* per second.  
|               |                                | The changed display of the 3D model can be saved in the following formats:  
|               |                                | - Bitmap (24 bit color, 8 bit gray scale)  
|               |                                | - JPEG (Color 24 bit)  
|               |                                | - TIF  

| Redlining files | When the viewer is started on the original application file is displayed.  
|                | If you create a comment as *Markups [Seite 269]* using Redlining functions and then saved them the Redlining files are listed.  
|                | When the viewer is started no Redlining file is active. You load the saved information by clicking on the selected Redlining file. |
List of Viewing Formats

You can use the integrated viewer from Engineering Animation, Inc. (EAI) to display the following formats and process using Redlining functions:

### 2D Formats

<table>
<thead>
<tr>
<th>2D village images files</th>
<th>AutoCAD DWG 2.5-14 (DWG)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AutoCAD DXF R11-14 (DXF)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD DWF (DWF)</td>
</tr>
<tr>
<td></td>
<td>CGM (CGM)</td>
</tr>
<tr>
<td></td>
<td>IGES (IGES, IGS)</td>
</tr>
<tr>
<td></td>
<td>HPGL/HPGL-2 (HPG, HPGL)</td>
</tr>
<tr>
<td></td>
<td>HP ME 10/30 MI (MI)</td>
</tr>
<tr>
<td></td>
<td>Calomp (906, 907)</td>
</tr>
<tr>
<td></td>
<td>CALS MIL-R Type I and Type II (MLR, MIL, MILR)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D pixel images files</th>
<th>Tagged Image File Format - Monochrome, color, &amp; grayscale (TIF)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows Bitmap (BMP)</td>
</tr>
<tr>
<td></td>
<td>JFIF Compliant (JPG, JPEG)</td>
</tr>
<tr>
<td></td>
<td>Portable Network Graphics (PNG)</td>
</tr>
<tr>
<td></td>
<td>EDMICS C4 (C4)</td>
</tr>
<tr>
<td></td>
<td>(TLC)</td>
</tr>
<tr>
<td></td>
<td>CompuServe (GIF)</td>
</tr>
<tr>
<td></td>
<td>MIL-RII - TRIFF (FSX)</td>
</tr>
<tr>
<td></td>
<td>SunRaster (RAS)</td>
</tr>
<tr>
<td></td>
<td>PICT-Macintosh Paint (PCT, PICT)</td>
</tr>
<tr>
<td></td>
<td>PC Paint (PCX)</td>
</tr>
<tr>
<td></td>
<td>Microstation (DGN)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D ASCII and Postscript files</th>
<th>ASCII Text (TXT)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PostScript I, II (PS)</td>
</tr>
<tr>
<td></td>
<td>Encapsulated Postscript (EPS)</td>
</tr>
</tbody>
</table>

### 3D Formats

Direct Model (*.JT)

Virtual Reality Modeling Language (*.WRL)
Stereolithography (*.STL)
Display Original Application File with the Viewer

Use
You can display original application files with the integrated viewer in the supported processing situations (for example, from the product structure or form the document info record).

See: Viewer for Displaying Original Application Files [Seite 566]

Prerequisites
You have made the setting in Customizing of Document Management for the viewer of the SAP System.

You are in a processing situation that supports viewing the original application file in the integrated viewer.

See: Viewer for Displaying Original Application Files [Seite 566]

Procedure
The following examples show you how to display an original application file in the different processing situations.

In all situation you can display the original application file by clicking on the button (Display original) or using the context menu (entry Display original).

Displaying Original Application File from the Product Structure
2. Display the product structure in the Product Structure Browser.
   See: Display Product Structure [Seite 482]
3. Explode the structure for documents.
   You can see whether a document versions has one or more original application files assigned to it:
   
   - Identifier in the display column Original with icon (Display original application files)
   - In the context menu the entry Display original exists.
4. Click on the icon Display original application file.
   The number of maintained original application files determines later procedures:

<table>
<thead>
<tr>
<th>Number of Original Application Files</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>No further action required. The original application file is displayed.</td>
</tr>
<tr>
<td>Several</td>
<td>You see a dialog box with a list. The list contains the workstation application or display a short text for the original application file. Select an original application file then choose Continue.</td>
</tr>
</tbody>
</table>
Displaying Original Application Files from the Document Info Record

3. Display the document info record.
   On the tab page Document data or Originals all existing original application files are listed.

4. Set your cursor on the line of the original application file you want to display. By double clicking on the original application file you start the viewer.

Result

The system checks the setting in Customizing of Document Management for the current frontend type (such as PC with operating system Microsoft Windows NT). Th system determines which viewer is appropriate for displaying the selected file format (for example *.ACD format for AutoCAD files calls a 2D viewer).

The viewer is started automatically and displays the data of the original application file in a new screen section.

The following example shows the redlining functions in addition to the viewer.
Display Original Application File with the Viewer

Display Document: Basic Data Engin/Des. Drawing (JB2)
Redlining for Original Application Files

Use

Especially in the development process of a product is it important to have an efficient exchange of information in order to save costs, time, and effort.

You can display your product with the integrated viewer of the standard system. All departments can visualize original application files in 2D and 3D formats.

Being able to see a product before it is produced allows you to expand on the scope of employees for product analysis. You can use Redlining functions to include original application files in other business processes. Users with authorization can add comments and suggestions to the document (for example, 3D model).

Integration

The standard SAP System’s SAP Graphical User Interface (SAP GUI) now has a viewer from Engineering Animation, Inc. (EAI). When you have made the setting in Customizing of Document Management for the viewer of the SAP System you can use Redlining functions without making any further settings.

See also: Viewer for Displaying Original Application Files [Seite 566]

Prerequisites

You can then use the functions for redlining when the following have been met:

- You have made the setting in Customizing of Document Management for the integrated viewer of the SAP System.

  See also: Viewer for Displaying Original Application Files [Seite 566]

- It is recommended to define the categories for markups, under General Data → Define category for markup.

  The remarks and comments (markups) that you create of an original application file are saved in a layer that you can also edit. You can edit a layer when the layer is assigned to individual categories (such as engineering/design, sales & distribution).

- The authorization assignment for editing layers is done with the authorization object for Document Management (C_DRAW_MUP – authorizations for markups).

  This authorization object controls which users can process which layers, based on a combination of activity and document type. You can restrict the check more by using document status and category.

Features

Calling the Menu

The Redlining functions are automatically available when you display an original application file with the integrated viewer in the supported processing situations.
Redlining for Original Application Files

Formats

You can create comments for original application files in all file formats that can be displayed by the viewer. The viewer can display the following formats:

<table>
<thead>
<tr>
<th>2D data</th>
<th>Vector data:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• With model character (such as DXF)</td>
</tr>
<tr>
<td></td>
<td>• With screen character (such as CGM)</td>
</tr>
<tr>
<td></td>
<td>• With plot character (such as HPGL)</td>
</tr>
<tr>
<td></td>
<td>Pixel data (such as TIFF, BMP, JPG)</td>
</tr>
<tr>
<td></td>
<td>Text data (such as ASCII, EPS, PDF)</td>
</tr>
<tr>
<td>3D model</td>
<td>Model data (JT, WRL, STL)</td>
</tr>
</tbody>
</table>

The complete list is available in the List of Viewing Formats [Seite 254].

Markups and Layers for Comments

You can write your comments on the original application file like when using a red pen. This does not change the actual original application file. Your comments are saved as Markups in a Layer. A list of the supported text and graphic elements for markups can be found here: Redlining Function Bar [Seite 262]

Other users add their comments to further layers. The system saves a layer for an original application file as an additional file for the original application file in the same storage data as the original application file itself.

The processing functions for layers depend on whether the viewer is displaying 2D or 3D format files.

<table>
<thead>
<tr>
<th>Format</th>
<th>Saving Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D data</td>
<td>The layer is saved as a transparent vector format (CGM) for 2D files.</td>
</tr>
<tr>
<td></td>
<td>• There is no limit to the number of layers for each original application file.</td>
</tr>
<tr>
<td></td>
<td>• You can display as many original application files and as many layers as you</td>
</tr>
<tr>
<td></td>
<td>want on top of each other in the viewer. The process is similar to when you</td>
</tr>
<tr>
<td></td>
<td>lay transparencies on top of one another on an overhead projector.</td>
</tr>
<tr>
<td></td>
<td>• The authorization assignment ensures that on authorized persons can create,</td>
</tr>
<tr>
<td></td>
<td>change or delete layers for documents of a particular document type.</td>
</tr>
<tr>
<td></td>
<td>• You can change or even delete the information that is stored in a layer.</td>
</tr>
<tr>
<td></td>
<td>• You can use the layer menu for easy processing of the individual layers.</td>
</tr>
<tr>
<td>3D model</td>
<td>The current development phase allows only storing redlining files in pixel format</td>
</tr>
<tr>
<td></td>
<td>(TIF) for 3D models. Storage is the same as the layers. More layer functions are</td>
</tr>
<tr>
<td></td>
<td>planned for future Releases.</td>
</tr>
<tr>
<td></td>
<td>• The system copies the 3D model into the Redlining file the way it currently</td>
</tr>
<tr>
<td></td>
<td>appears on the monitor screen (for example rotated on the X axis and with</td>
</tr>
<tr>
<td></td>
<td>frames) as well as with markups for your comments.</td>
</tr>
<tr>
<td></td>
<td>• Special Redlining functions for 3D Models are available such as anchoring</td>
</tr>
<tr>
<td></td>
<td>markups in the 3D model.</td>
</tr>
</tbody>
</table>
Activities

When you are in one of the named processing situations with the original application file in the integrated viewer you automatically see the application function bar. You can execute the following functions:

- Maintaining Layers for 2D Files [Seite 265]
- Creating Redlining Files for 3D Models [Seite 268]
- Executing Redlining Functions [Seite 269]
- Dimensioning 2D files [Seite 270]

The selection of the active functions depends on the current processing situation. For example it depends on whether the viewer is displaying 2D or 3D format files.
## Redlining Function Bar

See also: [Executing Redlining Functions](#) [Seite 269]

### General Redlining Functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Select Redlining object" /></td>
<td>Select Redlining object</td>
</tr>
<tr>
<td><img src="image2" alt="Highlight the markup object before cutting" /></td>
<td>Highlight the markup object before cutting.</td>
</tr>
<tr>
<td><img src="image3" alt="Cut" /></td>
<td>Cut</td>
</tr>
<tr>
<td><img src="image4" alt="Undo" /></td>
<td>Undo</td>
</tr>
<tr>
<td><img src="image5" alt="Redo" /></td>
<td>Redo</td>
</tr>
<tr>
<td><img src="image6" alt="Create layer" /></td>
<td>Create layer</td>
</tr>
<tr>
<td><img src="image7" alt="Save layer" /></td>
<td>Save layer</td>
</tr>
<tr>
<td><img src="image8" alt="Delete current layer" /></td>
<td>Delete current layer</td>
</tr>
<tr>
<td><img src="image9" alt="Settings" /></td>
<td>Settings</td>
</tr>
<tr>
<td><img src="image10" alt="Before you create markup objects, make these settings. You will on the tab page Extras special functions that are in an overview below called Special Redlining Functions for 2D Files." /></td>
<td>Before you create markup objects, make these settings. You will on the tab page Extras special functions that are in an overview below called Special Redlining Functions for 2D Files.</td>
</tr>
<tr>
<td><img src="image11" alt="Return" /></td>
<td>Return</td>
</tr>
<tr>
<td><img src="image12" alt="You return to the screen with the with the Viewer function bar. The current 2D original application file with the current layer is loaded, or the current 3D model with the current Redlining file is loaded." /></td>
<td>You return to the screen with the with the Viewer function bar. The current 2D original application file with the current layer is loaded, or the current 3D model with the current Redlining file is loaded.</td>
</tr>
</tbody>
</table>

### Markup Functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image13" alt="Draw free-hand" /></td>
<td>Draw free-hand</td>
</tr>
<tr>
<td><img src="image14" alt="Draw note arrow" /></td>
<td>Draw note arrow</td>
</tr>
<tr>
<td><img src="image15" alt="A selection of arrow type is under Extras, tab page Extras." /></td>
<td>A selection of arrow type is under Extras, tab page Extras.</td>
</tr>
</tbody>
</table>
### Redlining Function Bar

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw line</td>
<td>Create a line</td>
</tr>
<tr>
<td>Draw poly line</td>
<td>Create a polygon</td>
</tr>
<tr>
<td>Draw ellipse</td>
<td>Create an ellipse</td>
</tr>
<tr>
<td>Draw polygon</td>
<td>Create a polygon</td>
</tr>
<tr>
<td>Draw rectangle</td>
<td>Create a rectangle</td>
</tr>
<tr>
<td>Create text</td>
<td>Enter text</td>
</tr>
</tbody>
</table>

#### Create text
- Click on the button and a dialog box appears for entering text. After creating the comment, confirm your entry with the button. The system closes the dialog box.
- Put the cursor where you want to add the text.
- Click on the spot and the system positions the comment box according to the settings you made.

### Special Redlining Functions for 2D Files

#### Measuring functions
If you want to use these measuring functions, you must activate them.

**See also:** Dimensioning 2D files [Seite 270]

<table>
<thead>
<tr>
<th>Icon</th>
<th>Measuring function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle measurement</td>
<td></td>
</tr>
<tr>
<td>Line measurement</td>
<td></td>
</tr>
<tr>
<td>Radius measurement</td>
<td></td>
</tr>
</tbody>
</table>

**Calibrate**

This function only works with files in pixel format (such as *.BMP, *.TIF) because files in the vector format (such as *.DWG for AutoCAD) are already calibrated.

**See also:**
- Calibration [Seite 273]
- List of Viewing Formats [Seite 254]
### Special Redlining Functions for 3D Models

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Anchor Icon" /></td>
<td>Anchor</td>
</tr>
</tbody>
</table>

Anchoring a markup object keeps the markup object in the position where it was created. For example, when highlighting the piston of a motor with an arrow and then rotate the motor, the position for the arrow is always recalculated and rotates with the motor.

- Activate the anchor mode by clicking on ![Anchor Icon](image.png) *(Anchor)*. You can verify that the anchor mode is active. Place the cursor on the 3D model. The current cursor position is displayed using the little anchor symbol.
- Select the desired markup function. For example, if you want to draw a line click on ![Line Icon](image.png).
- Click on the model a second time to position the markup object.
Maintaining Layers for 2D Files

Use
You can create comments for an original application file without changing the original application file itself. You save the comments in a layer.

Prerequisites
You are displaying the original application file with the integrated viewer of the standard SAP system.

See also: Viewer for Displaying Original Application Files [Seite 566]

Creating Layers for 2D Files
You can create a layer from the viewer function bar as well as from the Redlining function bar.

In the viewer function bar the entry Layer appears when at least one layer exists for an original application file.

When one or more layers are loaded and you want to use Redlining functions it is recommended that you check which layers are loaded. Click on Layer. You see a list of all existing layers.

- The loaded layer is indicated by a check mark. Click on the layer to remove it from the screen section.
- Redlining functions are done using the active layer. The system determines the active layer based on the sequence of the layer loaded. The layer is active that is furthest on the bottom.

Creating Layers using the Viewer Function Bar
When you display the original application file with the integrated viewer of the standard SAP system and the viewer function bar is active.

See also: Viewer for Displaying Original Application Files [Extern]

A layer is automatically created when none exist and you switch to the Redlining processing mode.

3. In the viewer function bar select Tools → Redlining.

When no layer is currently active, the Layer name dialog box appears.

4. Enter a layer name and confirm with .

The remainder of the procedure depends on whether you have Redlining categories maintained for your enterprise in Customizing.

<table>
<thead>
<tr>
<th>Redlining Categories Maintained</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>no</td>
<td>The markup function bar appears that contains all the functions for creating markups.</td>
</tr>
</tbody>
</table>
Maintaining Layers for 2D Files

| yes | The dialog box Redlining category appears where the categories are listed that are maintained in your enterprise. Double-click on the desired category and the system assigns the new layer that is to be created to this category. The markup function bar appears that contains all the functions for creating markups. |

4. Create comments using the markup functions.
   - You can add a text, for example:
     - In the first step set up the layout; such as lines, framing, and text formats. Click on and the dialog box Settings appears for these settings.
     - Click on and a dialog box appears for entering text. After creating the comment confirm your entry with . The system closes the dialog box.
     - Put the cursor where you want to add the text.
     - Click on the spot and the system positions the comment box according to the settings you made.
   See also: Executing Redlining Functions [Seite 269]

5. Save the layer using .

Crating Layers Using the Redlining Function Bar

You display the original application file with the integrated viewer of the standard system. You selected the Redlining function in the viewer function bar (Tools → Redlining) and the Redlining function bar is active.

- Select . The dialog box Layer name appears.
- The rest of the procedure is the same as Crating Layers using the Viewer Function Bar.

Changing Layers for 2D Files

You are displaying the original application file with the integrated viewer of the standard SAP system and the viewer function bar is active.

2. Select Layer.
   - You see a list of all existing layers. You can use the context menu to display the attributes of the active layer, such as Redlining- category.

3. Double-click on the desired layer to see the comments made in the text.

4. Select Tools → Redlining.
   - The Redlining function bar contains all the functions you can use in the current processing situation, such as:
Delete a previous markup object.
Select the markup object you want to delete and cut it with.

Enter a new text.
Click on to make settings for lines, frames or text formats.
Click on and a dialog box appears where you enter your comments. Confirm with .
The system closes the dialog box.
Put the cursor where you want to add the text.
The system puts the comment where you click once.

5. Save the changes made to the layers.
You can return to the application function bar of the viewer by selecting (Back).
Creating Redlining Files for 3D Models

Use
You can create comments for a 3D model without changing the original application file. You save the comments in a Redlining file.

As opposed to the layers used for making comments on 2D files, you cannot make changes to a Redlining after you have saved.

Prerequisites
You are displaying the original application file with the integrated viewer of the standard SAP system.

See also: Viewer for Displaying Original Application Files [Seite 566]

Procedure
4. Display the 3D model in such a way so that you can make your comments as easily as possible. You can rotate the model about its X-axis for example.

5. Select Tools → Redlining.

   In the first step set up the layout; such as lines, framing, and text formats. Click on and the dialog box Settings appears for these settings.

   The remainder of the procedure depends on whether you want to anchor the markup in the 3D-model.

   – When you want to anchor the markup object, activate the anchor mode by clicking on (Anchor).
     You can verify that the anchor mode is active. Place the cursor on the 3D model. The current cursor position is displayed using the little anchor symbol.

   – Select the desired markup function. For example, if you want to draw a line click on .

   – Click on the 3D model. Clicking on the 3D Model again allows you to create the markup object.

      See also: Executing Redlining Functions [Seite 269]

6. Save the layer using .

   The system copies the 3D model into the Redlining file the way it currently appears on the monitor screen as well as the markups.

   You can return to the application function bar of the viewer by selecting (Back).
Executing Redlining Functions

Use
You can use markups to add comments and remarks to the displayed original application file. For 2D original application files these comments are saved in a layer and for 3D models they are saved as Redlining files.

General Redlining functions are for processing both 2D files and 3D models. Certain functions work only for one format or the other.

Prerequisites
You display the original application file with the integrated viewer of the standard system. You selected the Redlining function in the viewer function bar (Tools → Redlining). The screen section of the viewer displays the Redlining function bar. This bar contains all functions you can use to create, change, and delete markup objects for the original application files.

See also:
Maintaining Layers for 2D Files [Seite 265]
Creating Redlining Files for 3D Models [Seite 268]

Procedure
3. Before you create the markup objects you must set up the layout; such as lines, framing, and text formats.
   
   Click on and the dialog box Settings appears.

4. Select the markup function by clicking on the desired function in the Redlining function bar.
   
   See: Redlining Function Bar [Seite 262]
Dimensioning 2D Files

Use

The integrated viewer contains dimensioning functions so you can measure angles, lines and radii and save them to a layer. There are two ways of adding measurements to an original application file:

- You only need the measurements for the time being and therefore they do not have to be saved in a layer.
- You want to save the measurements for later processing purposes. In this case you save the measurements in an existing layer or create a new layer for the measurements.

Measurement Functions and Measurement Procedures

The following dimensioning functions can be used for measurement:

<table>
<thead>
<tr>
<th>Measuring function</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Angle measurement  | - Position the cursor on the first side of the angle and click the left-hand mouse button.  
|                    | - Position the cursor on the vertex of the angle and click the left-hand mouse button.  
|                    | - Position the cursor on the second side of the angle and click the left-hand mouse button.  |
| Line measurement   | - Position the cursor on the beginning point of the line and click the left-hand mouse button.  
|                    | - Position the cursor on the end point of the line and click the left-hand mouse button.  |
| Radius measurement | Position the cursor on three points one after the other for the circle to be measured. Click with the left-hand mouse button on each point.  |

The following measurement procedures can be selected:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Use</th>
</tr>
</thead>
</table>
| Pixel     | This measurement is best used with original application files in pixel format such as: *.TIF, *.BMP.  
|           | The basis of this procedure is the pixels that are saved in the original application file.  
|           | In order to preserve accuracy of the measurement results it is highly recommended that you Calibrate [Seite 273] before measuring lines and radii.  |
| Vector    | This measurement is best used with original application files in vector format such as: *.DWG, *.CGM.  
|           | The basis for this procedure is the data for the vectors (contact point, direction, and relief) that is saved in the original application file.  |
Dimensioning without Saving

You are displaying the original application file with the integrated viewer of the standard SAP system and the viewer function bar is active.

See also: Viewer for Displaying Original Application Files [Seite 566]

5. Select Tools → Dimensioning.

The system adapts the function bar for the new functions. For example, measurement and dimensioning functions as well as calibration are available.

A description of the meaning of the application functions can be found here: Creating Markups as Comments [Seite 269].

6. Select the measurement procedure for the original application file (for example pixel for *.TIF).

7. Select the measurement function (such as length measurement).

The remainder of the procedure depends on which measurement procedure you selected.

- If you selected Pixel it is recommended that you calibrate [Seite 273] first. Then execute the measurement function.
- If you selected Vector you can start immediately with the measurement function.

You can switch between any measurement functions.

8. You can return to the viewer function bar of the viewer by selecting ✕. The measurement data is not saved.

Dimensioning with Saving

You are displaying the original application file with the integrated viewer of the standard SAP System and selected Redlining functions. The Redlining function bar is active.

See also: Maintaining Layers for 2D Files [Seite 265]

8. Select Settings → Extras.

9. Make changes to the following settings in the dialog box that appears:

- Select Measurement functions on.

  You must set this indicator in order to use the measurement functions in the Redlining function bar.

- Select Calibrate if the original application file is a pixel format.

- Select the measurement procedure such as Pixel orientated.

- Confirm with ✔.

The Redlining function bar is active again.

10. Select the measurement function (such as length measurement).

- If you selected Pixel it is recommended that you Calibrate [Seite 273] first. Then execute the measurement function.

- If you selected Vector you can start immediately with the measurement function.
You can switch between any measurement functions.

11. Save the layer using 

Calibrate

Use

You need to calibrate when measuring and dimensioning lines and radii. This function is only used with files in pixel format (such as *.BMP, *.TIF) because files in the vector format (such as *.DWG for AutoCAD) are already calibrated. You can, for example, make a measurement of length for 10 centimeters (3.9 inches). For all further measurements there is a conversion according to the scale.

The *Calibrate* operation is dependent on how you carry out measurements:

- Calibrate, when you do not save the measurement
- Calibrate, when you save the measurement

**Calibrate, when you save the measurement**

You display the original application file with the integrated viewer. In the viewer function bar you selected *Tools → Dimensioning*. The measurement procedure is set to *Pixel*.

**See also:** Dimensioning 2D files [Seite 270]

5. Select *Calibrate*.

6. Highlight the length that you want to use for all measurements as a point of reference:
   - Position the cursor on the beginning point of the line and click the left-hand mouse button.
   - Pull the cursor to the end point of the line. The line then appears. Click the left-hand mouse button.

   The *Calibration* dialog box appears automatically.

7. Enter the *Distance* and the *Unit of measure* (for example 10 centimeters).

   Confirm with ✓.

8. Select the measurement function (*Line-* or *Radius measurement*).

**Calibrate, when you save the measurement**

You are processing a layer. The screen section of the viewer displays the Redlining function bar.

**See also:** Dimensioning 2D files [Seite 270]

12. In the Redlining function bar select *Settings → Extras*.

13. In the data group *Measurement functions* select *Calibrate*.

   Confirm with ✓. The Redlining function bar is active again.

14. Highlight the length that you want to use for all measurements as a point of reference.

   The remainder of the operation is the same as in *Calibrate, when you do not save the measurement*. 
Search Functions

Use
The system includes options for finding documents if you do not know the document key or only know part of the key.

Features

Search Criteria
You can use known data for the document find function that are either directly related to the document info record or come from the environment of the document. This data is known as search criteria.

The following data will lead to a quick result of a document find:

- Data from the document info record
- Characteristic values from the class that was used to classify the document
- Key data of an object that is linked to the document
- Text elements from short or Long texts
- Key data of a document from the document hierarchy
- Signature data

Options for Finding a Document
If you want to see a graphic of the options for finding a document, see Options for Finding a Document [Seite 274] which search function you choose is dependent on the known document data.

The following table shows which known document data you can use for which functions for finding documents.

<table>
<thead>
<tr>
<th>When you know the following data...</th>
<th>Then search using...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data from the document info record</td>
<td>The Find Document Function [Seite 277]</td>
</tr>
<tr>
<td>Characteristic values from the class that was used to classify the document</td>
<td></td>
</tr>
<tr>
<td>Key data of an object that is linked to the document</td>
<td>The Find Document Function [Seite 277]</td>
</tr>
<tr>
<td>Text elements</td>
<td>The Find Document Function [Seite 277]</td>
</tr>
<tr>
<td>Key data of a linked R/3 object from the area of PDM</td>
<td>Product Structure Browser [Seite 468]</td>
</tr>
<tr>
<td>Key data of any document with the document hierarchy</td>
<td>Explosion of Links Between Documents [Seite 73]</td>
</tr>
<tr>
<td>Signature data</td>
<td>Digital Signature [Seite 84]</td>
</tr>
</tbody>
</table>
You can also search for documents over the Internet [Extern].
Graphic: Options for Finding a Document

The following graphic shows options for finding a document.
The Process of Finding Documents

Purpose
The search function *Find documents* can be executed when you know document data or data from the environment of the document. The results of the find documents function are listed with all documents that fulfill the selection criteria. You can set up the document list so only the desired information is displayed. You can further process the documents from this document list.

Process

Entering the Selection Criteria
Start the search with *Document* → *Find*. You see the *Find Document: Selection criteria*. Four tab pages support entering selection criteria:

<table>
<thead>
<tr>
<th>Tab pages</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document data</td>
<td>Finding a Document using Document Data [Seite 279]</td>
</tr>
<tr>
<td>Classification</td>
<td>Finding a Document via Classes [Seite 281]</td>
</tr>
<tr>
<td>Linking objects to a document</td>
<td>Finding a Document via Object Links [Seite 282]</td>
</tr>
<tr>
<td>Texts</td>
<td>Finding a Document via Text Elements [Seite 284]</td>
</tr>
</tbody>
</table>

Each search for documents puts a load on the system by accessing the database. For example, if you do not know either the document number or the document type, and enter the special character * (or blank) in both fields, the system searches through all the documents in the system.

However, you can considerably reduce the load on the system by defining your selection criteria carefully. For this reason, the system allows you to search for documents in different ways. Enter as much data as you know to obtain as short a hit list as possible.

The Process of Finding Documents
The following graphic shows the internal process of searching for a document.
The Process of Finding Documents

Processing the Document List

The results of the find documents function are listed with all documents that fulfill the selection criteria. You can process the list the documents as well as the allocated original application files.

See also: Evaluation and Processing of the Document List [Seite 290]
Finding Documents Using Document Data

Use

The key fields have a decisive influence on the number of database accesses and therefore on the runtime of the Find function. If you enter main parameters, the system only uses secondary indices as a starting point for further selection. You can speed up the document search by making at least one entry in the key fields. To avoid overloading the system the R/3 Standard system has the maximum hit number set at 100.

Procedure

   
   You see the Find Document: Selection criteria.

2. You can enter known key fields and document data on the tab page Document data, such as:

   – You can make a generic entry in the Document and Document type field.

     | Entry          | Hits        |
     |----------------|-------------|
     | Document number: DR* | DRIVE-01-022 |
     |                 | DRILL-09-09 |
     | Document type: D* | DRW         |
     |                 | D-1         |

   – You can make a generic Find entry in the User field. To do this, enter the character string you know, followed by the special character *. Display the input help. A dialog box appears that contains the user name with this set of characters. Additionally, you see the department that this user belongs to, provided this information has been entered in the user master record.

     | Entry: BR* |
     | Result: BRUSH |
     | BRADY |

   – You can display the possible entries for the WS application (workstation application) and the Data carrier fields. You cannot make a generic entry.

   – The system sets the special character * as a default in the CAD indicator field (display documents irrespective of the CAD indicator).

     The system also includes the following options for selecting documents by CAD indicator:
Finding Documents Using Document Data

<table>
<thead>
<tr>
<th>Entry</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Documents <em>with</em> a CAD indicator</td>
</tr>
<tr>
<td></td>
<td>Documents <em>without</em> a CAD indicator</td>
</tr>
</tbody>
</table>

- If required, enter status data.
  
  If you want to find a document with a certain status, enter data on the status. Enter the language-dependent abbreviation of the status in the *Document status* field. The system checks the status in the logon language.
  
  You can set the time frame for searching for documents using the fields *Date from* and *Date to*.
  
  You can find further information as well as examples of searches in the online documentation about status fields.

3. Confirm your entries. Choose another tab page or start the find function with *Execute*.

**Result**

You see the search result in the form of a list containing all the documents that meet the search criteria you entered.

From this list, you can change and display documents and display original application data.

**See also:** [Analyzing the Document List after Selection](Seite 290)
Finding Documents Using Classification

Prerequisites
This function allows you to use all the search options available in the classification system. The system searches for all the documents that match your search criteria (such as characteristic values). You see a list of documents that match your criteria. From this list, you can select documents by entering other selection criteria (for example, a text string).

You can only use this function for documents that have been classified.

Procedure
   
   You see the Find Document: Selection criteria.
2. Enter the Class and Class type on the Classification tab page.
   
   The R/3 standard system has the class type 017 (document management) set for documents.

   The class data remain even when you repeat a search. You can recognize class data by its tab page. The title Classification is indicated by the character (*).
3. Choose Continue.
   
   The system lists all characteristics of the class entered, for example, Format, Paper quality).
4. You restrict the search area by assigning values to the characteristics, such as, Format Legal size. The system only selects objects whose characteristics have values that match your entries.
5. Confirm your entries. Choose another tab page or start the find function with Execute.

Result
If the system finds documents based on the values the screen Find document: Hit list.
From this list, you can change and display documents and display original application data.

See also: Analyzing the Document List after Selection [Seite 290]
Finding Documents Using Linked Objects

Prerequisites
You can only find a document via linked objects if you know at least one object link.

If the document is linked to other R/3 objects (for example, material master records), you can shorten the document hit list considerably by entering the keys of the linked object master records.

Procedure
   You see the Find Document: Selection criteria.
2. Select the tab page Object links.
   Another tab page appears that contains a tab page for each R/3 object type.

   A tab page is not displayed for each R/3 object type. This restriction is set with the entry of document data on the tab page Document data. If you have restricted the search for one or several document types the system only reports the R/3 object types that were chosen in Customizing of the document types.
3. Enter the key fields for the objects on each tab page.

   The object type (for example, Material) is located on the tab page. As soon as you have entered an object for the document search the system adds the icon (Links exist) to the text for the object type.

   This link is an AND-link. The system only reports documents that are linked to all of the listed objects.

   You can enter several individual objects (for example, material masters TUBING-01 and TUBING-02) for each R/3 object (for example, material). You can also enter other R/3 objects (for example, Equipment E-1).

   The system only reports documents that are linked to both materials AND with the equipment.

   The object links remain even when you repeat a search. You can recognize object data on the superior tab page Object links. The title Object links are indicated by the character (*).
4. Confirm your entries. Choose another tab page or start the find function with Execute.

Result
You see the search result in the form of a list containing all the documents that meet the search criteria you entered.
From this list, you can change and display documents and display original application data.

See also: Analyzing the Document List after Selection [Seite 290]
Finding a Document via Text Elements

Prerequisites
You can only find a document using text elements if you know a text string from the descriptive text. The system reads the short and long texts that describe the document and searches for a character string that you enter.

Procedure
   You see the Find Document: Selection criteria.
2. Select the Texts tab page.
3. Enter the language you want the system to use to search for the text string.
4. Enter a search term or text string in the first line. Capitalization is not important because all characters are converted to capitals.
   - The following special characters can be used as wild cards within the string:
     * an unspecified number of characters or no character
     + An individual character.
   - You have six lines for variants that you can set as AND links or OR links.
   - If you know character strings that do not occur in the description of the document you are looking for, you can enter them in the last three text lines (BUT NOT). Document info records that contain these negative search criteria do not appear in the search result.

The class data remain even when you repeat a search. You can recognize text elements by their tab page. The title Texts is indicated by the character (*).
5. Confirm your entries. Choose another tab page or start the find function with Execute.

Result
You see the search result in the form of a list containing all the documents that meet the search criteria you entered.

From this list, you can change and display documents and display original application data.

See also: Analyzing the Document List after Selection [Seite 290]
Resetting or Deleting Search Data

Use
You delete or reset search data if

- No documents were found using the given search data.
- You want to find documents with other data.

Deleting Individual Search Data
You delete individual search data on special tab pages.
1. Choose a tab page such as Classification.
2. Delete the data.
3. Choose another tab page or start the find function with Execute.
   
   The deleted document data are no longer read during the find function.

Resetting all Search Data
You delete the search data on all tab pages with one work step by using the Reset function.
There are then no longer any restricting data for the document find. The following fields are exceptions:

<table>
<thead>
<tr>
<th>Fields with default values</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Logon language</td>
</tr>
<tr>
<td>Maximum number of hits</td>
<td>100</td>
</tr>
</tbody>
</table>
Definition of Selection Variants

Use
Selection variants combine several selection criteria and simplify finding documents. You save several search criteria in one template. You can use this template to avoid entering often-used individual search criteria on various tab pages.

Prerequisites
We recommend you enter several search criteria for documents find.

Features
The type of selection variants, either general standard variants or user-specific, is dependent on which users can use them.
- **Standard Variants**
  A standard variant is a selection variant that any user can allocate before a document find.
- **User Variants**
  A user variant can only be allocated to the user before the document find that created selection variant.

Activities

Creating Selection Variants
   You see the Find document: selection criteria screen
2. Enter the search criteria on tab page, for example Classification, Texts.
3. Choose Save selection variants.
   You see the Save selection criteria dialog box.
4. Enter a technical name and a description.
5. You can also set the indicator User-specific. In this case you can use the selection variants.
6. Save the selection variants.
   The Find document: Selection criteria screen reappears. You can now start the document find function.

Choosing Selection Variants
   You see the Find Document: Search criteria
2. Choose Choose selection variants.
   You see the Choose selection criteria dialog box.
3. Position the cursor on the selection variants and choose Copy.
   
   The system copies the selection criteria into the tab page.

   The Find document: Selection criteria reappears. You can now start the document find function.

   ![Light Bulb]

   You can reset all the search data by choosing Reset selection criteria.

**Displaying the Overview of Selection Variants**

   
   You see the Find Document: Selection criteria.

2. Choose Selection variants → Management.

3. A list appears that contains all the Standard variants.

4. You can list the User variants by choosing User variants.

   ![Light Bulb]

   You can delete individual selection variant on these lists.
Full Text Search for Original Application Files

Use
You can use the full text search to find documents according to known data in the original application files.

Integration
The full text search is done using Content Management Service [Extern] (component of the SAP Knowledge Provider [Extern]). See: Document Search in the World Wide Web [Seite 298]

Prerequisites

Storage Data of Original Application Files
The full text search only reads original application files that are stored in the Knowledge Provider.

Settings in the SAP System
1. The Content Server is installed
2. Set the Content Server for indexing preparation:
   - Start the function Monitoring for Knowledge Provider (transaction code SKPR07).
   - Enter the document class DMS_PCD1.
   - Select Edit → Administration.
   - A dialog box appears where the following data is preset:

<table>
<thead>
<tr>
<th>Document Area</th>
<th>DMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration table</td>
<td>DMS1DIDSTA</td>
</tr>
<tr>
<td>Class can be indexed</td>
<td>X</td>
</tr>
</tbody>
</table>

   - Set the indicator: Setup indexing.

3. Select in Customizing of Document Management the MIME types that you want to be read for the full text search; under General Data → Settings for storage systems → Create MIME types for full text search.

4. Schedule the full text search for cyclical background preparation.
   - Execute transaction Start job (transaction code SM36).
   - Schedule the job for the following ABAP program: RSTIRIDX (Report for indexing stored documents).

Features
The IMS full text search allows you to use a known character string from the content of the original application file in a search.

You can start a full text search in the following processing situations:

- Standard SAP System: Function Document → Find
Internet scenario Finding Documents in the World Wide Web [Seite 298], for example from the Workplace

Activities

On the initial screen of the document search enter known data from the document info record such as Person responsible. In the lower section of the screen you can enter the search text with the known character string form the original application file.

The result is a list of documents that you can process.

See:

Evaluation and Processing of the Document List [Seite 290] (for processing in the SAP System)

Document Search in the World Wide Web [Seite 298]
Evaluation and Processing of the Document List

Purpose
You can process the document list as well as individual document info records and their original application files.

Prerequisites
The system has selected at least one document that fulfills the search criteria.

Process
The system creates a list of the documents that fulfill the search criteria that you entered.

We recommend you proceed as follows for an optimal evaluation of document information:

1. Process the document list. Reduce the reported documents again and restrict the data to the required information. For rather large lists we recommend you sort them according to their importance.

   See: Determining Contents of Document Lists [Seite 291]

2. Save the contents of your list. There are many possibilities for saving the contents of a list for later use and for making it available to other users.

   See: Keeping Document Lists [Seite 293]

3. Process the individual documents.

   Documents that you want to process from the document list can be selected and put together in a temporary worklist.

   See:
   Processing Documents from Document Lists [Seite 295] and Processing Documents from Worklists [Seite 296]
Determining Contents of Document Lists

Use
You see a document list of all the documents that meet the search criteria you entered. You can choose the information that you want to display about the individual documents for display.

Procedure
You can set up the list in the following ways:

- **Define Filter**
  You can restrict the documents reported even further by using a filter that you set with certain document data for the available value range.
  - Select (Set filters). You see the Define filter criteria dialog box.
  - Select the fields whose values you want to restrict further (for example, Document type).
    If you set a value range of DA* to DW* for the document type before starting a document search you can use the filter to restrict the document type to DRW at a later point.
  - Choose Copy. The Filter criteria dialog box appears that you can use to enter restrictive values for selected fields.
  - Confirm your entries. The document list appears that has been updated using the filter criteria.

  You can delete filter settings by choosing (Set filter). The dialog box Filter criteria appears as soon as filter settings exist. Choose (Delete selection indicator) or (Delete selection completely).

- **Sorting Document Data**
  You can sort the individual document data that is displayed in a table-like structure.
  - Choose (Sort in ascending order) or (Sort in descending order). You see the Define sort order dialog box.
  - Select the fields whose data you want to sort (for example Document type, User) and whether want them sorted in ascending or descending order.
  - Choose Copy. The document list appears that has been updated using the sort criteria.

  You can delete sort settings by choosing (Sort in ascending order) or (Sort in descending order). Select a field in the area Sort fields in the dialog box Define sort order and choose (Cut).

- **Defining Display Variants**
  Use display variants which fields in the document list are displayed or hidden.
Determining Contents of Document Lists

- Choose (Current display variants). You see the Define display variants dialog box.
- Select the fields you want to display and set the width of the columns.
- Choose Copy. The document list appears that has been updated using field selection.
- You can save the display variants as user-related or for general use.

You can replace the current display variant with an existing by choosing (Select display variants). A dialog box appears that displays all general display variants as well as display variant that you have saved as user-specific variants.
Keeping a Document List

Use
You can carry out various functions so you can call the document list at a later point or so you can make it available to other users.

Procedure
You can keep complete document list as follows:

- **Creating and Printing Print lists**
  - Choose \(\text{(Create print list)}\). The Report screen appears. Print output.
  - Enter the print parameter and specify the user-specific fixed values.
  - Choose Print.

- **Sending Document Lists**
  You can send document lists using SAPoffice to user of the R/3-System or to external addresses such as Internet addresses.
  - Select \(\text{(Send)}\). You see the Create and send document screen.
  - You can enter additional information. Enter the recipient in the lower section of the screen. The print list is already entered as and attachment on the tab page Attachment.
  - Select Send.

  When you send the print list within the R/3 System the recipient receives the SAPoffice document in the Business Workplace inbox. The recipient can then display the document as follows: Office → Workplace → inbox → Unviewed documents.

- **Creating Local Files**
  You can save the list in a file that is managed by your file system.
  - Choose \(\text{(Local file)}\).
    The dialog box Save list in appears
  - Choose one of the following formats:
    - Unconverted
    - Spreadsheet
    - Rich Text Format
    - HTML format
    The dialog box Copy list into local file appears
  - Enter path and the file name.
  - Choose Transfer.
Processing Documents from Document Lists

Use
You can process either an individual documents or several at a time from the document list for example Display.

If you searched for documents using different criteria the results are displayed in several document lists. If you want to process these documents together in one work step you can create a Worklist [Seite 296] and process the documents from the worklist.

Prerequisites
You must define the checks in an enterprise-specific program when you want to start enterprise-specific processes for individual processes. In the standard SAP System the function module DMS_PROC_DOC_DELETE is available that you can use to set the deletion indicator for selected documents (development class CV, function group CV100).

Enter this program in Customizing Document Management; under General Data → Enter processing procedure for documents.

Procedure
1. Select the document that you want to process with the same function.
2. Choose one of the possible processing functions:

<table>
<thead>
<tr>
<th>Document info record</th>
<th>Original application file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Display</td>
</tr>
<tr>
<td>Change</td>
<td>Print</td>
</tr>
</tbody>
</table>

If you chose Display (Display original application file) and several original application files exist for the document info record a dialog box appears. Choose the application for displaying the original application file. Double-click to start the application with the original application file.

3. Start the enterprise-specific process as necessary.
Processing Document from the Worklists

Use
Sometimes you need to determine which documents you want to process with more than one using the find function more than once. Perhaps you need to execute find functions more than once with different search criteria. A document list appears after each execution. You can process individual or all documents from the find results list. Worklists allow you to process related documents from different document lists.

The worklist is saved temporarily. It is deleted when you call Document → Find again.

Prerequisites
You must start find functions with different search functions.

Procedure
2. Enter your search criteria and choose Execute.
   See: Finding a Document using Document Data [Seite 279]
   You see the Document List According to Selection screen.
3. Select the documents you want to process and choose (Fill worklist).
   The system copies your selected documents to the worklist. The function Worklist is now active in the function bar.
   You can display the contents of the worklist by selecting Worklist. You can return to the document list by selecting (Back).
4. You finish processing the document list after copying the data that you require into the worklist.
   Select (Back). The Find document: Selection criteria screen reappears.
5. Enter the new selection criteria and start the find function again.
   The Document List According to Selection screen reappears. The temporary worklist still exists and the function worklist is active.
6. Select the documents you want to process and choose (Fill worklist).
   The system adds the selected documents into the existing worklist.

Result
You can carry out functions and process one or more documents after you have set up the worklist.
See: Changing a Document from the Document List [Seite 295]
Finding Documents in the World Wide Web

Use

You can now search for documents in the Document Management System even when you do not have access to a SAPGUI of the SAP System by using the Internet scenarios Find documents. Starts the document search in your own Workplace.

In order to keep the document search as effective as possible you can enter the following known data before you start the search:

- Document data (attribute) that either comes directly from the document info record or from the environment of the document
- Data from the contents of the original application file

Integration

Finding Attributes

There are two methods for finding attributes:

1. You can use the standard function of the SAP System (database selection).
2. You use an external search engine. It is advantageous to be able to use simple spoken-language-style search queries.

   The connection to external search engines is done using the Index Management Service [Extern], a component of the SAP Knowledge Provider [Extern].

- IMS is a service with an open programming interface for the selected search engines. The search engines can be chosen to match your needs in your enterprise and be installed on a computer or machine that is accessible over your network or the Internet.
- The R/3 Gateway connects IMS with the SAP System using RFC. You must therefore first enter an RFC destination Customizing and maintain the settings for the R/3 Gateway.
- The original application files are stored in the Knowledge Provider Content Server. The server uses the HTTP interface.

Full Text Search

The full-text search can only be done using an external search engine that is connected to the Index Management Service.

Prerequisites

Index Management Service

You must make the required settings in Customizing for the Document Management System. Under the node Document search in the World Wide Web execute the following activities:

- Maintain Search Server Relation
- Set up search engine index
Enterprise-Specific Processes

You can start various enterprise-specific processes from the results screen of the document search (Document list).

- Create a function module for each enterprise-specific process. The function module contains special checks and processes.
- Under the node Document search in the World Wide Web execute the following activity: Create processing procedure for document
  Detailed information can be found in the IMG for Document Management.

Selection criteria

Before you start the document search enter the known data from the document info record (metadata):

The connection of the external search engine using Index Management Service allows the following entries:

- Data from projects that is assigned to the document
- Characteristics values after classification
- Search Text from the Original Application File [Seite 304] (full text search)

Services

Various services are available for the document search. The differences relate to:

- Use of the search engine
- The scope of function for further processing of the documents in the document list

Services that require an External Search Engine

The following services require that an external search engine be connected:

- CVSE_SEARCH
- CVSE_MAINTAIN

The following overview shows a comparison of the two services.

<table>
<thead>
<tr>
<th>Similarities</th>
<th>Differences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope of the selection criteria</td>
<td>Selection of activities that can be executed from the results list (Document list):</td>
</tr>
</tbody>
</table>
|                                     | • CVSE_SEARCH
|                                     |     You can display documents and transfer into a worklist in your Workplace. |
|                                     | • CVSE_MAINTAIN
|                                     |     You can display documents and transfer into a worklist in your Workplace.  |
|                                     |     You can change the content of the original application file and storage data (check in / out). |
Finding Documents in the World Wide Web

**Services that do not require an External Search Engine**

The following services do not require that an external search engine be connected:

- CVW3
- CVW4

The following overview shows a comparison of the two services.

<table>
<thead>
<tr>
<th>Similarities</th>
<th>Differences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope of the selection criteria</td>
<td>Selection of activities that can be executed from the results list (Document list):</td>
</tr>
</tbody>
</table>
|                               | - CVW3
|                               |   You can display documents and transfer into a worklist in your Workplace. |
|                               | - CVW4
|                               |   You can display documents and transfer into a worklist in your Workplace. |
|                               |   You can change the content of the original application file and storage data (Check in / out). |

**Search Results**

The search results are presented as a document list where the data for each document is displayed such as:

- Key data for identification (document, document type, document part, document number)
- Status
- Person responsible
- Workstation application for processing the original application file and the size of the file

Further processing possibilities depend on the service selected. The following overview contains the function selection.

<table>
<thead>
<tr>
<th>Service</th>
<th>Supported Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVSE_SEARCH</td>
<td>Display document data such as:</td>
</tr>
<tr>
<td>CVW3</td>
<td>- Document data from the document info record</td>
</tr>
<tr>
<td></td>
<td>- Object links</td>
</tr>
<tr>
<td></td>
<td>- Status log</td>
</tr>
<tr>
<td></td>
<td>- Class data</td>
</tr>
<tr>
<td></td>
<td>- Display original application file</td>
</tr>
<tr>
<td></td>
<td>Files must be accessible in the file system or be stored in the Knowledge Provider.</td>
</tr>
<tr>
<td></td>
<td>They transfer documents into a worklist in your Workplace.</td>
</tr>
</tbody>
</table>
Display document data (see Service CVW3, CVSE_SEARCH).

They change document data such as:

- Document status
- Document data of the document info record (such as person responsible)
- Storage data (such as storing in a storage system)

You can execute an enterprise-specific process (such as release for production).

They transfer documents into a worklist in your Workplace.

You are processing an original application file.

- Change content
- Change storage data (Check in / out)

### Activities

See: [Document Search in the World Wide Web](Seite 302)
Searching for Documents in the Web

Use

You can use the document search form to search for documents from the Document Management System (DMS), using the Internet and without access to the SAP-GUI of the SAP system.

We supply a predefined form for the document search. It is divided into the following areas:

- Input field for object type for which a document is sought
- Input field for free text search: *Find*
- Search constraints: *Additional Search Criteria*

Prerequisites

You have defined the form layout using SAP@Web Studios [Extern].

If you access the form using Create Internal Service Request from the launchpad in the Employee Workplace, you must first choose the appropriate form.

Procedure

1. Enter the object to which the document you are looking for is linked.
   
   This is optional.

2. Enter the search term in the *Search for* field

   The system searches for all documents indexed using this search term. This is also optional. You can only control your search by means of the specifications you enter under *Additional Search Criteria*.

3. Enter one or more constraints under *Additional Search Criteria*. 
4. Choose *Find*.

**Result**

The system determines the appropriate documents.
Full Text Search for Original Application Files

Use
You can use the full text search to find documents according to known data in the original application file.

Integration
The full text search is done using Content Management Service [Extern] (component of the SAP Knowledge Provider [Extern]). See: Document Search in the World Wide Web [Seite 298]

Prerequisites

Storage Data of Original Application Files
The full text search only reads original application files that are stored in the Knowledge Provider.

Settings in the SAP System

3. The Content Server is installed
4. Set the Content Server for indexing preparation:
   • Start the function Monitoring for Knowledge Provider (transaction code SKPR07).
   • Enter the document class DMS_PCD1.
   • Select Edit → Administration.
     A dialog box appears where the following data is preset:

     | Document Area | DMS     |
     |----------------|---------|
     | Administration table | DMS1DIDSTA |
     | Class can be indexed | X       |

   • Set the indicator: Setup indexing.

4. Select in Customizing of Document Management the MIME types that you want to be read for the full text search; under General Data → Settings for storage systems → Create MIME types for full text search.

5. Schedule the full text search for cyclical background preparation.
   Execute transaction Start job (transaction code SM36).
   Schedule the job for the following ABAP program: RSTIRIDX (Report for indexing stored documents).

Features
The IMS full text search allows you to use a known character string from the content of the original application file in a search.

You can start a full text search in the following processing situations:
• Standard SAP System: Function Document → Find
• Internet scenario Finding Documents in the World Wide Web [Seite 298], for example from the Workplace

**Activities**

On the initial screen of the document search enter known data from the document info record such as *Person responsible*.

In the lower section of the screen you can enter the search text with the known character string form the original application file.

The result is a list of documents that you can process.

**See:**

Evaluation and Processing of the Document List [Seite 290] (for processing in the SAP System)

Document Search in the World Wide Web [Seite 298]
# Document Structures

## Definition

A document structure is a complete and formally structured list of linked documents including their document number, document type, document part, version, and quantity.

## Usage

Document structures help you organize complex information (documents) by creating information units. For example, you can use a document structure to manage the entire documentation on a very complex product, which consists of a text file, several technical drawings, photographs, various service manuals, and films containing operating instructions.

## Structure

A document structure is created for a document info record.

- The document structure only contains document items and text items.
- You only enter certain quantity data as general item data. Only the Item relevant to engineering and Item relevant to plant maintenance item statuses are supported.
- Recursive document structures are not supported.

The following graphic shows a document structure.

![Document Structure Diagram](image-url)
Each document in a document structure can have a document structure (assembly) of its own.

The term *assembly* comes originally from the context of material BOMs. In the context of document structures, this term is used to describe a set of linked documents and text items.

**Integration**

On the *Basic data screen*, you can recognize a document that has a document structure by the *Document structure exists* indicator.

You can define revision levels for a document structure to reflect the different change statuses of a product. Similar documents that contain only certain different items can be grouped together to form *variant* document structures and assigned to a joint BOM group.

You can use a document structure as an assembly more than once in different BOM categories (for example, material BOMs, equipment BOMs). See: [Multiple Use of Documents](Seite 308).

You can create a where-used list to determine the BOMs and document structures in which the assembly is used.

The mass change function allows you to replace an old document with a new one in several document structures or BOMs at once.
Multiple Use of Documents

A defined unit (assembly) can be used in several BOMs or document structures. Conversely, each document structure can exist only once physically. A document structure describes logical links between documents.

The following graphic shows how one assembly can be used in several equipment BOMs and material BOMs at once. (The warning messages form a document structure.)
Maintenance Functions for Document Structures

Scope of the Function

You can call these functions directly from the Basic data screen when you are processing the document.

- If you call a function for processing a document structure, you see the BOM processing screens.
- When you have finished processing the document structure (functions Save, Back, Exit), you see the Basic Data screen of the document info record again.

The following table shows the document structure processing functions.

<table>
<thead>
<tr>
<th>What do you want to do with the document structure?</th>
<th>Choose...</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Environment → Document structure → Create</td>
<td>The Document structure exists indicator is not set until you save the document.</td>
</tr>
<tr>
<td>Change</td>
<td>Environment → Document structure → Change</td>
<td>You can perform mass changes for documents in more than one document structure: Create, replace, delete, documents, change item data.</td>
</tr>
<tr>
<td>Display</td>
<td>Environment → Document structure → Display</td>
<td></td>
</tr>
</tbody>
</table>
Exploding Document Structures

Usage
The function for exploding a document structure from top to bottom gives you a list of all the documents and text items contained in the structure.

Each document contained in a document structure can have its own document structure, as well as being a component in other assemblies. These document structures are exploded completely, level by level. The depth of the explosion levels is unlimited.

Integration
You can explode the document structure directly from the processing function for the document info record.

Prerequisites
If a document has a document structure, this is indicated in the document info record in the Document structure field.

Activities
   You see the Validity dialog box.
2. In the Valid from field, enter the date for which you want to explode the document structure. The current date is displayed as the default value.
   Confirm your entry. When you confirm, the system checks whether the document structure is valid on this date.
   – If it is not valid, you see a message telling you that there is no valid data. This can indicate, for example, that the document structure is not valid on the date entered, or that there are no valid items.
   – If it is valid, you see the Explode BOM: Level by Level.
3. On the Explode BOM: Level by Level screen, the system lists all the items that are valid on the date entered. The item quantities refer to the required quantity displayed in the list header.
   – All components on the first level (1) are listed first. The system uses different colors to make a distinction between the individual components.
   – Components that are assemblies have an indicator in the Assm. (Assembly) field. They are not yet exploded.
   – The individual explosion levels are separated by a horizontal line.
   – If a component is an assembly (that is, if it has its own document structure), the structure is exploded on the next level (2) in a separate block. All assemblies for components of the preceding level are displayed one after the other. Once all the assemblies have been listed for all the components of one level, the system goes to the next level.
– If the authorization group of a component is not in your user profile, the assembly is not exploded further. If this is the case, you see a message in the component description line (Component authorization group is not in user profile).

Document items that occur more than once in a document structure are listed each time they occur.
Where-Used List for Documents

**Usage**

A where-used list answers the following questions: In which BOMs or document structures is a document used? How many times is it used there? This is something that you need to know in particular if you are using several documents in different places.

To determine the BOMs or document structures in which a document is used, you must explode the BOMs and document structures from bottom to top using the *Where-used list* function.

**Scope of the Function**

Only single-level where-used lists are supported for documents. The system finds the BOMs and document structures which contain the document in question either directly (as a document component) or indirectly (as an object allocated to a class component).

You can enter the following selection criteria for the where-used list:

- Type of use
- Selection
- Use in
- Selection criteria

**Type of Use**

In this dataset, you can determine that the system finds the BOMs and document structures which contain the document directly (as a component) or indirectly (as a class item).

- **Direct Use**
  
  You see all the BOMs and document structures which contain the document as a document component.

- **Indirect Use (Using Class)**
  
  You see all the BOMs and document structures which contain the document as an object allocated to a class item.

  If you select this option, the system marks all the documents that are allocated to a class item with an indicator in the where-used list.

**Selection**

You can create a where-used list for different effectivity periods. Using the *Valid from* and *Valid to* fields, you can define the period for which the system is to generate the list.

The following table shows the options that you have for defining the effectivity period.

<table>
<thead>
<tr>
<th>Make entries in these fields...</th>
<th>To define this effectivity period...</th>
</tr>
</thead>
</table>

April 2001
Where-Used List for Documents

<table>
<thead>
<tr>
<th>Valid-from date from change master record</th>
<th>Change number</th>
</tr>
</thead>
<tbody>
<tr>
<td>The date is copied from the change master. You see all the BOM data that is valid on the valid-from date or on an alternative date defined in the change master record.</td>
<td></td>
</tr>
</tbody>
</table>

| A particular date | Valid-from date: date as of which the BOM or document structure is to be displayed. Valid-to date: same as valid-from date. |
| A particular period | Valid-from date: date indicating the beginning of the period Valid-to date: date indicating the end of the period |
| Maximum effectivity period | Valid-from date: deletion indicator “!” at the beginning of the field. Valid-to date: no entry |
| Up to and including a particular date | Valid-from date: deletion indicator “!” at the beginning of the field. Valid-to date: date up to which BOM data is to be displayed. |
| A particular revision level | Revision level |
| revision level that was assigned to a change with reference to a particular change number. The system copies the valid-from date from the change master record. |

Use in BOMs

In this dataset, you can select the BOM categories for which you want the system to generate the where-used list:

- Document structure
- Equipment BOM
- Material BOM
- Standard BOM
- Functional location BOM

Further Selection Criteria for the Where-Used List

To ensure that the where-used list only contains the specific information you need, you can define further selection criteria. You do this on another screen in four datasets:

- Define view
- Restrict view
- Extend view
Where-Used List for Documents

- Format profile

For more information, see the PP Bills of Material Guide (Help → R/3 Library → Production Planning → Bills of Material Guide).

Activities

1. From the main Document Management screen, choose Environment → BOMs.
   You see the Bills of Material screen.

2. Choose Reporting → Where-used list → Document single-lev.
   You see the Document single-level screen.


4. Enter data in the Type, Selection, and Use in datasets as required.
   This allows you to restrict the where-used list to the BOMs and document structures you require.

5. Choose Continue.
   You see the View screen, where you can define the selection criteria for the where-used list.

6. Choose Execute.
   - You see a list of all the BOMs and document structures which contain the document and in which the defined selection criteria are met. The list can include, for example, material BOMs or equipment BOMs. Material BOMs are displayed first, followed by equipment BOMs.
   - At the top of each list item, you see the identifying data of the document concerned. Then you see the document item data (for example, item number and quantity) from the BOM or document structure where the document is used.
Variant Document Structure as a BOM Group

Usage

A BOM group for document structures comprises the documents and texts that together describe a number of documents. For example, you can create a BOM group for a document structure if a document has several versions whose document structures mostly have identical items.

You obtain one summarized BOM for all document structures in a BOM group. The overview shows you the variant in which a certain item is contained and the quantity. You can call several functions from this overview. For example, you can delete an item in certain variants, change item quantities, or add new items to particular variants.

Prerequisites

You can only create a BOM group (variant document structure) if the following requirements have been met:

- All the documents for whose document structures you want to create a joint variant document structure must have the same document type.
- The document for which you want to create a variant must not have a document structure.

Scope of the Function

You use a variant document structure to represent a number of similar documents. To do this, you add variants to an existing document structure.

You can maintain a BOM group for document structures starting either from the Document Management or from the Bills of Material screen:

- From the Document Management menu, choose Environment → Bills of material → Bill of material → Document structure → Create to maintain the BOM group.
- From the Bills of Material menu, choose Bill of material → Document structure → Create to maintain the BOM group.

Activities

   You see the Create Document Structure: Initial Screen.
2. Enter the key fields of the document for which you want to create a variant document structure.
3. Enter data to describe the validity of the document structure, if required.
   - If you enter a change number, the change master must allow the processing of document structures.
     If the change number identifies an engineering change request, your document structure must be defined as a change object, and the change request must have been approved and converted to an engineering change order.
Variant Document Structure as a BOM Group

4. Choose Create variant of...
   You see the Create Variant of... dialog box.

5. Enter the key fields of the document for whose document structure you want to create the variant.
   If you do not know the data, you can use the matchcode function to find it.

6. Confirm your entries.
   You see the Create Document Structure: Reference screen.

   If there are no items in the reference document structure that are valid on the valid-from date you entered on the initial screen, you see a warning message. In this case, the system displays the Header: Quantities/Long Text screen.

7. Select the item(s) you want to copy, then choose Copy.
   You see the Document Item Overview. The system has copied the header data and the selected items from the reference document structure to the document structure you are creating.

   The Copy function always includes the header of the source document structure.
   If the document structure for which you are creating a variant has no items, or if you have not selected any items, you see a dialog box with a warning message. In the dialog box, you can specify whether you want to copy just the header.

8. Correct the item data or add new item data, as required. Save your document structure.
Changing a BOM Group (Variant Document Structure)

Prerequisites
You are processing a document info record that has a document structure or BOM group.

Procedure
   You see the Change BOM Group: Initial Screen.
2. Enter data to identify the BOM group.
   To do this, enter either the BOM group or the fields of the document key.
3. Enter data to describe the validity of the document structure, if required.
   If you enter a change number, the change master must allow the processing of document structures.
   If the change number identifies an engineering change request, your document structure must be defined as a change object, and the change request must have been approved and converted to an engineering change order.
4. Confirm your entries.
5. You see the Summarized BOM.
   This overview shows a list of all the items of the BOM group, including the component quantities. The list of alternatives contains all the variants in the BOM group. In each item block, the system marks the variants in which the item concerned is used.
   – Displaying all the item data
     Select the item(s) and choose Complete item data. You see the General item data. From here, you can call the other detail screens.
   – Displaying variants
     To do this, call up the Summarized BOM screen and choose Var.Overw.
   – Changing the component quantity
     To do this, call up the Summarized BOM screen. Please note that this change affects all the variants where the item is used.
     If you want to enter a different component quantity for a specific variant, you must recreate the component with the new quantity and allocate it to the variant concerned.

   ![Tip](image)
   On the Summarized BOM screen, the allocation of the item to a variant is only displayed. If you also want to use the item in another variant or delete it from one or several variants, change the allocation of the item to the variant concerned on the Item in Variant(s) screen.
6. Changing the allocation of an item to a variant
   Select the item on the Summarized BOM screen and choose Item variants.
Changing a BOM Group (Variant Document Structure)

You see the Item in Variant(s) screen, containing a list of all the variants in the BOM group. You can set the allocation indicators here. The system copies the allocation to the Summarized BOM screen.

7. Adding new items

To do this, call up the Summarized BOM screen and choose New items.

You see the New Document Items screen, on which you enter the fields of the document key as well as the quantity. When you create the item, you immediately assign it to a variant on the Summarized BOM screen.

8. Deleting an item

Select the item on the Summarized BOM screen and choose Delete item.

9. Save your changes to the BOM group (variant document structure).
Displaying a BOM Group (Variant Document Structure)

You use this function to display all the variants in a BOM group. You see a summarized BOM which shows you the variant in which a certain item is contained and the quantity.

Procedure

   
   You see the Display BOM Group: Initial Screen.

2. Enter data to identify the BOM group.
   
   To do this, enter either the BOM group or the fields of the document key. If you enter both, the system ignores the entries in the key fields.

3. Enter data to describe the validity of the document structure, if required.
   
   – If you enter a change number, the system copies the valid-from date from the change master. All the document structure data that is valid on this date is displayed.
   
   – If you want to display the document structure for the maximum validity period, enter the special character ! at the beginning of the Valid field.

4. Confirm your entries.

5. You see the Summarized BOM.
   
   This overview shows a list of all the items of the BOM group, including the component quantities. The list of alternatives contains all the variants in the BOM group. In each item block, the system marks the variants in which the item concerned is used.
   
   – You can display all the item data by selecting the item(s) and then choosing Complete item data. You see the General item data. From here, you can call the other detail screens.
   
   – You can display the individual variants in a variant overview. To do this, call up the Summarized BOM screen and choose Var.Overview.

Result

You can call other functions from this overview. For example, you can display item data and document structure data.
Enhancements to the SAP Systems in the Area of PLM

Purpose

You can optimize your work processes in the area of Product Lifecycle Management (PLM) by changing and enhancing the scope of functions the standard SAP System. The enhancements are part of the standard SAP System and can be set up in your SAP System by means of enterprise-specific logic.

Enhancements

The following is an overview of the supported enhancements in the area of PDM.

<table>
<thead>
<tr>
<th>Enhancement</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer exit</td>
<td>Use</td>
</tr>
<tr>
<td>See also:</td>
<td>The function process of the standard SAP System is done by means of customer exit within the SAP System enhancement concept. The exits provided with the system do not have any functionality of their own. They simply represent a starting point for additional document distribution functions which you can develop using company-specific logic.</td>
</tr>
<tr>
<td></td>
<td>Integration</td>
</tr>
<tr>
<td></td>
<td>The customer exits are programmed as function module exits. You create an enhancement project by editing an enhancement that SAP has supplied. The enhancement contains the function module for the required function. The function module leads to an include program where you encode the enterprise-specific function requirements.</td>
</tr>
<tr>
<td></td>
<td>Prerequisites</td>
</tr>
<tr>
<td></td>
<td>When you use a function exit, you must create a company-specific include program that matches the programming logic of the function module. For example, the data that can be transferred from the include program to the standard program, and vice versa, is predefined here. Since each call for a customer-specific function module used contains both export and import parameters, the customer-specific function modules are also equipped with this predefined interface.</td>
</tr>
</tbody>
</table>
Enhancements to the SAP Systems in the Area of PLM

**Use**

Business Add-Ins are defined parts within a source that can add coding for different software levels, such as branches, partners, or customers, without changing the original program itself. The coding of the standard SAP System allows you to add implementation where the methods for the enterprise-specific processing are set.

**Integration**

The coding of the standard SAP System contains the definitions of the interfaces as well as the calls for the application programs. This enhancement is made of an interface and a method.

Each Business Add-in is made up of various methods that can be called in preset processing situations. The methods set the operations for the documents or their original application files. The enterprise-specific coding is entered in Implementation.

**Prerequisites**

You must enter the enterprise-specific enhancements in an implementation. You must create an implementation for the Business Add-In you have chosen and enter the required coding for the method. After the implementation is active you can use it when executing the application program.

**Business Transaction Events**

You can use two types of interfaces for modifying and enhancing the standard SAP System:

- Publish & Subscribe interface (informative interfaces)
  The interface informs that a particular result has been produced and transfers the data to external software.

- Process interface (Process)
  This interface replaces the standard processes from the SAP System.

**User exits in Customizing**

You determine in Customizing of the application which enterprise-specific changes you want to carry out. You will find detailed notes in the IMG.

---

Use the ABAP Workbench for the customer exits as well as for business add ins. Modification to SAP sources and ABAP Dictionary Objects are done within SAP Software Change Registration (SSCR).

These changes are upward compatible. This means that they remain effective even after an upgrade or installation of a support package.

### Enhancements for Objects from the Area of PDM

The following overview shows which enhancements are supported for which SAP objects.

<table>
<thead>
<tr>
<th>SAP Object</th>
<th>Customer exit</th>
<th>Business Add-In</th>
<th>Business Transaction Events</th>
<th>User Exits</th>
</tr>
</thead>
</table>

April 2001 321
Enhancements to the SAP Systems in the Area of PLM

<table>
<thead>
<tr>
<th>Document [Seite 323]</th>
<th>X</th>
<th>X</th>
<th>X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material [Seite 356]</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Change master record [Seite 358]</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bills of Material [Seite 360]</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Enhancements in Document Management

Use

You can set up work processes in the area of Document Management with different enhancements at an enterprise level.

Information about enhancements as well as an overview of planned enhancements to SAP objects in the area of PDM can be found in Enhancements to the SAP System in the Area of PDM [Seite 320].

Features

The following overview shows which enhancements are supported in the standard SAP System in the area of DMS.

<table>
<thead>
<tr>
<th>Enhancement</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>See also: Customer exit [Extern]</td>
<td></td>
</tr>
<tr>
<td>Enhancements using Business Add-Ins [Seite 341]</td>
<td>The coding of the standard SAP System allows you to add more than one implementation where the methods for the enterprise-specific processing of document info record and original application files are set.</td>
</tr>
<tr>
<td>See also: Business Add-In [Extern]</td>
<td></td>
</tr>
<tr>
<td>Enhancements using User Exits in Customizing [Seite 354]</td>
<td>You determine in Customizing of the Document Management which enterprise-specific changes you want to carry out. You will find detailed notes in the IMG.</td>
</tr>
</tbody>
</table>
Enhancements using Customer Exits (Document)

Use

In order to optimize the business processes in document management you can change some functions of the SAP System by using Customer Exits [Extern]. You can, for example, add additional authorization checks.

See also:
Enhancements of the SAP System in the Area of PDM [Seite 320] and The SAP System Enhancement Concept [Extern]

Prerequisites

When you use a function exit, you must create a company-specific include program that matches the programming logic of the function module.

You want to determine the original application files for a distribution order. You create an enhancement project where you use the enhancement CVDI0003 (Determine original application files). The enhancement contains the function module for the required function (for example, EXIT_SAPLCVV1_003). The function module branches to the include program zxcvv5u02. You use this include program to program your specific functional requirements.

Features

The tables below show the enhancements for customer exits used in document distribution (development class CVDI).

Enhancements for Function Group XCVV1 (Recipient List)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save recipient list</td>
<td>CVDI0001</td>
<td>EXIT_SAPLCVV1_001 [Seite 452]</td>
</tr>
<tr>
<td>Modify initial values for screen 100</td>
<td>CVDI0002</td>
<td>EXIT_SAPLCVV1_002 [Seite 453]</td>
</tr>
<tr>
<td>Determine original application file</td>
<td>CVDI0003</td>
<td>EXIT_SAPLCVV1_003 [Seite 456]</td>
</tr>
<tr>
<td>Determine document part and version of a document</td>
<td>CVDI0004</td>
<td>EXIT_SAPLCVV1_004 [Seite 458]</td>
</tr>
<tr>
<td>Create distribution order</td>
<td>CVDI0005</td>
<td>EXIT_SAPLCVV2_001</td>
</tr>
</tbody>
</table>

Enhancements for Function Group XCVV2 (Distribution Order)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create distribution order</td>
<td>CVDI0005</td>
<td>EXIT_SAPLCVV2_001 [Seite 458]</td>
</tr>
</tbody>
</table>
## Enhancements using Customer Exits (Document)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check part order</td>
<td>CVDI0006</td>
<td>EXIT_SAPLCVV2_002 [Seite 459]</td>
</tr>
<tr>
<td>Create initial order</td>
<td>CVDI0007</td>
<td>EXIT_SAPLCVV2_003 [Seite 460]</td>
</tr>
</tbody>
</table>

### Enhancements for Function Group XCVV5 (Events)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine context</td>
<td>CVDI0008</td>
<td>EXIT_SAPLCVV5_001 [Seite 462]</td>
</tr>
</tbody>
</table>

### Enhancements for Function Group XCVW (ITS Access)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITS access</td>
<td>CVDI0009</td>
<td>EXIT_SAPLCVVW_001 [Seite 464]</td>
</tr>
</tbody>
</table>
Finding Recipient Lists (EXIT_SAPLCVV1_001)

Definition
Function module that is called by customer exit CVDI0001 when a recipient list is saved and before the data is written to the database.

Use
You cannot change the program logic. You can only change the data in the logic.

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i_action</td>
<td>I, U</td>
<td>➔</td>
<td>Create a recipient list, Change a recipient list</td>
</tr>
<tr>
<td>e_return</td>
<td>0, &lt;&gt;0</td>
<td>←</td>
<td>OK, Error</td>
</tr>
<tr>
<td>c_drzao</td>
<td></td>
<td>↔</td>
<td>As database structure DRZAO (general data in a recipient list)</td>
</tr>
</tbody>
</table>

Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DRZA</td>
<td>As database structure CVIDRZA (recipient-document relations)</td>
</tr>
<tr>
<td>T_DRZAT</td>
<td>As database structure CVIDRZAT (language-dependent description)</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvv1u01.
Screen: Basic Data for Maintaining Documents

Definition
Function module that is called by customer exit CV110001.

Use
You can add to and enhancement the dialog for maintaining document data (function module in development class CV, function group CV110).

Integration
You can enter your company-specific programming logic in the source code of include program ZXCV110U01.
Screen: Recipient Lists (EXIT_SAPLCVV1_002)

Definition

Function module that is called by customer exit CVDI0002 after the data for recipient list screen (screen 100, program SAPLCVV1) has been read.

Use

Depending on the function (i_function) called, documents, recipients, or general data is determined. You can change this data in the include program. The modified data is then displayed on screen 100 (program SAPLCVV1).

If you change recipient data, for example, the changes must also be made in the following tables:

- Table T_DRZA (document recipient relation)
- Table T_REC (to display the change in the table control)

Structure

The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;&gt;0</td>
<td>Error</td>
</tr>
</tbody>
</table>
Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DRZA</td>
<td>As database structure CVIDRZA (document/recipient relation)</td>
</tr>
<tr>
<td>T_DOC</td>
<td>As database structure CVIDOC_TAB (documents displayed in the table control)</td>
</tr>
<tr>
<td>T_REC</td>
<td>As database structure CVIREC_TAB (recipients displayed in the table control)</td>
</tr>
<tr>
<td>T_IMP_OBJ</td>
<td>As database structure CVDIOBJ (table with selected document that was used to start the function)</td>
</tr>
</tbody>
</table>
**Integration**

You can enter your company-specific programming logic in the source code of include program zxcv1u02.
**Determine Original Application File (EXIT_SAPLCVV1_003)**

**Definition**

Function module that is called by customer exit CVDI0003 to determine the original application file that is to be sent.

**Use**

If the file is to be distributed manually (in dialog mode), this value is a default value and can be overwritten.

**Structure**

The interface is structured as follows:

**Parameters that can be processed in the Function Module**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0, &lt;&gt;0</td>
<td>OK, Error</td>
</tr>
</tbody>
</table>
### Determine Original Application File (EXIT_SAPLCVV1_003)

<table>
<thead>
<tr>
<th>importing</th>
<th>i_function</th>
<th>CR</th>
<th>→</th>
<th>Create recipient list</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>CH</td>
<td></td>
<td>Change recipient list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DI</td>
<td></td>
<td>Display recipient list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RD</td>
<td></td>
<td>Display all recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>of a document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DR</td>
<td></td>
<td>Display all documents sent to a recipient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SC</td>
<td></td>
<td>Start distribution with</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Recipient Lists</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SW</td>
<td></td>
<td>Start distribution with dialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SN</td>
<td></td>
<td>Start distribution without dialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SR</td>
<td></td>
<td>Start distribution without reading existing recipient list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ST</td>
<td></td>
<td>Start distribution with standard recipient list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RE</td>
<td></td>
<td>Restart distribution with dialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RP</td>
<td></td>
<td>Restart distribution of a package with dialog</td>
</tr>
</tbody>
</table>

- **i_objkey**
- **i_context**

<table>
<thead>
<tr>
<th>changing</th>
<th>c_original</th>
<th>←→</th>
<th>Determined original application file 1,2 or A (for 1 and 2)</th>
</tr>
</thead>
</table>

### Integration

You can enter your company-specific programming logic in the source code of include program `zxcvvvlu03`. 
Document Part and Version (EXIT_SAPLCVV1_004)

Definition
Function module that is called by customer exit CVDI0004. This function module is used to determine the key fields “document part” and “version” for the document to be distributed.

The customer exit is called when distribution is started for the recipient list (transaction CV17).

Use
The last version released is determined and proposed as a default for all documents in the recipient list. To determine a different version, enter your own logic for determining the version in the include.

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value Result</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>importing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e_doktl</td>
<td></td>
<td></td>
<td>Document part</td>
</tr>
<tr>
<td>e_dokvr</td>
<td></td>
<td></td>
<td>Document version</td>
</tr>
<tr>
<td>e_return</td>
<td>0</td>
<td>(\rightarrow)</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>&lt;=0</td>
<td></td>
<td>Error</td>
</tr>
<tr>
<td>exporting</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>i_doknr</td>
<td></td>
<td>(\leftarrow)</td>
<td>Document number</td>
</tr>
<tr>
<td>i_dokar</td>
<td></td>
<td></td>
<td>Document Type</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvv1u04.
Create Distribution Order (EXIT_SAPLCVV2_001)

Definition

Function module that is called by customer exit CVDI0005.

This customer exit is checked in the `create` method of BOR object BUS1082 (function module CVV2_DDO_CREATE – create distribution order). The exit is called after an initial order has been created and the INITIATED event has been generated.

Use

The distribution order parameters can be modified in the include. Individual part orders that are not relevant for distribution can be deleted from the table. Status `IG` or `ER` must be set in the customer exit for these part orders. You can use function module CVV3_DDOC_SET_READY (set part order status) for this purpose.

Structure

The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0</td>
<td>←</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;&gt;0</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Error</td>
</tr>
<tr>
<td>changing</td>
<td>c_drzo</td>
<td>←→</td>
<td>As database structure DRZO (distribution order data)</td>
</tr>
</tbody>
</table>

Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DDOC</td>
<td>List of part order numbers (structure: CVIORDERCOMP)</td>
</tr>
</tbody>
</table>

Integration

You can enter your company-specific programming logic in the source code of include program zxcvv2u01.
Check Part Order (EXIT_SAPLCVV2_002)

Definition
Function module that is called by customer exit CVDI0006.
This customer exit is checked in the check method of BOR object BUS1082 (function module CVV2_DDO_CHECK – check distribution order). The exit is called after an initial order has been created and the INITIATED event has been generated.

Use
The status of the part order is set to ER (error) if the e_return parameter returns a value <>0. A special process is implemented in the workflow for part orders that contain errors.

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;&gt;0</td>
<td>Order part has errors,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>do not distribute</td>
</tr>
<tr>
<td>importing</td>
<td>ddoc_id</td>
<td></td>
<td>Part order number</td>
</tr>
</tbody>
</table>
Create Initial Order (EXIT_SAPLCVV2_003)

Definition
Function module that is called by customer exit CVDI0007 when the system creates an initial order.

Use
The initial order data and part order data can be modified. You can also specify a status to be set for the part orders. If an error occurs in this customer exit, it must be output with the following statement: 
```
MESSAGE ID id TYPE mtype NUMBER n raising ERROR.
```

Structure
The interface is structured as follows:

Tables whose Data can be Changed (Changing)

<table>
<thead>
<tr>
<th>changing</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c_drzoi</td>
<td>Initial order data (structure DRZOI)</td>
</tr>
</tbody>
</table>
| c_status | Status
|          | SY - start immediately
|          | AS - start in the background
|          | MA - start manually in distribution log |

Table whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DRZOC</td>
<td>Part orders (structure: DRZOC)</td>
</tr>
</tbody>
</table>

Interface Parameters for Exceptions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>Error situation</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvv2u03.
**Determine Context (EXIT_SAPLCVV5_001)**

**Definition**
Function module that is called by customer exit CVDI008 if distribution is started by an event.

**Use**
The context that is to be used for distribution can be determined here. You can specify a context for an event in Customizing for Document Distribution. If other contexts are also to be included for this event, you must use this customer exit.

The function module is called in the following function modules:
- `CVV5_EVENT_START_DISTRIBUTION` (start distribution – initiated by an event)
- `CVV5_EVENT_START_DIST_ECM` (start distribution when change master record event is released)

**Structure**
The interface is structured as follows:

<table>
<thead>
<tr>
<th>Parameters that can be processed in the Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
<tr>
<td>exporting</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>importing</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>changing</td>
</tr>
</tbody>
</table>

**Tables Whose Fields can be Processed in the Function Module**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEVENT_CONTAINER</td>
<td>Event container (structure SWCONT)</td>
</tr>
</tbody>
</table>
Integration

You can enter your company-specific programming logic in the source code of include program zxcvv5u02.
ITS Access (EXIT_SAPLCVVW_001)

Definition
Function module that is called by customer exit CVDI0009 if the original application file is to be accessed via the Internet Application Server (ITS).

Use
Additional authorizations, for example, can be checked in this customer exit.
The exit is called in function module CVVW_GET_ORIGINAL (read original application file from application server).

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>e_doknr</td>
<td>→</td>
<td>Document number</td>
</tr>
<tr>
<td>i_dokar</td>
<td></td>
<td>Document Type</td>
</tr>
<tr>
<td>i_doktl</td>
<td></td>
<td>Document part</td>
</tr>
<tr>
<td>i_dokvr</td>
<td></td>
<td>Document version</td>
</tr>
<tr>
<td>i_filename</td>
<td></td>
<td>File name on application server</td>
</tr>
<tr>
<td>i_ddoc_id</td>
<td></td>
<td>Part order number</td>
</tr>
<tr>
<td>i_application</td>
<td></td>
<td>Workstation application</td>
</tr>
</tbody>
</table>

Interface Parameters for Exceptions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>Error situation</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvwwu01.
Determining the Application (EXIT_SAPLCVV1_005)

**Definition**
Function module that is called by customer exit CVDI0010.

**Use**
You can determine which workstation application was used to process the original application files that are to be distributed with this function module.
Enhancements using Business Add-Ins (Document)

Use
In order to optimize processes in your enterprise when working with document processing you can use Business Add-Ins to enhance the processing functions of the standard system.

See also:
Enhancements of the SAP System in the Area of PDM [Seite 320] and Business Add-Ins [Extern]

Integration
The coding of the standard SAP System contains the definitions of the interfaces as well as the calls for the application programs. This enhancement is made of an interface and a method.

You can use a Business Add-In to set that when a workstation application is started that compressed original application files are reproduced.

Prerequisites
You must create an implementation for the Business Add-In you have chosen and enter the required coding for the method.

Features
The following overview shows the Business Add-Ins that are supported in the Document Management System (development class CV).

Business Add-Ins for the Document Management System

<table>
<thead>
<tr>
<th>Description</th>
<th>Business Add-In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking Authorization from the Document Management Systems</td>
<td>DOCUMENT_AUTH01 [Seite 343]</td>
</tr>
<tr>
<td>Processing of Original Application Files</td>
<td>DOCUMENT_FILES01 [Seite 344]</td>
</tr>
<tr>
<td>General document processing</td>
<td>DOCUMENT_MAIN01 [Seite 346]</td>
</tr>
<tr>
<td>Status checks</td>
<td>DOCUMENT_STATUS01 [Seite 348]</td>
</tr>
<tr>
<td>Transport of Original Application Files</td>
<td>DOCUMENT_STORAGE01 [Seite 349]</td>
</tr>
</tbody>
</table>

Business Add-In without the Documentation in the SAP Library
The following Business Add-Ins were added to the notes 02200177:

<table>
<thead>
<tr>
<th>Description</th>
<th>Business Add-In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document exits and Menu enhancements for PAI in CV01N, CV02N, CV03N</td>
<td>DOCUMENT_MAN02</td>
</tr>
<tr>
<td>Enhanced number checks</td>
<td>DOCUMENT_NUMBER01</td>
</tr>
<tr>
<td>Filter for DMS processes</td>
<td>DOCUMENT_PROC01</td>
</tr>
</tbody>
</table>
### Enhancements using Business Add-Ins (Document)

<table>
<thead>
<tr>
<th>Description</th>
<th>Document Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhancements for the DMS@Web scenarios</td>
<td>DOCUMENT_WEB01</td>
</tr>
<tr>
<td>Enhancements for Microsoft Office integration</td>
<td>DOCUMENT_OFFINTEGR01</td>
</tr>
</tbody>
</table>
Checking Authorization from the Document Management Systems

Definition
Interface for an enhancement that the customer can use to extend the authorization check of the standard SAP System to include enterprise-specific authorization checks.

Use
You program the enterprise-specific authorization checks for the method of the Business Add-In.

Structure
The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHECK_AUTHORITY</td>
<td>After checking the authorization of the following authorization objects: C_DRAW_TCD, C_DRAW_TCS, C_DRAW_DOK</td>
<td>Enterprise-specific logic when deleting</td>
</tr>
</tbody>
</table>

Integration
You implement the enhancement by using Business Add-In DOCUMENT_AUTH01.
Processing of Original Application Files

Definition
Interface for an extension where the customer’s enterprise-specific requirements for processing original application files are implemented.

Use
You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure
The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
</table>
| BEFORE_ASSIGN_FILE          | Before the assignment of a physical file (original application file) | • Automatic definition of an original application file  
                              |                                                                      | • Enterprise-specific checks                                                                  |
| AFTER_ASSIGN_FILE           | After the assignment of a physical file (original application file) | Check whether the original application file is valid                                       |
| BEFORE_START_APPL           | Before starting the application                                      | Reproduces compressed files                                                               |
| AFTER_START_APPL            | After starting the application                                       | Deletion of temporary files                                                                |
| BEFORE_COPY_FILE_DIALOG     | When you create a new version and when the original application files are not checked in before the dialog box for entering a copy path is displayed | Automatic determination of the file name of the new version                                |
| AFTER_COPY_FILE_DIALOG      | When you create a new version and when the are not checked in after the original application files were copied | Check whether an original application file exists                                            |
| GENERATE_COPY_FILE_NAME     | When you create a new version and when the are not checked in and before the standard process for generating file names is run | Enterprise-specific name conventions for original application files when creating a new version |

Integration
You implement the enhancement by using Business Add-In DOCUMENT_FILES01.
Used more than once? If yes, where?
General Document Processing

Definition
Interface for an extension where the customer’s enterprise-specific requirements for processing documents are implemented.

Use
You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure
The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEFORE_READ_DATA</td>
<td>After the main screen Create, Change, Display and before reading the data</td>
<td>• Number check</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version determination</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Company authorization check</td>
</tr>
<tr>
<td>AFTER_READ_DATA</td>
<td>After the main screen Create, Change, Display and before reading the data</td>
<td>• Set the default values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Change data</td>
</tr>
<tr>
<td>ASSIGN_NUMBER</td>
<td>When saving</td>
<td>Number determination (instead of routine GET_NUMBER in program MCDÖKZNR)</td>
</tr>
<tr>
<td>BEFORE_SAVE</td>
<td>Before saving the document but after calling the internal number assignment</td>
<td>Check the data</td>
</tr>
<tr>
<td>BEFORE_DELETE</td>
<td>Before setting the deletion indicator</td>
<td>Enterprise-specific logic when deleting</td>
</tr>
<tr>
<td>AFTER_SAVE</td>
<td>After saving the document data</td>
<td>Enterprise-specific logic after saving</td>
</tr>
<tr>
<td>AFTER_DETERMINE_VALID_VERSION</td>
<td>After determining the valid version</td>
<td>Enterprise-specific determination of the valid versions</td>
</tr>
</tbody>
</table>

Integration
You implement the enhancement by using Business Add-In DOCUMENT_MAIN01.

Used more than once? If yes, where?
**General Document Processing (II)**

**Definition**

Interface for an enhancement you can use to check menu enhancements at the PAI time point.

These checks take place in the following processing situations:

- Create document (CV01N)
- Change document (CV02N)
- Display document (CV03N)

**Use**

You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

**Structure**

The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>D100_Before_PAI</td>
<td>Before the actual PAI of the screen [Extern] 100</td>
<td>Enterprise-specific checks when selecting a function in DMS</td>
</tr>
<tr>
<td>D101_Before_PAI</td>
<td>Before the actual PAI of the screen 101</td>
<td>Enterprise-specific checks when selecting a function in DMS</td>
</tr>
<tr>
<td>D100_PAI_CU1</td>
<td>PAI for menu enhancement 1 (+D100_CU1) screen 100</td>
<td>Menu enhancement for the initial screen of document processing</td>
</tr>
<tr>
<td>D100_PAI_CU2</td>
<td>PAI for menu enhancement 1 (+D100_CU1) screen 100</td>
<td>Menu enhancement for the initial screen of document processing</td>
</tr>
<tr>
<td>D100_PAI_CU3</td>
<td>PAI for menu enhancement 1 (+D100_CU1) screen 100</td>
<td>Menu enhancement for the initial screen of document processing</td>
</tr>
<tr>
<td>D101_PAI_CU1</td>
<td>PAI for menu enhancement 1 (+D100_CU1) screen 101</td>
<td>Menu enhancement for the initial screen of document processing</td>
</tr>
<tr>
<td>D101_PAI_CU2</td>
<td>PAI for menu enhancement 1 (+D100_CU1) screen 101</td>
<td>Menu enhancement for the initial screen of document processing</td>
</tr>
<tr>
<td>D101_PAI_CU3</td>
<td>PAI for menu enhancement 1 (+D100_CU1) screen 101</td>
<td>Menu enhancement for the initial screen of document processing</td>
</tr>
</tbody>
</table>

**Integration**

You implement the enhancement by using Business Add-In DOCUMENT_MAIN02.
**Status checks**

**Definition**
Interface for an extension where the customer’s enterprise-specific requirements for status check are implemented.

**Use**
You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

**Structure**
The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFTER_CHANGE_STATUS</td>
<td>After every status change according to the status checks of the standard system</td>
<td>Status dependent enterprise-specific checks</td>
</tr>
<tr>
<td>BEFORE_LIST_STATUS</td>
<td>Before the list of possible statuses is displayed</td>
<td>Restriction of the list of possible statuses for the selected status check</td>
</tr>
</tbody>
</table>

**Integration**
You implement the enhancement by using Business Add-In DOCUMENT_STATUS01.
Transport of Original Application Files

Definition
Interface for an extension where the customer’s enterprise-specific requirements for transport of original application files are implemented.

Use
You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure
The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEFORE_CHECKIN</td>
<td>Before physically transporting the original application file (Check-in)</td>
<td>• Compress original application file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Specify storage area</td>
</tr>
<tr>
<td>AFTER_CHECKIN</td>
<td>After physically transporting the original application file (Check-in)</td>
<td>• Delete original application file on the frontend computer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set status</td>
</tr>
<tr>
<td>BEFORE_CHECKOUT</td>
<td>Before physically transporting the original application file (Check-out) create when displaying, changing, printing or copying The call also is possible for original application files that are not checked in.</td>
<td>• Convert file name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set path for additional files</td>
</tr>
<tr>
<td>BEFORE_LIST_STORAGECATEG</td>
<td>Before displaying the possible storage categories</td>
<td>Application-specific filter for the list of possible storage categories</td>
</tr>
</tbody>
</table>

Integration
You implement the enhancement by using Business Add-In DOCUMENT_STORAGE01.
Checking the Attributes of the Document Key

Definition

Interface for an enhancement you can use to check enterprise-specific requirements you made in attributes.

The following attributes can be checked:

- Document number
- Document version
- Document part

You can also determine the last and next version number.

Use

You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure

The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCNUMBER_CHECK</td>
<td>Directly before the standard check in DMS</td>
<td>Enterprise-specific check for document number</td>
</tr>
<tr>
<td>DOCVERSION_CHECK</td>
<td>Directly before the standard check in DMS</td>
<td>Enterprise-specific check for document version</td>
</tr>
<tr>
<td>DOCPART_CHECK</td>
<td>Directly before the standard check in DMS</td>
<td>Enterprise-specific check for document part</td>
</tr>
<tr>
<td>DOCVERSION_GET_NEXT</td>
<td>When creating a new version for determining the template (source) document.</td>
<td>Enterprise-specific report of the last version</td>
</tr>
<tr>
<td>DOCVERSION_GET_LAST</td>
<td>When creating a new version for determining the next template (source) document.</td>
<td>Enterprise-specific report of the next version</td>
</tr>
</tbody>
</table>

Integration

You implement the enhancement by using Business Add-In DOCUMENT_NUMBER01.
Filter for DMS processes

Definition

Interface for an enhancement you can use to check enterprise-specific requirements you made in processes [Seite 295]. These processes can be integrated into the following functions:

- Find document (transaction CV04N)
- Web scenarios

Use

You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure

The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEFORE_LIST_PROCESS</td>
<td>Before displaying the possible processes</td>
<td>Enterprise-specific checks for processes and making processes available</td>
</tr>
<tr>
<td>BEFORE_LIST_STATUS</td>
<td>Currently not implemented</td>
<td></td>
</tr>
</tbody>
</table>

Integration

You implement the enhancement by using Business Add-In DOCUMENT_PROC01.
Enhancements for Internet Scenarios

Definition
Interface for an enhancement you can use to check enterprise-specific requirements you made in Web scenarios in the area of DMS.

Use
You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure
The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILTER_FILES</td>
<td>Before transferring document data to the IST</td>
<td>Checks and provision of original application files in the Web scenario</td>
</tr>
<tr>
<td>GET_URL</td>
<td></td>
<td>Determine URL for checkout in the Web</td>
</tr>
</tbody>
</table>

Integration
You implement the enhancement by using Business Add-In DOCUMENT_WEB01.
Enhancements for Microsoft Office integration

Definition

Interface for an enhancement you can use to check enterprise-specific requirements you made in Office Integration [Seite 121] in the area of DMS.

Use

You can use one or more methods for implementing the interface. You program the enterprise-specific requirements for the method of the Business Add-In.

Structure

The interface of the Business Add-In includes the following method:

<table>
<thead>
<tr>
<th>Method</th>
<th>Call</th>
<th>Example of a special check</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDIT_LINK_ITEMS</td>
<td>Before transferring data from the SAP System to the Microsoft Office application</td>
<td>Transfer of more data from the SAP System to a Microsoft Office application</td>
</tr>
<tr>
<td>AFTER_OPEN</td>
<td>After opening an original application file using Office integration</td>
<td></td>
</tr>
</tbody>
</table>

Integration

You implement the enhancement by using Business Add-In DOCUMENT_OFFINTEGR01.
Enhancements using User Exits (Document)

**Use**

In Customizing *Document Management* you can use user exits to create enterprise-specific enhancements and extensions for document processing. You can also use them to extend the standard SAP System with enterprise-specific checks or replace standard ones.

**Integration**

The enterprise-specific checks can be integrated by means of the ABAP workbench. As opposed to *Customer Exits [Extern]* you can use user exits to access program parts and data objects of the standard system.

Some upgrades and support packages will however overwrite the modifications and the must be reentered later.

💡 Verify after an upgrade whether enterprise-specific functions still exist or whether they cause conflicts.

**Features**

The following overview lists the possibilities for customer-specific changes. The documentation is in the IMG of each activity.

<table>
<thead>
<tr>
<th>Function</th>
<th>Activity in IMG Document Management</th>
<th>Notes and indications to the SAP Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create alternative screen</td>
<td>Control data → Define document types [Extern] (detail screen)</td>
<td>The alternative screen is only read by the <em>old</em> transactions CV01 to CV03.</td>
</tr>
<tr>
<td>Document number assignment</td>
<td>Control data → Define document types [Extern] (detail screen)</td>
<td><strong>See:</strong> Document number [Seite 25]</td>
</tr>
<tr>
<td>Setting enterprise-specific additional fields</td>
<td>Control data → Define document types [Extern] (detail screen)</td>
<td><strong>See:</strong> Additional Data for a Document [Seite 377]</td>
</tr>
<tr>
<td>Extensions to the object link</td>
<td>Control data → Define document type → Navigation step Determine object link [Extern]</td>
<td><strong>See:</strong> Adding Other Objects [Seite 66].</td>
</tr>
<tr>
<td>Executing a workflow task</td>
<td>Control data → Define document type → Define document status [Extern]</td>
<td><strong>See:</strong> Overview of Additional Functions After Status Changes [Seite 59]. Processing a Document Info Record (CA-DMS) [Extern]</td>
</tr>
<tr>
<td>Executing enterprise-specific program routines</td>
<td><strong>Control data</strong> → Define <strong>document type</strong> → Define <strong>document status</strong> [Extern]</td>
<td><strong>See:</strong> Overview of Additional Functions After Status Changes [Seite 59]</td>
</tr>
</tbody>
</table>
Enhancements Using Customer Exits (Material Master)

Use

To optimize work flows, you can use customer exits [Extern] to change some of the functions in the standard material master.

SAP Enhancement MGA00003 makes it possible to edit the display of material numbers as required. For example, if a material is assigned the number 123, you can use this enhancement to define that the material number is displayed with a prefix such as MAT-, even though the number in the database is still 123.

For more information, see the SAP library documentation Changing the SAP Standard (BC) Customer Exits [Extern].

Features

The following overview shows the enhancements defined for customer exits in the material master.

Enhancements for Function Group XMG0 (General)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extending and adding checks, and (to a restricted extent) changing data</td>
<td>MGA00001</td>
<td>EXIT_SAPLMGMU_001 (enhancements for material master tables)</td>
</tr>
<tr>
<td>Influencing how material numbers are assigned</td>
<td>MGA00002</td>
<td>EXIT_SAPLMG02_001 (internal number assignment)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLMG02_002 (external number assignment)</td>
</tr>
</tbody>
</table>
Enhancements Using Customer Exits (Material Master)

Influencing how material numbers are displayed

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MGA00003</td>
<td>EXIT_SAPLOMCV_001 (number conversion from display format to DB format (input: start))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLOMCV_002 (number conversion from display format to DB format (input: end))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLOMCV_901 (number conversion from DB format to display format (output: start))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLOMCV_902 (number conversion from DB format to display format (output: end))</td>
</tr>
</tbody>
</table>

Enhancements for Function Group XMGV (Distribution of Material Master Data by ALE)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALE distribution</td>
<td>MGV00001</td>
<td>EXIT_SAPLMV01_002 (IDoc creation)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLMV02_002 (IDoc posting)</td>
</tr>
</tbody>
</table>

Enhancements for Function Group XMG3 (Filter Objects for Material Master Distribution)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading customer-defined filter objects for a material</td>
<td>MGV00002</td>
<td>EXIT_SAPLMV03_001</td>
</tr>
</tbody>
</table>

Additional Information

In the SAP library documentation Material Master (LO-MD-MM) [Extern]:
- Material Numbers [Extern]
- Transfer and Distribution of Material Master Data [Extern]
Enhancements in the Area Engineering Change Management

Use

You can change some functions in the area of Engineering Change Management (ECH) with the use of Customer Exits [Extern] in order to optimize your work processes.

When the person responsible saves a change master record you may want to run self-defined checks to discover any discrepancies in the data and also to keep this data from being saved on the database. You create an enhancement project by using the enhancement PCCD0004 (Check before saving a change number). The enhancement contains the function module EXIT_SAPMC29C_005. This exit refers to the include program ZXCCAU05. Enter the program code in the include program.

See also:

Enhancements to the SAP System in the Area of PDM [Seite 320] and The SAP System Enhancement Concept [Extern]

Prerequisites

When you use a function exit you must create an enterprise-specific include program that fits the program logic of the appropriate function module.

Features

The following overview shows the enhancements that are supported for the customer exits in the area of Engineering Change Management (ECH) (development class CC).

Enhancements for the Function Group XCCA

<table>
<thead>
<tr>
<th>Description</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer field in the change master</td>
<td>PCCD0001</td>
<td>EXIT_SAPMC29C_001</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPMC29C_002</td>
</tr>
<tr>
<td>Check of the values of parameter effectivity</td>
<td>PCCD0002</td>
<td>EXIT_SAPMC29C_003</td>
</tr>
<tr>
<td>Check when setting a system status</td>
<td>PCCD0003</td>
<td>EXIT_SAPMC29C_004</td>
</tr>
<tr>
<td>Check before setting the change number</td>
<td>PCCD0004</td>
<td>EXIT_SAPMC29C_005</td>
</tr>
<tr>
<td>Check at initial screen</td>
<td>PCCD0005</td>
<td>EXIT_SAPMC29C_006</td>
</tr>
</tbody>
</table>

The documentation for the individual customer enhancements can be found in each of the enhancements itself in the SAP System. The following shows how to access the documentation for individual customer enhancements:

1. Go to Tools → ABAP Workbench → Help → Enhancements → Definition.
2. Enter the name of the customer enhancement.
3. Highlight the Documentation, option and select Display.
Enhancements in the Area Engineering Change Management
Enhancements in BOMs

Use

You can display workflows in the BOM area, in a company-specific way, using various enhancement options.

💡

Information about the enhancement options as well as an overview of the planned enhancements for SAP objects in PDM is contained in Enhancements of the SAP System in PDM [Seite 320]

Features

The following overview displays the enhancement options for the standard SAP System in BOMs.

<table>
<thead>
<tr>
<th>Enhancement Options</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhancements using Customer Exits [Seite 361]</td>
<td>You can display the processing of BOMs in a company-specific way using Customer Exits.</td>
</tr>
<tr>
<td>See also: Customer Exits [Extern]</td>
<td></td>
</tr>
<tr>
<td>Enhancement using business transaction events [Seite 363]</td>
<td>You can write separate programs that are performed when specific events are triggered in the standard SAP System.</td>
</tr>
</tbody>
</table>
Enhancements Using Customer Exits (BOMs)

Use

In order to optimize the BOM processing processes in your business, you can change some functions of the SAP System in BOMs by using Customer Exits [Extern].

If an administrator enters a new item in a BOM, you want the system, for example, to automatically check whether the material entered is allowed in this BOM. You create an enhancement project where you use the enhancement PCSD0005 (component check for material items). The enhancement contains the function module EXIT_SAPLCSDI_006. This links to the include program ZXCSAU10. Enter your program code into this include.

See also:
Enhancements of the SAP System in the Area of PDM [Seite 320] and Customer Exits [Extern]

Prerequisites

When you use a function exit, you must create a company-specific include program that matches the programming logic of the function module.

Features

The tables below show the enhancements for customer exits used in BOMs (development class CS).

Enhancements for Function Group XCSA

<table>
<thead>
<tr>
<th>Description</th>
<th>Enhancement</th>
<th>Function Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhance maintenance of material BOMs</td>
<td>PCSD0001</td>
<td>EXIT_SAPLCSDI_001</td>
</tr>
<tr>
<td>Customer fields in item</td>
<td>PCSD0002</td>
<td>EXIT_SAPLCSDI_002</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLCSDI_003</td>
</tr>
<tr>
<td>Customer fields in header</td>
<td>PCSD0003</td>
<td>EXIT_SAPLCSDI_004</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLCSDI_005</td>
</tr>
<tr>
<td>BOM comparison</td>
<td>PCSD0004</td>
<td>EXIT_RCS14001_001</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_RCS14001_002</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_RCS14001_003</td>
</tr>
<tr>
<td>Component check for material items</td>
<td>PCSD0005</td>
<td>EXIT_SAPLCSDI_006</td>
</tr>
<tr>
<td>Mass Changes</td>
<td>PCSD0006</td>
<td>EXIT_SAPMC29M_001</td>
</tr>
<tr>
<td>Check on the changes to BOM header</td>
<td>PCSD0007</td>
<td>EXIT_SAPLCSDI_007</td>
</tr>
<tr>
<td>WBS BOM: Customer-specific explosion</td>
<td>PCSD0008</td>
<td>EXIT_SAPLCSWB_001</td>
</tr>
</tbody>
</table>
**Enhancements Using Customer Exits (BOMs)**

<table>
<thead>
<tr>
<th>Enhancement Description</th>
<th>Code</th>
<th>Exit Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine standard URL for BOM browser</td>
<td>PCSD0009 [Exten]</td>
<td>EXIT_SAPLCSSO_001</td>
</tr>
<tr>
<td>BOM browser: Determine Explosion Date</td>
<td>PCSD0010 [Exten]</td>
<td>EXIT_SAPLCSSO_002</td>
</tr>
<tr>
<td>Knowledge Based Order BOM: Parallel Updates</td>
<td>PCSD0011 [Exten]</td>
<td>EXIT_SAPLCSSF_001</td>
</tr>
<tr>
<td>Customer material number/material type during material exchange</td>
<td>PCSD0012 [Exten]</td>
<td>EXIT_SAPLCSME_001</td>
</tr>
<tr>
<td>Customer specific processing of an explosion for the BOM browser</td>
<td>PCSD0013 [Exten]</td>
<td>EXIT_SAPLCSSO_003</td>
</tr>
</tbody>
</table>

You can find the documentation for the individual customer enhancements in the appropriate enhancement in the SAP System. To display the documentation for the individual customer enhancements you:

4. Choose **Tools → ABAP Workbench → Utilities → Enhancements → Definition**.

5. Enter the name of the customer enhancement.

6. Select **Documentation**, and click on 📚 **Display**.
Enhancements using Business Transaction Events (BOMs)

Use

In order to optimize BOM processes in your enterprise you can use Business Transaction Events to enhance the processing functions of the standard SAP System.

Business Transaction Events are defined parts within a source that can add coding for different software levels, such as branches, partners, or customers, without changing the original program itself.

You use Business Transaction Events, to enhance the standard SAP System with extra components. You can link in-house function modules, or a product from a third party, to the standard SAP System.

See also:
Using Business Transaction Events [Extern]

Features

Enhancement interfaces are defined in coding of the standard SAP System. If an event is triggered, the system calls up the function modules in which the customer-specific coding is executed.

The tables below show the enhancements for Business Transaction Events used in BOMs (development class CS).

Enhancements for Function Group CSBE

<table>
<thead>
<tr>
<th>Description</th>
<th>Event SAP-Function Module</th>
<th>Sample Module for Customer Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Bills of Material [Seite 364]</td>
<td>CS000010</td>
<td>SAMPLE_INTERFACE_CS000010</td>
</tr>
<tr>
<td></td>
<td>OPEN_FI_PERFORM_CS000010_E</td>
<td></td>
</tr>
</tbody>
</table>

Activities

1. Create your own function modules (customer modules).
   
   At the same time, copy the sample module as a template.

2. Enter your program code into the customer modules.

3. In table TBE11 activate the application CS.
   
   This has to be done before the SAP function module calls up the customer modules.

4. Assign an event to each customer module in the table TBE34.
   
   If the event is triggered, the system calls up the customer modules, which are assigned to the event in this table.
Update of a BOM (CS000010)

Use
You use this Business Transaction Event to start additional in-house programs during a BOM update.

💡
For example, you can start up external software to check a BOM against your own consistency rules.

Features
The function module OPEN_FI_PERFORM_CS000010_E is called up when the user saves a BOM, but before the system updates the data in the database.

The customer modules are called up using the function module OPEN_FI_PERFORM_CS000010_E.

All data for the corresponding BOM is transferred to the customer module.

Constraints
The interface does not return any data to the standard SAP System.
Enhancements in the Classification System

Use

In order to optimize the business processes in the classification system, you can change some classification functions of the SAP System by using customer exits.

If a user in characteristics maintenance has not maintained default values for finding objects, you can use enhancement CLCTMS01 (Default values for finding objects) to define default values in a table or add further values. The enhancement contains the function module EXIT_SAPLCTMS_001. This links to the include program ZXCTMSU01. Enter your program code in this include.

See also:
Enhancements to the SAP System in the Area of PDM [Seite 320]
Customer Exits [Extern]

Prerequisites

When you use a function exit, you must create a company-specific include program that matches the programming logic of the function module.

Features

The following is an overview of the enhancements supported in the classification system (development class CL).

<table>
<thead>
<tr>
<th>Description</th>
<th>Enhancement</th>
<th>Function Modules</th>
<th>Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default values for finding objects</td>
<td>CLCTMS01</td>
<td>EXIT_SAPLCTMS_001</td>
<td>ZXCTMSU01</td>
</tr>
<tr>
<td>Check for same classification</td>
<td>CLCTMS02</td>
<td>EXIT_SAPLCTMS_002</td>
<td>ZXCTMSU02</td>
</tr>
<tr>
<td>Change or predefine classification of an object</td>
<td>CLFM0001</td>
<td>EXIT_SAPLCLFM_001</td>
<td>ZXCLFU01</td>
</tr>
<tr>
<td>Call before updating classification data</td>
<td>CLFM0002</td>
<td>EXIT_SAPLCLFM_002</td>
<td>ZXCLFU02</td>
</tr>
<tr>
<td>Selection of objects for mass processing</td>
<td>CLMMD001</td>
<td>EXIT_SAPLCLMMD_001</td>
<td>ZXCLMMDU01</td>
</tr>
<tr>
<td>Manipulation of the search result</td>
<td>CLSC0001</td>
<td>EXIT_SAPLCLSC_001</td>
<td>ZXCLSCU01</td>
</tr>
<tr>
<td>Object dependencies in object search</td>
<td>CLCTMS03</td>
<td>EXIT_SAPLCTMS_003</td>
<td>ZXCTMSU03</td>
</tr>
</tbody>
</table>

The documentation on individual customer enhancements is in the SAP System with the enhancements themselves. To display the documentation on a customer enhancement:

1. Choose Tools → ABAP Workbench → Utilities → Enhancements → Definition.
Enhancements in the Classification System

2. Enter the technical name of the customer enhancement.

3. Select *Documentation* and choose *Display*. 
Enhancements in Variant Configuration

Use

In order to optimize the business processes in variant configuration, you can change some variant configuration functions of the SAP System by using customer exits.

If a user works with very complex, multilevel configurations, you can control the level of detail shown for the configuration. You can use enhancement CCUX0800 to determine whether all assemblies are exploded or only the configurable assemblies. The enhancement contains function module EXIT_SAPLCUKO_002. This links to include program ZXCUCU05. Enter your program code in this include.

See also:
Enhancements to the SAP System in the Area of PDM [Seite 320]
Customer Exits [Extern]

Prerequisites

When you use a function exit, you must create a company-specific include program that matches the programming logic of the function module.

Features

The following is an overview of the enhancements supported in variant configuration (development class CU).

Constant additions are being made to customer enhancements for variant configuration and this documentation may not include all the possible enhancements. To see the most up-to-date list of enhancements call the F4 help for Enhancements and the Development class CU* for Infosystem.

<table>
<thead>
<tr>
<th>Description</th>
<th>Enhancement</th>
<th>Function Modules</th>
<th>Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant configuration: external APIs</td>
<td>CAVC0000</td>
<td>EXIT_SAPLCAVC_CFG_001</td>
<td>ZXCACU01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLCAVC_INST_001</td>
<td>ZXCACU02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLCAVC_INST_002</td>
<td>ZXCACU03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ZXCACU01</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ZXCACU02</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ZXCACU03</td>
<td></td>
</tr>
<tr>
<td>Customer-specific batch-input processing</td>
<td>CCUCEI0B</td>
<td>EXIT_SAPLCEI0_020</td>
<td>ZXCEI0U12</td>
</tr>
<tr>
<td>Processing of planning tables</td>
<td>CCUP0001</td>
<td>EXIT_SAPLCUD2_800</td>
<td>ZXCUPU02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLCUTS_800</td>
<td>ZXCUPU01</td>
</tr>
<tr>
<td>Additional checks on configurations</td>
<td>CCUX0000</td>
<td>EXIT_SAPLCUKO_001</td>
<td>ZXCUCU02</td>
</tr>
<tr>
<td>Functions for loading configurations</td>
<td>CCUX0001</td>
<td>EXIT_SAPLCUD0_001</td>
<td>ZXCUCU01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXIT_SAPLCUXC_001</td>
<td>ZXCUCU03</td>
</tr>
<tr>
<td>Enhancement Description</td>
<td>Exit Code</td>
<td>Reference</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>Reaction to conflict when finding an object for a class node</td>
<td>CCUX0002</td>
<td>EXIT_SAPLCUD0_002 ZXCUCU04</td>
<td></td>
</tr>
<tr>
<td>Parameters for finding an object for a class node</td>
<td>CCUX0003</td>
<td>EXIT_SAPLCEIS_001 ZXCUCU17</td>
<td></td>
</tr>
<tr>
<td>Postprocessing of configuration with object dependencies</td>
<td>CCUX0004</td>
<td>EXIT_SAPLCUKO_003 ZXCUCU07</td>
<td></td>
</tr>
<tr>
<td>Transfer of item category after material variant matching</td>
<td>CCUX0005</td>
<td>EXIT_SAPLCEB1_001 ZXCUCU10</td>
<td></td>
</tr>
<tr>
<td>Fixing an order BOM</td>
<td>CCUX0006</td>
<td>EXIT_SAPLCUKO_007 ZXCUCU13</td>
<td></td>
</tr>
<tr>
<td>Definition of the BOM category for instantiation</td>
<td>CCUX0007</td>
<td>EXIT_SAPLCEB1_002 ZXCUCU14</td>
<td></td>
</tr>
<tr>
<td>No BOM explosion for externally procured components</td>
<td>CCUX0008</td>
<td>EXIT_SAPLCUKO_008 ZXCUCU15</td>
<td></td>
</tr>
<tr>
<td>Synchronization of initialization of variant configuration</td>
<td>CCUX0100</td>
<td>EXIT_SAPLCUD0_003 ZXCUIU01</td>
<td></td>
</tr>
<tr>
<td>Configuration: Additional processing for changing variant table contents</td>
<td>CCUX0510</td>
<td>EXIT_SAPLCUD3_001 ZXCUTU02</td>
<td></td>
</tr>
<tr>
<td>Effectivity date for order BOM</td>
<td>CCUXDATE</td>
<td>EXIT_SAPLCASL_002 ZXCUC1U03</td>
<td></td>
</tr>
<tr>
<td>Control of the level of detail in multilevel configurations</td>
<td>CCUX0800</td>
<td>EXIT_SAPLCUKO_002 ZXCUCU05</td>
<td></td>
</tr>
<tr>
<td>Explosion date for result-oriented order BOMs</td>
<td>CCUXDATU</td>
<td>EXIT_SAPLCASL_001 ZXCUC1U01</td>
<td></td>
</tr>
<tr>
<td>Maintenance of additional data for instantiation</td>
<td>CCUXIACD</td>
<td>EXIT_SAPLCEB1_100 ZXCUC1U02</td>
<td></td>
</tr>
<tr>
<td>Effectivity date for order BOM</td>
<td>CCUXDATE</td>
<td>EXIT_SAPLCASL_002 ZXCUC1U03</td>
<td></td>
</tr>
<tr>
<td>Modification for external number assignment for instantiation</td>
<td>CCUXINST</td>
<td>EXIT_SAPLCUKO_004 ZXCUCU09</td>
<td></td>
</tr>
<tr>
<td>Find material variants with the same value assignment</td>
<td>CCUCEI0V</td>
<td>EXIT_SAPLCEI0_023 ZXCIIU15</td>
<td></td>
</tr>
<tr>
<td>Assigned values file and object characteristics</td>
<td>CCUCEI0A</td>
<td>EXIT_SAPLCEI0_021 ZXCEI0U13</td>
<td></td>
</tr>
<tr>
<td>Change F4 help for characteristics in configuration</td>
<td>CCUCEI0H</td>
<td>EXIT_SAPLCEI0_022 ZXCEI0U14</td>
<td></td>
</tr>
<tr>
<td>Object types for finding objects for class nodes</td>
<td>CCUXOBTY</td>
<td>EXIT_SAPLCEIS_002 ZXCUCU19</td>
<td></td>
</tr>
</tbody>
</table>
## Definition of the BOM status for instantiated materials
- **CCUXSTAT**
- EXIT_SAPLCEB1_003
- ZXCUCU16

## Multilevel configuration with material variants
- **CCUXMVAR**
- EXIT_SAPLCUKO_009
- ZXCUCU20

## Component quantity for set development
- **CCUXSETQ**
- EXIT_SAPLCUKO_010
- ZXCUC2U01

## Availability of customer functions in the configuration editor
- **CEI00000**
- EXIT_SAPLCEI0_010 through EXIT_SAPLCEI0_019
- ZXCEI0U01
- ZXCEI0U02
- ZXCEI0U03

## Configuration: Determine superior material
- **CUBX0001**
- EXIT_SAPLCEB1_001
- EXIT_SAPLCEB1_002
- EXIT_SAPLM60P_003
- ZXCUBXU01
- ZXCUBXU02
- ZXCUBXU03

## Additional logic deleting classification data from the LO-VC view
- **CUCPDELE**
- EXIT_SAPLCLDL_002
- EXIT_SAPLCUCP_003
- EXIT_SAPLCUCP_004
- EXIT_SAPLCUCP_005
- ZXCUCPU01
- ZXCUCPU02
- ZXCUCPU03
- ZXCUCPU04

## Additional logic deleting classification data from the LO-VC view CBASE
- **CUCPDEL1**
- EXIT_SAPLCUCP_006
- EXIT_SAPLCUCP_007
- EXIT_SAPLCUCP_008
- ZXCUCPU05
- ZXCUCPU06
- ZXCUCPU07

The documentation on individual customer enhancements is in the SAP System with the enhancements themselves. To display the documentation on a customer enhancement:

4. Choose **Tools → ABAP Workbench → Utilities → Enhancements → Definition**.

5. Enter the technical name of the customer enhancement.

6. Select **Documentation** and choose 💬 **Display**.

**See also:**

[Specifying Enhancements in the Configuration Editor](mailto:extern)
Classification for Document Management

Use

The classification system allows you to use characteristics to describe documents according to criteria that you define, and to group similar documents together in classes.

Integration of the classification system provides the following document search options:

- Comprehensive search functions provide a powerful tool for finding documents. You can display a document by selecting matchcode ID C - *Find document via class* on the initial screen.
- You can define extra fields for the *Basic Data* screen.
- You can assign keywords to a document.

Prerequisites

See: Before You Classify a Document [Seite 372]

Features

Multiple classification is supported for documents. This means that you can allocate a document to more than one class of a specific class type.

The classification data is displayed on the screen *Classification*.

You can classify documents in the following processing situations:

- Classifying a Document in the Document Info Record [Seite 373]
  - Classifying a Document in the Classification System [Seite 374]

The following graphic shows how more than one document can be classified in different classes (for example, document 1 and 2 in class B). By assigning values to the characteristics (for example, format and material), you can describe the individual documents and separate them from one another (for example, format A0 and A5).
Classification for Document Management

Class A

Class B

Document 1
Format: A0
Material: paper

Class C

Document 2
Format: A5
Material: transparencies

Class D

Class E

Document 3
Weight: ...
Width: ...

Document 4
Weight: ...
Width: ...
Before you Classify a Document

You can only classify documents with reference to a class of a class type for which the Document object type (data base table DRAW) is maintained.

**Prerequisites in Customizing**

At least one **class type** for documents must be defined in Customizing for the Classification System, by choosing **Classes → Maintain object types and class types**.

In the standard R/3 system the following class types are supported for documents:

- 017 – Document management
- 201 - Documents (configurable objects)

**Prerequisites in the Classification System**

At least one **class** must be defined for the appropriate class type in the classification system.

This class does not need to have characteristics. However, the values assigned to characteristics are useful search criteria when you search for documents. The system does not have to access the database as often, and the search result is more precisely targeted.

Please note that characteristics and their values are inherited in a class hierarchy. Characteristics that are inherited from superior classes in the hierarchy are displayed as fields on the **Basic Data screen**.

If you want to define class types yourself, you must

- maintain the class status, organizational areas and text types
- define the classification status for the document allocations
- maintain object parameters
Classifying a Document in the Document Info Record

Prerequisites

See: Before You Classify a Document [Seite 372]

Procedure

1. On the Basic data screen, choose Extras → Classification.

   The Classification screen, which is divided into the following sections, is then displayed.

<table>
<thead>
<tr>
<th>Object</th>
<th>Displays the key data of the document as well as class type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocations</td>
<td>List of allocated class(es)</td>
</tr>
<tr>
<td>Valuation for &lt;Class&gt; &lt;Document&gt;</td>
<td>List of all characteristics of the given classes. Is only displayed when at least one class allocation exists.</td>
</tr>
</tbody>
</table>

2. Enter (one) document class(es) and confirm your entry.

   The system adds the screen section Valuation to <class> <object> to the screen. On the tab page General all characteristics of a class are listed.

   - If the class is part of a class hierarchy, you may see other characteristics for characteristics that are inherited from superior classes in the hierarchy.
   - As long as only one class has been allocated the characteristics displayed are based on the entered class.
   - As soon as several classes are allocated you must select a class and choose (Valuation of the allocations).

3. Select characteristic that you want to valuate.

4. Select (Choose).

   The settings in the characteristic (for value assignment or interface control, for example) determine how individual characteristics are processed. You can use all active value assignment functions.

5. After you have entered the characteristic data you can leave processing of the class data. Choose Back.

Classifying Documents in the Classification System

Prerequisites

See: Before you Classify a Document [Seite 372]

Procedure

1. Go to the Classification screen (Logistics → Central functions → Classification).
2. Choose Allocation → Maintain → Object to classes.
   
   You see the Allocate Object to Classes: The rest of the procedure is dependent on the following parameters in the user master data:
   
   - Parameter-Id CTY Class type
   - Parameter-Id CTY Class
   - Parameter for Documents [Seite 36]

   The following overview displays which activities you can do

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>No default value exists</td>
<td>• Choose the class type (for example 017 document management) and confirm your enter.</td>
</tr>
<tr>
<td></td>
<td>• Enter the document data, and confirm your entries.</td>
</tr>
<tr>
<td></td>
<td>• Enter the class(es).</td>
</tr>
<tr>
<td>Default value exists</td>
<td>The system reports the default values from the use master record when processing starts. The last-used data is always set as default when further processing starts. You can enter new data by choosing Allocation → Other allocation. After you have entered all the data for document data and class type you can allocate the class(es).</td>
</tr>
</tbody>
</table>

3. If want to display or valuate the characteristics select the class.
4. Select 🚀 (Valuation of the allocation).
   
   The system adds the screen section Valuation to <class> <object> to the screen. On the tab page General all characteristics of the entered class are listed.
   
   📘
   
   If the class is part of a class hierarchy, you may see other fields for characteristics that are inherited from other classes in the hierarchy.
5. Select characteristic that you want to valuate.
6. Select 🔄 (Choose).
   
   The Allocate Object to Classes screen reappears.
7. Save your allocation data.
Changing the Classification Data of a Document

Procedure

1. Process the document in change mode.

2. Choose Extras → Classification.

   You see the Classification screen. Here, you can use all active classification functions. You can:
   
   - Allocate new classes
     
     Chose in the screen area Allocations ➕ (New lines) and enter the new class.
   
   - Delete an allocation to a class
     
     In the screen area Allocations position the cursor the class and choose Delete. You see a dialog box with a confirmation prompt. Confirm.

   - Assign values to characteristics
     
     In the screen area Valuation for <class>, position the cursor on the characteristic and choose ➔ (Select).

   - Delete characteristic values
     
     In the screen area Valuation for <class>, position the cursor on the characteristic and choose ➔ (Cut char. value).

3. Choose Back to return to the Basic Data screen after you have made the change.

4. Save your document info record.
Additional Data for a Document

Use
The fields on the Basic data screen of a document can be extended. For example, you may be required to make entries for size for certain documents. This data that is in the document info record can be added using classes and their allocated characteristics.

Prerequisites
You must perform the following in the classification system:

- Create a characteristic for each additional field you require. For example, the characteristics LENGTH and HEIGHT.
  
  When you define the characteristics, for example, you determine how the characteristic is displayed, the data type, and the allowed values.

- Create a class with a class type for documents. For example, create the SIZE class for the standard class type 017.
  
  Enter the characteristics for the class, for example LENGTH and HEIGHT characteristics for the SIZE class.

Features
The characteristics of the class appear as additional fields for all documents of this document type.

Maintenance is done on different tab pages. The description of the class is generated as a head for the tab page. For example, in addition to the standard you see for all the documents of the document type MAD tab pages with additional fields for LENGTH and HEIGHT. These can also be maintained.

💡

If the class is part of a class hierarchy the fields of all superior classes are displayed within a class hierarchy.

Activities
The settings for the additional data are made in Customizing Document management; under Control data → Define document type → Detail screen.

- Allocate a class type and a class to the document type.
- It is not necessary to make an entry in the field Display for additional data at this stage of development because display is supported on the tab page.

💡

For example, for the MAR document type, enter the standard class type 017 (document management) and the SIZE class. LENGTH and HEIGHT are allocated to this class.
Additional Data for a Document

You can maintain the tab pages *Length* and *Height* for all documents of the document type MAR.
Engineering Change Management in Document Management

Use

All the objects that are affected by a change are grouped together in a change master record in the change department. For example, a BOM, routing, and a document can be affected if you change a material. The user departments make the object changes with reference to this change number (for example, BOM change, routing change). This means that a new data record is created for the objects.

To create historical data records, documents are processed without reference to a change number. Document versions inform you of the different change statuses of a document. Integration into the change process is by means of the change number. The change number is entered in the basic data.

You can use engineering change management to perform the following functions:

- To link documents to other SAP objects (for example, material, BOM, routing) that are also affected by the change.
- The valid-from date from the change master record gives a document a time reference.

Integration

You enter a change number in the basic data in the document info record. This change number identifies

- A change master record
- An engineering change order

If the change number identifies an engineering change request or engineering change order, the change procedure is also determined by the internally defined system status and user status (if a user status is defined).

Prerequisites

The following requirements must be met before you can enter a change number for a document:

- Customizing for the Document Management System
  The Change number field set must be defined for the chosen document type so that the Change number field is an optional or required field. As a result, the Valid from field is shown.
  You make the required settings under Document Management System → Control data → Define document types.

- Change Master Record
  A change master record for the change must exist in the system.
  For the Document object type:
  - The Object type active for change number (Act.) indicator must be selected
  - The Object type locked for changes indicator must not be selected.
You must create an object management record in the change master for the document concerned.

If you set the *Object management record generated* indicator for documents on the *Object Types* screen of the change master record, you do not need to create the object management record manually. When you change the document with reference to the change number, the system creates an object management record automatically.

**Features**

The change number is entered in the document info record. There is a one-to-one relationship between a change master record and its allocated document version. You cannot change the entry for the change number once you have saved it in the document info record.

The following graphic shows how change numbers can be allocated to the document versions.

The following functions are supported for processing documents with reference to change numbers:

- Creating a Change Master Record [Seite 381]
- Making a Reservation for a Change Number [Seite 382]
- Assigning a revision level [Seite 385]
Creating a Change Master Record

Procedure

1. On the Basic data screen of the document info record, enter the change number.
   When you confirm, the system sets the valid-from date from the change master record, provided that documents can be processed with reference to the change number. If the document is allocated to an alternative date in the change master record, the change is valid as of this alternative date rather than the valid-from date in the change master header.

2. Save your document info record.

Additional Checks for an Engineering Change Order

There are additional checks for an engineering change order.

- A change request must be approved and converted to a change order. If you are not entitled to do this, you see an error message. **System status: the change request has not been approved yet.**

  See also:
  [Change Processes Using an Engineering Change Request](#)

- If you set a status for the document which is complete in terms of engineering change management, the system checks the object management record in the change order.

  See also:
  [Checks for Document Release](#)
Making Reservations in Engineering Change Management

Usage
Documents are integrated into a change process by entering the change number in the basic data. This change number controls the change process.

When the change department enters all the objects that are affected by the change in the change master record (for example, BOM, routing), documents can be preselected for the change. Reserving documents for certain changes guarantees that only one change number which the processing status of the document is relevant for can be entered in a document version.

Integration
You reserve a document for a change in the change master record. When you process the document info record, you decide which of the change numbers should be copied into the document.

Prerequisites
Change master records that you want to reserve documents for must support document processing (object type settings).

Scope of the Function
You reserve a document for a change master record by creating an object management record for this document.

- You can reserve a document version in **more than one** change master record.
  As soon as there is a reservation for a document version, only one of the change numbers can be chosen for the version, or no change number is entered.

  ![Tip]

  You can either reserve one version (for example, version 08) or all versions of a document (enter * for the version) for the document key (document number, document type, and document part).

- You can copy **one** change number for the document.
Reserving a Document for a Change Number

Procedure

1. Choose the change master you require.
   

2. Enter the document as a change object. You have the following options:

   You know the document data:

   - If you know the data of the document key, choose Goto → Object overview → Document.

   If you only want to reserve one particular version of the document, enter the data of the document key together with the version number (for example, 08). The system checks that the document exists. You see an error message if the document does not exist.

   If you want to reserve all versions (including versions that do not yet exist), mask the value for the version by entering the special character "*" in the Version field. In this case, the system does not check that the document exists.

   Choosing the document using the product structure:

   - Choose Goto → Object overview
     
     You see the object overview.

   - Choose Extras → Product structure
     
     Enter the start object (for example, material), and explode the structure overview until you find the document affected by the change. Documents that can be copied as change objects have a checkbox next to the document key fields.

     Select the document(s) you want to copy and choose Copy.

     You see the Document object overview again with the copied data of the documents you selected.

3. Save your change master.

   The document is now reserved for a change number via its object management record.

Result

Once you have reserved a document for a change number, you see the Reservations in Engin. Change Mgmt. dialog box when you process the document (Document → Change).

This dialog box shows all the change numbers in which the document is reserved.

Once you have saved a change number, you can no longer change it. This means that when you next process the document, the change numbers that the document is reserved for are no longer displayed.
Processing a Reserved Document

Prerequisites
You have reserved the document in at least one change master record.

Procedure
1. Choose the (reserved) document you want to process.
2. Enter the document data on the initial screen, and confirm your entries.
   You see the Reservations in Engin.Change Mgmt. dialog box, which shows the change number(s) in which the document has already been reserved as a change object. In addition, you see the description(s) of the change number(s).
3. If the document is reserved for one or more change numbers, you can only enter one of these change numbers in your document info record.
   – Choose the change number. If you want to copy a change number to the Change number field (Basic Data screen) of your document info record, choose it.
   – If the dialog box only contains one change number, the system copies the change number when the data is released.
   – If you do not want to copy a change number now, choose Cancel in the Reservations in Engin.Change Mgmt. dialog box.
4. The Basic Data screen appears.
5. Save your document info record.
Revision Level Assignment

Usage
The revision level indicates a released processing status of a document. Later on, you can change documents that have a revision level with reference to either the change number or the revision level.

The following sequence of revision levels has been defined for documents: R1, R2,...R20

The following document is being processed:
*Document KON-01, document type DRW, part document 000*

Versions to which consecutive revision levels are assigned:
- Version 01 Revision level R1
- Version 03 Revision level R2
- Version 06 Revision level R3

The next version that is released with reference to a change number is assigned revision level R4.

Prerequisites
You must perform the following in Customizing:

- **Customizing for Engineering Change Management**
  
  Activate the revision level function under *Set up control data*.

  By doing this you determine whether the user can assign the revision level (external assignment) or whether the system automatically assigns the next revision level in the defined sequence (internal assignment).

- **Customizing for Document Management**
  
  - You define the sequence in which revision levels are assigned in Customizing for the *Document Management System* under *Control Data → Define revision levels for documents*. You see the revision levels defined as default values, which you can overwrite.
  
  - Revision levels for documents are only assigned automatically. Under *Control Data → Define document types*, you define for a document type whether revision levels are supported or not.
  
  - Under *Control Data → Define document types → Define document statuses*, you set the *Released* indicator for the status that defines the document as released.
Revision Level Assignment

Scope of the Function

Revision level assignment is automatic for documents when a version is released with reference to a change number for the first time. You receive a default value according to the predefined number sequence (Customizing).

The revision level uniquely identifies a processing status of a document. You can only process a document version with reference to one change number, so you can only have one revision level per version.

- Once you have entered a change number for a document info record and saved the document, you can no longer change the number. If you want to process the document at a later date with reference to a different change number, you must create a new version.
  See: Assigning a Revision Level to a Document [Seite 387]

- You cannot change a document revision level directly from the processing functions of a document info record or from the Document Management screen. Instead, go to the Engineering Change Management screen.
  See: Changing a Revision Level [Seite 388]
Assigning a Revision Level to a Document

Prerequisites

You are processing the document with reference to a change number. A status that has the release indicator set for it is defined in the status network for the document type.

See: Revision Level Assignment [Seite 385]

Procedure

1. Ensure that a change number has been entered for the document.
2. Allocate a document status that has the released indicator set for it.
   The further processing flow depends on the status network you have defined for the document type. For example:
   – You may see the Log Field dialog box, which prompts you to make an entry.
   – The document status that is interpreted as released may have the Locked or Original in work status type. In this case, the system tells you that you can no longer enter data in some of the fields. Only some of the functions can still be used, for example changing the status.
3. The system assigns a revision level and checks:
   – The revision levels that have already been assigned to a document version
   – The revision level that must be assigned next from the defined sequence.
     The control data settings in Customizing determine how the revision level is assigned:
     – If external assignment is defined, you see the next available revision level as a default value. You can overwrite this with any value.
     – If internal assignment is defined, you see a dialog box that tells you which revision level is assigned to this version.
4. Save your document.

Result

A revision level always identifies a version uniquely because you can process a version with reference to one change number only.
Changing a Revision Level

Procedure

   
   You see the Change Document Revision Level: Initial Screen.

2. Enter the following data to identify the document: document number, document type, and document part.
   
   Confirm your entries.

3. You see an overview of all the versions with a revision level.
   
   – The upper section of the screen contains the document number, document type, and document part that identify the document.
   
   – In the Revision level dataset, you see which revision level has been assigned to the document versions. You also see the valid-from dates of the revision levels and the change numbers to which they refer.
   
   – You can sort the versions according to various criteria, such as date, change number, or revision level.

4. You can enter data in the Revision level field. You can overwrite the value.
   
   Please note the following:
   
   – Each revision level can be assigned only once per document.
   
   – Any value is allowed for external assignment.
   
   – Only revision levels that have been defined in Customizing for the Document Management System under Control Data → Define revision levels can be used for internal assignment. You can choose the revision level from the possible entries by double-clicking.

5. Save your changes.
   
   You see the initial screen again.
Displaying a Revision Level

Procedure

You can display revision levels for documents in the following processing situations:

- Start from the Engineering Change Management menu.
  Choose Revision level → Document rev. level → Display.

- Start from the Change/Display Document screen.
  Choose Environment → Revision levels.

- You are processing a document.
  Choose Environment → Revision levels.

Irrespective of which of the above three processing situations you are in, you see the Display Document Revision Level: Initial Screen.

The following data is displayed:

- The upper section of the screen contains the document number, document type, and document part that identify the document.

- In the Revision level dataset, you see which revision level has been assigned to the document versions.
  You also see the valid-from dates of the revision levels and the change numbers to which they refer.
Engineering Change Requests (ECRs)

Purpose
An engineering change request controls the change processes for chosen change objects (for example, BOMs, routings, and documents) according to a predefined change type. For example, the sequence of change functions is determined by an internally defined status network (system status) and the user status (if one exists).

Prerequisites
You have created an engineering change request that supports document processing.
Creating an engineering change request means creating an engineering change master with reference to a change type (for more information, see the R/3 Library Engineering Change Management (LO-ECH)).

Process
The change process with reference to a change request occurs in the following processes:

- Changing a Document with an ECR [Seite 392]
- Checking a Document and Converting an ECR [Seite 393]
- Changing a Document and Completing an ECO [Seite 395]

The following graphic shows the change process from the creation of an engineering change request to the released change status. You cannot process the document until you have converted the engineering change request (ECR) to an engineering change order (ECO).
Changing a Document with an ECR

Procedure


   You see the following two additional fields on the change header: System status and User status. These fields contain the abbreviations of the statuses that have already been assigned to the change request.
   To display the status descriptions, choose Status.

   The system automatically sets the system status to Created. This system status is also copied to the change objects (for example, document) and displayed on the detail headers of the individual object management records.

2. Maintain the data in the change header.

3. Enter the indicators for the object types. You can only process one document if the indicators for the Document object type are set.

4. Enter the document that is affected by the change.
   To do this, go to the relevant object overview (for example, Document:Overview) and choose New entries.
   Enter the document.

5. Save the ECR.
Checking a Document and Converting an ECR

Procedure

1. Edit the ECR. To do this, choose Engin.change req.→ Change from the Engineering Change Management menu.

   Go to the change header and change the system status to Check request. This status is copied to all assigned change objects, which ensures that all change objects are checked by the system.

   Choose Edit (p) Set status.

   You see a dialog box showing all the statuses (business transactions) in the status network.

   The business transactions that can be carried out in the current processing situation have a pushbutton next to them. Use this pushbutton to set the required status.

   To display a list of the business transactions that are allowed or disallowed in the current situation, you can also use the following menu path: Goto → Status management. On the Status screen, choose Extras → Bus. transactions.

2. Check the change objects (for example, documents). Decide whether each object is affected by the change or not.

   From the object overview (for example, document overview), go to the detail screen of the object management record.

   Choose Edit → Set status.

   You see a dialog box in which you decide whether the change is relevant to this object. For example, a material may be affected by the change (object system status Change possible), whereas the change may not be relevant to a certain document (object system status Change unnecessary).

   If a change object cannot be changed for whatever reason (for example, due to technical requirements), you must set the Change impossible system status for this change object. In this case, the system automatically sets the system status of the change master to Lock. The system can undo the lock for the change master record (system status Unlock). However, you ought to check the change in the areas of your company that are affected by it so that you can make any required settings and fulfil all the necessary requirements.

   At this point, you cannot process the change objects (for example, document) with reference to this change number. The change request must be approved first.

3. The users responsible must approve the change request and convert it to an engineering change order (ECO).

   You cannot edit the change objects with reference to this change number until the change request has been approved and converted to an engineering change order.
Checking a Document and Converting an ECR

You can now edit change objects (for example, document) with reference to this change number.
Changing a Document and Completing an ECO

Prerequisites

To complete a document change, the following must apply:

- The current status of the change master record (object management record for the document) must support the Complete change system status as the next status.
- The current status of the document must support a follow-up status that has the Complete for engineering change management indicator set for it.

Procedure

   - For example, change an original application file and check it into a vault.
   - Set the document status that has the Complete for engineering change management indicator set for it.
      
        The system checks the object management record of the document in the allocated change master record. If all the requirements have been fulfilled, the system automatically changes the change master record (the object management record for the document receives the Complete change system status).

2. Edit the change master record.

   After changing an object, you must set the system status of the object to Complete change.
   
   You only need to take this step for those objects that have already been assigned the system status Change possible.

   ![Tip]

   You can only complete the engineering change order once the system status Complete change has been set for all objects.

Exception for documents:

The processing status Complete is not set in the change master record for documents.

3. Once all objects affected by the change have the Complete change status, an additional check can be performed. The business transaction Release change is defined for this purpose.

   Change the system status of the change objects and the change master to Release change and Release order respectively.
Document Distribution

Areas of Usage

You can use document distribution to distribute documents that are managed in the document management system (DMS) either manually or automatically. This means that you can distribute the most current document data to internal employees or external companies, for example, either simply as information, or to be processed further.

Implementation Notes

You can only use all functions if you are using further R/3 components, such as:

- Document Management System (DMS)
- SAP Business Workflow
- SAPoffice
- SAPconnect interface
- Computing Center Management System (Spool System)

Integration

You can only distribute documents that are maintained in the document management system using document distribution. All SAPoffice recipient types can also receive documents via document distribution.

You can call the document distribution functions from the Document Management menu, under Environment → Document distribution.


Features

Document distribution covers the following functions:

- **Recipient Management**
  You define who should receive the documents in the recipient list.

- **Creating and Processing Distribution Orders**
  You distribute the documents by making a distribution order. You control how the distribution takes place with a distribution type. All the distribution steps are controlled by SAP Business Workflow.

- **Monitoring Distribution Orders**
  The distribution steps that you make to send a document to the recipients are documented in the distribution log.
Restrictions

You can distribute single documents. In the case of document structures, the lower-level documents are not distributed automatically. You can copy these documents individually to the recipient list by using the Product Structure [Seite 468], for example.

You can only distribute the documents using a distribution order that is created either manually or by a defined event (SAP Business Workflow). You cannot distribute documents automatically just for a set period of time (for example, subscription).
Recipient Management

Use
You can use recipient management to define who receives a copy of the chosen document(s).

Integration
All SAPoffice recipient types can receive documents via document distribution.

Prerequisites
Before you can send documents to recipients on a list, you must have created and maintained this recipient list.

Features
You can send documents to the following recipients:

- All SAPoffice Recipients [Seite 399], for example:
  - External companies
  - R/3 System users
  - SAPoffice distribution lists
  - Organizational units

- Recipient Lists [Seite 402]
You can define recipient lists for distributing documents in the document management system. The recipients can be determined automatically from the existing recipient list.
You determine the following in the recipient list:
- who receives a document via document distribution
- how the recipient receives this document
Recipients

Definition
Name of the recipient who should receive a copy of the document. Different recipient types are defined in the SAP System. For example, you can distribute the documents to recipients who are maintained in central address management, SAPoffice, or as an organizational unit.

Use
Documents in the document management system are distributed to predefined recipients who have either been defined in the SAP System, or who can be reached using the SAPconnect interface.

If you think you will want to send documents to the same group of recipients again, you can group the recipients together in a Recipient List [Seite 402].

Structure
The data that you maintain for each recipient depends on the recipient type.

For example, the following recipient types are supported for documents:

- Internal user in central address management (CAM), for example, you enter the name
- SAPoffice recipient lists, for example, a personal distribution list and you enter a title
- External addresses in central address management (CAM), for example, you enter the name and the company
- Addresses and internal users for example, you enter the name and the address
- Organizational units for example, organizational unit, position, work center, person from the organizational structure department of the company

When you start the distribution, you can also enter recipients in the recipient list or the distribution order that no data exists for in the SAP System. The master record for these recipients is created directly from the recipient list or the distribution order. This function is supported for the following recipient types:

- New Internet address
- New FAX number
- New RML address

💡

The following recipients in the list of possible entries when you maintain a recipient list or a distribution order are of no significance for document distribution: SAP object instances and X.400 address.
Recipients

You can enter a plotter as a recipient when the plotter has already been defined in Customizing of Document distribution (activity Define plotter [Extern]).

Integration

You can use a distribution order to send several documents to several recipients. You determine how the recipient receives the document with the Distribution Type [Seite 415]. The distribution types are based on the SAPoffice Communication Types [Seite 417].

The system generates a distribution order for each document and recipient. The individual orders are grouped together for each recipient and distribution type to form distribution order packages. These are then sent according to the distribution type.
Creating a Recipient

Use
You can send documents to individual recipients using document distribution. To be able to do this, the recipients must be defined in the R/3 System.

Procedure
1. Choose Recipient from the Document distribution menu.

   You see a sub-menu listing all the document distribution recipient types that you can maintain a master record for in the R/3 System.

2. Choose a recipient type, for example, Office user.

3. The initial screen for your chosen recipient type appears and you can create/maintain the appropriate master record.

   The data that you maintain for a recipient depends on the recipient type. For example, for a user in the R/3 System, you can maintain fixed values, parameters, or profiles for working in the desired R/3 System.

   You can find detailed information on this in the R/3 library, under BC - Basis Components → Basis Services / Communication Interfaces → BC - SAPoffice.

Result
You can use the recipient that you have entered, or whose data you have maintained, in a recipient list or you can enter the recipient directly when you start the distribution.
Recipient Lists

Definition
A list in which recipients are allocated to one or more documents. If you want to send the document(s) to more than one recipient, you can group these recipients together in a recipient list. When you start the distribution, the system determines these recipients automatically from this allocation.

Use
You determine the following in the recipient list:

- who receives a document via document distribution
- how this recipient should receive the document (for example, the original as attachment to an e-mail)

The recipients can be determined automatically from the existing recipient list. You can limit the number of recipient lists that are considered when you start the document distribution by entering a Context [Seite 413].

Structure
The following data, for example, is managed in a recipient list:

- **Data for the Recipient List**
  - Recipient list identification number
    - The recipient list ID groups together all the recipients who have been allocated to one or more documents.
  - Identification as standard recipient list
    - Documents are sent automatically to standard recipient lists if the distribution is initiated in the background by an event, or if you explicitly state that the documents should be sent to the standard recipient list when you start the distribution.
    
    You can maintain one standard recipient list for each document. This list applies to all document parts and versions of a document.
    
    If you want to define another list as the standard recipient list for a document, you can withdraw the original list as the standard.
    
    When you set the standard recipient list indicator, all the recipient lists for the documents that are entered in this standard list are locked against changes. This ensures that no other recipient list can be defined as standard recipient list. This lock is withdrawn after you have saved the changes to the standard recipient list.
  - Description
    - You can enter a language-dependent description of up to 70 characters.
    
    [Context [Seite 413]]
Recipient Lists

- **Recipient Data**
  - Name of recipient
  - Recipient type (for example, user, SAPoffice recipient lists)
  - Number of copies that a recipient should receive
    This entry is only for information purposes. If the documents are distributed automatically, only one copy is created.
  - *Recipient inactive* indicator
    You can set this indicator if you want to exclude a recipient from the chosen recipient list. When you withdraw the indicator, the recipient receives the document on the next distribution.

- **Document Data**
  Documents are identified in the recipient list by the document number and document type, irrespective of document parts and versions. This means that you do not have to make an entry for these two document key fields.

- [Distribution Type Data](Seite 415)
- [Distribution Process Data](Seite 432)

**Integration**

You can use a distribution order to send several documents. This order is then divided into a clear 1:1 document to recipient relationship for distribution.

You use [Context](Seite 413) to define the conditions under which the documents are to be sent to the recipients. If you allocate a context to the recipient list, the document(s) are only sent to certain recipient lists (for example, sales area).
Create recipient list

Use

You can use Recipient Lists [Seite 402] to send documents to several recipients via document distribution.

Prerequisites

If you want the system to assign the name of the recipient list internally, you must define a number range for recipient lists in Customizing for the Document Management System, by choosing Document Distribution \(\rightarrow\) General Settings \(\rightarrow\) Number Ranges.

If you want to use a context to limit the recipient list, you must define the context in Customizing for the Document Management System, by choosing Document Distribution \(\rightarrow\) Context \(\rightarrow\) Define context.

The user must have the required Authorizations [Seite 466].

Procedure

1. Choose Recipient \(\rightarrow\) Create from the Document distribution menu.
   
   The Create recipient list screen appears. Create

2. Enter a name for the recipient list and choose Continue.
   
   The Create recipient list screen appears. Basic Data

3. Enter a description.
   
   If you want to enter a description in other languages, choose Edit \(\rightarrow\) Language-dependent description.

4. If you only want to use the recipient list under certain conditions, enter a Context [Seite 413].

5. Flag the recipient list as a standard recipient list, if required.

   The standard recipient list applies to all document parts and versions of the document.

6. Enter all the documents that you want the recipients in the recipient list to receive.
   
   You enter the documents irrespective of document part or version.
   
   You use the selection of the workstation application to determine which original application files you want to distribute.

7. Enter a Recipient [Seite 399].
   
   You can select the recipient by recipient type (for example, general Business Workplace distribution list) by choosing the possible entries button.

   You can explode a Business Workplace distribution list or organizational unit by choosing Explode distribution list/organizational unit.
8. Choose the Distribution Type [Seite 415]. This determines how the recipient receives the document (for example, e-mail with the original file as an attachment).

9. Enter further data as required, for example:
   – Number of copies for distribution type
   – Medium for the document (for example, paper)

10. If you do not want a particular recipient to receive the document that you are going to distribute, set the Recipient inactive indicator. As soon as you delete this indicator, this recipient receives the document the next time it is distributed.

11. Save your recipient list.

**Result**

When you start distribution, you can decide whether you want:

- To send the documents to the standard recipient list
- To send the documents to all recipient lists
  
  You can limit the number of recipient lists by using a context.
Copying Documents from the Product Structure

Use
When you are editing a recipient list, you can use a product structure [Seite 468] to find documents that are to be distributed and then add them to the recipient list. You can copy documents from either display in the product structure; both list display and control display.

See: Settings for the Product Structure [Seite 480]

Prerequisites
You must create a recipient list or change an existing one (Recipient List: Basic Data screen).

Procedure
You can copy documents from the product structure into the recipient list as follows:

Copying Documents from List Display [Seite 520]
Copying Documents using Drag and Drop [Seite 496]
Selecting Original Application Files for Distribution

Use

You must select the original application files for distribution. The selection is based on the entry made for the workstation application that was used to process the original application files.

Procedure

You can determine which original application files you want to distribute in the following ways:

- **Maintenance of the Recipient List**
  
  You can enter a workstation application for each document to be distributed. All original application files that were processed with the entered workstation application are distributed.

  If only one workstation application is defined for the document that is to be distributed when distribution for the reported recipient list starts this workstation application is set as default.

- **Definition of the Document Type**

  Setting which original application files you want to distribute is done dependent on the workstation application. Enter a default value for the workstation application when defining the document type. At the start of distribution the system sets the original application files that were processed with the workstation application as default to be distributed.

  If only one workstation application was chosen in a document then this one is set to default.

- **Using the SAP Enhancement CVDI0010**

  You can set in an enterprise-specific program from which workstation application you want to distribute the original application files.
Displaying the Recipient of a Document

Use

You can use this function to check which recipients can receive a specific document. All the recipient lists are taken into account.

Prerequisites

You have allocated the document to at least one recipient in a recipient list.

The user must have the required Authorizations [Seite 466].

Displaying a Recipient While You are Processing the Document

If you are processing the document that you want to see the recipient list for, proceed as follows:

1. Go to the Basic Data screen.
2. Choose Environment → Document distribution → Display all recipients.
   The Display all recipients dialog box appears.
3. If required, enter a context to limit the recipient list.
   If you want to search for the recipient list without any restrictions on the search, use the special character *.
4. Choose Continue.

Result

You see an overview that is divided up as follows:

- In the first part, you see the document data version and, where appropriate, the context that you have used to limit the recipient list search.
- In the second part, you see a list of all the recipients that a document version should be sent to using a recipient list.

You see further data concerning the distribution, for example:

a) Recipient, distribution type, medium, number of copies
b) Name of the recipient list

You can display the recipients from this list and display or change the recipient lists.

Displaying a Recipient from the Document Distribution Menu

If you want to display the recipient list for a specific document, proceed as follows:

   The Display all recipients of a document screen appears.
2. Enter the key fields for the document.
3. If required, enter further data:
   - If you want to display recipient lists, the use of which is limited by a context, enter the context here.
     - If you want to be able to display all recipient lists without any restrictions, select All and enter the special character * in the context field.
   - If you want to display the standard recipient list for the document version, select Standard.

4. Choose Continue.

Result When Displaying a Standard Recipient List

Only the recipients in the standard recipient list are displayed. The list is divided into the following parts:

- In the first part, you see the name of the standard recipient list and, where appropriate, the context that you have used to limit the recipient list search.
- In the second part, you see the key data and the document description.
  Since the standard recipient list applies to all document parts and document versions, you only see the document number and document type displayed.
- In the third part, you see a list of all the recipients in the standard recipient list that all the document parts and document versions are to be sent to.

You see further data concerning the distribution, for example:

a) Distribution type, medium, number of copies
b) Indicator showing whether the recipient is inactive in the standard recipient list

You can display the language-dependent description and recipient data from this overview.

Result When Displaying a Recipient List

Recipients from all the selected recipient lists are displayed. The list is divided into the following parts:

- In the first part, you see the document data version and, where appropriate, the context that you have used to limit the recipient list search.
- In the second part, you see a list of all the recipients that the document version should be sent to using a recipient list.

You see further data concerning the distribution, for example:

   c) Recipient, distribution type, medium, number of copies

   d) Name of the recipient list and the indicator showing whether the recipient is inactive in the recipient list

You can display the recipients from this list and display or change the recipient lists.
Displaying the Recipient of a Document
Displaying the Documents That a Recipient is Sent

Use
You can use this function to check which documents a recipient should receive via recipient lists.

Prerequisites
You have allocated at least one document to the recipient in a recipient list.
The user must have the required Authorizations [Seite 466].

Procedure
If you want to display the documents that the recipient should receive via recipient lists, proceed as follows:

1. Choose Recipient list \(\rightarrow\) Documents of recipient from the Document distribution menu.
   The Display all documents of a recipient screen appears.
2. Choose the recipient type by displaying the possible entries for the Recipient name field.
   a) Select a type, for example, distribution lists.
   b) Choose Continue. You see a dialog box for the recipient type you selected.
   c) Enter further selection criteria or enter a name.
   If your entries are correct, the Display all documents of a recipient screen appears again.
3. If required, enter a Context [Seite 413].
   - If you only want to display documents that the recipient is to receive via distribution lists whose use is restricted by a context, enter the context in the Context field.
   - If you want to be able to display all the documents that the recipient is to receive without any restrictions, enter the special character * in the Context field.
4. Choose Continue.

Result
You see an overview that is divided up as follows:

- In the first part, you see the recipient data (recipient name and type) and, where appropriate, the context that you have used to limit the recipient list search.
- In the second part, you see a list of all the documents that a recipient should be sent using recipient lists.
  You also see further information, for example the distribution type and the name of the recipient list.

You can display the recipients and the documents from this overview and display or change the recipient lists.
Displaying the Documents That a Recipient is Sent
Defining a Context

Use
You use a context to define the conditions for document distribution using recipient lists. For example, you want to distribute a version that has just been created to different recipients from a version that has already been released.

Integration
You allocate the context to a recipient list. By entering a context, you can limit the number of recipient lists that are considered when you start the document distribution. The document is only sent to those recipients for whom the chosen context has been maintained in the recipient list.

If you enter the special character * in the context field, all the recipient lists are taken into account. Even the recipient lists that a specific context has been allocated to are taken into account.

Prerequisites
You must have defined the context in Customizing for the Document Management System, under Document distribution → Context → Define context.

💡 Even if you do not want to use a context, you should enter the special character * in the Context field. This character is the default entry in the standard system. You should not delete this entry.

If you only want recipient lists with a specific context to be taken into account when you distribute documents automatically following a certain event, you must make the appropriate settings in Customizing for the Document Management System, under Document distribution → Context → Allocate context to an event.

Features
You set the conditions for distribution when you define the context. You decide:

- which original file is to be distributed
  You can overwrite this when you distribute manually.
- whether receipt of the document should be confirmed
  This default value is set in Customizing when you define the context.
  If you start the distribution manually, you can enter several recipients with different distribution types for the distribution order. The Send confirmation of receipt indicator allows you to determine whether a confirmation of receipt should be sent to the person responsible - provided that the distribution type supports a confirmation.
  Where a confirmation of receipt is concerned, the recipient must confirm receipt, for example by sending the confirmation of receipt back to the person responsible. The person responsible then sets the status of the distribution package in the distribution order log to Receipt confirmed.
- whether a manual check is supported for the documents
Defining a Context

This default value is set in Customizing when you define the context. If you start the distribution manually, you can enter several recipients with different distribution types for the distribution order. The Control output indicator allows you to determine whether the check takes place or not - provided that the distribution type supports a check of this nature.

The manual check is useful, for example, if the output is on paper and you want to check whether the printing process was successful.

- whether you want to send the documents immediately or later

Determining the Recipient List According to Context

When the document distribution is started (manually or automatically), the system determines the recipient list according to the context.

- **Manual Start**
  
  If you start the distribution manually, you can determine the context for the recipient lists.

- **Automatic Start**
  
  The document distribution can be started automatically when a certain event (status change) takes place in SAP Business Workflow. You can use a context to determine who receives the document(s) by allocating a context to the event and entering this context in the recipient list. When the distribution is started, the system takes into account all the recipient lists with the context that you have allocated to the event.

  If you have not allocated a context to the event in Customizing, the system sends the document(s) to the standard recipient list.

  **See also:** Starting the Distribution [Seite 438]

Activities

If you create or change a recipient list, enter the desired context.
Defining the Distribution Type

Use
You have to send all sorts of different documents in your company. For example, you may have to forward printed customer requests to the development department, or changes to an engineering/design drawing may have to be examined by several different employees in different branches of the company.

The distribution of these documents takes place in different ways. The distribution type controls it.

Integration
The distribution types for the document distribution system are based on the Communication Types in Central Address Management [Seite 417] (CAM). You can specify these communication types to suit the needs of document distribution in the document management system by making additional settings.


Prerequisites
You must have done the following before you can make any definitions regarding the distribution type:

- If you want to store original files on a specific computer for document distribution purposes, this computer must be accessible via the network.
  
  The data transfer takes place via FTP (File Transfer Protocol). You must enter a user and a password for this computer in Customizing for the Document Management System (General data → Maintain global settings). This user must have the appropriate authorizations on the computer.
- If you want to send special SAPScript Forms [Seite 422] for the title page, you must create these using SAPscript.
- If you want to send the documents to a distribution point (internal SAP users or an organizational unit), you must have defined this in the R/3 System.
- If you want to store the original files on a computer, you must define a platform-independent directory, under Document distribution → General settings → Platform-independent file names.

Features
The distribution type can, for example, control the distribution process as follows:

- By being assigned to a Communication Type in Central Address Management [Seite 417]
- By defining whether, for example:
  - A check is supported for the output of the originals.
    
    This indicator only controls whether the check is supported by even one distribution type. You define that the check should take place with the manual distribution type.
Defining the Distribution Type

- Whether receipt must be confirmed.
  This indicator only controls whether the check is supported by even one distribution type. You define that receipt should be confirmed with the manual distribution type.

- By defining how the original application files should be distributed:
  - Value 1: Object references are distributed (BOR object)
  - Value 2: Original application files are distributed as an attachment to a mail (buffered on the application server)
  - Value 3: Original application files are distributed to another computer
    For example, if the files are to be copied to another computer, you must enter the computer name and path.
    If the original files are to be copied from a URL (Uniform Resource Locator) using an Internet transaction server, you can enter one URL for each distribution type. The URL is extended by the parameters that uniquely identify the original application file during the distribution process.
    Example for URL:
    http://pgwdfalr.wdf.XXX-ag.de:1080/scripts/wgate.exe/?~service=webrfc&

- By entering forms for the title page and confirmation of receipt
- By entering data for the distribution point (internal SAP users or organizational unit)
  The distribution point is relevant to the following distribution types:
  - ORI (post)
    Distribution point receives a copy of the originals
  - LET (post)
    Distribution point receives mail with references to documents
  - PLO (plotter)
    Distribution point receives a file for plotting
  - COV (list of documents)
    Distribution point receives a printed list of the documents that are to be distributed. In this case, the documents are available, for example they have been plotted.

**Distribution Types in the Standard System**

Several different distribution types are supported in the standard system.

**See:** Distribution Types in the Standard System [Seite 419]

**Activities**

If you create or change a recipient list, enter the desired distribution type when you enter the recipient.
Distribution Type and Communication Type

Communication Type and Recipient’s Address

The communication type from central address management (CAM) determines how the information is sent to a recipient. You can maintain communication types for internal users, external companies, and for external contact people. A standard address is entered for each communication type. This address is copied when you send the documents.

The addresses that are needed for SAPoffice to function correctly are stored and maintained in address management.

- Address data for internal distribution
  Addresses in address management within SAPoffice (internal SAP user)

- Address data for external distribution
  Addresses such as mail recipients outside SAPoffice (for example, Internet addresses)

You should maintain the communication types via which you can reach the recipient in the address data for each recipient.

Distribution Type and Communication Type

The Distribution Types [Seite 415] for document distribution are defined using the CAM communication types as a basis. These communication types are enhanced by additional functions to form the distribution types used for document distribution.

The following distribution types are supported in the standard system:

<table>
<thead>
<tr>
<th>Distribution types</th>
<th>Description</th>
<th>Communication Types in Central Address Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>RML</td>
<td>SAPoffice mail (BOR object as attachment)</td>
<td>RML</td>
</tr>
<tr>
<td>RMA</td>
<td>SAPoffice mail (originals as attachment)</td>
<td>RML</td>
</tr>
<tr>
<td>ITS</td>
<td>Intranet (one URL for one package)</td>
<td>RML</td>
</tr>
<tr>
<td>INT</td>
<td>E-mail (originals as attachment)</td>
<td>INT</td>
</tr>
<tr>
<td>HTP</td>
<td>E-mail (URLs for access via ITS)</td>
<td>INT</td>
</tr>
<tr>
<td>ITE</td>
<td>Internet (one URL for one package)</td>
<td>INT</td>
</tr>
<tr>
<td>LET</td>
<td>Postal address (BOR object as attachment)</td>
<td>LET</td>
</tr>
<tr>
<td>ORI</td>
<td>Postal address (copy of the original files)</td>
<td>LET</td>
</tr>
<tr>
<td>PRT</td>
<td>Print</td>
<td>PRT</td>
</tr>
<tr>
<td>PLO</td>
<td>Plot</td>
<td>PRT</td>
</tr>
<tr>
<td>COV</td>
<td>Print list of documents</td>
<td>PRT</td>
</tr>
<tr>
<td>FAX</td>
<td>Fax</td>
<td>FAX</td>
</tr>
</tbody>
</table>
Distribution Type and Communication Type

See also: List of Distribution Types in the Standard System [Seite 419]
List of Distribution Types in the Standard System

SAP Mail

A SAPoffice mail is sent with this distribution type. The cover page information is copied to the mail text. The confirmation of receipt is sent as an attachment.

You have two options if you want to send attachments:

- **RML** (SAPoffice mail with BOR objects as attachment)
- **RMA** (SAPoffice mail with original application files as attachment)
- **ITS** (SAPoffice mail with documents as attachment)

  The recipient in an Intranet receives a link that can be used to start a document search in the Word Wide (service CVW3 [Seite 298]). Activating this link displays all the matching documents in a results list.

E-Mail

A SAPoffice document is sent as an e-mail with this distribution type.

You have two options for distribution:

- **INT** (e-mail with original as attachment)
  
  The cover page information is copied to the mail text. The original application files are sent as attachment to the mail.

- **HTP** (E-Mail)
  
  An external recipient receives an e-mail telling him that he has access to documents. The recipient can see the URL (uniform resource locator) in the e-mail. He can use this URL to access the original file via an Internet transaction server.

  The recipient collects the files from the R/3 System via IAC (Internet Application Component). The ITS (Internet Transaction Server) allows access to these documents.

  You must activate the function module CVVW_GET_ORIGINAL if you want to be able to access the ITS (transaction SMWO, function Internet release → Function modules, create function module; function Release → Release).

- **ITE** (e-mail with URL as attachment)
  
  The external recipient in an Intranet receives a link that can be used to start a document search in the Word Wide (service CVW3 [Seite 298]). Activating this link displays all the matching documents in a results list.

Post

The documents are sent to the recipient’s postal address with these distribution types.

The documents are first sent to a distribution point that then assumes the task of distributing the documents to the recipients. If the Send to distribution point indicator is set for the distribution
List of Distribution Types in the Standard System

type and no distribution point has been entered, then the distribution point is determined as follows:

- If you start the distribution manually, the current user is taken as distribution point.
- If the distribution is started by a Workflow event, the user who initiated the event is taken as distribution point.

You have the following options for distribution:

- **LET** (postal address with BOR objects as attachment)
  A SAPoffice mail with the document references (BOR objects) as attachment is sent to the distribution point. The person responsible must, for example, print out the documents, copy them to a disc or CD, and send them to the recipient.

- **ORI** (postal address with a copy of the original files)
  The original files are made available on a specific computer. At the same time, a SAPoffice mail is sent to the distribution point (SAP user or organizational unit).
  The recipients are told where the files are stored in the SAPoffice mail. The person responsible must, for example, copy the documents to a disc or CD, and send them to the recipient.

**Print**

Documents are printed with this distribution type. The original files are transferred to SAPspool.

- **PRT** (Print)
  The cover sheet, the original files, and if required, a confirmation of receipt are printed out. The printer must be able to process the format of the original files. This is usually postscript. If the printer cannot process the file format, you must convert the files to a format that they can be printed in. You can make this conversion in SAPconnect.

- **COV** (printing a document list)
  The distribution point receives a printed list of the documents that are to be distributed. The original files are available. The documents are printed on the default printer for the distribution point.

**FAX**

You can use the FAX distribution type to fax documents to a recipient.

The fax machine must be able to process the file format.

**Plot**

Documents are transferred to an external plotting system with this distribution type. The original files are copied from the distribution module to a specific computer. The plotting system then receives the information that the these original files are to be plotted.

Plotters are defined in the same way as printers in the R/3 System. The only difference is that plotters are created with co-type L. You must define a printer command for this type of printer. A script file is called on an application server and the interface to the external plotting system is established.

When you call this script file, an ASCII file that has been generated (SAPscript form DDS_COVER_PLO) is transferred in the form attribute name = attribute value.
You can transfer all the information in a distribution order to the external plotting system in this way. These parameters must be evaluated and the distribution of the original files must be started in the script.

**Prerequisites**

1. The external plotting system has to interpret the ASCII file and initiate a plotting order.
2. In Customizing, you have to:
   - Enter a plotter for the recipient or the distribution point for distribution type PRT. You do this by choosing *Distribution type → Define distribution type.*
   - Define which SAP printers should support the plotter functions. Enter all possible plotters by choosing *Document distribution → Define plotter.*
3. You must be able to access the storage location of the original application files from the external plotting system.
SAPscript Forms

Use
You need SAPscript forms when you send a distribution package.

- **Cover sheet**
  The recipients receive an SAP mail via SAPoffice. This mail contains distribution information. The SAP mail is generated for every distribution type by a SAPscript form that is denoted as a cover sheet.

  In the standard system, there are the following forms for the different distribution types:
  - DDS_COVER_PAGE
  - DDS_COVER_ITS
  - DDS_COVER_PLO
  - DDS_COVER_ORI
  - DDS_COVER_HTP

- **Confirmation of receipt**
  The confirmation of receipt contains information telling the recipient who he/she has to confirm receipt of the document with (distribution point address).

  In the standard system, there is the form DDS_RECEIPT for this purpose.

Integration
The function module CVV4_GENERATE_FORMULAR at run-time generates the SAPscript forms. Each form for document distribution is divided into four areas that are denoted as page windows:

- HEADER
- ADDRESS
- ORDER
- MAIN

The function module calls these windows in a predefined sequence. Language-dependent text elements are called in these windows. The fields are called with different structures. Their data is determined at run-time.

Structure
The following overview shows the text elements of the individual page windows:

<table>
<thead>
<tr>
<th>Text element</th>
<th>Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEADER</td>
<td>None</td>
</tr>
</tbody>
</table>
### ADDRESS

<table>
<thead>
<tr>
<th>Text element</th>
<th>Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDRESS</td>
<td>ADRS_REC</td>
</tr>
<tr>
<td></td>
<td>(DB structure: ADRS_PRINT - recipient's address in a prepared form)</td>
</tr>
<tr>
<td></td>
<td>ADRS_WA</td>
</tr>
<tr>
<td></td>
<td>(DB structure: ADDR3_VAL - return structure for recipient's address)</td>
</tr>
<tr>
<td></td>
<td>ADRS_DIS</td>
</tr>
<tr>
<td></td>
<td>(DB structure: ADRS_PRINT - distribution point address in a prepared form)</td>
</tr>
<tr>
<td></td>
<td>ADRS_DIS_WA</td>
</tr>
<tr>
<td></td>
<td>(DB structure: ADDR3-VAL - return structure for distribution point address)</td>
</tr>
</tbody>
</table>

### ORDER

<table>
<thead>
<tr>
<th>Text element</th>
<th>Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORDER</td>
<td>DRZO</td>
</tr>
<tr>
<td></td>
<td>(DB structure: DRZO - distribution order)</td>
</tr>
<tr>
<td></td>
<td>DRZOI</td>
</tr>
<tr>
<td></td>
<td>(DB structure: DRZOI - initial order)</td>
</tr>
<tr>
<td></td>
<td>DRZOP</td>
</tr>
<tr>
<td></td>
<td>(DB structure: DRZOP - distribution package)</td>
</tr>
<tr>
<td></td>
<td>TDICT</td>
</tr>
<tr>
<td></td>
<td>(DB structure: TDICT - distribution types)</td>
</tr>
</tbody>
</table>

### MAIN

<table>
<thead>
<tr>
<th>Text element</th>
<th>Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTERISTICS</td>
<td></td>
</tr>
<tr>
<td>(classification data of the initial order)</td>
<td>CHARACT (database structure CVI - characteristic)</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>DESCRIPT (short text, maximum four lines)</td>
</tr>
<tr>
<td>HEADER</td>
<td>None (title and text)</td>
</tr>
<tr>
<td>DOCUMENTS (called for every document)</td>
<td>DRZOC (DB structure: DRZOC - part order)</td>
</tr>
<tr>
<td></td>
<td>DRZOI (DB structure: DRZOI - initial order)</td>
</tr>
<tr>
<td></td>
<td>DRZO (DB structure: DRZO - distribution order)</td>
</tr>
<tr>
<td></td>
<td>DRAW_STR (DB structure: DRAW - document info record)</td>
</tr>
<tr>
<td></td>
<td>DRAT (DB structure: DRAT - document texts)</td>
</tr>
<tr>
<td>ORIGINALS (called for every original application file)</td>
<td>DRZOF (DB structure: DRZOF - original files of a part order)</td>
</tr>
<tr>
<td></td>
<td>URL_PARAM1 (field - file name)</td>
</tr>
<tr>
<td></td>
<td>URL_PARAM2 (field - part order ID)</td>
</tr>
<tr>
<td></td>
<td>URL_PARAM3 (field - workstation application)</td>
</tr>
<tr>
<td>DOL_CHARACTERISTICS (called for every document)</td>
<td>DOC_CHARACT (DB structure: CVI-CHARACTERISTICS)</td>
</tr>
</tbody>
</table>
Distribution orders

Definition
A distribution order is an order for the system to distribute documents in the document management system (DMS) to chosen recipients. It can be composed of one or more initial orders. The system identifies the distribution order by an internal number.

Use
The system stores all the data that is required to send the documents via SAP Business Workflow to the recipients in the distribution order.

Structure
Data from the Initial Order [Seite 428], the Part Order [Seite 429], and the Order Package [Seite 431] are stored in a distribution order, for example data concerning:

- The Recipient
  - Recipient type (for example, SAPoffice distribution list) and recipient ID
  - Recipient language and number of copies
- The Original Application File (of the document info record) that is to be distributed
- Communication
  - Distribution types
- Data on the Distribution Process
  - Reason for the distribution. This is determined internally depending on the way that the distribution is started
    Indicator showing whether the order was started manually or automatically by an event from SAP Business Workflow.
  - Part order ID, package ID
  - Processing status
    This status is set internally by the system, for example
    Distribution order awaiting distribution initiation due to event being created
  - Time and person involved in creating and changing the distribution order
  - Time and person involved in output and receipt confirmation
  - Distribution point
  - Description

Integration
The system creates an initial order when you start the document distribution. A distribution order is then initiated by this initial order. The distribution order can be initiated as follows:
Distribution orders

- Manual Start
  - If you start the distribution manually and the *Immediate distribution* indicator is set, the *Distribution order initiated* event is created. The distribution process is started immediately.
  
  - If you start the distribution manually and the *Immediate distribution* indicator is **not** set, the distribution process is not started. The *Distribution order initiated* event is created later, for example by a background job such as RCDDSSTAR.

- Automatic Start by an Event
  
  If the distribution is started by an event from SAP Business Workflow, the person responsible must start the distribution order manually from the distribution log.

The distribution process is started according to the status of the [Part Orders][1]:

This distribution order is split into a 1-1 relationship of document to recipient for the document distribution and processed further as a part order.

**SAP Business Workflow**

Irrespective of whether the distribution is started manually or automatically, processing takes place via SAP Business Workflow.

How the distribution order was created:

- Influences the status that the system sets internally for each initial order
- Controls the further distribution process.

The following table shows the statuses that are set when the distribution is started:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
</table>
| SY (synchronous)| This status is set automatically if the *Immediate distribution* indicator is set when you start the distribution manually. After the initial order has been created, the *Distribution order initiated* event is started immediately. The distribution process is started at once and controlled by the distribution order. 
If the distribution type allows for original application files to be made available on a specific computer, this file transfer takes place immediately. |
| AS (asynchronous)| This status is set automatically if the *Immediate distribution* indicator is **not** set when you start the distribution manually. The system only creates an initial order for each distribution that is started. 
The distribution order is **not** started until later. For example, a background job can create the *Distribution order initiated* event. 
This means that you can organize your company in such a way so that several orders are collected first, and then they are all sent to the recipient at once, for example every evening. 
If the distribution type allows for original application files to be made available on a specific computer, this file transfer takes place when you start the background job. |

[1]: Part Orders [Seite 429]
MA (manual) | This status is always set if a distribution order was started by an event from SAP Business Workflow. The person responsible must start the distribution order manually from the Distribution Log [Seite 442]. This means that you can check which distribution processes are started.

These statuses control how the part orders are processed further.

- A main workflow (WS 20000104 Document distribution) is started in SAP Business Workflow for every distribution order. The entry parameters for this main workflow are the individual part orders. There are different checks, for example checks to determine whether the original application files exist.

- Part orders are grouped together according to recipient and distribution type (for example, fax) to form a distribution package.

- A sub workflow (WS 20000137 Process distribution package) is started for every distribution package. This sub-workflow controls distribution for the different distribution types. If output or receipt confirmations are required, these are checked, for example.

- After all sub-workflows have been successfully completed, the system completes the distribution order. The system saves the individual processing steps in a Distribution Log [Seite 442] that you can check at any time.
Initial Order for Distribution

Definition

This is an order that the system generates when the distribution is started. The order is identified by an internal number. This order defines which documents are sent to which recipients. An initial order is divided into several part orders. A part order stores the unique link between a recipient and a document.

Use

The distribution order is started by the initial order.

- If the Immediate distribution indicator is set, the distribution takes place synchronously. The system starts a distribution order immediately from the initial order.

- If the Immediate distribution indicator is not set, the distribution takes place asynchronously. The system initiates the distribution order later - for example, if the distribution is started by a background job. It may be that one distribution order is created from several initial orders.

Structure

The following data, for example, is stored in an initial order:

- Type of Initiation for the Initial Order
  - Indicator showing whether the order was started manually or automatically by an event from SAP Business Workflow.

- Context

- Initiator

- Indicator showing whether a cover sheet and confirmation of receipt should be sent and whether an check should take place to ensure the document was sent.

- Due date for the return of the documents

- Description

Integration

As soon as the documents have been distributed, the system initiates the distribution order that will be processed further by SAP Business Workflow.
Part Order for Distribution

Definition
This order stores information on the 1 to 1 link between a recipient and a document. The system generates this order automatically. The order is identified by an internal number. The system groups together several part orders into one initial order when the document distribution is started.

Use
Since you can use different distribution types to send documents to several recipients in one initial order, the system needs special data for each individual distribution process. This data is saved in part orders.

Structure
The following data, for example, is stored in a part order:

- **Recipient Data**
  - Recipient type (for example, SAPoffice distribution list) and recipient ID
  - Recipient language and number of copies

- **Communication Data**
  - Distribution type (if required, entry of a communication address, for example printer)

- **Data on the Distribution Process**
  - Medium for the document distribution
  - Type of copy
  - Initial order ID, distribution order ID, package ID
  - Internal status for the processing status
  - Time and person involved in creating and changing the part order
  - Time and person involved in output and receipt confirmation

Integration
When a distribution order is initiated, several documents can be allocated to several recipients using the different distribution types. The data for each individual distribution process of a document to a recipient is saved in a part order. The system checks whether each individual part order can be executed. The distribution order can be executed even if some of the part orders are erroneous.

The distribution process that follows for the individual part orders depends on how the distribution was started.

- In a synchronous distribution, all the part orders are grouped together to form a distribution package in which documents of the same distribution type are sent to a recipient. The distribution is controlled by SAP Business Workflow (WS 20000137 Process distribution order package).
Part Order for Distribution

- In the following processing situations, the system creates individual part orders that are not allocated to any distribution order package:
  - Distribution started automatically by an event from SAP Business Workflow.
    You must start the distribution for these part orders manually from the distribution log.
  - Asynchronous distribution (Immediate distribution indicator is not set).
    You can either start the distribution for these part orders manually from the distribution log, or it is started by a background job.

You can follow the processing status of each part order in the Distribution Log [Seite 442].
Distribution Order Package

Definition

The distribution order package is a collection of part orders that sends documents of the same distribution type to a recipient. The system generates this order automatically. The order is identified by an internal number.

Use

For example, if an employee is to receive an engineering/design drawing, documentation on the changes, and a photograph of the model per fax, these three part orders are grouped together to form one distribution order package.

Structure

The structure of a distribution order package is determined by the Part Order [Seite 429] data.

Integration

Document distribution is controlled by the main workflow WS 20000104. In this workflow, all the part orders are grouped together to form a distribution package in which documents of the same distribution type are sent to a recipient.

A sub-workflow is started for each distribution order package. In this sub-workflow, the SAP mail that is to be sent according to the distribution type is generated, and the physical distribution via the communication interface is started (WS 20000137 Process distribution order package).

After the documents have been successfully distributed, each individual distribution order package confirms this. The main workflow is not ended until all the distribution order packages have been successfully completed.

Entries are made in a distribution log for the individual processing steps.
Distribution Process

Areas of Usage

One or more documents of different document types (for example, SAP mail, fax) from the document management system (DMS) are sent to one or more recipients in several processing steps.

Prerequisites

2. You must have defined the recipient or recipient lists that you want to send the documents to.

See also: Starting Distribution by an Event [Seite 438]

3. The distribution process is controlled by events from SAP Business Workflow. All the necessary event type linkages must be activated for this. You can make the activation for all the events required in one step in Customizing, under Document distribution → General settings → SAP Business Workflow → Activate event type linkage.

Process

You can either start the distribution manually, or it is triggered automatically by an SAP Business Workflow event. Irrespective of how you started the distribution, the system creates the event BUS1082 (distribution order) - INITIATED (created). This event causes the next distribution step to take place:

- If you start the distribution manually, you can either enter a context that you limit your choice of recipient lists with, or you use the standard recipient list.

- If the distribution is started by a workflow event, the system determines the standard recipient list for the documents. The context is determined according to your settings in Customizing.

If you start the distribution manually, you can enter one or more documents. For the distribution process, the system creates one part order for each document and recipient.

The individual part orders are grouped together for each recipient and distribution type to form distribution order packages. The system performs the distribution according to the settings for the distribution type. This distribution type can, for example, support a cover sheet, a check whether the document has been sent, or a confirmation of receipt.

When the individual distribution order packages have been successfully sent, this is confirmed internally in the distribution order.

Result

The system logs all the distribution steps in a distribution log. You can check the processing status of a part order at any time.

If a distribution order was triggered by an event from SAP Business Workflow, the person responsible must start the distribution order manually from the Distribution Log [Seite 442]. This means that you can make an additional check to see which distribution processes are started.
Starting Document Distribution

Use
You use this function to start distribution for the chosen document version manually. The system controls the distribution via a Distribution Order [Seite 425] that is created internally.

Prerequisites
You must have defined the recipient or recipient lists that you want to send the documents to.
The user must have the required Authorizations [Seite 466].

Procedure
The Start distribution: Initial screen appears.
2. Enter the key data for the document.
   If you want to choose the version from a selection list, enter the special character * in the Version field. You can copy the version by double-clicking on it.
3. Enter data for the recipient list.
   If the document is assigned to a recipient list, you can choose one of the following options:
   - If you want to send the document to the standard recipient list, choose Standard.
     The system determines the standard recipient list.
   - If you want to send the document to recipient lists with a specific context, choose All and enter the context.
   - If you want to send the document to recipient lists with different contexts, just choose All.
     The system determines all the recipient lists that the document has been entered in.
     You can delete individual recipients.
   If you want to send the document to one or more recipients (without a recipient list) just once, choose None.
4. If you want the recipient to confirm the receipt, set the indicator Confirm receipt.
The system displays Return date field where you enter the date by which the document must be returned.
5. Choose Execute. The Start document distribution basic data screen appears.
6. If required, enter data for the distribution point.
7. If required, set the indicator for sending a confirmation of receipt and for checking that the document is sent.
8. If you want the distribution process to be started immediately, set the Immediate distribution indicator.
9. Enter the documents that you want to be distributed. The system copies the document data from the initial screen. If required, enter other documents that you want to be distributed.
10. Enter the recipients of the documents. If the system determines at least one recipient list according to the selection criteria on the initial screen, the allocated recipients and the send data are listed.

The default distribution type is determined for each recipient if you have not entered a distribution type for the recipient in the recipient list. The system determines the appropriate default distribution type from the default communication type in central address management.

If required, enter other recipients and distribution data, for example, type of copy.

11. Start distribution.

**Result**

If you have set the *Immediate distribution* indicator, the distribution process is started immediately and controlled by the distribution order. If you have not set this indicator, the distribution process is started later as a background job.

You can keep track of all these processing steps in the Distribution Log [Seite 442].
Starting the Distribution for a Recipient List

Use

You use this function to start the document distribution manually for a chosen recipient list. The system controls the distribution via a Distribution Order [Seite 425] that is created internally.

The chosen recipient list is used as a template. Since the documents are only stored with the document number and the document type in the recipient list, and not with the document part and version, the system suggests the document automatically as follows:

1. Determines the document part according to the alphanumeric sequence.
   - Document part 000 always has priority.
2. Determines the version that was last released. The system checks the document status. A document is released when it has a document status that has the release indicator in Customizing for the Document Management System.
3. If there is no released version, the system determines the version that was last created. The check only takes place for the date. If more than one version exists for a date, the version with the highest number is taken.

The following versions exist for document PAP-AA, document type TXT, document part 000:

<table>
<thead>
<tr>
<th>Version</th>
<th>Created on</th>
<th>Status Released</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>12.12.1998</td>
<td>no</td>
</tr>
<tr>
<td>01</td>
<td>31.02.1999</td>
<td>yes</td>
</tr>
<tr>
<td>02</td>
<td>05.01.1999</td>
<td>no</td>
</tr>
</tbody>
</table>

The system determines the released version 01.

The following document parts with the following versions exist for document DOK-01, document type DRW:

<table>
<thead>
<tr>
<th>Document part</th>
<th>Version</th>
<th>Created on</th>
<th>Status Released</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>00</td>
<td>12.12.1998</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>01</td>
<td>25.01.1999</td>
<td>no</td>
</tr>
<tr>
<td>001</td>
<td>00</td>
<td>13.01.1999</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>03</td>
<td>17.01.1999</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>04</td>
<td>24.02.1999</td>
<td>yes</td>
</tr>
</tbody>
</table>
The system determines document part 000, version 01. Document part 001 has a released version, but document part 000 has higher priority.

You can define a company-specific logic for determining the document part and the version with a user exit.

**Prerequisites**

You must have defined the recipient or recipient lists that you want to send the documents to. The user must have the required Authorizations [Seite 466].

**Procedure**

1. From the Document distribution menu, choose Distribution → Start → For recipient list.
   The Start document distribution basic data screen appears.
2. Enter the recipient lost ID and choose Continue.
   A dialog box appears with a warning prompting you to check the default values for document part and version.
3. Choose Continue.
   The Start document distribution basic data screen appears.
4. If required, enter data for the distribution point.
5. If you want the recipient to confirm the receipt, set the indicator Confirm receipt.
   The system displays Return date field where you enter the date by which the document must be returned.
6. You can also set the indicator Output control.
7. If you want the distribution process to be started immediately, set the Immediate distribution indicator.
8. Check
   - The document parts and versions that the system has automatically determined. If required, enter other documents that you want to be distributed.
   - Recipients of the recipient list. Enter any other recipients that you want to receive the documents. If required, enter distribution data, for example the distribution type.

**Result**

If you have set the Immediate distribution indicator, the distribution process is started immediately and controlled by the distribution order. If you have not set this indicator, the distribution process is started later as a background job.

You can keep track of all these processing steps in the Distribution Log [Seite 442].
Starting Distribution by an Event

Use
Distributing documents to chosen recipients in a recipient list can automatically lead to a specific object (for example, document) processing status. For example, you can immediately send engineering/design drawings that have been released in the engineering/design area to work scheduling colleagues.

Integration
The processing status that is to start an automatic distribution is represented by an SAP Business Workflow event. As soon as the event (change in status) takes place, automatic distribution is started.

Prerequisites
1. You must activate the event linkage coupling in SAP Business Workflow for the event that is to start the automatic distribution. You do this under Tools → SAP Business Workflow → Development → Utilities → Events → Type linkages.
2. If you want the documents to be distributed to recipient lists with a specific context, you must make the appropriate settings in Customizing for the Document Management System, under Document distribution → Context → Allocate context to an event.

Features
In the standard system, an event that starts an automatic document distribution is defined for both document info record and change order processing.

Events in the Standard System
The following overview shows the events that are defined in the standard system for automatic distribution (Receiver type: DISTRIBUTION).

<table>
<thead>
<tr>
<th>Object type</th>
<th>Events</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRAW Document info record</td>
<td>CHANGED (changed)</td>
<td>Released documents are sent to recipient lists with a specific context or to the standard recipient list.</td>
</tr>
<tr>
<td>ECM Engineering change management</td>
<td>RELEASED (released)</td>
<td>Released change order documents are sent to recipient lists with a specific context or to the standard recipient list.</td>
</tr>
</tbody>
</table>

Automatic Distribution from Document Info Record Processing
An automatic start to the distribution takes place in the following steps in the standard system:
1. As soon as the document has been changed (event DRAW - CHANGED), the system checks whether the document status is set to Released using the check function module CVV5_EVENT_CHECK_REL_STATUS.
A document is counted as being released if it has a status that the release indicator in Customizing is set for.

- If the document has been released, the receiver function module CVV5_EVENT_START_DISTRIBUTION for event DRAW - CHANGED is processed.
- The system determines the recipient depending on the settings in Customizing. If a context is allocated to the event, the recipient lists are determined with the appropriate context; if not, the documents are sent to the appropriate standard recipient lists.

2. The system starts the distribution. A distribution order is created. A part order is transferred for each document-recipient allocation.

**Automatic Distribution from Change Order Processing**

An automatic start to the distribution takes place in the following steps in the standard system:

1. The change order is released if you set the *Released* system status (event: ECM - RELEASED). Since this system status is integrated in an internal system network, no other additional checks are required. There is no check function module.
   - The receiver function module CVV5_EVENT_START_DIST_ECM for event ECM - RELEASED is processed.
   - The system determines all the documents that are affected by the change with the appropriate change order (object management record in change order).
   - The system determines the recipients depending on the settings in Customizing. If a context is allocated to the event, the recipient lists are determined with the appropriate context; if not, the documents are sent to the appropriate standard recipient lists.

2. The system starts the distribution. A distribution order is created. A part order is transferred for each document-recipient allocation.

**Activities**

The triggering events DRAW - CHANGED and ECM - RELEASED are defined in the standard system, but not activated. If you want to use these events, you must activate them. You do this on the event type linkages detail screen (*SAP Business Workflow* → *Development Utilities* → *Events* → *Type linkages*).

If the distribution is started automatically by an SAP Business Workflow event, the system automatically determines the recipients and the documents that are to be distributed. However, a control step is supported, whereby the person responsible can decide which distribution processes really are started. All the part orders that have been created automatically by an event have the status MA (distribution must be started manually).

This check and the distribution take place in the *Distribution Log* [Seite 442].
Additional Data for Distribution Orders

Use
You can use additional data to create enterprise specific information for the distribution order. For example, you can enter in what format the document is and how many holes it has.

Integration
Additional data is maintained as characteristics of a class (class type 0170 document management) and are assigned to a context.

Prerequisites
To maintain additional data, do the following:

- Enter the required data in classification
  - Maintain the additional data for characteristics
  - Assign these characteristics to a class of the class type 170 document management.
    You can also assign the characteristics Format and No. of holes to the class V-1
- Assign the class, such as V-1 with the desired characteristics to a context in Customizing of Document distribution

Features
When you start the distribution for a context that supports additional data you assign values to the characteristics of the class.

Format Legal size
No. of holes: Five holes

All additional data is printed on the cover page of the distribution order.

You can search for certain distribution orders with additional data (for example, legal size and five holes) using the menu in classification.

Search using Classification Distribution Orders

Use the function Find objects using class (transaction code CL30N). You can display the distribution orders that were found (transaction code CVII).
Distribution Log

Definition
The most important steps in the distribution process are logged here.

Use
You can follow up each processing step in the distribution process in this log. Apart from being a source of information, you can also perform some distribution activities directly from the distribution log.

- In case of error, you can start the distribution again from the distribution log.
- If the distribution is started automatically by an SAP Business Workflow event, you can decide which part orders really are started.

Prerequisites
The distribution was started either manually or automatically by an event from SAP Business Workflow.
The user must have the required Authorizations [Seite 466].

Structure
The distribution log is displayed in a list. It contains one or more blocks of information for each distribution package. Each block lists all the part orders contained in that distribution package.

There is an action log for each part order. This action log contains all the steps involved in the part order.

See also: Displaying the Distribution Log [Seite 442]

Integration
You can influence the distribution process directly from the distribution log.

For each part order, you can perform other distribution process activities depending on the status.

See also:
Starting the Distribution from the Distribution Log [Seite 444]
Confirming Output and Receipt [Seite 447]
Ending a Part Order [Seite 449]
Displaying the Distribution Log

Use
You can use this function to give you information about the distribution process. You can check the state of the distribution for each individual part order and you can display additional information, for example, on the individual documents.

Prerequisites
The distribution was started either manually or automatically by an event from SAP Business Workflow.

The user must have the required Authorizations [Seite 466].

Procedure

The Start document distribution initial screen appears. This selection screen is divided into several areas where you can enter data for selecting a distribution log.

    - Distribution order, for example
      - Initial order ID, distribution order ID, part order ID
    - Document
      - Document number, document type, document part, version
    - Recipients
      - Recipient name, distribution type
    - Status
    - General data
      - Name of the person who created or changed the log, date when it was created or changed, data on the check for output and receipt

2. Enter the selection criteria.
3. Choose Execute.

    The Distribution log screen appears.

Result

List Structure
The distribution log is displayed as a list. This list is structured as follows:

- List header that displays the description or abbreviation for all the fields in the list
- Block of information for each Distribution Package [Seite 431]
Displaying the Distribution Log

There is a separate block of information for each distribution order package. The following information is displayed for each line in the block:

- Data on the distribution order package is displayed in the first line of a block (for example, package ID, recipient name, distribution type, send date, distribution point data).
- The individual part orders in a package are listed directly below the distribution order package. For a part order, the following data is displayed for each line: Part order ID, status, document data, initial order ID, recipient data, distribution order ID, medium).

To help you digest the information at a glance, the status is displayed by a traffic lights icon (red = error, yellow = distribution process has been started, green = distribution has been successfully completed).

- Block for all part orders that are not allocated to a distribution order package.
  These part orders have not been allocated to a distribution order package.

Additional Information for Part Orders

You can display additional information on each part order under the menu entry Goto.

- Action log
  List of actions that have been performed for a part order
- Workflow log
  Status information for the distribution
- Display SAPoffice mail
  You can display the SAPoffice mail that has been sent
- Document
  Document info record, Basic data screen
- Recipients
  Address data from Central Address Management
- Output address
  Example: internet mail address

Varying the List

You can display the list in different ways by using different functions. This means that you can exclude data from the list that you do not require in the current processing situation. For example, you can choose the following functions under the menu option Settings:

- Define column settings
- Save and choose display variants
- Display status of lists
Starting the Distribution from the Log

Use
You can start the document distribution from the Distribution Log [Seite 442] in different processing situations.

- When the system has started the distribution automatically by an event from SAP Business Workflow, you must start the distribution manually from the distribution log.
- You can start erroneous distribution order packages that have not been sent a second time from the distribution log.

Start Functions
Three functions are supported for starting the distribution from the distribution log:

- **Manual**
  You use this function to start the distribution of documents from part orders whose distribution was started as follows:
  - Distribution started automatically by an event from SAP Business Workflow.
  - Asynchronous distribution (*Immediate distribution* indicator is not set when the distribution is started).
  You can also start the distribution of documents from these part orders via a background job.

- **Erroneous**
  You use this function to re-send all erroneous part orders in a distribution order package, even if you only select one part order.

- **Start again with changes**
  You use this function to re-start part orders, for example, that have already been successfully completed, and make any necessary changes to the documents or recipients.

Prerequisites
The distribution was started either manually or automatically by an event from SAP Business Workflow. The part orders must be allocated to a distribution package and have a specific status.

The user must have the required Authorizations [Seite 466].

Status
A part order that you want to start the distribution for from the distribution log, must have a specific processing state (status) for each start function. The following table lists the statuses that you can start the distribution from.

<table>
<thead>
<tr>
<th>Status</th>
<th>Start manually</th>
<th>Start erroneous part orders</th>
<th>Start again with changes</th>
</tr>
</thead>
</table>

April 2001
Procedure

1. Select the part order that you want to start the distribution for.
2. Choose Extras → Start distribution → <Start function> (for example, manual).
   Please note that the part order you select must have a status that is supported for this distribution.

   How you proceed depends on the start function you choose.
   
   - **Manual**
     The system starts the distribution for the part order you select without you having to enter any further data.
   
   - **Erroneous**
     The system starts the distribution again for all the erroneous part orders in a package without you having to enter any further data.
   
   - **Start again with changes**
     The *Start document distribution* basic data screen appears, and copies the data for the documents that you want to distribute and for the recipients. You can change this data and add any other documents or recipients as required. As soon as you choose the *Start* function on the basic data screen, the system returns to the distribution log.

Result

The system starts the distribution process. You can check on the state of this process by refreshing the distribution log.
Starting the Distribution from the Log
Confirming Output

Use
When you start the distribution, you can define whether a check for the output of the originals is supported. This check is useful, for example, if the original application files are to be printed on a printer using distribution type PRT. In this case, you must check whether the printer really has printed the data, and then you must confirm this in the distribution log.

At the same time, the person who initiated the distribution, or the distribution point, receives a work item in their inbox. This work item shows that the person responsible has to check the output of the package. All the part orders in the package are displayed when this task is performed in the SAPoffice inbox. You must execute the Confirm output function.

Prerequisites

1. The system checks whether the distribution type supports an output check. You make the settings for this in Customizing for the Document Management System under Document distribution → Distribution type → Define distribution type.

2. Check output indicator
   - You must set the Check output indicator for manual distribution.
   - If the distribution is started automatically by an event with a chosen context, this context must support the output check. You make the settings for this in Customizing for the Document Management System under Document distribution → Context → Define context.

3. Part orders that an output check is to be made for are indicated in the distribution log by the status WO (Check output).

Procedure

1. Select the part order that you want to confirm the output check for.

2. Choose Extras → Confirm output.

Result
The system changes the part order status. If a confirmation of receipt is supported, the status is set to WR (Confirm receipt); otherwise it is set to OK (Distribution completed successfully).
Confirming Receipt

Use
When you start the distribution, you can define whether the recipient has to confirm receipt.
This check is useful, for example, if the documents are sent to an external company by a secretary. The external companies have to confirm receipt of the documents explicitly. The confirmation of receipt that is attached contains address data telling the company where receipt has to be confirmed (for example, telephone number of the secretary's office). The recipient can confirm receipt by telephone in the appropriate secretary's office. Receipt is then invoiced by the secretary in the distribution log. When the secretary makes this confirmation, the system sets the status of the part order to OK (Distribution completed successfully).

At the same time, the person who initiated the distribution, or the distribution point, receives a work item in their inbox. This work item shows that the person responsible has to confirm receipt of the package. All the part orders in the package are displayed when this task is performed in the SAPoffice inbox. You must execute the Confirm receipt function.

Prerequisites
1. The system checks whether the distribution type supports this confirmation of receipt. You make the settings for this in Customizing for the Document Management System under Document distribution → Distribution type → Define distribution type.
2. Confirm receipt indicator
   - You must set the Confirm receipt indicator for manual distribution.
   - If the distribution is started automatically by an event with a chosen context, this context must support the confirmation of receipt. You make the settings for this in Customizing for the Document Management System under Document distribution → Context → Define context.
3. Part orders that a confirmation of receipt is supported for are indicated in the distribution log by the status WR (Confirm output).

Procedure
1. Select the part order that you want to confirm receipt of.
2. Choose Extras → Confirm receipt.

Result
The system sets the status of the part order to OK (Distribution completed successfully).
Ending a Part Order

Use

You can ignore erroneous part orders or part orders that have not yet been sent. These part orders are counted as completed.

Prerequisites

You can ignore part orders with the following statuses:

- AS (start asynchronously)
- MA (start manually)
- ER (error)
- WO (check output)
- WR (confirm receipt)

Procedure

1. Select the part order that you want to confirm receipt of.
2. Choose Extras → Ignore.

Result

The system sets the status of the part order to IG (Ignored). No more distribution activities take place.
Enhancements using Customer Exits (Document)

Use
In order to optimize the business processes in document management you can change some functions of the SAP System by using Customer Exits [Extern]. You can, for example, add additional authorization checks.

See also:
Enhancements of the SAP System in the Area of PDM [Seite 320] and The SAP System Enhancement Concept [Extern]

Prerequisites
When you use a function exit, you must create a company-specific include program that matches the programming logic of the function module.

You want to determine the original application files for a distribution order. You create an enhancement project where you use the enhancement CVDI0003 (Determine original application files). The enhancement contains the function module for the required function (for example, EXIT_SAPLCVV1_003). The function module branches to the include program zxcvv5u02. You use this include program to program your specific functional requirements.

Features
The tables below show the enhancements for customer exits used in document distribution (development class CVDI).

Enhancements for Function Group XCVV1 (Recipient List)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save recipient list</td>
<td>CVDI0001</td>
<td>EXIT_SAPLCVV1_001 [Seite 452]</td>
</tr>
<tr>
<td>Modify initial values for screen 100</td>
<td>CVDI0002</td>
<td>EXIT_SAPLCVV1_002 [Seite 453]</td>
</tr>
<tr>
<td>Determine original application file</td>
<td>CVDI0003</td>
<td>EXIT_SAPLCVV1_003 [Seite 456]</td>
</tr>
<tr>
<td>Determine document part and version of a document</td>
<td>CVDI0004</td>
<td>EXIT_SAPLCVV1_004 [Seite 458]</td>
</tr>
<tr>
<td>Create distribution order</td>
<td>CVDI0005</td>
<td>EXIT_SAPLCVV2_001</td>
</tr>
</tbody>
</table>

Enhancements for Function Group XCVV2 (Distribution Order)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create distribution order</td>
<td>CVDI0005</td>
<td>EXIT_SAPLCVV2_001 [Seite 458]</td>
</tr>
</tbody>
</table>
Enhancements using Customer Exits (Document)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check part order</td>
<td>CVDI0006</td>
<td>EXIT_SAPLCVV2_002 [Seite 459]</td>
</tr>
<tr>
<td>Create initial order</td>
<td>CVDI0007</td>
<td>EXIT_SAPLCVV2_003 [Seite 460]</td>
</tr>
</tbody>
</table>

Enhancements for Function Group XCVV5 (Events)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine context</td>
<td>CVDI0008</td>
<td>EXIT_SAPLCVV5_001 [Seite 462]</td>
</tr>
</tbody>
</table>

Enhancements for Function Group XCVVW (ITS Access)

<table>
<thead>
<tr>
<th>Use</th>
<th>Enhancement</th>
<th>Function Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITS access</td>
<td>CVDI0009</td>
<td>EXIT_SAPLCVVW_001 [Seite 464]</td>
</tr>
</tbody>
</table>
Finding Recipient Lists (EXIT_SAPLCVV1_001)

**Definition**
Function module that is called by customer exit CVDI0001 when a recipient list is saved and before the data is written to the database.

**Use**
You cannot change the program logic. You can only change the data in the logic.

**Structure**
The interface is structured as follows:

**Parameters that can be processed in the Function Module**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i_action</td>
<td>I</td>
<td>→</td>
<td>Create a recipient list</td>
</tr>
<tr>
<td></td>
<td>U</td>
<td>→</td>
<td>Change a recipient list</td>
</tr>
<tr>
<td>e_return</td>
<td>0</td>
<td>←</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>&lt;&gt;0</td>
<td>←</td>
<td>Error</td>
</tr>
<tr>
<td>c_drzao</td>
<td></td>
<td>←→</td>
<td>As database structure DRZAO (general data in a recipient list)</td>
</tr>
</tbody>
</table>

**Tables Whose Fields can be Processed in the Function Module**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DRZA</td>
<td>As database structure CVIDRZA (recipient-document relations)</td>
</tr>
<tr>
<td>T_DRZAT</td>
<td>As database structure CVIDRZAT (language-dependent description)</td>
</tr>
</tbody>
</table>

**Integration**
You can enter your company-specific programming logic in the source code of include program zxcvv1u01.
Screen: Recipient Lists (EXIT_SAPLCVV1_002)

Definition

Function module that is called by customer exit CVDI0002 after the data for recipient list screen (screen 100, program SAPLCVV1) has been read.

Use

Depending on the function (i_function) called, documents, recipients, or general data is determined. You can change this data in the include program. The modified data is then displayed on screen 100 (program SAPLCVV1).

If you change recipient data, for example, the changes must also be made in the following tables:

- Table T_DRZA (document recipient relation)
- Table T_REC (to display the change in the table control)

Structure

The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0 &lt;&gt;0</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;</td>
<td>Error</td>
</tr>
</tbody>
</table>
Screen: Recipient Lists (EXIT_SAPLCVV1_002)

<table>
<thead>
<tr>
<th>importing</th>
<th>i_function</th>
<th>CR</th>
<th>Create recipient list</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CH</td>
<td>Change recipient list</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DI</td>
<td>Display recipient list</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RD</td>
<td>Display all recipients</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DR</td>
<td>of a document</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SC</td>
<td>Display</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SW</td>
<td>Start distribution with</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SN</td>
<td>Recipient Lists</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SR</td>
<td>Start distribution with dialog</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ST</td>
<td>Start distribution without dialog</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RE</td>
<td>Start distribution without reading existing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RP</td>
<td>recipient list</td>
<td></td>
</tr>
<tr>
<td>i_ass_id</td>
<td></td>
<td>Number of the recipient list</td>
<td></td>
</tr>
<tr>
<td>i_ref_ass_id</td>
<td></td>
<td>Number of the template for Recipient Lists</td>
<td></td>
</tr>
</tbody>
</table>

Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DRZA</td>
<td>As database structure CVIDRZA (document/recipient relation)</td>
</tr>
<tr>
<td>T_DOC</td>
<td>As database structure CVIDOC_TAB (documents displayed in the table control)</td>
</tr>
<tr>
<td>T_REC</td>
<td>As database structure CVIREC_TAB (recipients displayed in the table control)</td>
</tr>
<tr>
<td>T_IMP_OBJ</td>
<td>As database structure CVDIOBJ (table with selected document that was used to start the function)</td>
</tr>
</tbody>
</table>
**Integration**

You can enter your company-specific programming logic in the source code of include program zxcvv1u02.

| T_TEXT | As database structure CVITEXT (language-dependent description of the recipient list) - for recipient list functions only |
Determine Original Application File (EXIT_SAPLCVV1_003)

Definition
Function module that is called by customer exit CVDI0003 to determine the original application file that is to be sent.

Use
If the file is to be distributed manually (in dialog mode), this value is a default value and can be overwritten.

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;&gt;0</td>
<td>Error</td>
</tr>
</tbody>
</table>
### Determine Original Application File (EXIT_SAPLCVV1_003)

<table>
<thead>
<tr>
<th>importing</th>
<th>i_function</th>
<th>CR</th>
<th>Create recipient list</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CH</td>
<td></td>
<td>Change recipient list</td>
</tr>
<tr>
<td></td>
<td>DI</td>
<td></td>
<td>Display recipient list</td>
</tr>
<tr>
<td></td>
<td>RD</td>
<td></td>
<td>Display all recipients of a document</td>
</tr>
<tr>
<td></td>
<td>DR</td>
<td></td>
<td>Display all documents sent to a recipient</td>
</tr>
<tr>
<td></td>
<td>SC</td>
<td></td>
<td>Start distribution with Recipient Lists</td>
</tr>
<tr>
<td></td>
<td>SW</td>
<td></td>
<td>Start distribution with dialog</td>
</tr>
<tr>
<td></td>
<td>SN</td>
<td></td>
<td>Start distribution without dialog</td>
</tr>
<tr>
<td></td>
<td>SR</td>
<td></td>
<td>Start distribution without reading existing recipient list</td>
</tr>
<tr>
<td></td>
<td>ST</td>
<td></td>
<td>Start distribution with standard recipient list</td>
</tr>
<tr>
<td></td>
<td>RE</td>
<td></td>
<td>Restart distribution with dialog</td>
</tr>
<tr>
<td></td>
<td>RP</td>
<td></td>
<td>Restart distribution of a package with dialog</td>
</tr>
</tbody>
</table>

**i_objkey**

**i_context**

<table>
<thead>
<tr>
<th>changing</th>
<th>c_original</th>
<th>↦ ↟</th>
<th>Determined original application file 1,2 or A (for 1 and 2)</th>
</tr>
</thead>
</table>

**Integration**

You can enter your company-specific programming logic in the source code of include program zxcvvl0u03.
Document Part and Version (EXIT_SAPLCVV1_004)

Definition
Function module that is called by customer exit CVDI0004. This function module is used to determine the key fields “document part” and “version” for the document to be distributed.

The customer exit is called when distribution is started for the recipient list (transaction CV17).

Use
The last version released is determined and proposed as a default for all documents in the recipient list. To determine a different version, enter your own logic for determining the version in the include.

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value Result</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>importing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e_doktl</td>
<td></td>
<td></td>
<td>Document part</td>
</tr>
<tr>
<td>e_dokvr</td>
<td></td>
<td></td>
<td>Document version</td>
</tr>
<tr>
<td>e_return</td>
<td>0</td>
<td>→</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>&lt;&gt;0</td>
<td></td>
<td>Error</td>
</tr>
<tr>
<td>exporting</td>
<td></td>
<td>←</td>
<td></td>
</tr>
<tr>
<td>i_doknr</td>
<td></td>
<td></td>
<td>Document number</td>
</tr>
<tr>
<td>i_dokar</td>
<td></td>
<td></td>
<td>Document Type</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvv1u04.
Create Distribution Order (EXIT_SAPLCVV2_001)

Definition
Function module that is called by customer exit CVDIO005.

This customer exit is checked in the create method of BOR object BUS1082 (function module CVV2_DDO_CREATE – create distribution order). The exit is called after an initial order has been created and the INITIATED event has been generated.

Use
The distribution order parameters can be modified in the include. Individual part orders that are not relevant for distribution can be deleted from the table. Status IG or ER must be set in the customer exit for these part orders. You can use function module CVV3_DDOC_SET_READY (set part order status) for this purpose.

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td>0 &lt;&gt; 0</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>←</td>
<td>Error</td>
</tr>
<tr>
<td>changing</td>
<td>c_drzo</td>
<td>←→</td>
<td>As database structure DRZO (distribution order data)</td>
</tr>
</tbody>
</table>

Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DDOC</td>
<td>List of part order numbers (structure: CVIORDERCOMP)</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvv2u01.
Check Part Order (EXIT_SAPLCVV2_002)

Definition

Function module that is called by customer exit CVDI0006.

This customer exit is checked in the check method of BOR object BUS1082 (function module CVV2_DDO_CHECK – check distribution order). The exit is called after an initial order has been created and the INITIATED event has been generated.

Use

The status of the part order is set to ER (error) if the e_return parameter returns a value <>0. A special process is implemented in the workflow for part orders that contain errors.

Structure

The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exporting</td>
<td>e_return</td>
<td></td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>←</td>
<td>Order part has errors, do not distribute</td>
</tr>
<tr>
<td></td>
<td>&lt;&gt;0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>importing</td>
<td>ddoc_id</td>
<td>→</td>
<td>Part order number</td>
</tr>
</tbody>
</table>

Integration

You can enter your company-specific programming logic in the source code of include program zxcvv2u02.
Create Initial Order (EXIT_SAPLCVV2_003)

Definition

Function module that is called by customer exit CVDI0007 when the system creates an initial order.

Use

The initial order data and part order data can be modified. You can also specify a status to be set for the part orders. If an error occurs in this customer exit, it must be output with the following statement: 
\[\text{MESSAGE ID id TYPE mtype NUMBER n raising ERROR.}\]

Structure

The interface is structured as follows:

Tables whose Data can be Changed (Changing)

<table>
<thead>
<tr>
<th>changing</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c_drzoi</td>
<td>Initial order data (structure DRZOI)</td>
</tr>
<tr>
<td>c_status</td>
<td>Status</td>
</tr>
<tr>
<td></td>
<td>SY - start immediately</td>
</tr>
<tr>
<td></td>
<td>AS - start in the background</td>
</tr>
<tr>
<td></td>
<td>MA - start manually in distribution log</td>
</tr>
</tbody>
</table>

Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_DRZOC</td>
<td>Part orders (structure: DRZOC)</td>
</tr>
</tbody>
</table>

Interface Parameters for Exceptions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>Error situation</td>
</tr>
</tbody>
</table>

Integration

You can enter your company-specific programming logic in the source code of include program zxcvvv2u03.
Determine Context (EXIT_SAPLCVV5_001)

Definition
Function module that is called by customer exit CVDI008 if distribution is started by an event.

Use
The context that is to be used for distribution can be determined here. You can specify a context for an event in Customizing for Document Distribution. If other contexts are also to be included for this event, you must use this customer exit.

The function module is called in the following function modules:
- CVV5_EVENT_START_DISTRIBUTION (start distribution – initiated by an event)
- CVV5_EVENT_START_DIST_ECM (start distribution when change master record event is released)

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter value</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>export</td>
<td>e_return</td>
<td>0</td>
<td>OK</td>
</tr>
<tr>
<td>import</td>
<td>i_event</td>
<td>&gt;=0</td>
<td>Event (such as SWEINSTOU-EVENT)</td>
</tr>
<tr>
<td></td>
<td>i_objkey</td>
<td></td>
<td>Object key (such as SWEINSTOU-OBJKEY)</td>
</tr>
<tr>
<td></td>
<td>I_objtype</td>
<td></td>
<td>Object type (such as SWEINSTOU-OBJTYPE)</td>
</tr>
<tr>
<td>changing</td>
<td>c_context</td>
<td></td>
<td>Context</td>
</tr>
</tbody>
</table>

Tables Whose Fields can be Processed in the Function Module

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_EVENT_CONTAINER</td>
<td>Event container (structure SWCONT)</td>
</tr>
</tbody>
</table>
Integration
You can enter your company-specific programming logic in the source code of include program zxcvv5u02.
ITS Access (EXIT_SAPLCVVW_001)

Definition
Function module that is called by customer exit CVDI0009 if the original application file is to be accessed via the Internet Application Server (ITS).

Use
Additional authorizations, for example, can be checked in this customer exit.
The exit is called in function module CVVW_GET_ORIGINAL (read original application file from application server).

Structure
The interface is structured as follows:

Parameters that can be processed in the Function Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>e_doknr</td>
<td></td>
<td>Document number</td>
</tr>
<tr>
<td>i_dokar</td>
<td></td>
<td>Document Type</td>
</tr>
<tr>
<td>i_doktl</td>
<td></td>
<td>Document part</td>
</tr>
<tr>
<td>i_dokvr</td>
<td></td>
<td>Document version</td>
</tr>
<tr>
<td>i_filename</td>
<td></td>
<td>File name on application server</td>
</tr>
<tr>
<td>i_ddoc_id</td>
<td></td>
<td>Part order number</td>
</tr>
<tr>
<td>i_application</td>
<td></td>
<td>Workstation application</td>
</tr>
</tbody>
</table>

Interface Parameters for Exceptions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>Error situation</td>
</tr>
</tbody>
</table>

Integration
You can enter your company-specific programming logic in the source code of include program zxcvvwu01.
Determining the Application (EXIT_SAPLCVV1_005)

Definition
Function module that is called by customer exit CVDI0010.

Use
You can determine which workstation application was used to process the original application files that are to be distributed with this function module.
Authorization Objects for Document Distribution

Definition
The document distribution authorization objects are elements of the standard SAP System authorization concept.

Use
The document distribution authorization objects allow you to control authorizations for maintaining part orders and sending documents.

Structure
The authorization objects for document distribution are allocated to the Document Management object class. Two authorization objects are defined for document distribution in the standard system.

Authorization Object C_DRZA_TCD (Activities for Recipient Lists)
The following table shows authorization object C_DRZA_TCD. This object controls which activities a user is allowed to perform for recipient lists.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTVT</td>
<td>01</td>
<td>Create</td>
</tr>
<tr>
<td></td>
<td>02</td>
<td>Change</td>
</tr>
<tr>
<td></td>
<td>03</td>
<td>Display</td>
</tr>
<tr>
<td></td>
<td>06</td>
<td>Delete (only own recipient lists)</td>
</tr>
<tr>
<td></td>
<td>41</td>
<td>Delete (administrator)</td>
</tr>
<tr>
<td></td>
<td>A9</td>
<td>Send (start distribution with recipient list)</td>
</tr>
</tbody>
</table>

Authorization Object C_DRZI_TCD (Distribution Order)
The following table shows authorization object C_DRZI_TCD. This object limits part order processing.

Fields for the Authorization Object C_DRZI_TCD

<table>
<thead>
<tr>
<th>Fields</th>
<th>Possible Values</th>
<th>Description</th>
</tr>
</thead>
</table>
Authorization Objects for Document Distribution

<table>
<thead>
<tr>
<th>ACTVT</th>
<th>Description</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Start the distribution manually from the distribution log</td>
<td>03 Display</td>
</tr>
<tr>
<td>02</td>
<td>Start the distribution again from the distribution log</td>
<td>59 Distribute</td>
</tr>
<tr>
<td>03</td>
<td>Display the distribution log</td>
<td></td>
</tr>
<tr>
<td>04</td>
<td>Confirm receipt</td>
<td></td>
</tr>
<tr>
<td>05</td>
<td>Confirm output</td>
<td></td>
</tr>
<tr>
<td>06</td>
<td>Ignore distribution order</td>
<td></td>
</tr>
<tr>
<td>07</td>
<td>Display mail from the distribution log</td>
<td></td>
</tr>
<tr>
<td>08</td>
<td>Delete temporary files from the application server</td>
<td></td>
</tr>
</tbody>
</table>

Integration

The following document management authorization objects are also checked for document distribution:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Description</th>
<th>Activity</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_DRAW_TCD</td>
<td>Activities for documents</td>
<td>03 Display</td>
<td>59 Distribute</td>
</tr>
<tr>
<td>C_DRAW_BGR</td>
<td>Authorization group</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C_DRAW_DOK</td>
<td>Access to original file</td>
<td>53 Display via application</td>
<td>54 Display via application from archive</td>
</tr>
</tbody>
</table>

Apart from this, there is also the authorization check for a user exit that you may have programmed for document status.
Product Structure Browser

Purpose
The Product Structure Browser display information about your product data that is maintained in the area of Product Data Management (PDM). This information is especially important for engineering and design as well as production. This graphical browser gives you a quick overview of product-defined data that is displayed structurally. You can navigate within a product structure and access all data that is relevant for your product.

The Product Structure Browser can also be used for executing the following tasks:

- You want to find out the assignments of different documents (such as 2D drawings, 3D models, reports, assembly instructions) related to a product.
- You want to manage release and change statuses so that you have a well-organized plan and control of product development throughout its entire life cycle.
- You want to carry out business process for different master data of a product from a central point.

Integration

Systems
You can explode the product structure across systems. The following overview shows the destinations where data can be read:

<table>
<thead>
<tr>
<th>System</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local system</td>
<td>The standard SAP System only allows objects to be exploded in the local SAP System.</td>
</tr>
<tr>
<td>RFC destinations</td>
<td>RFC destinations can only be selected when an RFC connection is available from the system to the current SAP System.</td>
</tr>
<tr>
<td>ALE destinations</td>
<td>ALE destinations can only be selected for objects that are maintained in the current SAP System with an ALE Distribution Model.</td>
</tr>
</tbody>
</table>

Value Assignment Areas
The following overview shows the enterprise area where the product data can be read or values assigned:

<table>
<thead>
<tr>
<th>Enterprise area</th>
<th>SAP Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materials management</td>
<td>Materials</td>
</tr>
<tr>
<td>Document Management System (DMS)</td>
<td>Document info record</td>
</tr>
<tr>
<td>Engineering change management (ECH)</td>
<td>Change Master Record</td>
</tr>
<tr>
<td>Production (master data)</td>
<td>• Routings</td>
</tr>
<tr>
<td></td>
<td>• Reference operation sets</td>
</tr>
</tbody>
</table>
Classification System
- Characteristics
- Classes

Plant maintenance
- Equipment
- Functional location

Quality Management
- Inspection plans
- Material specification

Features

Calling the Product Structure Browser
You can start the browser directly using:

- Logistics → Central Functions → Engineering → Environment → Product Structure Browser
- Logistics → Central Functions → Engineering Change Management → Environment → Product Structure Browser
- Logistics → Central Functions → Document Management → Environment → Product Structure Browser

You can start the browser while processing objects:

- While processing change master records Change Master Record → Change → Environment → Product Structure Browser
- While processing document info records Document → Change → Environment → Product Structure Browser

Explosion Criteria
You can limit what data is displayed by setting explosion criteria.
The overview shows what criteria you can use to explode the product structure.

<table>
<thead>
<tr>
<th>Explosion criteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection date</td>
<td>In the standard system, the product structure is exploded on today’s date. You can overwrite the selection date as you wish.</td>
</tr>
<tr>
<td>Filters</td>
<td>In the standard system, all the data for the different object types is checked. Define filters to improve performance and limit the amount of data shown.</td>
</tr>
</tbody>
</table>

See: Product Structure Filters [Seite 471]
You can display the product structure in different ways, depending on your hardware configuration. You can use the function Settings to switch between the old and the new views.

See: Settings for the Product Structure [Seite 480]

When you have processed an object with a change master record that has a parameter effectivity [Extern] set for it then the explosion occurs according to the desired effectivity conditions.

By entering the parameter you identify one concrete change status [Extern] of the product that you want to explode.

See: Entering Values for Parameter Effectivity [Seite 486]

You can display the product structure and product data in the following way:
- Displaying the Product Structure in the New View [Seite 482]
- Displaying the Product Structure in a List [Seite 516]

You can execute object-specific business processes from the displayed product structure. The change process can be integrated as a long-term process; Workflow [Extern] tasks are part of short-term or temporary processes.

The following overview shows you which activities you can execute in the new view.

<table>
<thead>
<tr>
<th>Object</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Master Record</td>
<td>Copying a Change Object Using Drag and Drop [Seite 497]</td>
</tr>
<tr>
<td>Recipient list for document distribution</td>
<td>Copying Documents using Drag and Drop [Seite 496]</td>
</tr>
<tr>
<td>Objects from the Engineering Workbench</td>
<td>Maintaining Objects in the Engineering Workbench [Seite 499]</td>
</tr>
<tr>
<td>Functional location and Equipment</td>
<td>Maintaining Structures from Plant Maintenance [Seite 501]</td>
</tr>
<tr>
<td>Material specification</td>
<td>Display</td>
</tr>
<tr>
<td>Object folder</td>
<td>Using the Product Structure for Object Folders [Seite 509]</td>
</tr>
<tr>
<td>Original Application File of a Document Info Record</td>
<td>Displaying Original Application File with a Viewer [Seite 506]</td>
</tr>
</tbody>
</table>
Product Structure Filters

Use

All of the data for the product structure is checked in the local system. Sometimes, however, you only require some of the data for your tasks. You can use filters to set the scope of the data. This allows you to set up the explosion of the product structure exactly to your needs.

If you restrict your object choice and relations in a filter, system performance improves because a lot of relations do not have to be taken into account. Therefore it is highly recommended to use filters.

The results screen is also then easier to manage. Only data that is necessary for the current processing situation is displayed.

You can only define filters in the local system that reads and filters class networks, document and change hierarchies.

Features

Filter type

The type of filter, either general or private, is dependent on which users can use them.

<table>
<thead>
<tr>
<th>Filter type</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>General filter</td>
<td>A general filter can be assigned to any user before starting the explosion.</td>
</tr>
<tr>
<td>Private Filter</td>
<td>Only the user who created the filter can use it before starting the explosion.</td>
</tr>
</tbody>
</table>

You can define one or more filters. The filter that is to influence the explosion is activated before starting the explosion.

Filter Settings

You can make the same settings for both the general and private filters. The following overview shows the supported settings that can be used level-by-level.

<table>
<thead>
<tr>
<th>Filter setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection of the objects to be read</td>
<td>In the first setting level you set the object and relationships that you want to have checked (for example, document, change number, material) from the product structure. When you start the explosion you can only select an object that is part of the filter. In this example, this means only a document; change number or material may be used as an initial object.</td>
</tr>
</tbody>
</table>
## Product Structure Filters

<table>
<thead>
<tr>
<th>Destination Selection</th>
<th>You can select for each object the destinations where you want the explosion to be executed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- The standard SAP System only allows objects to be exploded in the local system.</td>
</tr>
<tr>
<td></td>
<td>- ALE destinations can only be entered for objects that have been maintained with an ALE distribution model.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Restrictions per Object Type</th>
<th>You can define, per object type, the objects and relations that you want to be displayed in the product structure, for example: The following restrictions may apply to some objects:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Documents: relationships, document type, laboratory</td>
</tr>
<tr>
<td></td>
<td>- Change number: Relationships</td>
</tr>
<tr>
<td></td>
<td>- Material: relationships, material type, laboratory</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other Object-Specific Restrictions</th>
<th>You can apply object-specific restrictions to all objects. They are displayed from the context menu. The following restrictions may apply to some objects:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Documents: Versions, template documents, object links</td>
</tr>
<tr>
<td></td>
<td>- Change number: Object change (such as BOM changes)</td>
</tr>
</tbody>
</table>

| Using Additional Filters [Seite 478] | You can restrict or filter data in enterprise-specific check programs even more.                                                                                                                   |

## Activities

**See:**
- Defining Filters [Seite 473]
- Activating/Deactivating Filters [Seite 476]
- Checking Filters [Seite 477]
Defining General Filters

Use
Filters define the data that is to be evaluated for the product structure and displayed on the result screen. If several people need the same product data you can set up a general filter. Each user can use these general filters for the product structure explosion.

See: Product Structure Filters [Seite 471]

Prerequisites
You must have the required authorization to define these general filters in Customizing with Customizing projects (authorization object S_PROJECT Authorization for working with Customizing projects).

Procedure
   You see an overview that contains the general and private filters that are defined for the Product Structure Browser on your enterprise.
2. Select New entries.
   Define the filter according to the instructions in the implementation guide (IMG) under Define filter.

Result
You have defined a filter that each user can use to explode and display the product structure.

💡 You must activate the filter [Seite 476] if you wish to see the product structure when using the filter settings.

Only the objects or relations that you have selected in your filter are checked in the product structure.
Defining Private Filters

Use
Filters define the data that is to be evaluated for the product structure and displayed on the result screen. You can use a private filter to display product data for specific situations. This private filter is user-specific and cannot be used by any other user.

See: Product Structure Filters [Seite 471]

Prerequisites
You are in the Product Structure Browser. Initial Screen.

See: Product Structure Browser [Seite 468]

Procedure
   Dependent on the existing filters the following screens will appear:
   Overview screen: General and private filters
   You see this overview when at least one general filter is defined.
   The filters you have created are marked in the column as Private. This overview contains no private filters.
   Choose Create filter. The Define filter screen appears.
   Define Filter

2. In the Define filter: <Description> screen enter the name of your filter and a description.
3. Choose Continue.
   The Filter screen appears. Define. You see an overview of all the object types that can be exploded in the product structure, for example documents, change numbers.
4. Explode the object types (for example, document) that you want to make the filter settings for to the lowest level possible.
   The expansion icon indicates a level that can be expanded.
   You must be at the deepest level of the explosion before you can start restricting data.

   Exploding the explosion path for the object type Document shows the following explosion levels:
   Document → Local System → Dependencies → Versions and Document parts and Revisions levels and so on.
5. Decide what you are going to include in your filter, and what not in the following way:
Excluding from the filter

You can restrict the selected settings. The standard system displays selected settings with a ☑ (selected).

Click on ☑ (selected) to change the selected setting from a non-restricted to restricted ✗ (restricted).

Cancel restrictions

You can cancel the restrictions. The standard system displays selected settings with a ✗ (restricted).

Click on ✗ (restricted) to change the selected setting from a restricted to non-restricted ☑ (selected).

If you want to include or exclude a complete node (for example, Class) in the filter, place the cursor on the uppermost node in the structure (for example, Class) and click on it to change it as required.

6. Save your filter.

Result

You have defined a filter that only you can use to explode and display the product structure. If you have only defined one private filter, this will automatically be activated.

As soon as several filters exist you must activate the filter [Seite 476]. Only the objects or relations that you have selected in your filter are checked in the product structure.
Activating/Deactivating Filters

Use
You can use one or more filters when exploding the product structure Filter [Seite 471] so you have a view of specific data only. If more than one filter is defined, the explosion is done based on the active filter.

Prerequisites
You are in the Product Structure Browser. Initial Screen.
See: Product Structure Browser [Seite 468]

Activating/Deactivating General and Private Filters
1. Select in the Product Structure Browser: Initial screen Choose the function (Filters).
   You see the Overview dialog box. General and private filters.
2. Select the filter that you want to activate or deactivate.
3. Select one of following icons for the desired function:
   - Activate Filter
   - Deactivate Filter

Result
Only the objects or relations that you have selected in your filter are checked in the product structure.
Checking Filters

Use

No filter [Seite 471] is defined in the standard system. The explosion shows all object relations.

When the Display Product Structure: Initial screen. If you see a message that a filter is active in the upper part of Display product structure: Initial screen we recommend that you check the filters before displaying the product structure.

Displaying the Filter Overview

The following overview shows how you can go to the filter overview:

<table>
<thead>
<tr>
<th>Processing situation</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Product Structure</td>
<td>Choose Environment → Product structure.</td>
</tr>
<tr>
<td>Browser</td>
<td>The Product structure screen appears. Display</td>
</tr>
<tr>
<td></td>
<td>Select Filters.</td>
</tr>
<tr>
<td></td>
<td>The Overview screen appears. General and private filters.</td>
</tr>
<tr>
<td>In Customizing, work step</td>
<td>You see this work step when you choose the following call up:</td>
</tr>
<tr>
<td>Define filter</td>
<td>Customizing Logistics General → Product Structure Browser → Define filter.</td>
</tr>
<tr>
<td></td>
<td>Process the filters in the Overview screen: General and private filters.</td>
</tr>
</tbody>
</table>

The following information is displayed for each filter in the filter overview:

- Processing status
- Indicator if filter is defined as a private filter
- Indicator specifying whether the filter is active (Filter active)

Displaying Filter Settings

1. Select the filter whose settings you want to display.
2. Choose Display filter.

Result

The system then lists all of the object types that can be evaluated for the product structure. A separate explosion in the form of a tree structure, in which the object-specific data for the explosion can be selected, is available for each object type.
Using Additional Filters

Purpose
You can create filter for general checks in the standard SAP System. You can use these additional filters to select product data for enterprise-specific checks. You can set up a filter for each object (for example, material or document) which data is read and displayed.

You define a filter that only selects documents that have the name Smith as the author or person responsible.

Prerequisites
You must create a program for enterprise-specific filters. The program’s interface must be identical to the example program RCPDMEXTENDEDFILTERTEMPLATE.

Do not change the interface of the example program.

Process
1. Display the source text of the example program RCPDMEXTENDEDFILTERTEMPLATE.
   This program contains a FORM routine [Extern] for each object. You can take the parameters you require from this routine.
   Verify the interface of the FORM routine that you want to use to execute enterprise-specific filter checks, for example for documents FORM_CHECK_DOCUMENT.

2. Create the enterprise-specific filter program in the following steps:
   – Copy the source text (source and text elements) of the example program.
   – Enter the program name that is located in Customer name space [Extern] such as Z_FILTER_DOC_SPECIALIST.
   – Change the name of the FORM routine that you are using for an enterprise-specific check, such as FORM_SPECIALIST_CHECK_DOCUMENT.
   – Create the source test for the FORM routine.

   You only want documents to be filtered that have the person responsible as Smith:
   check document_data-dwnam ne 'SMITH'
   – Enter at the end of the FORM routine whether the object has successfully completed the additional check and you want it to be displayed. Set the parameter CHECK_OK with the following values:
     X Display object.
     Space: Do not display object.

3. Edit the filter you want to use to select enterprise-specific product data.
Using Additional Filters

– Expand the tree structure of the object that you want to use the special check with.
– Double-click on the structure entry *additional filter* and the dialog box *additional filter* appears.
– Enter the name of the program and the FORM routine for the check.

  Program name: **Z_FILTER_DOC_SPECIALIST**
  FORM routine: **SPECIALIST_CHECK_DOCUMENT**

– Save the filter setting.

4. Activate the enterprise-specific filter.

**Result**

The system runs a filter check all the way to the deepest explosion level when you start an explosion. On product data is returned that meets the criteria of the general and enterprise-specific filter checks.
Settings for the Product Structure

Use

Depending on the hardware of your computer you can choose between the simple list display and the new view display version.

The new display version is set as default in the standard SAP System. New functions in the user interface allow for a better overview as well as easier processing of the product structure.

Comparison of the Display Versions

The two different display forms have two things in common:

- Display in the form of a tree structure
- Large number of functions for processing objects and layout of the list (see below):

The following overview shows the differences of the two displays.

<table>
<thead>
<tr>
<th>Differences</th>
<th>New View Display Version</th>
<th>Simple List Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>On (32 bit) WINDOWS platforms</td>
<td>On all platforms (for example, WINDOWS, UNIX Frontend)</td>
</tr>
<tr>
<td>Display variants</td>
<td>User-specific and general list variants possible</td>
<td>User-specific field selection possible</td>
</tr>
<tr>
<td>Display of relationships using the context menu</td>
<td>Adjustable</td>
<td>no</td>
</tr>
<tr>
<td>Expand product structure</td>
<td><em>Expand</em> in the same or new window</td>
<td><em>Set focus</em> in the same window</td>
</tr>
<tr>
<td>Drag&amp;Drop function</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>

Settings for Product Structure

You can switch between the new display version and the simple list display by setting the indicator *New Display Version*.

You must make this setting before selecting the initial object. After selection of the initial object the system explodes the product structure.

1. Go to the screen *Product Structure Browser: Initial Screen* if you want to change any of the settings:

   **See:** Product Structure Browser [Seite 468]

2. On the *Product Structure Browser screen: Initial screen* select (Settings).

   The *Product structure* dialog box appears. Settings.

   - The New Display Version is default in the standard SAP System. No other settings are therefore required for this the new display version.
You can also set whether the relationship nodes are displayed when you use the New Display Version by using the Context menu [Seite 490].

- You can switch to the simple list display by resetting the indicator New Display Version.

The new display version is not supported for non-Windows operating systems.
Displaying the Product Structure

Use

New technical functions in the graphical user interface (GUI) allow you to process and view the product structure in simpler and easy-to-use ways. This display is based on the OLE custom control (OCX control).

This new display version is set up as default in the SAP System under Settings for the Product Structure [Seite 480]. The Product Structure Browser creates an easy-to-use directory of all the objects that are related in the form of a tree structure. You can then use the graphical maintenance functions in this tree structure.

This new display version requires a 32 bit based Windows operating system. If you do not have this operating system installed you can only use the simple list display.

See also: Displaying the Product Structure in a List [Seite 516]

Prerequisites

You must have a 32 bit Windows operating system installed.

You are in the Product Structure Browser. Initial screen.

See: Product Structure Browser [Seite 468]

Procedure

1. Enter in the Product Structure Browser: Initial screen a selection date or parameter values for the parameter effectivity.

2. Select a filter [Seite 471] or maintain a private filter [Seite 474].

3. If you do not want to display all the relation nodes, rather only certain ones select (Settings).

4. Set the indicator Display relationships in context menu and select Continue.

5. Choose an object type (for example, material) and enter the key data.

See: Selecting Initial Object using a Stack [Seite 484]

6. Start the product structure explosion by choosing Continue.

In the following processing situations you will also see the dialog box Parameter effectivity:

You have not yet entered any parameter values. The initial object as a material or a class that was processed with a change number. The effectivity of the change number was set by parameter values.
Enter the parameter values in the dialog box and select *Continue*.

**See:** Entering Values for Parameter Effectivity [Seite 486]


**Result**

On the *Product structure* screen: *<Effectivity date>* will display the structure of the object based on the chosen explosion criteria, such as effectivity date. All the objects are listed that are related to the initial object.

The filter key is displayed in the header when a filter is active, such as *Product structure. Filter F-1-L; Effectivity date 20.Feb.2000*.

Only selected data is shown when the filter is active.

**Further Activities**

The following overview shows the activities you can use to process the product structure or the listed objects.

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processing the Product Structure (General) [Seite 488]</strong></td>
<td>The function bar only contains functions that can be called up for processing the entire tree structure. For example, you can process display variants or check whether an object appears more than once in the structure.</td>
</tr>
<tr>
<td><strong>Processing Objects [Seite 492]</strong></td>
<td>You can only call object related functions by using the context menu. For example, you can use SAPoffice to send a document to another user.</td>
</tr>
<tr>
<td><strong>Copying Objects using Drag and Drop [Seite 495]</strong></td>
<td>You can only transfer an object from the product structure into a master record or another structure by means of the mouse.</td>
</tr>
<tr>
<td><strong>Displaying Original Application File with a Viewer [Seite 506]</strong></td>
<td>You can use the integrated viewer to view individual original application files in 2D or 3D formats.</td>
</tr>
</tbody>
</table>
Selecting Initial Object using Stack

Use

In order to simplify processing, the system saves the last used objects of each user and lists them in a stack.

For every object (for example, material), the system saves the last ten objects that were exploded in the product structure for each user. If you want to display one of these objects again, you can use the Stack function when you enter the key fields.

Prerequisites

The stack function is only active when the following prerequisites are met:

- You have at least exploded the product structure for an object of the necessary object type.
- You are at the Product structure browser: Initial Screen.

See: Product Structure Browser [Seite 468]

Procedure

When you want to change the Settings [Seite 480] for the product structure explosion it is recommended doing this before the selection of the initial object. After selecting the initial object the system explodes the product structure.

1. On the Product Structure Browser screen: Initial Screen select the tab page for the initial object (for example document).

   If there is no tab page for the object you would like to display, check the active filter. When the filter settings does not allow this object type to be displayed, you must first use another filter or no filter at all.

   You see the tab page where the key fields for the selected object type are entered.

   The function (Stack) is on the tab page when you have exploded the object of this type at least once.

2. Select (Stack).

   You see the dialog box Last-used <object type> (such as Documents).

3. Double click on an object to copy this object as initial object of the product structure.

Result

The system explodes the product structure using the filter settings.

You can navigate within the product structure or use it to execute other functions, for example, to copy change objects to a change master record, or documents to a recipient list.
Entering Values for Parameter Effectivity

Use

Effectivity of a change status can not only be controlled in a time cycles such as Valid from but also with other conditions such as customer, serial number and so on. For special effectivity conditions you can use the functions of Parameter effectivity [Extern].

Because changes statuses of objects within a product structure can be used for different effectivity conditions it is possible to enter the effectivity parameters for the explosion of a product under unique effectivity conditions.

The initial object is class K-1 with temporal effectivity (date Valid from). This class classifies a material. A bill of material (BOM) exists for this material. This BOM was created in relation to a change status. The change status’ effectivity parameters were defined by the effectivity type customer (parameter customer and country).

In this example, different product versions can be made for different customers and for one customer there can be different version for different countries. In order to explode the product structure according to the desired effectivity parameters you must enter in addition to the date the parameters Customer and Country.

Obligatory Entry of Parameters

When the following indicators for the initial objects Material or Class are set the entry of the following parameter values for parameter effectivity is obligatory:

<table>
<thead>
<tr>
<th>Initial Object</th>
<th>Settings in …</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materials</td>
<td>Material master record (basic data 1)</td>
<td>Assign effectivity values / override change numbers</td>
</tr>
<tr>
<td>Classes</td>
<td>Customizing Classification (class types: Detail screen)</td>
<td>Engineering Change Management (ECH) with parameter effectivity for classification</td>
</tr>
</tbody>
</table>

The entry of parameters is optional when this indicator for materials or classes is set and the materials or classes are in a deep level of the explosion (no initial objects).

Prerequisites

You are in the Product Structure Browser screen: Initial Screen.

See: Product Structure Browser [Seite 468]

Entering Obligatory Parameters

When the initial object (material or class) requires the assignment of values to the effectivity parameters you will see the dialog box Parameter effectivity at the start of the product explosion.

See: Assigning values to effectivity parameters [Extern]
Entering Optional Parameters

   You see the Effectivity parameter dialog box.
2. Assign values for the effectivity parameters.
   See: Assigning values to effectivity parameters [Extern]

Result

The system read the effectivity parameter you entered ion the local SAP System all the way to the deepest explosion level.
Processing the Displayed Product Structure

Use

The product structure offers you not just only an overview of related SAP Objects. You can also process the product structure from the exploded view.

Prerequisites

You are in the Product Structure Browser screen: Initial Screen.

See: Product Structure Browser [Seite 468]

Procedure

You can select the following functions from the function bar:

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain display variants</td>
<td>You can choose the fields for each object type you want to display in the list.</td>
</tr>
<tr>
<td></td>
<td>• The help on each field offers you more information on the data. You can set, for example, for documents that the person responsible and the status are displayed in the product structure.</td>
</tr>
<tr>
<td></td>
<td>• You can reduce the product structure to the desired amount of information by using sort criteria and filter conditions. You can save the display variants as user-related or for general use.</td>
</tr>
<tr>
<td>Display same objects</td>
<td>You can use this function to check whether an object occurs more than once in a structure.</td>
</tr>
<tr>
<td></td>
<td>• Position your cursor on the object.</td>
</tr>
<tr>
<td></td>
<td>• Select Same objects. If an object appears more than once the object lines are highlighted with a different color.</td>
</tr>
<tr>
<td>Maintain filter</td>
<td>You can display the filter overview when you want to change the active filter or choose another one.</td>
</tr>
<tr>
<td>Display filter information</td>
<td>You can display the filter settings for the active filter.</td>
</tr>
</tbody>
</table>
## Legend

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Documents" /></td>
<td>Documents</td>
</tr>
<tr>
<td><img src="image2.png" alt="Materials" /></td>
<td>Materials</td>
</tr>
<tr>
<td><img src="image3.png" alt="Equipment" /></td>
<td>Equipment</td>
</tr>
</tbody>
</table>

Icons show the object types of the individual objects. You can see what each icon means when you display the key.

## Refresh product structure

You can change objects directly in the product structure. However, these changes are not shown in the product structure until you refresh it.

## Display further object

In addition to the current product structure you can display the structure of another, further object. Select the new initial object. The system splits the screen section and displays the structure of the second object in the second, new screen section.

Different processing functions are available for the objects listed in the product structure. An overview of the object related functions is available in Processing Objects [Seite 492].
Displaying Dependencies using Context Menus

Use
In the standard SAP System all dependencies of an object are displayed as nodes in the tree structure. If document links and BOMs exist to a document then relation nodes are in the tree structure for documents and BOMs.

You can make the settings for the new display view so that the dependencies to be displayed can only be chosen from context menus.

Prerequisites
You must have a 32 bit Windows operating system installed.

You are in the Product Structure Browser. Initial Screen.

See: Product Structure Browser [Seite 468]

Activating the Context Menu
1. Select (Settings).

   The Product structure dialog box appears. Settings.
2. Select the indicator New Display version and Relationships in context menu.
3. Choose Continue.

   The Product Structure Browser screen reappears. Initial Screen.

Displaying Dependencies using Context Menus
1. Start the explosion of the product structure.
   - On the Product structure screen: <Date of effectivity> only the object node of the initial object is displayed (for example, material).
   - The relationships to other objects are no longer displayed directly on the nodes in the tree structure. Because of this the text lines that described the relationship type (for example, document) no longer appear.
2. You can only see the relationships of an object to other objects after calling the context menu.
   - Position the cursor on the icon of the object t, for example, material.
   - Depress the right mouse button to call up the context menu.

      The entry Dependencies appears when dependencies exist from one object to other objects.
3. Display the relationships by expanding the entry Relationships.
   - The objects are listed that have a relationship to the initial object in the relationship path (such as documents).
   - In the screen section Product structure the column Relationships appears. The display variant is set up so that the relationship type is in the first lost column.
Processing Objects of a Product Structure

Use

You can call up other functions from the product structure in an object-related manner. Selection of functions is object type dependent. For example you execute functions for functional locations that do not support documents or material.

Prerequisites

You are in the Product Structure Browser. Initial screen.

See: Product Structure Browser [Seite 468]

Procedure

Object related functions are not displayed in the function bar. You can only call object-related functions by using the context menu.

- In order to call up all functions for a single object, such as material, position the cursor on the icon of the object, for example Material.
- Depress the right-hand mouse button to call up the context menu. All executable functions are listed in the context menu.

The following object related functions are supported:

Functional Location
Create subordinate functional location; Rename, Install equipment; Change; Send; Create work item; Store in object folder

Class:
Change; Maintain characteristic; Send; Create work item; Store in object folder

General Function Overview

The functions that you can execute for most objects are explained below:

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display master records of objects</td>
<td>Double-click on the icon of the object (for example Material) to display the master records.</td>
</tr>
<tr>
<td>Change master record of objects directly</td>
<td>You can change master records directly from the product structure. However, these changes are not shown in the product structure until you refresh it (icon ). For example, if you create a superior document in the document info record, this relation is first displayed after you refresh the structure.</td>
</tr>
</tbody>
</table>
Maintain Engineering Workbench | Following objects and relations that are assigned Product Structure Browser can be maintained in the Engineering Workbench:
- Materials
- Bill of material (BOM)
- Item
You can start the Engineering Workbench when the object supports it. The object relationship is indicated by the icon 🗑️ in the display column Workbench.

Create task | By choosing Create task, you can start ad-hoc business workflow tasks for the objects from the display mode. By choosing Create task, you can start ad-hoc business workflow tasks for the objects from the display mode.
Example:
- For change numbers
  You can send a document using SAPoffice which allows the recipient to display the chosen change master record.
- For document info records
  You can execute several tasks, for example, find dependent objects to the document.

Send | You can send objects that are defined in the Business Object Repository using SAPoffice as an attachment to an e-mail.

Check into object folder | You can save any object in an object folder [Seite 509].

Expand as new tree | You can display the relations that exist for an object to other objects.
Click on the object and select this function.
The new tree then replaces the old tree in the screen section.

Expand in a new window | You can display the relations that exist for an object to other objects.
Click on the object and select this function.
The tree that is currently displayed in the screen section remains.
The system opens the new tree for the selected object in another window.

Collapse partial tree | The tree is collapsed to the point where only the object remains in the structure.

**Object Related Functions**
In addition to the general functions that are supported by most functions there are also object-related functions.

**See also:**
- Copying Objects using Drag and Drop [Seite 495]
- Maintaining Objects in the Engineering Workbench [Seite 499]
Processing Objects of a Product Structure

Maintaining Structures from Plant Maintenance [Seite 501]
Displaying Original Application File with the Integrated Viewer [Seite 566]
Using the Product Structure for Object Folders [Seite 509]
Copy Objects using Drag and Drop

Use

The object transfer from the product structure to a master record or to another structure is easier when you use the mouse for so called Drag&Drop (drag and drop).

The following overview shows which objects can be copied using this method.

<table>
<thead>
<tr>
<th>Object</th>
<th>Processing situation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change object</td>
<td>When processing a change master record and copying change objects to the change master record.</td>
</tr>
<tr>
<td>Documents</td>
<td>When processing a recipient list and copying the documents to be distributed to the list.</td>
</tr>
<tr>
<td>Business Objects</td>
<td>When processing an object folder and copying the business objects to the folder.</td>
</tr>
</tbody>
</table>

Prerequisites

Under the Settings [Seite 480] for the product structure the New display version is activated.

Procedure

The new display version simplifies object transfers. The transfer can only be done with the mouse.

1. Select the object you want to integrate into another structure with the cursor.
2. Pull the object by holding down the right-hand mouse button on the object into the target structure let the object “drop” on the structure node of your choice by letting the mouse button go (Drag&Drop).

See:

- Copying a Change Object Using Drag and Drop [Seite 497]
- Copying Documents using Drag and Drop [Seite 496]
- Copying objects into object folder [Seite 512]
Copying Documents using Drag and Drop

Use
You can copy documents from the product structure to a recipient list using Drag and Drop.

Prerequisites
You have selected Control display [Seite 482] in your settings for the product structure.

Procedure
1. Choose in the recipient list Goto → Product structure.
   
   The Product Structure Browser screen appears. Initial Screen.

2. Choose Settings and select Control display.

   If you want to select the dependencies that you want to display in the product structure
   using a context menu you must also select Display dependencies with context menu
   [Seite 490].

3. You can also edit the filter [Seite 471].

4. Choose Continue and enter the data for the initial object.

5. Start the product structure explosion by choosing Continue.

   The Product structure screen appears. < Validity date >.

   The Product Structure screen is divided into several sections:

   – First section: Product structure of the initial object

     This part shows the product structure for the initial object. You can copy all the
     documents that are marked with the Move icon to the recipient using drag and drop.
     You copy the document by placing the cursor on the document you want to copy and
     pressing the left mouse button. Move the document by moving the mouse with the
     left button still pressed into the Recipient list area and let it fall on the entry
     Document.

     If you decide not to copy the object you selected, you can copy it back to the product
     structure using drag and drop.

   – Second section: Recipient Lists

     This section refers to the recipient list that you are currently processing. The selected
     documents are copied to this part of the screen.

6. Choose (Copy objects).

Result
The system copies your selected documents to the recipient list.
Copying Change Objects using Drag and Drop

Use
You can copy objects from the product structure to a master record or even another structure using Drag and Drop.

Prerequisites
If you want to copy objects from the product structure to the change master record, you must first set the following indicators for the relevant object types, such as material, document, in the change master record (Object Types screen):

- **Active** *(Object type active for change number)*
- **Object** *(A management record is required for each object)*

If you set these indicators for the material and document object types, for example, you can use the product structure to copy just documents and materials as change objects.

On the initial screen of the Product Structure Browser select the Settings [Seite 480] for the product structure New version for display.

Procedure
1. In the change mode for the change master record, choose Go to \(\rightarrow\) Select object.
   You see the Select Objects screen. Initial Screen.
2. Select the Settings and select the New version for display.
   If you want to select the dependencies that you want to display in the product structure using a context menu you must also select Display dependencies with context menu [Seite 490].
3. You can also edit the filter [Seite 471].
4. Enter the data for the entry object.
   - If you have entered the initial object manually, select Continue.
   - If you created the initial object using Stack [Seite 484]) you are automatically moved to the Object selection: <Product structure screen>.
5. You see the Select Objects screen. <Product structure>
   The Select Objects screen is divided into three:
   - First section: Product structure of the initial object
     This part shows the product structure for the initial object. You can copy all the objects that are marked with the Move icon to the change master record using drag and drop.
   - Second section: Selected Objects
Copying Change Objects using Drag and Drop

The system lists all the objects that you select as change objects using the Product Structure Browser. These objects can then be transferred to the engineering change master record. Because this data is only stored temporarily the list is empty as soon as you stop processing the change number or save.

You can only transfer objects into the list that have the following indicators set in the engineering change master record (tab page object types): Active (Object type for change number active) and Object (An administration record is required for each object).

- Third section: Integrated Viewer

Original application files of a document info record can be display using the integrated Viewer of the SAP System [Seite 506].

6. Cops the objects as follows:

- Highlight the object you want to copy and press the icon next to it (such as \(\text{material}\).
- Press the left-hand mouse button and move the object while keeping the mouse button depressed to the section Structure of change numbers.
- Drop the icon on the column Object type.
  
  If the selected object (such as a routing) is not transferred, verify in the change master record (tab page Object types) whether the indicator Active and Object are set for the object type.
  
  If you do not want to transfer the selected object you can delete the object using \(\text{material}\).

7. Choose \(\text{Copy objects}\).

The overview of change objects appears.

**Result**

The system copies your selected objects to the change master record. You can process the change master record further or save.
Maintaining Objects in the Engineering Workbench

Use
The product structure the following objects or relationships are assigned values that are maintained in the Engineering Workbench:

<table>
<thead>
<tr>
<th>Materials</th>
<th>Routing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill of material (BOM)</td>
<td>Reference operation set</td>
</tr>
<tr>
<td>Item</td>
<td>Inspection plan</td>
</tr>
</tbody>
</table>

When an object or a relationship is maintained in the Engineering Workbench you can start the maintenance directly from the product structure.

Prerequisites
Under the Settings [Seite 480] for the product structure the New display version is activated.

The maintenance possibilities using the Engineering Workbench are displayed in the following ways:

- The object relationship is indicated by the icon in the display column Workbench.
- The entry Workbench is in the context menu of the object or relationship.

Starting the Engineering Workbench using the Context Menu
1. Select the icon of the object such as material or relationship such as item.
2. Depress the right-hand mouse button to call up the context menu.
   - The entry Workbench is in the context menu of the object when it can be maintained using the Engineering Workbench.
3. Select the entry Workbench.

Starting the Engineering Workbench using the Icon
1. Select the icon of the object such as material or relationship such as item.
2. Change the display variants so that the display column shows Workbench.
   - Highlight the column Workbench.
   - Press the left-hand mouse button and pull the column to the desired position.
3. Click on to start the Workbench.

Result
- The Work area [Extern] dialog box appears if you have not set up a work area.
  - Enter a work area that can be used to display or process the object types (for example, BOM processing).
  - Choose Continue.
Maintaining Objects in the Engineering Workbench

- Depending on the object or relationship where you started the Workbench, you will end in one of these overviews:
  - Overview screen: BOM headers [Extern]
  - Overview screen: Items [Extern]
  - EWB: Overview Routing Headers [Extern]
  - EWB: Overview Operations [Extern]
  - EWB: Overview Inspection characteristics [Extern]

You can use all active Engineering Workbench functions. After you have changed and saved your data you can return to the product structure.
Maintaining Structures from Plant Maintenance

**Use**

The graphical user interface (GUI) of the Product Structure Browser makes it easy to maintain the following structures from plant maintenance:

- Functional location
- Equipment

All object specific functions can be called using the Context menu [Seite 490] in the Product Structure Browser for functional locations and equipment.

**Prerequisites**

Under the Settings [Seite 480] for the product structure the New display version is activated.

**Procedure**

1. Display structure of a plant maintenance object.
   Select either a functional location or equipment as an initial object.
   
   See also: Display Product Structure [Seite 482]

2. Position the cursor on the icon of the object that you want to process.
   - Functional location
   - Equipment

3. Depress the right mouse button to call up the context menu.
   The functions are listed in the context menu of the selected object. These functions are also only the functions that can be carried out in this processing status:
   
   - Function Overview for Functional Locations [Seite 502]
   - Function Overview for Equipment [Seite 504]
Function Overview for Functional Locations

Functions for Functional Locations

The following functions can be carried out for any functional location:

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create subordinate functional locations</td>
<td>Create a functional location. The new functional location is created as a subordinate functional location in the structure of the highlighted functional location.</td>
</tr>
<tr>
<td>Rename</td>
<td>The function is active when the following activity is carried out in Customizing Functional locations: Activate alternative identifier. The highlighted and all subordinate functional locations are renamed.</td>
</tr>
<tr>
<td>Move partial hierarchy</td>
<td>You move the selected structure under a functional location as subordinate structure.</td>
</tr>
<tr>
<td>Copy partial hierarchy</td>
<td>You use the highlighted location structure as a copy template or a new location structure.</td>
</tr>
</tbody>
</table>

Functions for Highlighted Functional Locations

The following functions can only be carried out on highlighted functional locations and their subordinate functional locations:

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set or reset deletion indicator</td>
<td>You can set or reset the deletion indicator for the selected functional location. This function also deletes all subordinate functional locations.</td>
</tr>
<tr>
<td>Activate or deactivate</td>
<td>You can activate or deactivate the highlighted functional location when no deletion indicator is set for it. This function activates the entire subordinate location structure as well. You can set the display variants for functional location so that the display column is displayed inactive. The indicates an inactive functional location.</td>
</tr>
<tr>
<td>Change</td>
<td>You can change master records directly from the product structure.</td>
</tr>
<tr>
<td>Display</td>
<td>Double click on to display the functional location.</td>
</tr>
</tbody>
</table>

Equipment can be integrated in the location structure as follows:

- You can create new equipment and add it to the location structure at the same time.
- You set up existing equipment in the location structure.
General Functions
You can execute general processing functions that are available for all objects of the product structure.

See also: Processing Objects of a Product Structure [Seite 492]

Executing Functions using Drag&Drop
Some functions are not only available by means of the context menu but can also be executed using the so-called Drag&Drop function. These functions therefore can only be carried out by means of a mouse.

3. Select the object you want to integrate into another structure with the cursor.
4. Pull the object with the mouse into the target structure and let the mouse button.

You can do the following by Drag&Drop:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move functional location</td>
<td>The functional location you dragged is moved to the structure of the functional location you select.</td>
</tr>
</tbody>
</table>
| Set up equipment       | • If the highlighted equipment is not set up in a functional location the structure of the highlighted functional location is set up.  
                          • If the highlighted equipment is already set up in a functional location the location structure is copied automatically into the new location structure. |
Function Overview for Equipment

Function for Equipment

The following functions can be carried out for any equipment:

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create equipment</td>
<td>Create new equipment and set up subordinate equipment in the structure of the highlighted equipment.</td>
</tr>
</tbody>
</table>
| Set up equipment  | You set up existing equipment in the plant maintenance structure. The following installation (setup) areas are supported:  
|                   | • Set up as subordinate equipment in superior equipment               |
|                   | • Set up in a functional location                                    |

Functions for Highlighted Equipment

The following functions can only be carried out on highlighted equipment and their subordinate equipment:

<table>
<thead>
<tr>
<th>Function</th>
<th>Use</th>
</tr>
</thead>
</table>
| Set up            | You set up the highlighted equipment in the plant maintenance structure. The following installation (setup) areas are supported:  
|                   | • Set up as subordinate equipment in superior equipment               |
|                   | • Set up in a functional location                                    |
| Dismantle         | The highlighted equipment is removed from the plant maintenance structure. |
| Move              | The highlighted equipment is moved within the current equipment structure or into the structure of other equipment or functional location. |
| Set or reset deletion indicator | The deletion indicator is set or reset for the highlighted equipment. |
| Activate or deactivate | The highlighted equipment be activated or deactivated as long as it is not set for deletion. |

General Functions

You can execute general processing functions that are available for all objects of the product structure.

See also: Processing Objects of a Product Structure [Seite 492]

Executing Functions using Drag&Drop

Some functions are not only available by means of the context menu but can also be executed using the so-called Drag&Drop function. These functions therefore can only be carried out by means of a mouse.
5. Select the equipment you want to integrate into another structure with the cursor.
6. Pull the object with the mouse into the target structure and let the mouse button.

You can do the following by Drag&Drop:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| Move equipment                        | • If the highlighted equipment is not set up in another equipment it is set up as a subordinate equipment to the selected equipment.  
                                           | • If the highlighted equipment is already set up in equipment the equipment is copied automatically into the new equipment. |
| Set up equipment in functional location | • If the highlighted equipment is not set up in a functional location the structure of the highlighted functional location is set up.  
                                           | • If the highlighted equipment is already set up in a functional location the location structure is copied automatically into the new location structure. |
Display Original Application File with the Viewer

Use
You can display original application files with the integrated viewer in the supported processing situations (for example, from the product structure or form the document info record).

See: Viewer for Displaying Original Application Files [Seite 566]

Prerequisites
You have made the setting in Customizing of Document Management for the viewer of the SAP System.
You are in a processing situation that supports viewing the original application file in the integrated viewer.

See: Viewer for Displaying Original Application Files [Seite 566]

Procedure
The following examples show you how to display an original application file in the different processing situations.

In all situation you can display the original application file by clicking on the button (Display original) or using the context menu (entry Display original).

Displaying Original Application File from the Product Structure

3. Display the product structure in the Product Structure Browser.

   See: Display Product Structure [Seite 482]

4. Explode the structure for documents.
   You can see whether a document versions has one or more original application files assigned to it:
   
   - Identifier in the display column Original with icon (Display original application files)
   - In the context menu the entry Display original exists.

5. Click on the icon Display original application file.

   The number of maintained original application files determines later procedures:

<table>
<thead>
<tr>
<th>Number of Original Application Files</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>No further action required. The original application file is displayed.</td>
</tr>
<tr>
<td>Several</td>
<td>You see a dialog box with a list. The list contains the workstation application or display a short text for the original application file. Select an original application file then choose Continue.</td>
</tr>
</tbody>
</table>
Display Original Application Files from the Document Info Record

5. Display the document info record.
   
   On the tab page Document data or Originals all existing original application files are listed.

6. Set your cursor on the line of the original application file you want to display. By double clicking on the original application file you start the viewer.

Result

The system checks the setting in Customizing of Document Management for the current frontend type (such as PC with operating system Microsoft Windows NT). The system determines which viewer is appropriate for displaying the selected file format (for example *.ACD format for AutoCAD files calls a 2D viewer).

The viewer is started automatically and displays the data of the original application file in a new screen section.

The following example shows the redlining functions in addition to the viewer.
Display Original Application File with the Viewer
Using the Product Structure for Object Folders

Use

The SAP component SAPoffice [Extern] allows you to copy SAP Business Objects to object folders [Extern].

- By storing these objects in personal folders, you can organize various operations according to your specific needs.
- By sending object folders, you can forward information to the employees responsible throughout your enterprise or within your project group.

Integration

Object folders are indicated in SAPoffice in the tab page properties with the indicator *Folders contains only objects.*

Prerequisites

You can only copy SAP Business Objects to object folders if you are using the SAP component SAPoffice. You must have the appropriate Authorizations [Extern] to execute the SAPoffice functions.

Features

Since only the users themselves and their representatives are to have access to the object folders, the folders are user-specific and referred to as personal folders [Extern]. Object folders are organized and managed in Personal folders [Extern].

Contents

You can assign to your personal object folder either other object folders or various SAP Business Objects, such as:

- Customer complaints orders
- Maintenance notifications
- Materials
- Documents
- Change numbers
- Characteristics
- Classes

Structure

You can organize your object folders in a hierarchy. This folder hierarchy is then displayed as a tree structure. To change the structure of your object folder, simply add other folders. When you add an object folder, any subordinate folders are also included.

This hierarchical structure allows you to organize the SAP Business Objects according to various criteria, such as operations or activities.
Using the Product Structure for Object Folders

Activities

When you create an object folder and you can copy the objects you need.

Processing of the existing object folder is done in display mode. You can change the contents of the folder by either adding to or deleting the SAP Business Objects contained in it.

You can process the object folders as follows:

- **Add SAP Business Objects**
  
  You can add objects in the following way:
  
  - Inserting them directly in the folder overview
  
  - By selecting them from the product structure and copying them to the folder

- **Send**
  
  You can send object folders both internally and externally from your inbox, outbox, and private folders. You can also reply to folders you receive.
  
  - When you send a folder internally, it is sent to a SAPoffice user in the same system.
  
  - When you send externally the object folder is sent to recipients that do not use SAPoffice.

- **Forward**
  
  You can forward object folders from your inbox.

- **Create attachment**
  
  To store or send different objects with related contents together, you can attach the following objects to the object folder:
  
  - Documents
  
  - SAP Business Objects
  
  - URL for a website

See also:

Creating object folders [Seite 511]

Checking in Objects from the Product Structure into a Folder [Seite 512]

Object Transfer in Folder Processing [Seite 514]
Creating Object Folders

Procedure

1. Select the function Office \(\rightarrow\) Work center \(\rightarrow\) Personal inbox.
2. Select either \(\text{(Personal inbox)}\) or \(\text{(Folder already exists)}\).
3. Depress the right-hand mouse button to call up the context menu.
4. Choose Create subfolder.
   
   You see the Create folder dialog box. Attributes.
5. Set the indicator Folder contains only objects and enter the remaining folder data.
6. Choose Continue.
   
   The system copies the newly create folders into the screen area Work center <User name>.

   ![Refresh](image)

   Refresh the screen section of Personal inbox with the button \(\text{(Refresh)}\).

Result

You have created an object folder, which you can extend with:

- You add further object folders.
- You insert SAP Business objects:
  - Add directly from processing the folder
  - Explode the product structure and copy selected objects from the product structure into the object folder

See also: Copying Objects from the Product Structure [Seite 512]
Checking Objects from the Product Structure into a Folder

Use
Related SAP Business Objects are displayed in a clear and concise manner in the product structure [Seite 468]. If you want to group individual PDM (Product Data Management) objects for your organization in object folders [Seite 509], you can use the product structure to select the objects.

You can copy the following PDM objects from the product structure to object folders:

- Materials
- Documents
- Change numbers
- Characteristics
- Classes
- Equipment
- Functional location

Copying Objects from the List Display
1. Display the product structure in the list display.
   See: Displaying the Product Structure in a List [Seite 516]
   The Product structure screen appears. < Effectivity date >.
2. Position the cursor on the object that you want to copy into the object folder.
3. Choose Check into object folder.
   You see the Folder selection dialog box.
   Select an existing object folder or create a new one.
4. Choose Continue. The system assigns the objects to the selected object folder.

Copying Objects from the Control Display
1. Display the product structure in the control display.
   See: Control Display of the Product Structure [Seite 482]
   The Product structure screen appears. < Effectivity date >.
2. Position the cursor on the icon of the object that you want to copy, for example, material.
3. Depress the right-hand mouse button to call up the context menu.
4. Choose Check into object folder.
   You see the Folder selection dialog box.
   Select an existing object folder or create a new one.
Checking Objects from the Product Structure into a Folder

5. Choose *Continue*. The object is assigned to the object folder.

**Result**

The objects you selected in the product structure are now contained in the object folder. You can then send the object folder with its contents (objects) or execute other SAPoffice functions.

*See:* [Using Object Folders [Seite 509]]
Object Transfer in Folder Processing

Prerequisites
At least one object folder exists in your personal storage/inbox.
See: Creating object folder [Seite 511]

Procedure
1. Select the function Office → Work center → Personal inbox.
   The Business Workplace of <User name> screen appears.
2. Select the icon of the folder you would like to extend.
3. Click on the folder in the second screen section <folder name>.
   If objects are already assigned to this folder they are also listed.
4. Select Select object.
   The Product Structure Browser screen appears. Initial screen, where you can enter an initial object.
5. Display the product structure.
   - In the Control view [Seite 482] you can copy the objects into the object folder by using Drag&Drop:
     In the Product structure section of the screen click on the object you want to copy. Hold down the mouse button and pull the object into the area Object folder. Drop the object on the entry of the appropriate object type (such as, document).
     Choose (Copy objects).
   - In the List view [Seite 516] you can copy the objects into the object folder in the following way:
     Expand the structure entry for object (such as document) you want to copy. The objects are indicated in the following way:


<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Object already copied]</td>
<td>The document is already assigned to the recipient list that you are currently processing.</td>
</tr>
<tr>
<td>![Copy object]</td>
<td>You can copy the document into the recipient list you are currently processing. Click on the Copy icon to copy the document.</td>
</tr>
</tbody>
</table>

Click on the icon to display a second temporary tree structure where the objects are listed that belong together.
Once you have selected all the objects you want to copy choose (Copy objects).

The Business Workplace of <User name> screen reappears.
6. Refresh the folder data by using the button (refresh).

**Result**

The objects you selected in the product structure are now contained in the object folder. You can then send the object folder with its contents (objects) or execute other SAPoffice functions.

See: Using Object Folders [Seite 509]
Displaying the Product Structure with the Simple List Display

Use
The simple list display contains a concise list of all the related objects in the form of a tree structure.

See: Settings for Product Structure [Seite 480]

Prerequisites
You are in the Product Structure Browser. Initial screen.

See also: Product Structure Browser [Seite 468]

Procedure
1. Enter in the Product structure browser: Initial screen a selection date or parameter values for the parameter effectivity.
2. Select a filter or maintain a private filter.
3. Select (Settings).
   The Product structure dialog box appears. Settings.
4. Reset the indicator New display version and select Continue.
   The Product Structure Browser screen reappears. Initial screen.
5. Select the tab page for the object type that you want to use as an initial object (for example, material).
6. Enter the key data.
   See also: Selecting Initial Object using a Stack [Seite 484]
7. Start the product structure explosion by choosing Continue.
   
   In the following processing situations you will see the dialog box Parameter effectivity:
   The initial object as a material or a class that was processed with a change number.
   The effectivity of the change number was set by parameter values.
   Enter the parameter values in the dialog box and select Continue.
   See: Entering Values for Parameter Effectivity [Seite 486]
8. The Product structure screen reappears. < Effectivity date >.

Result
On the Product structure screen: <Effectivity date> will display the structure of the object based on the chosen explosion criteria, such as effectivity date. All the objects are listed that are related to the initial object.
The filter key is displayed in the title bar when a filter is active. Only chosen data is normally displayed when a filter is active.

Header with an active filter: Product structure: Filter F-1-L; Effectivity date 02.20.2000

On the Product structure screen: <Effectivity date> you can execute additional functions for the objects:

- General functions (See Processing Objects for a Product Structure [Seite 492])
- Object specific functions such as
  - Processing Objects in List Display [Seite 518]
  - Copying a Change Object from the List [Seite 522]
  - Displaying Original Application File with a Viewer [Seite 506]
Processing Objects in List Display

Prerequisites

You are displaying the product structure in List display [Seite 516] and are in the screen Product structure: < Effectivity date >.

Procedure

The following special functions are supported for list display:

- **Set focus**
  
  If you want to create an additional tree structure for any object, select the object and then choose Set focus.
  
  The system opens a new tree structure at the end of the original one. The object you selected is shown as the root object in the new tree structure.

- **Create tasks**
  
  By choosing Create task, you can start ad-hoc business workflow tasks for the objects from the display mode. By choosing Create task, you can start ad-hoc business workflow tasks for the objects from the display mode.
  
  Example:
  
  - for change numbers
    
    You can send a document using SAPoffice which allows the recipient to display the chosen change master record.
  
  - for document info record
    
    You can execute several tasks, for example, find dependent objects to the document.

- **Send e-mail with object as attachment**
  
  You can send objects that are defined in the Business Object Repository using SAPoffice as an attachment to an e-mail.

- **Change master record of objects directly**
  
  You can change master records directly from the product structure. However, these changes are not shown in the product structure until you refresh it. For example, you change a relation if you enter a superior document in the document info record.

- **Store in folder**
  
  You can save any object to an object folder.
  
  See: Using Object Folders [Seite 509]

- **Display current display variant**
  
  You can choose the fields for each object type you want to display in the list. The help on each field offers you more information on the data.
You can set, for example, for documents that the processor responsible and the status are displayed in the structure.

You can save the display variant for each object type as user-specific.

**See also:**
Further functions are also described in the following documents.

- Settings for Product Structure [Seite 480]
- Copying a Change Object from the List [Seite 522]
- Displaying Original Application File with a Viewer [Seite 506]
Copying Documents from the List Display

Use
You can use the product structure to select documents of a product to send to one or several recipients when processing a recipient list.

Prerequisites
You are processing a recipient list.

See:

Procedure

1. Select in the Recipient List Basic data screen the icon (Product structure).
   The Product Structure Browser screen appears. Initial Screen.

2. Choose Settings and select List display.

3. You can also edit the filter.

4. Choose Continue and enter the data for the initial object.

5. Start the product structure explosion by choosing Continue.


   This screen is divided into two:
   
   - **Product structure of the initial object** in the upper part
     
     This part shows the product structure for the initial object.
     
     The system lists all of the object types that can be related to this initial object. You find under the object type Document all documents that have already been assigned a recipient list or can have a recipient list assigned to them.
     
     An additional icon indicates the documents as follows:

     | Icon | Description |
     |------|-------------|
     | ![Icon](object-already-copied) | (Object already copied) The document is already assigned to the recipient list that you are currently processing. |
     | ![Icon](copy-object) | (Copy object) You can copy the document into the recipient list you are currently processing. Click on the Copy icon to copy the document. |

   - **Recipient list** in the lower part
     
     This section refers to the recipient list that you are currently processing.
     
     Documents in the current processing situation that you select for copying into the area of the product structure are copied by the system into this area and marked them for copying.
7. Choose (Copy objects).

**Result**

The system copies your selected documents to the recipient list.
Copying a Change Object from the List Display

Use

While you are processing a change master record, you can use the product structure to select all the objects of a product that are affected by a change.

Prerequisites

If you want to copy objects from the product structure to the change master record, you must first set the following indicators for the relevant object types in the change master record (Object Types screen):

- Indicator: a management record is required for each object
- Indicator: object type active for change number

If you set these indicators for the document and material object types, for example, you can use the product structure to copy just documents and materials as change objects.

Procedure

1. In the change mode for the change master record, choose Go to → Select object.
2. Choose Settings and select List display.
   - You see the Select Objects screen. Initial Screen.
3. You can also edit the filter.
4. Choose Continue and enter the data for the initial object.
5. Start the product structure explosion by choosing Continue.
6. The Product structure screen appears. < Effectivity date >.
   - This screen is divided into two:
     - **Product structure of the initial object** in the upper part
       - This part shows the product structure for the initial object.
       - The system lists all of the object types that can be related to this initial object. The objects that are related to the initial object are listed under the individual object types.
       - An additional icon indicates the objects as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="checkmark.png" alt="checkmark" /></td>
<td>(Object already copied) The object has already been entered as a change object for the change number that you are currently processing.</td>
</tr>
</tbody>
</table>
The object can be copied as a change object for the change number that you are currently processing.

Click on the Copy icon to copy the object.

If you want to copy an object that does not have the copy icon, review the change master record to see whether the object type indicators allow this object type (for example, BOM) to be processed.

### Object List of the Change Numbers in the lower section

This section lists the change objects of the change numbers that you are currently processing.

Objects in the current processing situation that you select for copying into the area of the product structure are copied by the system into this area and marked for copying.

7. Choose (Copy objects).

### Result

The system copies your selected objects to the change master record. The screen appears where you chose the function Select objects.
Conversion

Purpose
Optimization of the product setup and development process can be obtained by means of methods from Digital Mock-up (DMU) or Virtual Product Development Management (VPDM). All members participating in the design process have common, regulated access to the product’s geometry and topology and can even display the product digitally in the development stages.

The standard SAP System’s SAP Graphical User Interface (SAPgui) now has a viewer from Engineering Animation, Inc. (EAI) that allows you to view your products in the Product Lifecycle Management [Extern] (PLM) area.

This integrated viewer as well as other visualization programs can only display product information of certain file formats. For this reason it is necessary that you be able to convert the source file into a file format that can be displayed by the available software.

You create a drawing (file type *.model) in a CATIA system that you want to display in the product structure. The viewer cannot display the CATIA format directly. In this case it is necessary to convert the file to a format either 2D (for example *.jpg) or 3D (for example *.jt) that can be displayed by the viewer.

The following Release allows the use of conversion interface functions of Digital Mock-Up Viewing.

Integration
You need the conversion server where the actual conversion takes place. Install the converter and communication programs on this server.

The SAP System communicates using an RFC connection to the conversion server. RFC destinations must be maintained. Use Customizing for conversions to set which original application files are converted at which processing statuses.

The following graphic shows the integration.
The integration is done in the following steps:

- **Installing the Converter [Seite 528]**
  
  Therefore, one or more converters need to be installed for the conversion process. The selection of converters is based on which conversions are necessary and which type of files you want to display.

- **Definition of an RFC destination**
  
  RFC (Remote Function Call) is an SAP interface protocol sets up communication between the converter and the SAP System. Notes on the definition of RFC destinations can be found under Programs for Communication [Seite 531].

- **Customizing of Conversion [Seite 542]**
  
  The conversion interface controls conversions of original application files and document inf records in the standard SAP System. You can set in the SAP System which processing status triggers an automatic conversion. The conversion specification contains all notes, indications, and details for the conversion. You create this in Customizing for Conversions. SAP help programs take car of the actual data transfer to the converter.

**Features**

The current conversion interface allows original application files to be converted: Conversion of Original Application Files [Seite 547].

The following overview contains the phases of the conversion processes.
### Conversion

<table>
<thead>
<tr>
<th>Start</th>
<th>You can start the conversion in two ways:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document:</td>
<td></td>
</tr>
<tr>
<td>• Converting Documents (Automatic Start) [Seite 546]</td>
<td></td>
</tr>
<tr>
<td>• Converting Documents (Manual Start) [Seite 547]</td>
<td></td>
</tr>
<tr>
<td>Assembly:</td>
<td></td>
</tr>
<tr>
<td>• Convert Assembly [Seite 548]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preparation for conversion</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Beginning background preparations</strong></td>
<td>The conversion process is started as a background job. This allows the user who started the conversion to continue working. The conversion does not have to be completed before resuming work. You can also set up the conversion to run only at night (See: Customizing for Conversions [Seite 542]).</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Finding a free conversion server</strong></td>
<td>The system checks which conversion server is available for the conversion (Maintaining the converter [Extern]) and reports the destinations where the SAP help programs communicate with the conversion program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The system creates a temporary directory on the conversion server where the original application files are stored:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>− Original application files that you want to convert</td>
</tr>
<tr>
<td></td>
<td></td>
<td>− Converted original application files that you want to transfer to the SAP System</td>
</tr>
<tr>
<td></td>
<td>• <strong>Messages in the application log</strong></td>
<td>Since the conversion process is not a dialog process you see no dialog messages during the conversion. Logs messages in the application log tell you what happened during the conversion (Display Messages [Seite 550]).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The scope of the output messages is determined in Customizing for Conversions [Seite 542]. You decide in what time frame the logs are deleted.</td>
</tr>
</tbody>
</table>

| Conversion on the Conversion server | The conversion of original application file is done using a converter that you installed to fit your needs. You can set up a time period for the converter in Customizing for conversions. The selection and syntax of these parameters are dependent on the converter. | |
| Import of converted original application files on the storage systems | After conversion the original application files are saved in the temporary working directory. The converted original application files are transported into the SAP System by means of SAP help programs. The transport is done into the storage category that was entered in the conversion specification. You define in the conversion specification in which processing situations the converted original application files are deleted from the temporary working directory. You can set, for example, that the files are deleted once they have been converted correctly but converted original application files with errors are left intact. |

**Result**

A visual result appears where the system displays a list of the original application files for the document info record. The converted original application files are added to the originals in the source format automatically. You can display all file formats from the tab page *Original Application Files*.

The integrated viewer [Seite 566] of the SAP System will display many standard formats and is set up as the default viewer for these.
Installing the Converter

Purpose
Converting original application files is not done with tools of the SAP System but by means of one or more converters from different suppliers on the market.

A converter interface is part of the standard SAP System. This interface controls the conversion as well as the data exchange between the converter and the SAP System. Specify in Customizing of the SAP System how the conversion is run. You determine at what processing status the conversion is started automatically.

We strongly recommend that you read all instructions and notes from the converter’s manufacturer as well as from SAP before installing a converter to ensure that conversion fits optimally into your business processes.

Prerequisites
The converter that you chose for conversion can be coupled the SAP System. Important here is that the converter is running in batch mode, this means without user entries.

Installing the Converter and Communication Programs

2. Select the computer where you want to install the converter.

   This computer is the conversion server.

   Note the following:

   - Some converters require additional hardware and software that must also be installed on the conversion server.

   - It is recommended to always leave the conversion server running so that conversions can also be executed evenings and weekends.

   The conversion time of the converter are set in Customizing of Conversion under Determine conversion.

   - When other users also use the conversion server during the day you may want to have all conversions executed at night. This avoids the users being slowed down during the workday.

      This is also true when you use an SAP application server as the conversion server. Otherwise the SAP System performance may be greatly reduced.

      It is highly recommended the application server not be used as the conversion server to ensure reliable and efficient operation.

   - You can set up as many conversion servers as required. The definition is done in Customizing of Conversion; under Maintain converter.

3. Install the converter.

   Please read all of the manufacturer’s documentation.
Installing the Converter

The SAP GUI can display the 3D format *.jt.
If you want to convert CAD original application files into the *.jt format you can use the converter from Engineering Animation, Inc. (EAI). This converter already has an interface built into the standard SAP System.

4. Install the following programs for communication between the SAP System and the converter.

<table>
<thead>
<tr>
<th>Program</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapftp and saphttp</td>
<td>Transport files between the SAP System and the conversion server</td>
</tr>
<tr>
<td>(Available on the SAP R/3 Client Installation CD)</td>
<td></td>
</tr>
<tr>
<td>ConvUtil</td>
<td>• Creates temporary directories</td>
</tr>
<tr>
<td></td>
<td>• Deletes files from the conversion server</td>
</tr>
<tr>
<td>Program for communicating with the converter such as ConvServSamp, ConvRfc2Corba</td>
<td>Communication between the SAP System and the converter</td>
</tr>
</tbody>
</table>

You can find more information under: Connecting the Converter [Seite 534]
You will find the programs ConvUtil, ConvServSamp and ConvRfc2Corba on a SAP server SapservX under the following path: ~ftp/general/misc/converter. It is highly recommended that you read Hints for the Communication Programs [Seite 531] as well as the readme.txt file that is on the server under the archive docu.SAR. This file contains the most up-to-date information.

5. Set up an RFC destination for the program RunConvUtil.bat (for Windows NT) or StartConvUtil (for UNIX).

See:

6. You can also create an RFC destination for the other three programs that you need.

   The other three programs are started by the program ConvUtil with the name ConvServ or ConvServ.bat. Sapftp and saphttp start them if you do not set up RFC destinations for the three programs. The start is done with the parameters that are necessary for communication with the SAP System.

Notes

Converting CATIA Files to Direct Model Files (*.jt)
If you specify a conversion of CATIA files into Direct Model format note the following entries:

- Read the installation information from EAI. Choose the settings in the configuration file in such a way so that each CATIA is converted into exactly one Direct Model file.
- Enter the configuration file in Customizing of Conversion for the conversion specification. Enter the configuration file according to the following convention in the activity Enter parameters for conversion: -z <Filename>
Installing the Converter

- The temporary path where the files are checked out from can only be a maximum of 8 characters long.
## Hints on the Communication Programs

The following overview contains special information regarding each of the four programs.

<table>
<thead>
<tr>
<th>Program</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapftp</td>
<td>Under WinNT, the program librfc32.dll must be accessible.</td>
</tr>
<tr>
<td>saphttp</td>
<td></td>
</tr>
<tr>
<td>ConvUtil</td>
<td>Before calling the program, set the path to that sapftp, saphttp, and</td>
</tr>
<tr>
<td></td>
<td>ConvServ can be accessed and be started by the program ConvUtil.</td>
</tr>
<tr>
<td></td>
<td>When you select the option Start for when defining the RFC destination</td>
</tr>
<tr>
<td></td>
<td>you will only have a very basic path set. In this case use shell</td>
</tr>
<tr>
<td></td>
<td>script to set the path and then call the program ConvUtil.</td>
</tr>
<tr>
<td>ConvServSamp</td>
<td></td>
</tr>
<tr>
<td>ConvRfc2Corba</td>
<td></td>
</tr>
</tbody>
</table>
### Hints on the Communication Programs

<table>
<thead>
<tr>
<th>Program for communication between the SAP System and the converter such as ConvServSamp, ConvRfc2Corba</th>
<th>When you start the program using ConvUtil you write a shell script with the name ConvServ (or ConvServ.bat when using the operating system Windows NT). You call the RFC server for communication with the converter in this shell script (Examples: ConvServSamp, ConvRfc2Corba).</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you use a CORBA server from Engineering Animation, Inc. (EAI) for conversion you will need the SAP program ConvRfc2Corba.</td>
<td></td>
</tr>
<tr>
<td><strong>•</strong> In addition to the parameters stated here the program also needs the parameter for CORBA communication with the CORBA server. These parameters can be found in the installation guide from EAI.</td>
<td></td>
</tr>
<tr>
<td><strong>•</strong> The program ConvRfc2Corba must be started with the parameters that are used to start the conversion server from EAI for example:</td>
<td></td>
</tr>
<tr>
<td>```bash</td>
<td>CatiaTranslatorServer -hostName iw1027 -TranslatorName CAT1 -namingContext DefaultNamingContext -portNumber 10000</td>
</tr>
<tr>
<td><strong>•</strong> The following parameters are needed as well:</td>
<td></td>
</tr>
<tr>
<td>```bash</td>
<td>-sessionFactory &lt;sessionFactory&gt; - listFactory &lt;GeneralListFactory&gt;</td>
</tr>
<tr>
<td>The values of these parameters must be identical to the parameters used when calling the program VisDSSessionMgr. Here is an example of a complete call:</td>
<td></td>
</tr>
<tr>
<td>```bash</td>
<td>ConvRfc2Corba &lt;RFC Parameter&gt; -hostName iw1027 -TranslatorName CAT1 -namingContext -sessionFactory &lt;sessionFactory&gt; -listFactory &lt;GeneralListFactory&gt; -portNumber 10000</td>
</tr>
<tr>
<td><strong>•</strong> Start the program ConvRfc2Corba after the other CORBA programs from EAI have been started.</td>
<td></td>
</tr>
<tr>
<td>The program ConvRfc2Corba must be closed and restarted in the following situations:</td>
<td></td>
</tr>
<tr>
<td>- Another CORBA program has been started.</td>
<td></td>
</tr>
<tr>
<td>- The SAP System was restarted.</td>
<td></td>
</tr>
<tr>
<td>The program runs better on a UNIX machine and when maintaining the RFC destination (transaction code SM59) select the option Start or start the program using ConvUtil.</td>
<td></td>
</tr>
<tr>
<td>The program ConvRfc2Corba does not have to be run from the conversion server. The other three programs do.</td>
<td></td>
</tr>
<tr>
<td><strong>•</strong> If you encounter communication problems between the CORBA programs you must add the –Oanumeric parameter. A communication problem can occur when the nameserver (ConvRfc2Corba, nameserv, VisDSSessionMgr and the translator server, such as CatiaTranslatorServer or ProETranslatorServer.exe) cannot be found in the CORBA programs.</td>
<td></td>
</tr>
<tr>
<td><strong>•</strong> You can also start the CORBA programs from EAI from ConvRfc2Corba. In this case the parameters are automatically selected for consistency. To do this you must set the path for nameserv and VisDSSessionMgr so that the can be found before calling ConvRfc2Corba.</td>
<td></td>
</tr>
<tr>
<td>Set all environment variables for ConvRfc2Corba as required by the converter. Also enter the parameters –corbaTranslatorServerName &lt;TranslatorServer&gt; when calling ConvRfc2Corba. <strong>&lt;TranslatorServer&gt;</strong> is required for your conversion. The</td>
<td></td>
</tr>
</tbody>
</table>
Connecting the Converter

Use

There are several ways to connect a converter to the SAP System. You must consider the conversion results when selecting one. For example, if you want to convert original application files from documents, you must set up the conversion server differently than when you want to convert assemblies.

There are three ways to connect a converter to the SAP System.

<table>
<thead>
<tr>
<th>Method</th>
<th>Objects you want to convert</th>
<th>Transfer of parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Individual original application files from documents</td>
<td>Parameters are transferred between the SAP System and the converter using files</td>
</tr>
<tr>
<td>2</td>
<td>Individual original application files from documents and assemblies</td>
<td>Parameters are transferred between the SAP System and the converter using an RFC interface</td>
</tr>
<tr>
<td>3</td>
<td>Individual original application files from documents and assemblies</td>
<td>Parameters are transferred between the SAP System and the converter using an RFC interface</td>
</tr>
</tbody>
</table>

2. Method

You can convert individual original application files of documents using the converter connected with this method. You can use the compiled example server ConvServSamp. No previous programming knowledge is required. It is however necessary to modify the shell-script and possibly a batch file.

You can find examples on the SAP server SapservX in the directory ~ftp/general/misc/converter/.

The graphic display how the example convert All2txt is connected to the SAP System using the first method. All2txt converts files into text files. A shell-script file (such as ConvServ) starts ConvServSamp. This method uses the following conversion steps:

- Information for the conversion is transferred to the form the SAP System to the program ConvServSamp using the RFC destination.
- ConvServSamp stores the information as files on the conversion server and starts a shell-script file (in this case: StartConv) with its own parameters.
- The shell-script file (in this case: StartConv) calls the converter (here: All2txt) using the syntax for the converter.

When you install your own converter you must modify StartConv that it is called with its special syntax and not All2txt which was used only as an example.
Example for First Method

Conversion server

ConvServSamp ↔ StartConv

Konverter: All2txt

Information transfer using RFC connection

RFC destination (Transaction SM59)

SAP System

Below are tips and notes for the individual steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call ConvServSamp</td>
<td>You must enter the following parameters when calling ConvServSamp:</td>
</tr>
<tr>
<td></td>
<td>• RFC parameter</td>
</tr>
<tr>
<td></td>
<td>• Path name of the <em>shell-script</em> file that ConvServSamp starts</td>
</tr>
<tr>
<td></td>
<td>for conversion (using parameter <em>-s</em>&lt;shell-script filename&gt;)</td>
</tr>
<tr>
<td></td>
<td>More information about the document you are converting can be saved</td>
</tr>
<tr>
<td></td>
<td>as an extra file by using the parameter <em>-ReadDocumentDetails</em>.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>• ConvServSamp -s c:</td>
</tr>
<tr>
<td></td>
<td>• ConvServSamp -s $HOME/bin/StartConv &lt;RFC Parameter&gt;</td>
</tr>
</tbody>
</table>
Connecting the Converter

The file `<WorkingDirectory>/Parameters.txt` is created before calling `StartConv` and contains the parameters that were maintained in Customizing of the conversion specification. In Customizing of Conversion you make the settings Logistics General → Conversion → Determine conversion.

Additional Files

The following files are also created when `ConvServSamp` is called using the parameter `-ReadDocumentDetails`:

- `<WorkingDirectory>/Documentdata.txt`
- `<WorkingDirectory>/Ecmdata.txt`
- `<WorkingDirectory>/Documentdescriptions.txt`
- `<WorkingDirectory>/Longtexts.txt`
- `<WorkingDirectory>/ClassData.txt`
- `<WorkingDirectory>/Objectlinks.txt`
- `<WorkingDirectory>/Statuslog.txt`
- `<WorkingDirectory>/ExportData.txt`
- `<WorkingDirectory>/UserData.txt`

The files contain the data that the function module `CAD_GET_TITLE_BLOCK_DATA` determines. You can find information about the content of these files in the documentation for this function module (Export Parameter `DOCUMENTDATA` and `ECMDATA` and tables `DOCUMENTDESCRIPTIONS`, `LONGTEXTS`, `CLASS_DATA`, `OBJECTLINKS`, `STATUSLOG`, `EXPORT_DATA` and `USER_DATA`).

- The files `Documentdata.txt` and `Ecmdata.txt` contain `DOCUMENTDATA` or `ECMDATA` for every element of the structure. This data is in a line where the name and value of the element are entered:
  `<Name> = <Value>` (example: `DOCUMENTTYPE = DRW`)
- All other files contain a line for each line of the structure. Each line contains a value for each element of the structure from the table. The number of the columns is based on the width set in the SAP System.
  No limits are used.
**ConvServSamp** sets parameter values for *StartConv*

The example server **ConvServSamp** calls the file **StartConv**:

```
StartConv <Version> <WorkingDirectory> <FileToConvert>
<language> <ConverterTimeOut> <conversionName>
<DocumentKey> <current_user_name> <sy_language>
```

- **ConvServSamp** sets `<WorkingDirectory>`, `<FileToConvert>`, `<DocumentKey>`, `<current_user_name>` and `<sy_language>` for the parameter values at the beginning and end of each special character "
  - This keeps the *Shell* from interpreting the special character.
- Each conversion has its own `<WorkingDirectory>` where the converted files are written.

**Parameter meanings:**

- `<Version>` (such as: 5):
  - Which functions are supported by the current SAP System
- `<WorkingDirectory>`:
  - Directory used for converted files
- `<FileToConvert>`:
  - Files you want to convert
- `<language>`:
  - Language for possible dialog boxes ('X' means no language selected)
- `<ConverterTimeOut>`:
  - Cancel conversion after this many minutes.
- `<conversionName>`:
  - Name for conversion
- `<DocumentKey>`:
  - Key for the document in the following sequence:
    - 3 characters: documenttype
    - 25 characters: documentnumber
    - 3 characters: documentpart
    - 2 characters: documentversion
- `<current_user_name>`:
  - Name of user who started the conversion implicit or explicit
- `<sy_language>`:
  - Language used by `<current_user_name>`
Connecting the Converter

Modifying StartConv

<table>
<thead>
<tr>
<th>Change the example file StartConv so that</th>
</tr>
</thead>
<tbody>
<tr>
<td>• This file starts your converter and</td>
</tr>
<tr>
<td>• One of the files &lt;WorkingDirectory&gt;/Error.txt or</td>
</tr>
<tr>
<td>&lt;WorkingDirectory&gt;/ConvPath.txt is created</td>
</tr>
</tbody>
</table>

After StartConv is completed ConvServSamp runs through the following steps:

<table>
<thead>
<tr>
<th>The first line of the file &lt;WorkingDirectory&gt;/Error.txt is transferred</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The file &lt;WorkingDirectory&gt;/Error.txt exists and</td>
</tr>
<tr>
<td>• The first line of this file is not empty</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If exit code of the shell-scripts (for example StartConv) does not equal 0 (zero) the value is returned the SAP System as an error.</th>
</tr>
</thead>
</table>

| If none of the above is true, the path name of the converted file from the file <WorkingDirectory>/ConvPath.txt is read. This file is automatically transferred to the SAP System and stored as a new original application file. |

2. Method

You can convert individual original application files of documents and assemblies using the converter connected with this method.

You can use the compiled example server ConvServSamp. No previous programming knowledge is required. It is however necessary to modify the shell-script and possibly a batch file.

The procedure is very much the same as the previous method.

The following overview shows information about files and parameters that are processed for converting assemblies only.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Note</th>
</tr>
</thead>
</table>

ConvServSamp creates <WorkingDirectory>/ConvStructFilename.txt

<table>
<thead>
<tr>
<th>Before calling StartConv the &lt;WorkingDirectory&gt;/ConvStructFilename.txt is created by ConvServSamp.</th>
</tr>
</thead>
</table>

Each line of this file contains the following parameters:

<table>
<thead>
<tr>
<th>parent_guid[38]</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID of the father of this part</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>guid[38]</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID of this part</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>file_changed[1]</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the part was changed (currently not supported)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>filename[255]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path name of the part</td>
</tr>
</tbody>
</table>

The format is fixed. There is no separator between the entries.
The converter creates <WorkingDirectory>/ConvPathAndMatrix.txt instead of the file <WorkingDirectory>/ConvPath.txt. This file is not read when the file <WorkingDirectory>/ConvPath.txt exists.

Each line of this file contains the following parameters:

- `parent_guid[38]`  
  ID of the father of this part (as entered)
- `guid[38]`  
  ID of this part (as entered)
- `filename[255]`  
  Path name of the part
  Path name: Must not contain any empty spaces, end with empty or end of line

The format for these three parameters. There is no separator between the entries.

In case the path name is not yet at its end, it must contain 12 real number between these there must be an empty space:

- `locox`, `loc oy`, `locoz`, `axis1x`, `axis2x`, `axis3x`, `axis1y`, `axis2y`, `axis3y`, `axis1z`, `axis2z`, `axis3z`, `scale`

The transformation matrix is used to describe the relative position of the part to the father.

When more than on instance exists then each instance must have its own line. These lines must be identical except for the transformation matrix.

### 3. Method

You can change the example server `ConvServSamp` when you do not wan to transfer your conversion parameters as files or when the first two methods do not meet your needs. You need to have programming knowledge of (C source code).

You will find the C source code for the RFC Server ConvServSamp on the SAP Server `SapservX` in the following directory: `~ftp/general/misc/converter/source.SAR`

The converter is called from the SAP System as follows:

```plaintext
CALL FUNCTION 'ASSEMBLIE_CONVERTER'
  DESTINATION wa_converter_dests-conv_dest
  EXPORTING interface_version = interface_version
      output_directory = output_directory
      language = isola
      sy_language = sy_isola
      timeout_minutes = timeout_minutes
      conversion_name = wa_conv_requested-handle
      document_key = document_key
```
Connecting the Converter

```java
current_user_name = sy-uname
IMPORTING error_message = error_message
   return = bapireturn
TABLES ti_conv_struct_filename = t_conv_struct_filename
   ti_parameters = te_parameters
   te_conv_path_and_matrix = ti_conv_path_and_matrix
```

Information about the type and structure of the fields are in the file `ConvServ.h`.

Below is information about the use of individual fields.

### Entries for the Converter

<table>
<thead>
<tr>
<th>Entry</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>interface_version</td>
<td>Indicates which functions are supported by the current SAP version</td>
</tr>
<tr>
<td>(int, for example 3)</td>
<td></td>
</tr>
<tr>
<td>output_directory</td>
<td>Working directory where the converted files are sent</td>
</tr>
<tr>
<td>(char *255)</td>
<td></td>
</tr>
<tr>
<td>language</td>
<td>Language for the error messages in the SAP System</td>
</tr>
<tr>
<td>(char *2, such DE or EN)</td>
<td></td>
</tr>
<tr>
<td>sy_language</td>
<td>Language used by the user to logon to the SAP System before starting</td>
</tr>
<tr>
<td>(char *2, such as DE or</td>
<td>the conversion.</td>
</tr>
<tr>
<td>EN)</td>
<td></td>
</tr>
<tr>
<td>timeout_minutes</td>
<td>Time in minutes after which the conversion is cancelled as not</td>
</tr>
<tr>
<td>(int, for example 30)</td>
<td>successful</td>
</tr>
<tr>
<td>conversion_name</td>
<td>Name for identifying the conversion</td>
</tr>
<tr>
<td>(char *32)</td>
<td></td>
</tr>
<tr>
<td>document_key</td>
<td>Key of the document that you want to convert</td>
</tr>
<tr>
<td>(struct DOCUMENT_KEY)</td>
<td></td>
</tr>
<tr>
<td>current_user_name</td>
<td>User who started the conversion</td>
</tr>
<tr>
<td>(char 12*)</td>
<td></td>
</tr>
<tr>
<td>ti_conv_struct_filename</td>
<td>Structure and path names</td>
</tr>
<tr>
<td>(table)</td>
<td>See: Section Converting Assemblies,</td>
</tr>
<tr>
<td></td>
<td>&lt;WorkingDirectory&gt;/ConvStructFilename.txt</td>
</tr>
<tr>
<td>ti_parameters (table)</td>
<td>See: Section Converting Original Application Files of a Document,</td>
</tr>
<tr>
<td></td>
<td>&lt;WorkingDirectory&gt;/Parameters.txt</td>
</tr>
</tbody>
</table>

### Output of the Converter

<table>
<thead>
<tr>
<th>Output</th>
<th>Use</th>
</tr>
</thead>
</table>
### Connecting the Converter

<table>
<thead>
<tr>
<th><strong>te_conv_path_and_matrix</strong></th>
<th>Here you can transfer the converted file and the transformation matrix and/or an error message (in 2 table lines) for the file you entered.</th>
</tr>
</thead>
</table>
| (table)                     | - **msg_type = ' '** (Blank)  
  The table lines (struct CONV_PATH_AND_MATRIX) contain a converted file and possibly transformation matrix  
  transformation_matrix_valid = 'X'  
  See: Section *Converting Assemblies*,  
  <WorkingDirectory>/ConvPath.txt)  
- **msg_type <> ' '** (Blank)  
  The table lines (struct CONV_PATH_AND_MATRIX_ERR) contain an error message. |

<table>
<thead>
<tr>
<th><strong>error_message</strong></th>
<th>Error Messages:</th>
</tr>
</thead>
</table>
| (struct MESSAGES) | - **msg_type = ' '** (Blank)  
  No error  
- **msg_type = 'W'** Warning: The file was converted, however there is still a problem that user should know about  
- **msg_type = 'E'**  
  Error: File or assembly could not be converted  
- **msg_type = 'F'**  
  There are error messages in te_conv_path_and_matrix; parts of the assembly or the entire assembly could not be converted.  
- **msg_type = 'L'**  
  Not all licenses are available for conversion. The converter will be available later, however with input from an administrator.  
- **msg_type = 'C'**  
  System error that requires input form the administrator (for example hard drive is full)  |

If all fields (except msg_type and msg_txt) are released, an long message can be entered in the msg_txt that has up to 200 characters.

<table>
<thead>
<tr>
<th><strong>return</strong></th>
<th>Error messages can also be added to this structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>(struct BAPIRET2)</td>
<td>The RFC server must also contain the function CONV_SERV_ABOUT that you can use without changing the example ConvServSamp.c.</td>
</tr>
</tbody>
</table>
Customizing for Conversions

Use

Settings have to be made in the system for other applications as well as in Customizing for Conversions. Use the Implementation Guide (IMG) for instructions of the individual activities where you enter the required data.

Activities

2. Decide whether you want to check in files to a secure area that you want to convert into the SAP System. Secure storage areas are storage systems controlled by the Knowledge Provider [Seite 138] such as vault, archive, and the SAP database [Seite 141].

By deciding to check in and store the files you make it possible for the files to be accessed from any workstation. A disadvantage of this is that the data must be transported often. Note the following:

<table>
<thead>
<tr>
<th>Checking an Original Application File into a Secure Storage Area</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>In Customizing for Conversions [Seite 542] you must <strong>not</strong> set the following indicators:</td>
</tr>
<tr>
<td></td>
<td>• General local files</td>
</tr>
<tr>
<td></td>
<td>• Local files</td>
</tr>
</tbody>
</table>
Set up a file server so that all users and the conversion server can access the files under the same path name.

Under WinNT a file c:\users\test.doc is created and put in a document info record of the SAP Systems as an original application file.

**Problem**
The conversion server that is running on another computer cannot access this file.

**Solution**
Allow other computers to access c:\users.
Connect c:\users to the local computer as well as the conversion server with a logical drive, for example x:
Process the file locally under the name x:\test.doc.
Crate an original application file in the document info record of the SAP System using this name.

Enter in Customizing of Conversion (conversion specification) the following data:

- Indicator General local files
- Storage category, where the converted original application files are checked in and stored

### 3. Maintain the conversion data.

*See: Maintain Customizing for Conversions [Seite 544]*

### 4. Assign SAP authorizations for users.

Each user that starts a conversion (implicitly) needs the following authorizations:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_DRAW_TCD</td>
<td>Check in and check out of original application files</td>
</tr>
<tr>
<td>C_STUE_BER</td>
<td>Process bills of material (only necessary when converting assemblies)</td>
</tr>
<tr>
<td>S_BTCHADM</td>
<td>Batch administrator</td>
</tr>
<tr>
<td>S_BTCHJOB</td>
<td>Operations for jobs in background processing</td>
</tr>
<tr>
<td>Call RFC modules</td>
<td></td>
</tr>
</tbody>
</table>

### 5. Verify that a DEFAULT entry for the frontend computer is defined in Document Management.

This setting ins in Customizing of Document Management; under General Data → Define data carrier [Seite 132] → Data carrier type "Defined server, frontends" → Identify frontend computer.
Maintaining Customizing for Conversions

Use

You control the conversion process in Customizing for Conversions. In the SAP reference IMG you will find Customizing of Conversion under the path: Logistics General → Conversion.

The following activities are required for conversion:

3. Maintaining Converters
4. Determine conversion

Maintaining Converters

In this activity you maintain the general data for the converter.

3. You can name the converter as you like, such as CATtoJT for a converter that converts CATIA files to JT files.

4. Enter the RFC destinations [Extern] for the program ConvUtil.

   Enter the RFC Destination as the Help program for conversions. This is the same destination you use for the program ConvUtil.

   ![Light Bulb]

   You do not have to make any other entries for the rest of the RFC Destinations. The program ConvUtil starts the RFC server.

   See also: Installing the Converter [Seite 528]

More Notes

<table>
<thead>
<tr>
<th>Area</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch process</td>
<td>All converters that you define in this activity can be used at the same time for conversions. Each conversion uses its own batch process. Set up the SAP System so that enough batch processes are available. We recommend you have an additional batch process for each converter in addition to the batch processes for the enterprise areas.</td>
</tr>
</tbody>
</table>
| Lock active converter | Normally, each of these programs [Seite 531] can only be accessed one at a time when converting. Running another program simultaneously will cause an error to appear. To avoid this, the converter being used for the conversion is locked while converting. This lock is only possible when the following conditions are met:  
  - Each RFC destination is only used once.  
  - Different converters are maintained in different activities for different SAP Systems and in different clients. |
Conversion test

When you test the settings in Customizing system and then transport the settings into the productive system both systems have the same entries.

Do not start any more conversion in the Customizing system at this point. Otherwise errors will occur during conversion.

More information can be found in the IMG of Conversion; Logistics General → Conversion → Maintain converter.

Determine conversion

Enter the conversion data in two partial-steps:

2. Enter data for the converter specification.

   You decide for each document type which source format of original application files in which target format for the conversion.

   Enter the status of the document info record that will automatically trigger a conversion of original application files.

3. Enter the parameters and parameter values for each specification. The entries are dependent on the converter you selected.

   More information can be found in the IMG of Conversion; Logistics General → Conversion → Determine conversion.
Converting Documents (Automatic Start)

Use

This function converts original application files of a workstation application automatically when you save a document info record to a particular status you set in the conversion specification.

Prerequisites

You have maintained Customizing of Conversion [Seite 542] and entered detailed instructions for the conversion. You create the conversion specification for a document type in conjunction with a particular document status.

When you set a status in a document info record, the system checks whether this document type is set up so that this status triggers an automatic conversion.

Procedure

2. Process the document, such as by Logistics → Central Functions → Document Management → Document → Change).
3. In the Basic Data screen set the status that is used in the conversion specification.
4. Save your document.

   The system starts the conversion process. It checks which workstation application is set in the conversion specification.

   See also: Conversion [Seite 524]

Result

You can control the results of the conversion in the following ways:

- Display the messages from the application log.

  See also: Displaying messages [Seite 550]

- Display the document info record.

  A visual result appears where the system displays a list of the original application files from the document info record.

  The converted original application files are added to the originals in the source format automatically. You can display all file formats from the tab page Original Application Files.
Converting Documents (Manual Start)

Use
This function you carry out when you want to start the conversion for original application files of a particular document manually.

Prerequisites
You have maintained Customizing of Conversion [Seite 542] and entered detailed instructions for the conversion. You create the conversion specification for a document type in conjunction with a particular document status.

When you start a conversion manually the system only checks the settings in Customizing. The status history of the documents is not checked. The document does not have to have had this status nor does this status have to be set to the current processing time point.

Procedure
Ensure that the document you want to convert is not locked. A document can be locked when it is in change mode, for example.


You see the Convert document screen.

3. Enter the data that identifies the document info record whose original application files you want to convert.

4. Enter the status of the document info record that a conversion specification in Customizing of Conversion.

5. Choose Execute.

When the document you entered does not exist or if no conversion specification exists for the document type and document status you entered the conversion is cancelled. Otherwise the conversion runs in the background.

Result
A visual result appears where the system displays a list of the original application files for the document info record. The converted original application files are added to the originals in the source format automatically. You can display all file formats from the tab page Original Application Files.

The integrated viewer of the SAP System will display many standard formats and is set up as the default viewer for these.

Messages that occur during the conversion can be displayed.
See: Displaying messages [Seite 550]
Converting Assemblies

Purpose

So that you can carry out Digital Mock-Up Viewing, transformation matrices have to be maintained for the SAP System. The transformation matrices can either be generated from the CAD coupling (such as from the CATIA-System) or by the conversion of assemblies.

Prerequisites

Customizing

You need to define the following settings in Customizing:

- In Customizing of Conversion you define the scope of the conversion scenario. In this case set that the entire BOM structure is to be converted.

  The setting is under Logistics General → Conversion → Determine conversion → Conversion specification (detail screen). Enter Complete structure as the Check out depth.

- In Customizing of Document Management you must set up support for document assignments for the BOM header as well as for the BOM items.

  See also: Setting up Customizing for DMU Viewing [Seite 564]

CAD Coupling

The following is required for CAD coupling:

- The CAD link for the material BOM must be set up and functional. Assemblies are stored in these material BOMs that you want to convert or display.

- The following documents must be stored in the BOM using the CAD coupling in the SAP System:
  - The document for the assembly must be stored in the BOM header (Assembly file).
  - The base object must be stored on the BOM items (Part files).

- The CAD coupling call the following function modules for converting assemblies: CONV_API_CONVERT_BOM_ASSEMBLY (development class CONV, function group CONV_API).

Process Flow

4. The engineer creates a CAD drawing for each assembly part in the CAD system.

5. Then the CAD coupling is used to create the assembly in the material BOM of the SAP System.

   The system creates a document info record for each CAD file and links the document info record to the BOM header or BOM item.

6. The conversion program is started.

   You have the following options:

   - Manual Start [Seite 547] (parallel to conversion of individual files)
• Automatic Start (using CAD coupling)
  The system runs the following steps:
• Converts the CAD files in the format of the viewer (Direct Model).
• Assigns the files to the documents in the SAP System.
• Determines the transformation matrices based on the CAD files for the entire assembly.
  A transformation matrix defines geometrical position of a component within space.
• Assigns transformation matrices to the BOM items.

A wheel has 19 spokes.
In the BOM for the wheel the system assigns the item "Spoke" to the drawing and 19 transformation matrices. Each transformation matrix defines the geometric position of an individual spoke.

**Result**
You can now display the 3D model in the Engineering Workbench.
Displaying Messages

Use
The conversion process is a background job, therefore any information generated while running it can be read in the application log.

Prerequisites
At least one conversion process was started either manually or automatically with the automatic start being triggered by a particular status of the document status. Both cause messages to be written to the application log.

Procedure
5. Select Logistics → Central Functions → Engineering → Environment → Conversions → Display messages.
   You see the Display messages screen.
6. Enter the time period that you want the conversion to take place in.
7. Enter the name of the user who carried out the following activities:
   - User who started the conversion of the original application file manually (Converting documents (manual start) [Seite 547])
   - User who saved the document status that triggered the automatic conversion.
   If you want to see all messages without restrictions do not make any entries.
8. Choose Execute.
   - If no conversion were executed according to the selections you made the following message appears:
     No log found in the data base
   - When conversions were executed according to your selections then the Display log screen appears.

Reading the Log
The screen Display log contains all conversions that were executed with the selections you made.

The traffic light gives you a quick and easy way to see how the conversion were executed:
- Conversion was completed successfully (green light)
- Errors occurred during conversion (red light)
  You will find detailed information in the application log when errors or warnings occurred in the individual conversions. Use the following transactions to restart a conversion that was cancelled because of timeout errors:
- conv02 (convert document)
- conv03 (convert assembly)
The user who started the conversion as well as the time of start are displayed.

Double-click on a message to see more technical information or display the long text.

💡
You will receive notes about troubleshooting if errors occurred during conversion. These notes are in the output file on the conversion server of the converter.
Administrative Utilities

Checking the status of a converter is an important administrative utility. This helps you avoid conversion errors.

Display the status in Customizing for Conversions [Seite 544], in activity Maintain converter. Each converter can have one of the following statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready for conversions</td>
<td>No error has occurred yet.</td>
</tr>
<tr>
<td>Conversion in execution</td>
<td>This status can sometimes be incorrect. It may appear after a system crash, for example. Check whether a conversion is actually running. Set the status: ready for conversions when no conversion is actually taking place.</td>
</tr>
<tr>
<td>Connection error not ready</td>
<td>The system sets this status when an error occurs.</td>
</tr>
<tr>
<td></td>
<td>- Check the RFC destinations and the installation. You will find notes about troubleshooting the errors in the field Error number. Also read the output files from the communication programs (See: Installing the Converter [Seite 528]).</td>
</tr>
<tr>
<td></td>
<td>- Set the status to Ready for conversions once everything runs properly. Rerun a conversion with this converter to ensure that the error was corrected.</td>
</tr>
<tr>
<td>No license for the last conversion</td>
<td>No software license available that is required for the conversion. The system automatically sets the status: Ready for conversions after a short pause. You can also set this status manually.</td>
</tr>
</tbody>
</table>
Setting up an RFC Destination for a RFC Server

There are two methods for setting up RFC destinations:

- **Method A:** Set up for starting the program using the SAP Gateway
- **Method B:** Registration on the SAP Gateway

Below are the methods with a comparison of their advantages and disadvantages:

<table>
<thead>
<tr>
<th></th>
<th>Method A</th>
<th>Method B</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advantages</strong></td>
<td>The program only runs when it is actually needed.</td>
<td>Works on all operating systems.</td>
</tr>
<tr>
<td></td>
<td>The system is more stable. You can usually continue working even if the conversion server is restarted.</td>
<td>Simple installation.</td>
</tr>
<tr>
<td><strong>Disadvantages</strong></td>
<td>Only works when the conversion server is running on UNIX.</td>
<td>Program always runs in the background.</td>
</tr>
<tr>
<td></td>
<td>Installation is very complex.</td>
<td>If the program is halted, for example, because the conversion server has been restarted, it must be restarted.</td>
</tr>
<tr>
<td><strong>Use</strong></td>
<td>This method is highly recommended if you have a conversion server running UNIX.</td>
<td>This method is best for conversion servers using Microsoft Windows NT.</td>
</tr>
</tbody>
</table>

Information for Setting up an RFC Destination

The following information is required for both methods:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GATEWAY_HOST</td>
<td>Name of the computer where the SAP Gateway is running (for example hs0009)</td>
</tr>
<tr>
<td>GATEWAY_SERVICE</td>
<td>Gateway Service you are using (such as sapgw01)</td>
</tr>
<tr>
<td>RFC_SERVER</td>
<td>Complete path name of the program on the conversion server where you want to set up the RFC destination (for example /usr/converter/All2txt/StartConvUtil)</td>
</tr>
</tbody>
</table>
Setting up the Program Start Using SAP Gateway

Use
You are making the settings for using Method A that uses the SAP gateway to start a program for the opening the RFC connection.

See also: Setting up an RFC Destination for a RFC Server [Seite 553]

Prerequisites
The following information is required for method A:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GATEWAY_USER</td>
<td>Name of the user who started the SAP Gateway on GATEWAY_HOST</td>
</tr>
<tr>
<td>CONVERTER_HOST</td>
<td>Name of the conversion server (such as hs100)</td>
</tr>
</tbody>
</table>

Procedure
Replace the text between < and > with the values used in your enterprise.

1. <GATEWAY_HOST> Replace using the name of the computer where your SAP gateway is running.
2. Create a user with the name <GATEWAY_USER> on the conversion server.
3. Log on to the conversion server using <GATEWAY_USER>.
4. Create or modify the file $HOME/.rhosts.
5. Add the line <GATEWAY_HOST> to the file $HOME/.rhosts.
6. Set the access authorization for the file using the following values: -rw-r--r-- (for example with chmod 644 $HOME/.rhosts).

Read the main page for the command remote login if problems occur. The command could be man remsh or man rsh depending on the computer. Or contact a UNIX specialist.

In some cases the Gateway computer must entered twice in two lines in the file $HOME/.rhosts once with and once without the domain name.

hs0009
hs0009.sap-ag.de

7. Set the access authorization for <RFC_SERVER> so that <GATEWAY_USER> is authorized for at least r- and x-.

chmod 755 <RFC_SERVER>
8. Give authorization to write to the files and files that are written on the <RFC_SERVER> the user <GATEWAY_USER>.
   
   If you are using the SAP example programs you must give authorization to the <GATEWAY_USER> to write to the directories where <RFC_SERVER> is located.

9. Start the transaction SM59 (*Display and maintenance of RFC destinations*) on your SAP System
   
   - Select Create and enter any name in the RFC destination field, for example CONVERTER_ALL2TXT.
   - Enter T as the Connection type value.
   - Enter a description and confirm your entries.

10. Select the value *Start on explicit host* as activation type.
    
    Enter <RFC_SERVER> as the value for Program and <CONVERTER_HOST> as Target machine.

11. Select the entry Gateway options in the Destination menu.
    
    Enter <GATEWAY_HOST> as Gateway host and as <GATEWAY_SERVICE> Gateway service. Confirm the entry and save the document.

12. Select Test connection.
    
    - Everything is fine when you see the connection data with the transfer times.
    - A red colored error message indicates an error.
      
      Hints for troubleshooting can be found when files were created <RFC_SERVER>.
      
      No files exist when:
      
      - The user <GATEWAY_USER> does not have authorization to write to the files.
      - Start using remsh or rsh was unsuccessful.

    ![Red symbol]
    
    Verify your procedure. You can find information in the UNIX help (*man remsh* or *man rsh*).
    
    Conversion can only be executed when the connection test is successful.
Setting up Registration on the SAP Gateway

Use

You are making the settings for using Method B that registers the RFC connection on the SAP gateway.

See also: Setting up an RFC Destination for a RFC Server [Seite 553]

Prerequisites

The following information is required for method B:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProgramID</td>
<td>ID where the RFC server can be identified. Select and ID for each RFC server (such as converter.All2txt.1)</td>
</tr>
</tbody>
</table>

Procedure

Replace the text between < and > with the values used in your enterprise.

1. Replace <GATEWAY_HOST> with the name of the computer where your SAP gateway is running.

2. Edit <RFC_SERVER>.

   When using the example programs (RunConvUtil.bat or RunConvUtil) you must include the following information in the file:
   
   set ProgramID=<ProgramID>
   set GATEWAY_HOST=<GATEWAY_HOST>
   set GATEWAY_SERVICE=<GATEWAY_SERVICE>

   (RunConvUtil.bat) or
   
   ProgramID=<ProgramID>
   GATEWAY_HOST=<GATEWAY_HOST>
   GATEWAY_SERVICE=<GATEWAY_SERVICE>

   (RunConvUtil)

   Otherwise the RFC server must be called with the following parameters:
   
   -a <ProgramID> -g <GATEWAY_HOST> -x <GATEWAY_SERVICE>


4. Verify the messages on the screen (RunConvUtil.bat) and in the output files (RunConvUtil).

   After 30 seconds or more it is unlikely that an error occurs.

   Otherwise verify whether <GATEWAY_HOST> and <GATEWAY_SERVICE> are set correctly and whether the gateway server is operational.
5. Start the transaction SM59 (*Display and maintenance of RFC destinations*) on your SAP System

- Select *Create* and enter any name in the *RFC destination* field, for example CONVERTER_ALL2TXT.

- Enter T as the *Connection type* value.

- Enter a description and confirm your entries.

- Select *Registration* as the *Activation type*.

  Enter <ProgramID> as the value for *Program-ID*.

- Select the entry *Gateway options* in the *Destination* menu.

  Enter <GATEWAY_HOST> as *Gateway host* and as <GATEWAY_SERVICE> *Gateway service*. Confirm the entry and save the document.

6. Select *Test connection*.

- Everything is fine when you see the connection data with the transfer times.

- A red colored error message indicates and error.

  Verify whether <RFC_SERVER> is still running and if the data <ProgramID>, <GATEWAY_HOST> and <GATEWAY_SERVICE> are the same as the data you entered in the <RFC_SERVER>.

  Conversion can only be executed when the connection test is successful.
Example Installation of a Conversion Server

Procedure

The following example will show you how to install the conversion server All2txt.

2. Create a directory on the conversion server.

   (for example c:\converter (WinNT) or $USER/converter (UNIX).

3. Copy the archive (files *.SAR) into your directory from the directory ~ftp/general/misc/converter on the SAP FTP server sapservX.

   Read the file ~ftp/general/misc/converter/contents.txt to find out which archives you need.

4. Extract the archive with the program SAPCAR. The following files must then be in your directory:

<table>
<thead>
<tr>
<th>WinNT</th>
<th>UNIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConvUtil.exe ConvServSam p.exe</td>
<td>ConvUtil ConvServ</td>
</tr>
<tr>
<td>sapftp.exe  saphttp.exe sleep.exe</td>
<td>sapftp saphttp</td>
</tr>
<tr>
<td>librfc32.dll All2txt\RunConvUtil.bat</td>
<td>All2txt/Sta rtConvUtil</td>
</tr>
<tr>
<td>All2txt\ConvServ.bat</td>
<td>All2txt/Sta rtConvUtil</td>
</tr>
<tr>
<td>All2txt\StartConv.bat</td>
<td>All2txt/Sta rtConvUtil</td>
</tr>
<tr>
<td>All2txt\All2txt.bat</td>
<td>All2txt/Sta rtConvUtil</td>
</tr>
</tbody>
</table>

The programs sapftp.exe and saphttp.exe (WinNT) or sapftp and saphttp (UNIX) are on the Client Installation CD.

5. Set up the RFC destination [Seite 553] to All2txt\RunConvUtil.bat or All2txt\StartConvUtil.

   Name the RFC destination ALL2TXT_RFC.

6. Make the settings Customizing for conversions [Seite 542].

   In the SAP reference IMG you will find Customizing of Conversion under the path: Logistics General → Conversion.

   • Select Maintain converter. Create a new entry with the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
</table>

   (Your specific data here)
Example Installation of a Conversion Server

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the conversion server</td>
<td>All2txt</td>
</tr>
<tr>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>RFC destination for converter</td>
<td>ALL2TXT_RFC</td>
</tr>
<tr>
<td>Help programs (utilities) for conversion</td>
<td></td>
</tr>
<tr>
<td>FTP destination</td>
<td></td>
</tr>
<tr>
<td>HTTP destination</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Ready for conversions</td>
</tr>
<tr>
<td>Error number</td>
<td>000</td>
</tr>
</tbody>
</table>

- Select Determine conversion. Create a new entry with the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the conversion specification</td>
<td>DOC to TXT</td>
</tr>
<tr>
<td>Workstation application (source)</td>
<td>DOC</td>
</tr>
<tr>
<td>Workstation application (target)</td>
<td>TXT</td>
</tr>
<tr>
<td>Name of the conversion server</td>
<td>All2txt</td>
</tr>
<tr>
<td>Document Type</td>
<td>DRW</td>
</tr>
<tr>
<td>Automatically start according to status</td>
<td>RE (released)</td>
</tr>
<tr>
<td>Storage category for converted original application files</td>
<td></td>
</tr>
<tr>
<td>Language for error messages</td>
<td>/tmp/all2txt</td>
</tr>
<tr>
<td>Directory where files are checked out</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Earliest start time</td>
<td>00:02:00</td>
</tr>
<tr>
<td>Maximum time</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Start delay</td>
<td></td>
</tr>
<tr>
<td>Wait time, days</td>
<td></td>
</tr>
<tr>
<td>Time limit for converter (min)</td>
<td></td>
</tr>
<tr>
<td>Delete input files</td>
<td></td>
</tr>
<tr>
<td>Delete output files</td>
<td></td>
</tr>
<tr>
<td>Messages</td>
<td></td>
</tr>
<tr>
<td>Expiration date for application log</td>
<td></td>
</tr>
<tr>
<td>Check out depth</td>
<td></td>
</tr>
<tr>
<td>Structure of the files that were checked out</td>
<td></td>
</tr>
<tr>
<td>Epsilon for comparing lengths</td>
<td></td>
</tr>
<tr>
<td>Epsilon for angles</td>
<td></td>
</tr>
<tr>
<td>Messages at the beginning and end of each conversion</td>
<td></td>
</tr>
<tr>
<td>When without errors, delete</td>
<td></td>
</tr>
<tr>
<td>When without errors, delete</td>
<td></td>
</tr>
</tbody>
</table>

7. The installation is complete after you have saved your data. Test the converter as follows:
Example Installation of a Conversion Server

- Create a document with the document type DRW.
- Create an original application file in the document using the workstation application DOC.
- Set the status of the documents to RE (released). Depending on the status network you may have to carry out more than one step.
- Save your document.

**Result**

Conversion starts. Note the Messages in the application log [Seite 550].

After a several minutes open up the document again. You will see another original application file in the screen section Original if the conversion was successful, in this case the original application file is in *.txt format.
Digital Mock-Up Viewing

Use

You can use this function to visualize new products as 3D models in the development phase throughout the whole enterprise. You can display a 3D model of an assembly and its components in the Engineering Workbench of the SAP System.

Other areas can now use product information that used to only be accessible on paper format to the engineering/design department as well. All departments involved in the development project can see the 3D model of an assembly on the screen even before a prototype is available.

Integration

CAD Interface

The SAP System obtains product information from a CAD system. You create a construction drawing the CAD system for the assembly and its components. While doing this you also set the spatial relations of the components to each other.

You use the CAD Interface [Extern] to transfer your BOMs and CAD documents from your CAD system to your SAP System.

Contact your CAD interface provider about whether SAP’s DMU Viewing is supported. If DMU viewing is supported the CAD coupling creates the required assignments and starts the converter that then creates the transformation matrices and original application files in Direct Model format.

See: Converting Assemblies [Seite 548]

Alternatively, the CAD coupling can write the transformation matrices. The converter creates the original application files in Direct Model format when a status is set.

See: Converting Documents (Automatic Start) [Seite 546]

A converter must be installed in both cases. Please note the Installation Notes [Seite 528].

Conversion Interface

The conversion interface SAP System along with the external converter control the conversion of the original application files as well as the creating of the transformation matrices that contain the information about the geometric positions of the components.

The system creates a visual 3D file (such as *.jt) out of the CAD document for each component. This file is then stored in the SAP System as an original application file of the Document Management System and managed by means of a document info record.

You can now use the viewer that is integrated into the SAP System from Engineering Animation, Inc. (EAI) to view your 3D models of assemblies. The viewer is part of the standard SAP System's SAP Graphical User Interface (SAPgui) and is integrated into Engineering Workbench.

See: Viewer for Displaying Original Application Files [Seite 566]
Digital Mock-Up Viewing

Prerequisites

Original application files must be in a 3D format that supports Digital Mock-Up. Direct Model format (*.jt) is supported, for example.

The original application files in the SAP System are managed by means of Document info records. These document info records are assigned to items in your BOM.

See: Document Assignment [Extern]

Transformation matrices are also assigned to BOM items. A transformation matrix defines geometrical position of a component within space. When a component in an assembly is used more than once you need a transformation matrix for each part.

If you are working with multilevel BOMs, each level of the BOM must have a transformation matrix assigned to it.

Set the parameter for Digital Mock-Up when you transfer data to the SAP System using the CAD interface. Once you have done this the system converts the original application files automatically and creates the document info records and document assignments. Further information can be found under Conversion of CAD Files [Seite 548].

In Customizing of Document Management you will find the setting for the viewer of the standard SAP System under General Settings → Define workstation application:

- You created the entry for the workstation application JT.
- Set which viewer you want to use to display the JT original application files for the workstation application. Work step: Maintain workstation application in network.

See: Displaying Original Application File with a Viewer [Seite 506]

Features

You can display a 3D model of an assembly and its components in the SAP System. You can display a 3D model on the screen without opening another window while processing or displaying a BOM in Engineering Workbench.

You can also display individual or several components. When you select several components the system calculates the geometric items of the component and sends them to the viewer for display. When the components are an assembly in and of themselves you can dismantle components and display or hide individual components.

The BOM of an automobile contains the body and wheels, for example. You can just display the wheels or just the body.

When you display the body and the wheels or the whole automobile the system calculates the geometrical positions of the components and displays them.

When the body itself is an assembly you can also dismantle it into its components (fender, doors).

If the product has a multi-level BOM you can dismantle all assemblies for the 3D models of their components. This requires however that data from design drawings has been transferred to the
SAP System. You can do this for any number of levels. You can combine the components from any assemblies.

You can execute the following functions in 3D models:

- Display an individual component
- Display further components
- Hide individual components
- Display an entire assembly

You can also dismantle the components of assemblies to subordinate levels.

- You can highlight a component.
- Display a multi-level BOM

You can also use all the 3D functions of the viewer for displaying original application files such as:

- Rotating and tilting the 3D model
- Zoom
- Save the current screen contents of a file
Setting up Customizing for DMU Viewing

Use

Some data is already preset in the standard SAP System. Verify that this data is also correct and complete for your enterprise.

Special DMU Settings
Carry out the following steps under the structure node Control data:

- **Define document types [Extern]**
  Define a document type that you can use to manage the original application files that you create using the CAD interface. The interface is used when working with CAD drawings and the SAP System. For storing and checking in original application files we recommend you use the Knowledge Provider.

  Under the structure nodes Determine object links, you enter the document assignment for the following entries:
  - STKO_DOC for the assignment to a BOM header
  - STPO_DOC for the assignment to a BOM item

- **Maintain screen for object link**
  Screens [Extern] are already part of the standard SAP System that are required for links to BOM headers and BOM items.
  Verify the following entries or add others to them:

<table>
<thead>
<tr>
<th>Object</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>STKO_DOC (BOM header)</td>
<td>258</td>
</tr>
<tr>
<td>STPO_DOC (BOM item)</td>
<td>257</td>
</tr>
</tbody>
</table>

- **Maintain key fields**
  Key fields are already part of the standard SAP System that are required for links to BOM headers and BOM items.
  Verify the following entries or add others to them:

<table>
<thead>
<tr>
<th>Object</th>
<th>Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>STKO_DOC (BOM header)</td>
<td>GUIDX</td>
</tr>
<tr>
<td>STPO_DOC (BOM item)</td>
<td>GUIDX</td>
</tr>
</tbody>
</table>

Further entries (such as transaction codes) are not necessary for these link objects because the data is read internally.
Settings for Conversion

When you use the CAD interface to transfer CAD data into the SAP System the CAD files are converted into visual 3D files (such as *.jt). You define the settings for the conversion process in Customizing for Conversion.

See Customizing for Conversions [Seite 542] for more information about the required settings.

Setting for the Integrated Viewer

You can display your product with the integrated viewer of the standard SAP System. See Viewer for Displaying Original Application Files [Seite 566] for more information about the required settings.
Viewer for Displaying Original Application Files

Purpose

The standard SAP System’s SAP Graphical User Interface (SAP GUI) now has a viewer from Engineering Animation, Inc. (EAI) that allows you to view your products in the PLM area [Extern]. This viewer works with all Windows 32 bit operating systems and can display most original application files of a document info record.

- Thanks to the integration of this viewer solution in the Product Structure Browser you can view not only technical drawings but also 3D models. There are different functions for navigation such as rotate, zoom, center. You can then use the functions for redlining for processing the objects, saving them or printing them out.
- You can view products during the development phase using Digital Mock-Up Viewing [Seite 561].

Implementation Notes

You must make the following settings in Customizing of Document Management for the viewer of the SAP System.

- Control data → Define document types
  
The document type of the document info record that manages the original application file must have the Knowledge Provider [Seite 138] defined for the storage systems. This setting is done on the detail screen of the document type, indicator Storage via Knowledge Provider.

  You can only use viewer and redlining functions when the document type is so defined that it allows storage of original application files using Knowledge Provider.
  
The original application file does not have to be stored in a storage category of the Knowledge Provider in order to display it. The file can also be in a logical directory with the local network.
  
This type of storage is not always accessible by all frontend computers, whereas with the Knowledge Providers all frontend computers can access the original application files. SAP recommends therefore that all original application files be stored using the Knowledge Providers.

- General data → Define Workstation Applications [Extern]
  
The following partial steps are necessary:
  - Assign the correct application (for example Direct Model) for the file format you want to display (for example *.jt).
  - Maintain all data on the Detail screen that are supported for processing original application files with the workstation application such as for the application Direct Model for processing JT files.
  - Select the navigation step Maintain workstation application in network. Enter the call for the viewer.
You can use this call to determine for such things as whether you want display 2D or 3D formats.
The call for saying 3D formats (such as *.jt for Direct Model) with a workstation application could be done as follows:
EAIWeb.webviewer3D.1 %SAP-CONTROL%
Detailed information for the call of the application can be found in the IMG under Define workstation application.

Integration
You can view the product data in the following processing situations:

- Product Structure Browser
  You can expand the document data in a product structure and view the original application files of a document.

- Document Management
  You can display original application files from the tab page Document data or Originals.

- Engineering Workbench
  You can view original application files of material items from the Product Structure Browser.

- Process using the Project Builder (change and display) or use the Internet-Scenario Collaborative Engineering

Features

Supported Viewing Formats
The integrated viewer can display most 2D pixel, vector, and some text formats as well as 3D model formats. A complete overview is available in the List of Viewing Formats [Seite 254].

Calling the Menu
After the function Display original application file is started the original application file is displayed either inplace or outplace. The display variant is set for the individual processing situations (such as displaying from a document info record or the Product Structure Browser) and cannot be changed.

- inplace
  The original application file is displayed in the same window as the one used for processing.
  - Example: If you display the original application file while processing the document info record of the Product Structure Browser or Engineering Workbench, the system splits the screen and the current screen and displays the viewer in the new screen section.
  - In the screen section where the viewer is located the original application file is also displayed the viewer function bar becomes active.

- outplace
Viewer for Displaying Original Application Files

The original application file is displayed in a different window as the one used for processing.

If you display the original application file from the results screen of a document search, the system creates a new window automatically. In the new screen section the original application file is also displayed the viewer function bar becomes active.

See also: Displaying Original Application File with a Viewer [Seite 506]

Viewer Function Bar

When you display the original application file with the integrated viewer the system adds a function bar for the viewer. The viewer function bar contains all the functions you can use in the current processing situation, such as Redlining functions. The scope of function depends on whether the viewer is displaying 2D or 3D format files.

An overview of the processing functions can be found in the Function Overview of the Viewer [Seite 251].

Redlining Function Bar

The call of the Redlining functions is done from the viewer function bar. The system changes from viewer mode into Redlining mode and makes the Redlining function bar available.

For more information, see Redlining for Original application files [Seite 259].

Dimensioning 2D Files

Dimensioning functions allows you to measure such things as angles, line and radii.

An overview of dimensioning functions can be found under Dimensioning 2D files [Seite 270]

Example

The following example shows how an assembly is viewed in the Engineering Workbench. The assembly was transferred from a CAD system into the SAP-System (Digital Mock-Up Viewing).
Restrictions

The viewer can be used on machines with at least a Pentium® class processor at 133 MHz.

For 3D formats you will need the following:

- Pentium II
- 128 MB RAM
Displaying 3D Models of Assemblies

You are in the Engineering Workbench overview for items.

2. Click \[\text{button} \]

The dialog box EWB: Options appears.

3. Select in the tab page Browser the option Digital Mock-up.

In this way you ensure that the BOM in the object browser is displayed on a key date, this means that only change status is displayed for each BOM item.

4. Click \[\text{button} \]

5. Enter the change number or the key date in the dialog window that appears and select \[\text{button} \].

The object browser is displayed in the left screen section. There you find the column with the heading DMU (Digital Mock-Up). In this column a check-box appears for each component.

If you do not see the column DMU you must increase the size of the screen section of the object browser to the right.

You can use the check-boxes to hide or display individual components in the DMU column or use the context menu.

Displaying Components Using Check-Boxes

Click on the check-box to display or hide a component. The viewer is displayed as soon as the first check-box is activated.

You can see which assemblies and components are currently being displayed in the viewer by looking at the check-boxes.

When you activate the check-box for an item, the system automatically activates the check-boxes for the subordinate assembly. This displays that the data came from this assembly.

The advantage of this is that you can always recognize which assembly’s data is currently being displayed, even when you collapse the partial tree under the assembly.

Displaying Components Using the Context Menu

The context menu is displayed when you click with the right-hand mouse button on a BOM header or an item. The following commands are available in the context menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>System activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMU: Display item again</td>
<td>Delete the display in the viewer and display the individual components</td>
</tr>
</tbody>
</table>
Displaying 3D Models of Assemblies

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMU: Add items</td>
<td>Display another component in the viewer while considering the components that are already displayed</td>
</tr>
<tr>
<td>DMU: Highlight items</td>
<td>Highlight components in the viewer</td>
</tr>
<tr>
<td>DMU: Hide item</td>
<td>Hide item in viewer</td>
</tr>
<tr>
<td>DMU: Display item</td>
<td>Show an item again that you had hidden with the command DMU: Hide item</td>
</tr>
</tbody>
</table>

See also:
Highlighting Components [Extern]